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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross 
Technology. 
Our mission is to:
1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach 
out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality 
customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to 
guide our behavior:
1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong 
and it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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Statement of Compliance
This product has been determined to be compliant with the applicable standards, regulations, and 
directives for the countries where the product is marketed.

Compliance documentation, such as certification or Declaration of Compliance for the product is 
available upon request by contacting techsupport@rossvideo.com. Please include the product; 
model number identifiers and serial number and country that compliance information is needed in 
request.

EMC Notices
United States of America - FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, 
pursuant to part 15 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a Commercial environment. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this equipment in 
a residential area is likely to cause harmful interference in which case the user will be required to 
correct the interference at his own expense.

Canada

This Class A device complies with Canadian ICES-003 and part 15 of the FCC Rules.

Cet appariel numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

European Union

This equipment is in compliance with the essential requirements and other relevant provisions 
established under regulation (EC) No 765/2008 and Decision No 768/2008/EC referred to as the 
“New Legislative Framework”.

Australia/New Zealand

This equipment is in compliance with the provisions established under the Radiocommunications 
Act 1992 and Radiocommunications Labelling (Electromagnetic Compatibility) Notice 2008.

Korea

This equipment is in compliance with the provisions established under the Radio Waves Act.

Class A equipment (Broadcasting and communications service for business use).

This device is a business-use (Class A) EMC-compliant device. The seller and user are advised to be 
aware of this fact. This device is intended for use in areas outside home.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Ltd. 
could void the user’s authority to operate this equipment.

Warning — This equipment is compliant with Class A of CISPR 32. In a residential environment this 
equipment may cause radio interference.



International

This equipment has been tested under the requirements of CISPR 22:2008 or CISPR 32:2015 and 
found to comply with the limits for a Class A Digital device.

Warranty and Repair Policy
The Ultrix systems are backed by a comprehensive one-year warranty on all components.

If an item becomes defective within the warranty period Ross will repair or replace the defective 
item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are 
conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of 
Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be 
supplied free of charge while defective items undergo repair. Return packing, shipping, and special 
handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or 
application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or 
consequential damages (including loss of profit). Implied warranties, including that of 
merchantability and fitness for a particular purpose, are expressly limited to the duration of this 
warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of 
ownership.

Environmental Information
The equipment may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need 
for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back 
systems. These systems will reuse or recycle most of the materials from your end-of-life equipment 
in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

Notice — This is a Class A product. In domestic environments, this product may cause radio 
interference, in which case the user may have to take adequate measures.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited 
could void the user’s authority to operate this equipment.
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If you need more information on the collection, reuse, and recycling systems, please contact your 
local or regional waste administration. You can also contact Ross Video for more information on the 
environmental performances of our products.

This appliance may contain a Coin type battery which should not be treated as household waste.

To ensure that the battery will be treated properly use the appropriate take-back systems in your 
area. These systems will reuse or recycle most of the materials from your end-of-life equipment in 
an environmentally friendly and health conscious manner.

Security and Privacy 
If you would like more information on how Ross Video security and privacy practices have been 
applied to Ultrix, what you should know about maintaining security of this product, and how we can 
partner with you to ensure security throughout this product's life-cycle, contact 
techsupport@rossvideo.com.

Ross Video has implemented reasonable administrative, technical, and physical safeguards to help 
protect against security incidents and privacy breaches involving a Ross Video product provided 
those products are used in accordance with Ross Video instructions for use. However, as systems 
and threats evolve, no system can be protected against all vulnerabilities and we consider our 
customers the most important partner in maintaining security and privacy safeguards. If you have 
any concerns, we ask that you bring them to our attention, and we will investigate. Where 
appropriate, we will address the issue with product changes, technical bulletins and/or responsible 
disclosures to customers and regulators. Ross Video continuously strives to improve security and 
privacy throughout the product life-cycle using practices such as: 

• Privacy and Security by Design
• Product and Supplier Risk Assessment
• Vulnerability and Patch Management
• Secure Coding Practices and Analysis
• Vulnerability Scanning
• Access Controls appropriate to Customer Data
• Incident Response
• Clear paths for two-way communication between customers and Ross Video

If you would like to report a potential product related privacy or security issue (incident, breach, or 
vulnerability), contact techsupport@rossvideo.com.



Company Address

Ross Video Limited 
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613  652  4886

Fax: (+1) 613  652  4425

Technical Support: (+1) 613  652  4886

After Hours Emergency: (+1) 613  349  0006

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Introduction
This guide covers the configuration and operation of the Ultrix router. The following chapters are 
included:

• “Introduction” summarizes the guide and provides important terms, and conventions.
• “Getting Started” provides general information to keep in mind before configuring your Ultrix, 

instructions for configuring the Ultrix network settings, and displaying the Ultrix nodes in 
DashBoard.

• “Software License Keys” provides instructions for enabling licensed features of your Ultrix 
router.

• “Ultricore Profiles” provides an introduction to the Ultricore Profiles for your router matrix and 
includes general information on managing those profiles.

Hardware Configuration
• “Configuring the Ports” provides instructions on how to manage your hardware matrices, 

configure an AUX port, and assign an UltriScape (Multiviewer) head to a physical output.
• “UHD Gearbox Configuration” provides instructions on how to set up your Gearbox groups. 
• “ULTRIX-IP-IO Setup” outlines how to configure receivers and senders for the Ultrix router to be 

used in video and audio streaming when at least one ULTRIX-IP-IO blade is installed in a slot of an 
Ultrix router chassis.

• “ULTRIX-SFP-IO Setup” outlines how to utilize the ports for the Ultrix router when an 
ULTRIX-SFP-IO blade is installed in a slot of an Ultrix router chassis.

Routing Configuration and Operation
• “Device Communication Setup” provides instructions for using Ultrix to establish connection 

points to Ross NK Series devices, Ross Ethernet devices, and third-party devices in your routing 
system.

• “Database Configuration” provides instructions on how to define destinations, sources, and 
levels for your router.

• “Managing the UltriScape Heads” provides instructions on how to, load and assign a layout to 
an UltriScape head, and assign router input signals to PiPs in a layout.

• “Tallies” provides instructions on how to enable TSL UMD messages in the active database, 
assign Tally IDs to your sources and destinations, and how to manage tally objects in your 
UltriScape heads.

• “Configuring an Audio Matrix” provides instructions on how to enable Sample Rate Conversion 
(SRC) of the embedded audio, audio fading, configuring how the audio is embedded in the 
outputs, mapping audio channels, and configuring MADI signals.

• “Using Remote Control Panels” provides information on operating the Ultrix router with Ross 
remote control panels (RCP).

• “Using Categories” describes how to assign each destination, source, and level to a specific 
category in the router database. 

• “Soft Panels in DashBoard”describes the Matrix, MultiBus, and Category panels in DashBoard, 
and provides instructions on how to use the soft panels to perform crosspoint switches.

• “Using Salvos” describes how to create and recall a salvo using the options in DashBoard.
• “Operation with Ross Devices” provides general information for operating the Ultrix router in a 

routing system that also includes Ross NK Series devices.
• “External Control” lists the third-party protocol commands the Ultrix router supports.
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• “ULTRIX-UCCI Redundancy” outlines the ULTRIX-UCCI Control redundancy feature for the 
ULTRIX-FR5.

• “Managing your Ultrix Settings” outlines how to import and export archived files (*.ufs) of your 
Ultrix router settings to another Ultrix router.

• “Monitoring the Hardware” outlines how to monitor the router hardware via the DashBoard 
status fields.

• “Monitoring the Communications” summarizes how to verify communications on an Ethernet 
port, an Ultricore connection, and the overall communication status of the Ultrix router.

• “Monitoring the Signals” outlines how to monitor the reference signal, the inputs and outputs 
signals via the options in the Frame Configuration interface of DashBoard.

• “Software Upgrades” provides instructions on how to upgrade the Ultrix router through 
DashBoard.

• “DashBoard Interface Overview” summarizes the functions, menus, and parameters of the 
Ultrix tabs and windows in DashBoard.

• “Glossary” provides a definitions of commonly used terms and conventions for this guide.

If you have questions pertaining to the operation of Ultrix, contact us at the numbers listed in 
“Contacting Technical Support”. Our technical staff is always available for consultation, training, 
or service.

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user 
must enter, or a sequence of menus and sub-menus that must be followed to reach a particular 
command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For 
example:

In the Save As dialog, click OK.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the section “Hardware Overview” in the Ultrix Installation Guide.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. 
For example, if a step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

 An error message displays when an object overlaps a tile or when one tile overlaps another in the 
workspace.
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Contacting Technical Support
At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as 
the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. 
After-sales service and technical support is provided directly by Ross Video personnel. During 
business hours (Eastern Time), technical support personnel are available by telephone. After hours 
and on weekends, a direct emergency technical support phone line is available. If the technical 
support person who is on call does not answer this line immediately, a voice message can be left 
and the call will be returned shortly. This team of highly trained staff is available to react to any 
problem and to do whatever is necessary to ensure customer satisfaction.

• Technical Support: (+1) 613-652-4886
• After Hours Emergency: (+1) 613-349-0006
• E-mail: techsupport@rossvideo.com 
• Website: http://www.rossvideo.com 

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Getting Started
An effective routing system takes careful planning. Routing systems may consist of many devices 
either located within the same facility, or across multiple locations. Routing devices (routers) must 
connect and communicate with each other and any control system devices all on a high speed 
network.

 DashBoard is required to configure the Ultrix router.

Configuration Overview
The generalized work-flow of configuring your Ultrix router is:

1. Configure the network interface settings for the Ultrix router.

2. Establish DashBoard connectivity.

3. Configure Ultrix device system settings

4. Define a database for the router.

5. Set up control panels.

 Ultrix supports a maximum of 25 DashBoard clients with 50 other TCP/IP connections (remote 
control panels, third-party control systems, etc.).

Figure 1  Process for Configuring an Ultrix Router

Establish Communications
Walkabout is a DashBoard system for network device discovery. Ultrix supports the Walkabout 
system for configuration of its IP settings. Once you establish communications over Ethernet 
between the Ultrix router and DashBoard, you can proceed to use the interfaces in DashBoard that 
enable Ultrix to communicate with the other devices in your routing system.

 Ross Video recommends a Memory Allocation of at least 4GB in DashBoard to ensure reliable 
operation. Refer to the DashBoard User Guide for details on setting the Memory Allocation value.

Network Settings
The Ultrix network settings may be changed by either the Dashboard Walkabout interface, or the 
Ultrix front panel interface. A complete network setting requires a static IP address, a network mask 
address, and a gateway address. These should be supplied by your IT Department for this device.

Using Walkabout to Assign the Initial IP Address to the Router
Once the Ultrix router is physically installed and cabled to your facility network, you will need to 
assign it an initial static IP Address to enable DashBoard to locate it on your network. Establishing 
an initial IP Address enables DashBoard to communicate with the router and update the Basic Tree 
View with the Ultrix nodes.
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 After you edit a cell in the Walkabout table, it is recommended to wait approximately 1 minute, 
then click Refresh to apply the new settings.

To assign the initial static IP address for the Ultrix router

1. Launch DashBoard.

2. From the DashBoard client main toolbar, select File > Show Walkabout.

The DashBoard window displays the Walkabout table.

3. Click Refresh, located at the bottom of the Walkabout tab, to ensure the list in the Walkabout 
interface is current.

4. In the Walkabout table, find the entry for the Ultrix you want to configure.

 A factory default Ultrix will display Ultrix in the Name field and an IP address of 192.168.20.140. 

5. Use the Name field to assign a unique identifier to the Ultrix router. 

This will also be the name displayed in the Tree View of DashBoard.

6. To assign a new IP address:

a. Double-click the Address field.

b. Enter the IP Address supplied by your IT Department for this device.

c. Press Enter to save the new address.

7. Ensure the Netmask field is set to match your network requirements.

8. Use the Gateway field to specify the IP Address for connection outside of the local area 
network (LAN).

9. Click Reboot in the row of the Walkabout table for the Ultrix router.

The router reboots and the new settings are applied.

Adding the Ultrix Router to the Tree View in DashBoard
Once you have assigned the Ultrix router a static IP Address, you can then manually add it to the 
Tree View in DashBoard. Manually adding the Ultrix router displays its node in the Tree View, 
granting you access to the interfaces described in the chapter “DashBoard Interface Overview”.

To manually add the Ultrix router to the Tree View in DashBoard

1. In the Basic Tree View toolbar of DashBoard, click .

The Select Equipment or Service Type to Add dialog opens.

2. Expand the openGear/DashBoard Connect node.
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3. Select TCP/IP DashBoard Connect or openGear Device.

4. Click Next >.

The TCP/IP DashBoard Connect/openGear Device dialog opens.

5. Select the JSON radio button as the Protocol.

6. Enter the IP Address for the router in the IP Address field that you assigned in “To assign the 
initial static IP address for the Ultrix router”.

7. Perform one of the following steps:

• In the text fields provided, enter the display name for the Ultrix router, and port of the panel 
you wish to add; or

• Click Detect Frame Information to automatically retrieve the connection details.

8. Click Finish. 

Accessing the Ultrix Interfaces in DashBoard
The interfaces are accessed by expanding the Ultrix node in the DashBoard Tree View and selecting 
the appropriate sub-node. Several of the interfaces are organized in a table layout with a toolbar on 
the bottom, and a toolbar on the left side of the tab.

To access the Database interfaces in DashBoard

1. Locate the Ultrix in the Tree View of DashBoard.

2. Expand the Ultrix node to display a list of sub-nodes.
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3. Select a sub-node for the interface you want to access. For example, expand the Ultrix node to 
display a list of options for the Ultrix router.

4. If required, expand the sub-node to access the function of the interface. For example, expand 
the Database node to list the options available for configuring a database for the Ultrix router.

5. Double-click a sub-node to display its tab in the right-side of the DashBoard window. For 
example, double-click the Destinations node to display the Destinations interface.

 The selected interface may be blank or missing some data if the database is new and is not 
configured yet.

To access the Device Configuration interfaces in DashBoard

1. Locate the Ultrix in the Tree View of DashBoard.

2. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

3. Expand the Devices node.

4. Expand the Controllers + Matrices node.

5. Double-click the Ultrix node to open the Device Configuration interface.

6. Select a button from the toolbar to display that interface in the DashBoard window. 

In the above example,  was selected.
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Updating the Network Settings for the Ultrix Router
 This section is not applicable if your router is already set to the correct IP address.

Once you establish initial communications with the Ultrix router, and it displays in the DashBoard 
Tree View, you may wish to review or change the IP Address and other settings according to your 
facility network requirements.

 This procedure requires a reboot of the router.

To update the network settings for the Ultrix router

1. Locate the Ultrix in the Tree View of DashBoard.

2. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

3. Double-click the System Status node.

4. Select the Network tab.

5. Locate the Settings area.

6. Edit the fields as required.

 Do not assign the Ultrix to an IP address in the range of 192.168.12.0-192.168.12.255. These are 
reserved addresses.

7. Click Apply.

8. Click Reboot. This button is located at the bottom of the window. 

Re-naming the Ultrix Router
If you installed multiple Ultrix routers in your system, each router must have a unique name 
assigned to it via its front panel menu system. This ensures that the router is easily identifiable in 
the Walkabout interface and uniquely identifies its inputs and outputs in the DashBoard database 
interfaces.

Throughout the DashBoard interface, actual sockets (inputs and outputs) of a router (or matrix) are 
referred to by hierarchical dotted notation: Frame.Slot.Port.Type.Channel where Frame identifies 
the physical router chassis housing the matrix/matrices. By default, each Ultrix router ships with the 
name “Ultrix” automatically set. By re-naming each Ultrix router, you are providing a unique 
identifier for the sockets within the router system.

You can rename a router via the options in DashBoard or via the front panel. This section outlines 
both methods.

Re-naming the Ultrix Router via DashBoard
Each Ultrix router can be given a unique name that is used on internal menus and as the identifier 
in the tree views of DashBoard. 

 Changing the router name after database configuration takes time to propagate through the 
system, and for DashBoard to reconnect, resuming stable system operation. Sufficient time must 
be allowed when making this change before attempting to use the system. This time will vary 
depending on features, matrix size, and configuration. In the case of the ULTRIX(-NS)-FR1 and 
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ULTRIX(-NS)-FR2, the worst case will be 3-4 minutes. In the case of the ULTRIX-FR5, the worst case 
is 10 minutes. The router name is typically assigned during initial commission and very rarely 
ever changed again.

 This procedure requires a reboot of the router.

To re-name the Ultrix router via DashBoard

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Setup tab.

3. Use the Device Name field to specify the new name for the Ultrix router.

 Ultrix does not support Unicode characters.

4. Press Enter to apply the new name.

5. Click Reboot.

 It may take several seconds or more for the Ultrix node name to update in the Tree View of 
DashBoard.

Re-naming the Ultrix Router via the Front Panel
The LCD Display on the Ultrix front panel reports the chassis IP Address, the unique name of the 
router, and reports when an error or warning condition is occurring on the router. Next to the LCD 
Display is a five-direction round finger joystick that is used to access and navigate the Ultrix 
messages and menus on the LCD Display.

For More Information on...
• using the joystick to navigate the front panel menu system, refer to the Ultrix Installation Guide.

To re-name an Ultrix router via the front panel

1. Navigate to the Frame Name menu via the front panel as follows:

The current name for the router is displayed in the bottom line of the Frame Name: field. The 
first character position in the field will alternate flash with an underscore character. This 
provides visual feedback to the current cursor position.

1 2 3 4Network
>System

1 2 3 4Frame Name
 System  Name

1 2 3 4Frame Name:
 Ultrix

1 2 3 4>Config
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2. Use the joystick to assign a new name to the router.

• Pressing the joystick LEFT/RIGHT positions the cursor.
• Pressing UP/DOWN selects a character.

3. Press the joystick IN to apply the new name.

4. Ensure the cursor is positioned at the front of the name.

5. Press the joystick LEFT to navigate back up the menu tree.

Specifying a Default Reference Format
If you did not connect a reference source signal to the REF port on the Ultrix rear panel, you can still 
configure a Default Reference format using the options in the Frame Configuration interface. Note 
that this Default Reference setting only applies to start-up with no reference source connected.

Keep the following in mind:

• If you connect a valid reference source to the REF port, it will take precedence over the Default 
Reference setting.

• If the connected reference source becomes unavailable, the Ultrix router will use the last known 
good reference format until a re-boot or power cycle occurs (at which time the Default Reference 
setting will be applied). 

• If the Ultrix router does not have a valid reference signal connected to it, UltriScape still needs a 
reference to output correctly. Specifying the Default Reference Format provides an internal 
reference signal of either NTSC or PAL rates to allow UltriScape to still output with no system 
reference signal connected.

To specify the default reference format for the Ultrix router

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens.

5. Select the References tab.

6. Use the Detect Reference area to manage the reference formats for the Ultrix router. 

Specifying the Time Source
The Ultrix router requires an external time source in order to accurately report the time-of-day. The 
options in the Frame Configuration interface enable the selection of time/date source via an NTP 
Server in your facility, or you can set the device time to match the computer which is running the 
current DashBoard client.

Using an NTP Server as the Time Source
 Before proceeding, contact your IT Department to learn the IP address(es) of the NTP server(s) in 

your facility. 
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To specify an NTP Server as the time source for the Ultrix router

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens and the Communications tab is automatically selected.

5. Locate the NTP Servers area on the Communications tab. 

6. If you are using one NTP server, enter the IP address in the Address field of the Server 1 row.

7. If using a backup NTP server:

a. Enter the IP address of the first NTP server in the Address field of the Server 1 row.

b. Enter the IP address of the backup NTP server in the Address field of the Server 2 row.

8. Select the NTP Enabled box.

9. Verify that the Status field(s) in the NTP Servers table report a valid connection to the listed IP 
address(es). You may need to refresh the interface as follows:

a. Close the Device Configuration interface.

b. Re-open the Device Configuration interface by repeating steps 1 to 3 to update the field(s).

Using the DashBoard Client Computer as the Time Source
This section outlines how to set the Ultrix to the local time without using an NTP Server. Instead, 
you will set the time to the values reported by the DashBoard client computer you are using.

 The time the Ultrix reports is not linked to this computer. It is a once off setting of the time to 
match the computer time when the Set to PC Time button is selected on the Ultrix interface. If 
the DashBoard client computer time changes, you will need to update the time reported on the 
router by repeating the procedure below.

To specify the DashBoard client computer as the time source for the Ultrix router

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens and the Communications tab is automatically selected.

5. Locate the NTP Servers area on the Communications tab. 

6. Click Set to PC Time. This button is located in the top right corner of the Communications tab.
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Configuring Access for DashBoard Clients
You can specify which DashBoard clients on your network can access and connect to your Ultrix. By 
default, the Permitted Clients list is blank, allowing all DashBoard clients on your network to 
connect to your Ultrix.

 Ross Video strongly encourages use of static IP addresses throughout systems using its 
equipment. A network device which acquires its address through DHCP is not guaranteed to 
always be assigned to the same IP address. In this case, use of DHCP could result in DashBoard 
client PCs being denied access to the Ultrix system.

To enable access for a DashBoard client

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Network tab.

3. Locate the Permitted Clients area of the Network tab.

4. Click Add in the Permitted Clients area.

The Add Address dialog opens.

5. Use the IP Address field to specify the IP Address of the DashBoard client you wish to grant 
access to your Ultrix.

 IPV6 addresses and computer names are not currently supported for this list.

6. Click Apply.

The Add Address dialog closes.

The Dashboards list in the Permitted Clients area updates to display the specified IP Address.

7. Repeat steps 4 to 6 for each DashBoard client you want to allow access.

 Ensure that the IP Address for your DashBoard client machine is also added.

8. Click Apply in the Permitted Clients area to apply the changes.

To disable access for a DashBoard client

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.



32 • Getting Started Ultrix User Guide (v23.0)

2. Select the Network tab.

3. From the Dashboards list, select the IP Address of the client you want to disable access for.

 Do not delete the IP Address for your DashBoard client machine.

4. Click Delete in the Permitted Clients area of the Network tab.

5. Click Apply in the Permitted Clients area to apply the change.

Define a Database for the Router
The Database interface in DashBoard for an Ultrix enables you to create system input and output 
lists, assign those signals to system sources and destinations, define multiple levels and matrices. 
You may wish to use the following process when defining the database for your router.

 Ultrix supports a maximum of 64 levels, with a maximum matrix of 4096 sources and 4096 
destinations.

For More Information on...
• databases, refer to “Database Configuration”
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Software License Keys
The Ultrix routers have software options that license functions and features. This chapter outlines 
the available software licensed features, and how to install a software key for a licensed feature. 

Before You Begin
When installing a software license key on the Ultrix router:

• You must have the DashBoard client installed and communicating with the Ultrix router that you 
wish to install the key for.

• Ensure that you are using DashBoard version 9.0 or higher. This information is available by 
selecting Help > About DashBoard from the DashBoard main toolbar.

License Keys Overview
Table 1 provides a brief summary on the types of licensed features available for the Ultrix router.

 The per slot UltriMix license comes standard with every Ultrix router.

Table 1  List of Ultrix Licensed Features

License Description
ULTRIMIX-MXR A license that enables the configuration and use of audio mixer 

soft panels.

UltriScape Each license enables one Multiviewer Head (output) per slot.
Each slot supports up to three Multiviewer Heads.

UltriSpeed A license that enables the use of UHD 12Gbps SDI signaling on all 
slots of the Ultrix router.
The 12Gbps SDI signaling through an SFP module installed in an 
AUX port is also supported. You must order the SFP module 
separately.
This license is required if you wish to configure a UHD Gearbox.

UltriSRC A per input license enabling Sample Rate Conversion (SRC) on 
MADI audio inputs. This allows MADI inputs that are not 
synchronized to the frame reference.

UltriSync A per input 3G frame sync license enabling alignment to router 
sync.

Ultrisync-UHD A per input frame sync license to support UHD video rates. Each 
slot supports up to 3 Ultrisync-UHD ports.
Requires software version 4.2.0 or higher and is applicable only to 
the ULTRIX-HDBNC-IO and ULTRIX-SFP-IO blades.

Ultriscape-CA A license that enables the display of CEA-608, CEA-708, and OP-47 
closed caption data on a Multiviewer Head.

Ultricore-EMBER+ A license that enables the use of the EMBER+ protocol for video 
and audio streaming via an ULTRIX-IP-IO blade.

Ultricore-NVISION A license that enables the use of the NVISION protocol on all slots 
of the Ultrix router.
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Installing a License Key
Ross Video uses license keys to control user access to specific Ultrix features. You can obtain a key 
for an Ultrix licensed feature from Ross Video Technical Support.

To install an Ultrix license key

1. Launch the DashBoard client. 

2. Locate the Ultrix node in the Tree View.

3. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

4. Expand the Devices node.

5. Expand the Controllers + Matrices node.

6. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

7. Select .

The Licenses page opens with License Keys sub-tab automatically selected.

8. Make a note of the character string in the Request Code field for the license you wish to enable.

9. Contact Ross Video Technical Support using the information found in “Contacting Technical 
Support”.

a. When you speak to your Technical Support representative, tell them your name, your facility 
name, and the Request Code from step 8.

b. You will be given a License Key for the licensed feature.

10. Enter the provided License Key in the applicable License Key field of the Licenses tab.

 You can also right-click on the row for the License Key you are installing, and copy the Request 
Code to or paste the License Key from the Microsoft® Windows® clipboard.

ULTRICORE-PRO A licensed that provides full Ultricore Profiles support on Ultrix 
frames.

Ultricore-SNMP A license that enables basic SNMP monitoring on Ultrix routers. 

Table 1  List of Ultrix Licensed Features

License Description
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11. Click Apply in the row for the License Key you entered in step 10.

12. Verify that the Count field is updated to report each installed License Key.

To activate an UltriScape license for a specific slot/head

1. Install the license key as outlined in the procedure “To install an Ultrix license key”.

2. In the Licenses sub-tab, select the UltriScape sub-tab.

Each row in the tab represents a slot and UltriScape head in the Ultrix router (with slot 1 as the 
topmost slot in the router). The Port column in the tab represents the output for the head. The 
Format column represents the video format assigned to that head.

3. In the Port column, select the cell for the UltriScape head you want to enable.

A drop-down menu displays that lists the available ports.

4. Select Enable to apply the UltriScape license to that UltriScape head.

Removing a License Key
When you want to move an Ultrix licensed feature from one slot to another in the same router, you 
must first disable the Ultrix feature on the current Ultrix router. 

 Removing a License Key also removes user access to all of the Ultrix features associated with that 
License Key.

To remove a Ultrix license key

1. Launch the DashBoard client. 

2. Locate the Ultrix node in the Tree View.

3. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

4. Expand the Devices node.

5. Expand the Controllers + Matrices node.

6. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

7. Select .

The License Keys sub-tab is automatically selected.

8. To remove a license key for a specific slot:

a. Select the sub-tab for the license type you want to remove.

Each row in the sub-tab represents a slot in the Ultrix router. Each column represents a type 
of licensed feature.

b. Select Disable to remove the license for the selected slot.

 If you wish to apply the same license key to another slot, follow the steps outlined in the 
procedure “Installing a License Key”.

9. To remove a license key from the router:

a. On the License Keys sub-tab, located the row for the licensed feature you want to remove.

b. Click Cancel in the row. 
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Locking Access to the Licenses
The Ultrix includes a password-protected feature that prevents unauthorized changes to license 
keys. When the License tab is locked, users require a password to access/edit the license key 
information. This feature is disabled by default (the License tab is editable).

Enabling the Port License Lock
To lock the tab, you must enable the Password Protected settings in the System Status > Setup tab.

To enable the lock on the Port License tab

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Setup tab.

3. In the Password Protected Settings area, select the Protect all Licensed features with a 
password box.

4. Click Apply at the bottom of the Setup tab.

Changing the Password
It is recommended to change the password from the default value that is assigned at the factory.

 A password must be at least 8 characters long.

To change the password

1. Click Change Password.

The Enable Password Protection dialog opens.

2. If you are changing the password from the default value:

a. In the Password field, type r0ssUltrix.

b. Click Apply.

The Change Password dialog opens.

3. If you are changing the password from a value other than the default:

a. In the Password field, type the character string for the current password.

b. Click Apply.

The Change Password dialog opens.
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4. Use the Password field to type the current password.

5. Use the New Password field to type the character string for the new password.

6. Use the Confirm Password field to type the same character string you entered in step 5.

7. Click Apply.

The Change Password dialog closes and the Port License tab is now locked.

Unlocking the Port Licenses via Password
A user can unlock the Port License tab by clicking the Unlock button and entering a password.

To unlock the Port Licenses tab via password

1. Launch the DashBoard client. 

2. Locate the Ultrix node in the Tree View.

3. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

4. Expand the Devices node.

5. Expand the Controllers + Matrices node.

6. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

7. Select .

8. Click Unlock... .

The Protected Access dialog opens.

9. In the Password field, type the password as defined in step 5 of the procedure “To enable the 
lock on the Port License tab”.

10. Click Apply.

The Protected Access dialog closes and the Licenses tab is now editable.

 To re-lock the Licenses tab, click Lock.
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Ultricore Profiles
A DashBoard client has the ability to detect devices on a subnet and can enable complete control of 
all settings on all devices. Ultricore Profiles are designed to enable administrators to assign and 
manage user permissions and determine the level of access for those users. For example, one user 
is only responsible for monitoring the video sources is given access only to control panels, while 
another user who manages the input and outputs of the router matrix is also given access to 
manage the databases. 

This chapter provides an introduction to the Ultricore Profiles for your router matrix and includes 
general information on managing those profiles. 

Overview
The Ultricore Profiles operate as a form of hierarchical database where user permissions are 
organized into a tree-like format. A profile determines which groups and pages that a user can 
access. 

Any number of profiles may be created and can be used in the following ways:

• Group/Role — This profile type is not specific to any user or machine. Once created they can be 
referenced or used by any number of users or machines. For example, a Graphics Editor profile 
can be created and referenced by a team of graphics editors. When a new control panel is added 
to that profile, all graphics editors are updated with the new panel automatically.

• User — A user profile identifies a specific username and can either reference an existing role as 
above or copy an existing role then modify, add, or remove items to allow total customization as 
required. This allows a user that has a specific profile to have the same capabilities on any 
DashBoard system regardless of where they log in. 

• Location — This profile is defined by a specific location (user station) and assigns a consistent 
function regardless of who is logged in that suits the operation in that location. In this way the 
DashBoard instance in front of, for example, the audio operator in a specific control room will 
only have the optimize functionality for that role. A location profile can also reference or copy and 
modify role profiles.

Profiles can also be created that identify a specific user at a specific user station to further optimize 
the user interface in different locations. If no profile exists for the combination of user and location, 
the system default profile is used.

When there are multiple possible profiles the one used is chosen as follows:

1. A User profile has the highest priority. This means that an administrator can log in anywhere 
and execute Administrator level functions or an operator can login anywhere and have an 
optimized UI for their function.

2. A Location profile is used for all users at a specific location unless the user logged in has a 
profile. This allows more or different functionality for users logged into a specific location even 
if they do not have a specific profile themselves.

3. The system default profile is used in all other scenarios.

Modes of Operation
The Ultricore Profiles feature consists of three sub-functions or modes of operation.

 The ULTRICORE-PRO license is required to upgrade from the basic, non-configurable profiles on 
the Ultrix chassis to full, customizable configurations. The ULTRICORE-PRO license is standard on 
the Ultricore-BCS.
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Creation and Management of User Credentials
User profiles can reference the operating system username of the individual currently logged into 
the workstation.

Enabling User Credentials in the Setup tab of the status page engages the Ultricore User Credentials 
feature which allows an independent definition of usernames and passwords specifically for the 
Ultricore Profiles feature.

Creation and Management of User Profiles via the Default Role Profiles Only 
User and Location profiles are created and function as above but only reference one of the three 
default profiles:

• Engineer Admin (default profile) can access all features;
• Operator Admin (default operator profile) has full database and configuration capability but not 

engineering configuration and admin functions; or 
• Operator (default minimum profile) can access all soft panels for normal day to day operations.

Full Creation, Customization and Management of User Profiles
In addition to the above mode included with Ultricore-BCS and optional for Ultrix and Ultricore-CC 
is the ability to create and customize group and role profiles as well as create custom profiles on a 
user or location basis as appropriate. In addition, the order of items within these profiles can be set 
to fully optimize the operational environment for a specific user or group as needed.

Ultricore Profiles Interface
The options for configuring and managing the Ultricore Profiles are organized as individual panes 
within a single interface of a DashBoard window. The available options, and the number of panes, 
depends on whether the ULTRICORE-PRO license is installed.

Accessing the Ultricore Profiles Interface
You display the Ultricore Profiles interface by selecting its node in the DashBoard Tree View for the 
router in your system. By default, all nodes are displayed and accessible by any user or DashBoard 
client machine.

To display the Ultricore Profiles interface

1. Launch DashBoard on your desktop. 

2. Locate the Ultrix in the Tree View of DashBoard.

3. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

4. Expand the Database sub-node.

5. Double-click the Ultricore Profiles sub-node.

The Ultricore Profiles interface displays in the DashBoard window. The following example 
shows the default interface (the ULTRICORE-PRO license is not enabled).
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Overview
When the ULTRICORE-PRO license is enabled, the Ultricore Profiles interface is organized into five 
distinct areas. Figure 2 Each area is briefly described in this section starting with the leftmost area 
of the DashBoard window.

Figure 2  Example of the Ultricore Profiles Interface with the ULTRICORE-PRO license

Users

When the system is configured to use the Ultrix user login mechanism, a list of all currently 
configured usernames along with their current online status displays in this area.

Profiles

A list of all currently configured profiles. Selecting a profile (row) in this area automatically updates 
the items displayed in the Profile Details, Device Tree, and Options areas.
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Profile Details

This area displays the details of the profile showing the conditions under which the tree in the 
following section will be applied. 

Tree Nodes

A visual representation of the tree view that is defined in the Profile Details. Note that certain 
entries that are specific to licenses or other conditions may be visible but not in the actual tree view. 
Should conditions change that enable those entries, they will appear as shown in this display. A 
profile also maintains the position of items in groups allowing the most relevant items to be the 
easiest to reach.

The tree nodes are organized in a hierarchy where the top level (blue icons) list system specific 
options, and secondary levels (yellow icons) list specific functions. 

 This area only displays when the ULTRICORE-PRO license is enabled.

Group Tabs

This area displays all the available items that have not yet been assigned to the currently selected 
profile but are available to define.

 This area only displays when the ULTRICORE-PRO license is enabled.

Creating a Database of Users
If you wish to use the User Profile feature, the first step is to create a new user account. Once this 
account is created, all users will default to the Operator Profile (the default minimum profile) 
unless or until they have a profile created that allows them appropriate access for their role. 

When creating users and profiles, ensure that the system is not in use. Any currently active 
DashBoard instances will require users to login and features may be blocked. 

To create a new user account

1. Display the Ultricore Profiles interface as outlined in “To display the Ultricore Profiles 
interface”.

2. Click Manage Users.

The Manage Users dialog opens.

 Users can change their own password at the login screen, the Update Password button allows 
an Administrator to reset a forgotten password. A user name change requires the deletion of the 
current user and the creation of a new one with the new user name.
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3. Click Add.

 You can create as many users as required by your system.

4. Use the User Name field to assign a unique identifier for the user account. 

5. Use the Password field to define the password the user will need to enter when logging in with 
this account.

6. Repeat this procedure for every new user you wish to create. 

7. roceed to create profiles and assign users to these profiles.

Creating a Profile
 The User Profiles features offers a significant flexibility to optimize the tools in front of individual 

operators which, if inadvertently mis-configured could lead to administrators being locked out. 
As such, it is a good idea for the administrator to ensure that no users are actively working within 
the system prior to making significant changes to users and profile settings. 

Four profiles are created automatically: 

• Engineer Admin Profile — a group profile giving access to all features and functions as has been 
available prior to the Ultricore Profiles feature. This profile is read-only by default.

• Operator Admin Profile — a group profile giving access to all non-engineering features and 
functions. This allows an operational Administrator the ability to configure and use all 
operational functions and databases of the systems. 

• Operator Profile — a group profile giving access to only the soft control panels. This allows users 
that are registered but either have no defined profile on a system or only require basic 
operational access the ability to control pre-configured operational functions of the systems. 

• Ultrix Admin Profile — a user profile which allows the “Administrator” user mentioned above to 
have full admin and engineering capabilities by using the Default Profile. This profile is read-only 
by default.

 All users default to the Default Tree Profile with no System Login required. In other words, until 
specifically enabled, the Ultricore Profiles feature is not engaged, and the systems will all behave 
as in previous versions. It should be noted that while the user profiles feature is not engaged, the 
default user profile can be modified should the tree for all users need to be modified. 

To create a profile

1. In the Profiles area, click Manage Profiles. 

The Manage Profiles dialog opens.
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2. Click Add to create the new profile.

3. Use the Profile Name field to assign a unique name for the profile. 

Since the profile could be either specific to a user, a workstation or a group of users, it is 
recommended to create a name that reflects its purpose. For example, John Doe (a specific 
user), Graphics Operator (a group of users), or PCR1-TD (a workstation). 

4. Use the Username field to assign a specific user to the profile. 

An asterisk (*) indicates the profile applies to all users subject to the other profile detail entries. 

5. Use the Machine Name field to specify the OS/DNS machine name for a workstation. 

This allows the identification of a specific workstation in an environment where DHCP means 
the IP address may change over time. 

6. Use the IP Address field to specify the IP address for a workstation. 

This allows identification of a specific workstation in a statically addressed system. 

7. Use the Admin box to enable/disable (selected/cleared) access to admin functions.

For example, upload, reboot, refresh and other tasks that are not normal operational functional 
requirements. 

8. Use the Parent Profile to assign any of the currently configured profiles as a parent or 
reference profile for the profile being created or edited. 

9. Use the Use and/or Copy options to determine if the parent profile tree configuration is used 
directly by the profile being created or edited or copied into this profile allowing customization 
of the tree for the specific needs of the user. 

 If another profile tree is used rather than copied, changes to the tree need to be performed on 
the parent profile tree and will affect all users that “use” that parent profile and that the same 
change would need to be executed individually on all users that copied the parent profile tree. 

10. Repeat this procedure for every new profile you wish to create.

Defining the Permissions for a Profile
Once a profile is created, the remaining two areas of the Ultricore Profiles interface allow display 
and/or modification of the tree structure that will be enabled for the user(s) of the selected profile. 

 This section only applies if the ULTRICORE-PRO license is enabled.

Figure 3  Example of the Tree Nodes and Tabs for a Selected Profile
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Overview
This section provides a brief overview of each area and their options.

Tree Nodes

The tree (the leftmost area) displays all the assigned options and their desired order in the tree 
structure much like the tree view in DashBoard for an Ultrix router. The nodes in Ultricore Profiles 
tree view are determined by your system configuration and any licenses installed for your system. 
Buttons at the bottom of this area (Up, Down, Remove) allow entries to be moved up and down in 
the tree within the group to which the item belongs or removed if they are not required for the 
selected profile. When removed, the item is returned to the list of available items in the appropriate 
group tab. 

Group Tabs

The group tabs (the rightmost area) contain all items available in the group in question that are not 
included in the selected profile’s tree currently. If an item is not in the tree currently but required, 
the appropriate group tab is selected, the item required is selected and the Assign button is clicked 
moving it to the bottom of the appropriate group of the tree. The Up and Down buttons can then 
be used to order the tree items specific to the needs of the profile. 

When any changes are made to the tree structure(s), the changes are captured locally but are not 
recorded in the database until the Apply button on the bottom row is clicked. Clicking Apply 
records all the pending changes in the system database. Clicking Cancel will discard any unsaved 
changes. There are no pending changes if the Apply and Cancel buttons are not highlighted. 

Enabling the Ultricore Profiles Feature
Once you created the profiles and groups for your system, you can proceed to enable the Ultricore 
Profiles feature. Enabling the feature requires you to disable the current user credentials and 
settings and apply the profiles and groups you defined in previous sections. 

 Before proceeding, ensure that you created a new Administrator profile that has full access to 
your system. This is a separate profile from the default Ultrix Admin profile (which is read-only).

 This procedure requires a reboot of the Ultrix.

To enable the Ultricore Profiles feature

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Setup tab.

3. Locate the Ultricore Profile Settings area.

You may need to scroll down the tab to view this area.

4. Clear the User Credentials box.

A dialog opens to confirm the selection.

5. Select the User Profiles box.

A dialog opens to confirm the selection.

6. Click Reboot.
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Application of the Ultricore Profiles
Once the Ultricore Profiles function is enabled, all users will initially view a tree that only has a 
System Login entry. Once the user is created with either the default or a specific password by the 
Administrator, the user can login through a login page displayed in the DashBoard window.

Figure 4  Example of the System Login Sub-node

To log in

1. In the Basic Tree View, locate the device you wish to access.

2. Expand the device nodes to display the System Login sub-node.

3. Double-click the System Login sub-node.

The System Login page displays in the DashBoard window.

4. Enter the credentials for the profile assigned to you.

5. Click Login.

• The login information is confirmed by the system, and the appropriate tree with all assigned 
pages and functions are immediately available for use in the DashBoard window. 

• The Login page updates to the Logout page. 

When you log out, the Basic Tree View returns to the System Login tree view. Figure 4

To change the password

• Click Change Pwd on the System Login page.

 The old password is required to change the password, and to confirm that the new password is 
entered correctly. If the old password is forgotten/lost, the admin can force an update to the user 
password through the Users > Manage Users of the Ultricore Profiles interface. 

Unlocking the Ultrix Router via the Front Panel
Under some conditions, mis-configurations of Admin profiles, lost passwords etc. it may be 
necessary to force the Ultricore Profiles feature to be disabled to recover. This can be done via the 
front panel controls of the router.

To unlock the Ultrix via the front panel

1. Use the LCD panel and joystick to select Config > System > UC-Profiles.

2. Select Disable.

3. Perform a reboot to apply the change to either enable or disable the use of profiles.

User Data Import/Export
Due to the need to maintain different permutations of user data to system data, the Import/Export 
database functions now includes the ability to import databases with and without the user data 
(user accounts and profiles). In addition, the user files can be imported and exported independently 
to any chosen database. This allows for instance a different show configuration to be loaded while 
maintaining the same staff and location configuration or for a truck for instance, allows a new crew 
configuration to be loaded without changing system configurations. 
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Configuring the Ports
Ultrix is capable of switching video signals1 from 270Mbps to 12Gbps2. This format flexibility 
permits SD, HD, 3G and UHD video signals to be used seamlessly in the same system. 

Ultrix also comes complete with an audio matrix side-chain to enable multiplexing, de-multiplexing, 
channel swapping and processing of the SDI embedded audio.

For More Information on...
• configuring the UHD Gearbox, refer to “UHD Gearbox Configuration”.
• configuring the ULTRIX-IP-IO ports, refer to “ULTRIX-IP-IO Setup”.
• configuring the ULTRIX-SFP-IO ports, refer to “ULTRIX-SFP-IO Setup”.
• the audio features of the Ultrix router, refer to “Configuring an Audio Matrix”.

Physical Port Configuration Overview
Table 2 summarizes the configuration options for the physical input and output ports of the Ultrix 
router.

1. SMPTE standard rates.
2. Requires the UltriSpeed license.

Table 2  Available Port Configurations

Port Option Notes
Inputs
2-SI Group Enables 2SI quad input (four 3Gbps streams).

Refer to “Configuring the Ultrix Router for Multiplexing 
Quad Input Signals” for details.

Audio sub-channel 
processing

You can apply a gain (+/- 20db), invert channels, and/or sum 
channels as required. 
Refer to “Applying Proc Amps to the Embedded Audio 
Input” for details.

FrameSync Delay Specify a frame buffer size.
Refer to “UltriSync Configuration” for details.

Outputs
Clean Switch enable Per output enable/disable of Clean Switch.

Refer to “UltriClean Configuration” for details.

Clean Switch mode Selectable Clean Switch clock source.
Refer to “UltriClean Configuration” for details.

Clean Switch Delay Specify a Clean Switch buffer size.
Refer to “UltriClean Configuration” for details.

Audio sub-channel 
processing

Apply a gain (+/- 20db), invert channels, sum channels, and/or 
insert tones as required.
Refer to “Applying Proc Amps to the Embedded Audio 
Input” for details.
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Configuring a Reference Trigger for the Ultrix Router
If multiple reference formats will be fed into the Ultrix router, you can configure a reference trigger 
with a custom switching point. This is useful when you will be manually changing the reference 
signal format that is fed into the REF port on the Ultrix rear panel.

 A variety of switching points across the routing switchers may be required to deal with the range 
of digital video formats that are available. 

For More Information on...
• cabling the reference source for your router, refer to the Ultrix Installation Guide.
• monitoring the reference status, refer to “Monitoring the Reference Signal”.

To configure the reference trigger for the router

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens.

5. Select the References tab.

6. Locate the Triggers area in the References tab.

Only the REF A port is implemented at this time on the ULTRIX-FR1 and ULTRIX-FR2 routers.

The Detected field indicates the format of the reference signal connected to the REF A port on 
the router.

7. Use the SDI Video Format field to select the switch timing that will be used by the router when 
switching inputs/outputs.

8. If you selected Custom in step 7, use the Custom field to specify the time (number of 
microseconds) from the start of the custom switching line to the actual switching event. The 
maximum value is 65,535us.

9. Repeat steps 7 and 8 to configure additional triggers as required.

Configuring an SFP Port
The various modules available for Ultrix provide SFP+ slots for expansion of the base module I/O 
blade. Refer to the Ultrix SFP Modules Guide for a list of available SFP modules from Ross Video.
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Keep the following in mind:

• The Flex slot in the ULTRIX-FR5 does not support any I/O in the AUX ports.
• The ULTRIX-SFP-IO blade only supports MADI in the AUX A and AUX B ports.
• The ULTRIX-IP-IO blade only supports Ultriscape outputs (SDI video) in the AUX 1 and AUX 2 ports.

Before You Begin
You will also need to install an:

• UltriSpeed license for each slot that includes an SFP-HDB-IN-12G and/or SFP-HDB-OUT-12G.
• UltriScape license for each AUX port that will be used to provide an UltriScape head output.
• UltriSRC license for each AUX port configured for asynchronous MADI input.

Specifying the SFP Type
Once the SFP module is installed in a port, you must specify the port type. Select SDI Video for video 
SFP types, or MADI for audio SFP types. MADI audio SFP types allow you to specify the channel 
quantity (either 56 or 64) as per your facilities' standard.

The SFP Configuration interface is organized into two sub-tabs: AUX Ports, and SFP Ports. The AUX 
Ports tab lists all the AUX port settings for all blades in the Ultrix chassis. The SFP Ports tab lists all 
the ULTRIX-SFP-IO blade port settings.

To specify the SFP type

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The SFP Configuration page opens with the AUX Ports tab selected.

5. From the Slots table, select the router slot for the port you want to configure.

The tab updates to display a list of available ports based on the slot(s) selected.

6. Locate the row for the port you want to configure.

7. In the SFP column, select either SDI Video or MADI as appropriate for the fitted port.

8. Click Apply to save your changes. 
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UltriSync Configuration
UltriSync allows the re-timing of asynchronous or time offset input signals to the frame reference. 
UltriSync is a per input feature and requires a license for each input that will be used by the 
UltriSync. There are two license types:

UltriSync
This license allows for SDI data rates up to 3Gbps (1080p). This license is available on AUX A, AUX B, 
and Inputs 1-16 (a maximum of 18 ports). 

UltriSync-UHD 
This license allows the Frame Sync to operate at up to 12Gbps (2160p) data rates. This license is 
available for the ULTRIX-HDBNC-IO, ULTRIX-HDX-IO, or ULTRIX-SFP-IO blades only.

• This license is available on 3 inputs per ULTRIX-HDBNC-IO or ULTRIX-SFP-IO blade:
› AUX B or Input 1
› Input 5 or Input 6
› Input 11 or Input 12

• On the ULTRIX-HDX-IO, this license is provides the following port assignments (with a maximum 
of 16 ports):
› Aux A or Input 1, Input 2-4
› Aux B or Input 5, Input 6-8
› Aux C or Input 9, Input 10-12
› Aux D or Input 13, Input 14-16

Before You Begin
Ensure to:

• Monitor the video input signals via the Timing Lines and Timing Pixels fields in the Port 
Configuration page. These fields report the amount of detected timing offset (in lines and pixels 
respectively) between the incoming signal and the frame reference signal. The timing fields are 
updated every 15 seconds. This information is useful in deciding where to install an UltriSync 
license as follows:
› If there is an input that is out of time with regards to the frame reference, then it would 

beneficial to synchronize it with the frame reference.
› If the timing is +/- half-line, then UltriClean can accommodate the synchronization. The amount 

of pixels per line depends on the video standard being used. For example, 1080p is actually 
1920x1080 pixels (nominally), so 1920 pixels makes one line.

• Install one (or more) UltriSync licenses. Refer to “Installing a License Key”.
• Verify that the video source signals are the same format as the frame reference.

Configuring UltriSync for an Input Port
UltriSync allows configuration of the frame buffer size between 1 frame and 2 frames. Data is 
clocked out of the buffer using the frame reference, thus timing arbitrarily timed input signals to a 
common clock. The size of the buffer can determine its resilience to incoming signal disturbances.

To assign an UltriSync license to an input port

1. Install the license key as outlined in the procedure “Installing a License Key”.

2. From the Device Configuration interface, select .
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The License page displays with the License Keys tab selected.

3. Select the UltriSync tab.

Each row in the tab represents a port on the Ultrix router with each column a type of UltriSync 
license.

4. Select the box in the applicable License column for the port you want to enable an UltriSync 
license for.

To configure the UltriSync settings for an input port

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

5. In the Physical Address column, locate the row for the input port you wish to configure.

6. In the FrameSync Delay column, select the buffer size for the required port. Choose from the 
following:

• 1 frame — ensures a short delay (up to 1 frame) in router throughput, but is susceptible to 
incoming stream disturbances like a non-clean upstream switch.

• 2 frames — delays the signal between 1 and 2 frames depending on signal to reference 
timing offset. If an incoming signal is corrupted at a line or single frame rate, then a 2 frame 
buffer can repeat the last known good frame for the corrupted frame thus ensuring a clean 
output.

  If there is a 1 or 2 frame timing difference between the audio and video, try setting the 
FrameSync Delay to 1 frame to minimize the difference.

UltriClean Configuration
UltriClean allows users to enable a Clean Switch mode and apply a line buffer (delay) on a per 
output basis. Incoming video is buffered based on the timing of the input, and is then output based 
on the timing of the Ultrix system reference (including any offsets added in the Triggers setup). 
Users can then switch between inputs that are not perfectly co-timed without perceiving any 
glitches of the incoming data. Video source timing must remain within the buffer to properly switch 
between sources (buffer depth is user-configurable).

Before You Begin
Ensure that:

• All video sources must be the same video format, locked to the same reference, and vertically 
timed to within the selected Clean Switch window.

• Reference triggers are correctly configured. The trigger format for the selected trigger must 
match the input video format or an equivalent custom trigger set up to comply with RP-168 
Switch point. Refer to “Configuring a Reference Trigger for the Ultrix Router” for details on 
setting up a reference trigger.

Notes on Timing

It possible that you may find a discrepancy on an output from Ultrix when trying to set the 
horizontal time to zero with respect to the reference. 
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This is because there is a certain amount of latency through the Ultrix router even with Clean Switch 
disabled for the port. Due to our industry leading internal processing engine which supplies 
advanced features, a certain amount (though minimal) of delay should be expected. This should not 
pose a problem for most digital downstream equipment. If you do encounter a problem, we 
recommend using an external line sync device (such as our SFS-8622 openGear card) to zero time 
the Ultrix router output.

While it may be technically possible to zero time (horizontally) the output of the Ultrix router, it is 
not recommended for the following reasons:

• While you can zero time the output if you disable Clean Switch for that output, there will still be a 
large timing window that you have to exceed in order to get the output timing to re-sync. This is 
due to the line sync is always enabled even though it is put into a very low line length mode 
(resulting in a small the timing window). As a result, every timing adjustment applied to the input 
is ignored on the output until the window is exceeded. Once it is exceeded, the output timing 
jumps. You will need to adjust the timing incrementally until the timing is set to zero. This is 
further complicated during a power cycle where the timing may not be exactly zero as the 
window may have moved slightly on re-boot.

• The frame syncs output timing is hard coded to match the timing of a synchronous input that is 
zero timed at the input to the router.

It is recommended that all synchronous inputs to the router be zero timed to the inputs of the 
router instead of trying to zero time the router outputs.

Configuring Clean Switch Mode for an Output Port
The Clean Switch mode uses the input signal timing to decide when a frame of active picture begins. 

To configure the Clean Switch mode for an output port

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

5. In the Physical Address column, locate the row for the output port you wish to configure.

6. To enable Clean Switch mode for an output, select the Clean Switch box for the output you 
want to configure. 

7. Use the Clean Switch Mode menu to specify timing source. Choose from the following:

• Reference — The Clean Switch is based on the reference signal available on the REF port of 
the router.

• Input — The Clean Switch is based on the input signal available on the specified port of the 
router.

To configure the Clean Switch timing window

1. Navigate to the Port Configuration interface as outlined in the procedure “To configure the 
Clean Switch mode for an output port”.

2. In the Physical Address column, locate the row for the output port you wish to apply a delay to.

3. Click in the Clean Switch Delay cell for the output you want to configure. 

A drop-down menu displays.

4. Use the drop-down menu to specify the buffer size to apply.
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 This will effectively delay the signal up to the amount specified minus signal-to-reference offset 
for a maximum delay of the chosen setting.

 Select Full Line to add one full line of delay to the output. This will align the output horizontally 
with the reference but with one full line delayed vertically (two lines when using 3G Level B). This 
option is useful if you want a horizontally timed output.

UltriSRC Configuration
The UltriSRC license is a per port license enabling Sample Rate Conversion for MADI audio inputs. 
The sample rate conversion will re-sample incoming MADI up to 48kHz. This allows MADI sources 
that are not reference locked to the Ultrix.

To assign an UltriSRC license to an input port

1. Install the license key as outlined in the procedure “Installing a License Key”.

2. From the Device Configuration interface, select .

3. Select the UltriSRC tab.

Each row in the tab represents a physical AUX SFP port on the Ultrix. Each column in the second 
table represents a type of licensed feature and indicates whether it is enabled for that input.

4. Select the box in the License column for the physical port you want to enable an UltriSRC 
license for.

Loss of Input Signal
If the input signal is absent, the output is automatically set to SDI black and Ultrix uses the last 
known and valid video format detected on the output. This feature is similar to a “squelch” control. 
High-speed digital devices will try to lock to any signal. If there is no direct input, they will try to 
equalize noise (to a point), possibly resulting in down-stream equipment having issues with a 
non-valid SDI stream. If there is a router input that is either not terminated, or the upstream device 
outputs a non-valid signal, then the input is forced to SDI black.
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Configuring an Audio Matrix
The UltriMix sub-system provides advanced audio integration, including the ability to embed and 
de-embed audio on all of the inputs and outputs of the router. Users also have complete flexibility 
to process, swap, sum, mute, or route any discrete or embedded audio input to any output. UltriMix 
is perfect for applications where audio is constantly changing, and it can be added as needed 
without throwing away any initial investment in the system.

The Ultrix routers include the following features:

• 16 AES audio channels coming from each input SDI video stream
• Asynchronous processing of all audio channels
• Support for MADI on the AUX ports when a SFP-MADI-COAX, SFP-MADI-850MM, or 

SFP-MADI-1300MM is installed
• Audio channel status Dolby® bit capture and overwrite capabilities

Audio Routing Overview
The Ultrix router handles high-bandwidth, broadcast-quality, digital video and audio signals, and 
embedded audio signals. The Ultrix router can perform signal processing functions like audio 
shuffling and insert into and extra from MADI streams.

Each SDI I/O allows for up to 1 stream of 16 channels of 48kHz sampled, 24bit audio, for a total of 16 
channels. If there are audio channels that are received at a higher rate than 48kHz, the number of 
channels is limited. 

Before You Begin
Keep the following in mind when using the UltriMix feature:

• By default, all embedded audio is de-multiplexed at each input and passed through processing 
(proc-amps) and the audio matrix. 

• Each input has an Audio Bypass configuration option. When Audio Bypass is enabled for an input, 
the audio will follow the SDI regardless of any individual audio channel routing or configuration 
on the output. The individual channels of a input in Bypass mode are still de-multiplexed and 
available for audio routing via the audio matrix.

• Re-mapping of all audio channels from source to destination with transitions is available 
• Audio processing controls are available for each audio channel (gain, sum, invert, tone insert)
• Audio summing of any two adjacent channel pairs is available (1 + 2, 3 + 4, 5 + 6, etc.)

General Configuration Workflow
You may wish to use the following process when defining the database for your audio workflow.

Figure 5  Process for Configuring the Audio Channels

Enable UltriMix Define Audio
Routing Levels

Assign Audio
Ports to Logical

Sources

Assign Audio
Ports to Logical

Destinations
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Enabling the Audio Matrix
You must enable the audio matrix (UltriMix) before you can map the individual audio channels.

 It is recommended to enable/disable the UltriMix feature before database configuration.

To enable the audio matrix

1. Launch the DashBoard client. 

2. Locate the Ultrix node in the Tree View.

3. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

4. Expand the Devices node.

5. Expand the Controllers + Matrices node.

6. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

7. Select .

The Licenses page opens with License Keys sub-tab automatically selected.

8. Select the UltriMix sub-tab.

9. Locate the row for the slot you wish to enable the UltriMix feature for.

10. From the UltriMix column, select Enable.

11. Repeat steps 9 and 10 as required.

Audio Matrix Routing and Processing
Table 3 summarizes the audio mapping options when using SDI embedded audio or MADI signals.



Ultrix User Guide (v23.0) Configuring an Audio Matrix • 57

Table Legend

Notes on Using the Audio Bypass
• Selecting Audio Bypass in the Device Configuration interface forces the embedded audio of the 

input SDI stream to bypass the audio routing section and be routed with the SDI to a Destination 
for all embedded audio channels. 

• Selecting Audio Bypass in the Device Configuration interface for MADI inputs or outputs results in 
a non-valid situation where MADI channels cannot be routed.

Defining the Database Audio Levels
A level is a term used to describe a section or layer of the routing system (e.g. video level, audio 
level). Refer to “Defining the Levels in a Database” for instructions on how to define a level in your 
database. For each audio level, you will assign a port channel.

 If an audio level is not defined for a given input or output channel of the port, then the output will 
remain at its default selection (slot1.in[1].audio.chxx). For example, if OUT 3 is selected to IN 

Table 3  Audio Mapping Options

Source Destination

ResultAudio 
Mapping

Input Proc 
Amp 

Available

Audio 
Mapping

Output 
Proc Amp 
Available

EMB


EMB


Switches based on logical configuration (with full 
breakaway support)

EMB, PT


EMB


Switches logical configuration (but passes through each 
channel defined as pass-through from the SDI input 
content)

EMB, DS X EMB X Switches logical configuration (but mutes for each 
channel that has “disconnect” defined)

EMB  MADI  Follows breakaway operation based on logical mapping

EMB, PT


MADI
X

Switches logical configuration (but passes through each 
channel defined as pass-through from the SDI input 
content)

EMB, DS X MADI X Switches logical configuration (but mutes for each 
channel that has “disconnect” defined) 

MADI


MADI


Switches based on logical configuration (with full 
breakaway support)

MADI, PT  MADI X Not Valid

MADI, DS X MADI X Switches logical configuration (but mutes for each 
channel that has “disconnect” defined)

 Feature is enabled/available or SDI embedded audio is mapped to audio levels.

X Feature is not enabled/available or no audio levels are mapped

EMB Source or destination is mapped for SDI embedded audio channels

MADI Source or destination is mapped for MADI audio channels

PT ‘passthrough[1].audio’ is defined for some or all source levels

DS ‘disconnect[1].audio’ is defined for some or all source levels
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10 but only channels 1 - 4 are defined in the logical map, then OUT 3 will have channels of IN 1 
audio mapped to channels 5 - 16. 

In Figure 6, Levels 2-6 are defined for audio channels.

Figure 6  Example of Defined Audio Levels in a Database

MADI Overview
Multi-channel Audio Digital Interface (MADI) is the industry standard for the transmission of up to 
64 audio channels on a single cable. The Ultrix router supports the following SFP module options 
that provide the ability to route discrete MADI:

• SFP-MADI-COAX — the AUX port can receive and transmit MADI signals of 125Mbps over 75 
coaxial cables via HD-BNC connectors.

• SFP-MADI-850MM, SFP-MADI-1300MM — the AUX port can receive and transmit MADI optical 
signals as defined in SMPTE 297-2006.

Figure 7  Example of Ultrix Audio Interconnect using Two SFP-MADI-COAX Options

For More Information on...
• the specifications for your SFP module, refer to the Ultrix SFP Modules Guide.

Before You Begin
Ensure an SFP Module that supports MADI is physically installed in an AUX port of the Ultrix router.

 Downstream equipment of the Ultrix MADI output may report signal on all channels due to Ultrix 
setting status bits. This is to ensure maximum equipment compatibility.
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Configuring an AUX Port for MADI
Each SFP Module that supports MADI includes an IN (Rx) connector and an OUT (Tx) connector. 

 External MADI devices must be timed to the Ultrix reference signal unless an UltriSRC license is 
enabled for a given SFP port.

For More Information on...
• on the input and output connections for your module, refer to the Ultrix SFP Modules Guide.

MADI Inputs

A MADI input source is identified in the routing system using the nomenclature 
Frame.Slot.Port.Type.Channel. For example, ultrix.slot4.AUXA-in1.audio.ch5 where AUXA 
represents the physical AUX port the SFP module is installed, and ch5 represents Channel 5 in the 
MADI signal.

You must define the MADI input channels in the database for your Ultrix router to be able to route 
the individual MADI channels.

MADI Outputs

A MADI output source is identified in the routing system using the nomenclature 
Frame.Slot.Port.Type.Channel. For example, ultrix.slot4.AUXB-out1.audio.ch64 where AUXB 
represents the physical AUX port the SFP module is installed in, and ch64 represents Channel 64 in 
the MADI signal.

You must define the MADI output channels in the database for your Ultrix router to be able to route 
the individual MADI channels.

Mapping the Audio Channels
You can configure audio channels from DashBoard. Note that source and destination logical 
mapping is required to complete the setup of the Ultrix embedded audio routing.

To map the audio destinations

1. Double-click the Destinations node located under the Database node.

 As the audio map for Ultrix may be very large, an Advanced Fill tool is available to automatically 
generate a map for the audio levels. Refer to “Using the Advanced Fill Tool” for more 
information on using this tool.

2. In the table of the Destinations tab, select the first row in the series for the audio level you 
defined in “Defining the Database Audio Levels”.

3. Press and hold Shift.

4. Click the last row in the series to select a range of cells within the Level column.

5. Select a range of audio outputs as outlined in “To map a physical output to a destination”.

6. Click Assign.

7. Click Apply at the bottom of the Destinations tab to apply the changes to the database.

To map the audio sources

1. Double-click the Sources node located under the Database node.

2. In the table of the Sources tab, select the first row in the series for the audio level you defined 
in “Defining the Database Audio Levels”.

3. Press and hold Shift.
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4. Click the last row in the series to select a range of cells within the Level column.

5. Select a range of inputs as outlined in “To map an input to a source”.

6. Click Assign.

7. Click Apply at the bottom of the Sources tab to apply the changes to the database.

Specifying the Audio Transition Mode
You can specify an audio transition mode for each audio channel output. 

To set the audio transition mode for an audio channel

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Port Configuration page opens.

5. Select the I/O Module (slot) containing the output(s) you wish to configure.

6. Select Outputs from the Views toolbar.

The Port Configuration page updates to display the options for the selected outputs.

7. Use the Transition field to set the audio transition mode for the audio channel. Choose from 
the following:

• Cut — The audio input channel is immediately switched to its selected output. A transition to 
or from Dolby® will always be a Cut transition regardless of what the Transition setting is set 
to.

• V Fade — The original audio input channel fades down to silence followed by the new input 
channel fades up from silence to unity gain level.

• X Fade — The original audio input channel fades down to silence as the new input fades up 
from silence, and both will be mixed.

• Cut Fade — The original audio input channel cuts to silence and the new input fades up from 
silence to unity gain level.

• Fade Cut — The original audio channel fades down to silence and the new input is cut in at 
unity gain level.

• Quiet Cut — The original audio channel performs a V Fade transition with a 5ms duration.

8. Use the Duration field to specify the length of the audio transition in milliseconds.

Applying Proc Amps to the Embedded Audio Input
Ultrix includes Processing Amplifiers (Proc Amps) for the audio inputs. For each audio channel of an 
input signal, you can set the Bypass Mode, invert selected channels, and sum two adjacent audio 
channels or apply audio delay. The Proc Amp settings are applied before going through the audio 
matrix.

To set up processing of the embedded audio input

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.
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The Device Configuration interface opens.

4. Select .

The Port Configuration page opens.

5. From the Ultrix rear panel map, select the port for the audio input you wish to process.

The Port Configuration tab updates to display the audio options for the selected input.

6. Select the Audio Bypass box to a prevent breakaway switching of untimed sources. The router 
will alarm when the audio signal becomes asynchronous to the reference signal provided on 
the REF port of the router.

 Select the Audio Bypass box if the input is asynchronous to other inputs. This will avoid any 
improper mapping of the associated audio channels onto other asynchronous outputs. 

7. To apply a gain to a channel, use the associated Gain field to select a value between -20dB and 
20dB.

8. To invert a channel, select the associated Invert box. 

9. To sum two adjacent audio channels, select the Sum box for the first channel.

The Sum box for the second channel is automatically selected.

 Each selected channel will carry the average of the two input channels ((A+B)/2). When the input 
is summed, the original signals are no longer available for output.

10. Apply up to 500ms of delay per channel.

 The audio delay feature requires an UltriSync license applied to the port.

11. If required, repeat steps 5 to 10 for each audio input you want to configure.

Applying Proc Amps to the Embedded Audio Outputs
The Ultrix router includes Processing Amplifiers (Proc Amps) for the audio outputs. Proc Amp 
adjustments are applied in the following order:

1. Gain — This option provides a +/- 20dB gain range in 0.50dB increments. If you have added a 
gain to an input channel, the gain value specified for the output channel is an addition. For 
example, if you set the gain for an input to 10dB, then specify a gain of 2dB on the output, the 
total gain will be 12dB on the final output.

2. Invert — This option enables you to invert the polarity of the audio signal for the selected 
channel.

3. Sum — This option enables the selected channels to carry the average of the specified channels 
((A+B)/2). 

To configure the embedded audio outputs

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Port Configuration page opens.

5. From the Ultrix rear panel map, select the port for the output you wish to configure.

The Port Configuration interface updates to display the audio options for the selected output.
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6. Use the Trigger menu to specify which reference signal trigger to use. Refer to “Configuring a 
Reference Trigger for the Ultrix Router” for details.

7. To apply a gain to a channel, use the associated Gain field to select a value between -20dB and 
20dB.

8. To invert a channel, select the associated Invert box. 

9. To two adjacent audio channels, select the Sum box for the first channel.

The Sum box for the second channel is automatically selected.

 Each selected channel will carry the average of the two channels ((A+B)/2). When the output is 
summed, the original signals are no longer available for output.

10. To insert a test tone into a channel:

a. Use the Tone Freq menu to specify the type of test tone to embed in the output. 

a. Use the Tone Mode menu to enable test tones for that channel.

11. Repeat steps 5 to 10 for each channel you wish to configure.

Examples of Audio Configured Databases
UltriMix enables access to the 16 audio channels embedded in the SDI stream. 

Muting Embedded Channels
Once the various channels are mapped to levels, then we may treat those channels individually akin 
to them being independent physical connections to the router. For example, we may define a 
source to the router as:

With this mapping, we may route the embedded channels to any other audio enabled destination 
by selecting levels required prior to making our route selection.

Consider the case where only the first audio group (Embedded channels 1, 2, 3 and 4) are needed 
for routing. What occurs to the other 12 channels of the SDI stream that are not mapped?

The remaining audio channels within the SDI stream are still there and even though they are not 
explicitly defined within the logical map. They will remain at a default routing of 1-to-1 (i.e.; input #1 
embedded channel #8 will always be routed to output #1 embedded channel #8). It may be 
undesirable to have these extra embedded audio channels routed this way, so a “Disconnect” may 
be defined for the input channels not required. 

Switching Bilingual Sources
This example assumes the following setup:

• Embedded audio channels 1 and 2 are the primary channels.
• Incoming sources have English on Embedded channels 1 and 2, and French on 3 and 4.

Source SDI Level 1 Level 2 Level 3 Level 4 ...
Input1 SDI.in[1] SDI.in[1].ch1 SDI.in[1].ch2 SDI.in[1].ch3 SDI.in[1].ch4 ...

... ... ... ... ... ... ...

Source SDI Level 1 Level 2 Level 3 Level 4 Level 5 ... Level 16
Input1 SDI.in[1] SDI.in[1].ch1 SDI.in[1].ch2 SDI.in[1].ch3 SDI.in[1].ch4 Disconnect ... Disconnect

...... ... ... ... ... ... ... ...
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The Sources are defined as follows:

The Destinations are defined as follows:

To route Src1 to Dest1 and swap the Primary Audio from English to French

1. Select the Destination.

2. Select the Source.

The resulting status would be:

The Destination will have the video from SDI.in[1] but embedded channels Level A1 and Level A2 
will have the input SDI embedded channels 3 and 4 respectively which we have previously defined 
as being our French language stereo pair. Note that in this example the English language stereo pair 
are still available but now on the destination channels Level A3 and Level A4.

If pair Level A3 and Level A4 are not required to be muted, the source definitions change to contain 
a 'disconnect' in the Level A3 and Level A4 levels (and any other levels requiring muting): 

Embedded Channel Routing
Embedded audio routing encompasses the following scenarios:

• Embedded channels to embedded channels
• Embedded channels to MADI channels
• MADI channels to Embedded channels
• MADI channels to MADI channels

To accommodate these scenarios, the database source table defines many individual channels in 
addition to the standard SDI plus audio source. In the examples below, In 1 is our SDI and audio 
source - our normal “audio follow video” source. Also defined are the individual embedded audio 
channels that will allow routing of these to other audio destinations.   

Sources SDI Level A1 Level A2 Level A3 Level A4 ...
SRC1 EN SDI.in[1] SDI.in[1].ch1 SDI.in[1].ch2 SDI.in[1].ch3 SDI.in[1].ch4 ...

SRC1 FR SDI.in[1] SDI.in[1].ch3 SDI.in[1].ch4 SDI.in[1].ch1 SDI.in[1].ch2 ...

Destinations SDI Level A1 Level A2 Level A3 Level A4 ...
Dest 1 SDI.out[1] SDI.out[1].ch1 SDI.out[1].ch2 SDI.out[1].ch3 SDI.out[1].ch4 ...

... ... ... ... ... ... ...

Status SDI Level A1 Level A2 Level A3 Level A4
Dest1 SDI.in[1] SDI.in[1].ch3 SDI.in[1].ch4 SDI.in[1].ch1 SDI.in[1].ch2

Sources SDI Level A1 Level A2 Level A3 Level A4 ...
SRC1 EN SDI.in[1] SDI.in[1].ch1 SDI.in[1].ch2 disconnect[1].ch1 disconnect[1].ch1 ...

SRC1 FR SDI.in[1] SDI.in[1].ch3 SDI.in[1].ch4 disconnect[1].ch1 disconnect[1].ch1 ...
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 If all 16 channels of embedded audio are not required or used, then only the in-use channels 
need be defined. This can serve to reduce the source table size to just the required definitions.

The Source definitions for SDI IN 1 and its individual embedded audio channels are defined as 
follows:

The Destinations for SDI outputs are defined as follows:

The Source definitions for MADI inputs are defined as follows:

The Destinations for MADI outputs are defined as follows:

Embedded Channels to Embedded Channels
If we wish to perform the route as illustrated below (a channel swapping route) where the audio.ch3 
and audio.ch4 are to be routed to destination audio.ch1 and audio.ch2, we need to route the 
embedded channels individually as our default mapping provides no common control levels 
between source audio.ch3 and audio.ch4 and destination audio.ch1 and audio.ch2.

To route Audio Channels 3 and 4 from Src1 to SDI OUT 1 Channels 1 and 2

1. Select the Destination (Out 1).

Sources SDI Level A1 Level A2 ... Level A15 Level A16
In1 sdi.ch1 audio.ch1 audio.ch2 ... audio.ch15 audio.ch16

In1 ch1 audio.ch1 audio.ch1 ... audio.ch1 audio.ch1

In1 ch2 audio.ch2 audio.ch2 ... audio.ch2 audio.ch2

... ... ... ... ... ... ...

In1 ch16 audio.ch16 audio.ch16 ... audio.ch16 audio.ch16

Destination SDI Level A1 Level A2 ... Level A15 Level A16
Out1 sdi.ch1 audio.ch1 audio.ch2 ... audio.ch15 audio.ch16

Out2 sdi.ch1 audio.ch1 audio.ch2 ... audio.ch15 audio.ch16

... ... ... ... ... ... ...

Sources SDI Level A1 Level A2 ... Level A15 Level A16
MADIch1 audio.ch1 audio.ch1 ... audio.ch1 audio.ch1

MADIch2 audio.ch2 audio.ch2 ... audio.ch2 audio.ch2

... ... ... ... ... ...

MADIch63 audio.ch63 audio.ch63 ... audio.ch63 audio.ch63

MADIch64 audio.ch64 audio.ch64 ... audio.ch64 audio.ch64

Destination SDI Level A1 Level A2 ... Level A15 Level A16
MADIch1 audio.ch1 ...

MADIch2 audio.ch2 ...

... ...

MADIch63 audio.ch63 ...

MADIch64 audio.ch64 ...
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2. Perform the first switch (Switch the SDI Level) as follows:

a. Select the SDI Level.

b. Select the Source (In 1).

c. Press TAKE to switch.

3. Perform the second switch (Source In1ch3 on Audio Level 1) as follows:

a. Select Level A1.

b. Select the Source (In1 ch3).

c. Press TAKE to switch.

4. Perform the third switch (Source In1ch4 on Audio Level 2) as follows:

a. Select Level A2.

b. Select the Source (In1ch4).

c. Press TAKE to switch.
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The Level buttons serve to indicate the Destination channels we are routing to.

Embedded Channels to MADI Channels
To route embedded channels to MADI channels, select a MADI channel destination, then select the 
appropriate source. If the current level mask or breakaway contains level A1, then level A1 does not 
need specific selection. As the destination MADIchx contains only physical port assignments in level 
A1, then all other levels are ignored.

The following illustrates routing source In1 embedded ch3 and ch4 to our MADI destination on ch5 
and ch6 respectively:

1. Select the Audio Level.

2. Perform the first switch (Source In1ch3 to Destination MADIch5) as follows:

a. Select the Destination (MADIch5).

b. Select the Source (In1ch3).

c. Press TAKE to switch.

3. Perform the second switch (Source In1ch4 to MADIch6) as follows:

a. Select the Destination (MADIch6).

b. Select the Source (In1ch4).

c. Press TAKE to switch.

RCP-QE36

HOME

CAT
MODE DOWN

UP TAKE
In1
ch4

Out
1

Out
2

Out
3

Out
4

Out
5

In1
ch2

In1
ch1

In1 In1
ch3

MADI
ch1

MADI
ch2

MADI
ch5

MADI
ch3

MADI
ch4

MADI
ch6

MADI
ch5

MADI
ch3

MADI
ch1

MADI
ch2

MADI
ch4

MADI
ch6

LVL
A1

LVL
SDI

LVL
A2

RCP-QE36

HOME

CAT
MODE DOWN

UP TAKE
In1
ch4

Out
1

Out
2

Out
3

Out
4

Out
5

In1
ch2

In1
ch1

In1 In1
ch3

MADI
ch1

MADI
ch2

MADI
ch5

MADI
ch3

MADI
ch4

MADI
ch6

MADI
ch5

MADI
ch3

MADI
ch1

MADI
ch2

MADI
ch4

MADI
ch6

LVL
A1

LVL
SDI

LVL
A2

RCP-QE36

HOME

CAT
MODE DOWN

UP TAKE
In1
ch4

Out
1

Out
2

Out
3

Out
4

Out
5

In1
ch2

In1
ch1

In1 In1
ch3

MADI
ch1

MADI
ch2

MADI
ch5

MADI
ch3

MADI
ch4

MADI
ch6

MADI
ch5

MADI
ch3

MADI
ch1

MADI
ch2

MADI
ch4

MADI
ch6

LVL
A1

LVL
SDI

LVL
A2

RCP-QE36

HOME

CAT
MODE DOWN

UP TAKE
In1
ch4

Out
1

Out
2

Out
3

Out
4

Out
5

In1
ch2

In1
ch1

In1 In1
ch3

MADI
ch1

MADI
ch2

MADI
ch5

MADI
ch3

MADI
ch4

MADI
ch6

MADI
ch5

MADI
ch3

MADI
ch1

MADI
ch2

MADI
ch4

MADI
ch6

LVL
A1

LVL
SDI

LVL
A2

RCP-QE36

HOME

CAT
MODE DOWN

UP TAKE
In1
ch4

Out
1

Out
2

Out
3

Out
4

Out
5

In1
ch2

In1
ch1

In1 In1
ch3

MADI
ch1

MADI
ch2

MADI
ch5

MADI
ch3

MADI
ch4

MADI
ch6

MADI
ch5

MADI
ch3

MADI
ch1

MADI
ch2

MADI
ch4

MADI
ch6

LVL
A1

LVL
SDI

LVL
A2

RCP-QE36

HOME

CAT
MODE DOWN

UP TAKE
In1
ch4

Out
1

Out
2

Out
3

Out
4

Out
5

In1
ch2

In1
ch1

In1 In1
ch3

MADI
ch1

MADI
ch2

MADI
ch5

MADI
ch3

MADI
ch4

MADI
ch6

MADI
ch5

MADI
ch3

MADI
ch1

MADI
ch2

MADI
ch4

MADI
ch6

LVL
A1

LVL
SDI

LVL
A2

RCP-QE36

HOME

CAT
MODE DOWN

UP TAKE
In1
ch4

Out
1

Out
2

Out
3

Out
4

Out
5

In1
ch2

In1
ch1

In1 In1
ch3

MADI
ch1

MADI
ch2

MADI
ch5

MADI
ch3

MADI
ch4

MADI
ch6

MADI
ch5

MADI
ch3

MADI
ch1

MADI
ch2

MADI
ch4

MADI
ch6

LVL
A1

LVL
SDI

LVL
A2



Ultrix User Guide (v23.0) Configuring an Audio Matrix • 67

MADI Channels to Embedded Channels
Routing MADI input ch5 and ch6 to SDI embedded ch1 and ch2 of Out 2 is as follows:

1. Select the Destination (OUT 2).

2. Perform the first switch as follows:

a. Select Level A1.

b. Select the Source (MADIch5).

c. Press TAKE to switch.

3. Perform the second switch.

a. Select Level A2.

b. Select the Source (MADIch6).

c. Press TAKE to switch.

MADI Channels to MADI Channels
Routing MADI inputs to MADI outputs is as follows:

1. Select the Destination.
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2. Perform the first switch.

a. Select the Destination (MADIch3).

b. Select the Source (MADIch5).

c. Press TAKE to switch.

3. Perform the second switch.

a. Select the Destination (MADIch4).

b. Select the Source (MADIch5).

c. Press TAKE to switch.
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UHD Gearbox Configuration
Ultrix provides maximum performance and quality with standard configurations supporting data 
rates up to 12Gbps. In addition, you can purchase the UltriSpeed software license that enables 
12Gbps performance throughout every signal path within the router. When combined with the 
inherent capabilities within the router, the UltriSpeed license also enables routing of the emerging 
single link UHD (50Hz, 60Hz) standard alongside Quad-link UHD signals, and seamlessly switch 
these signals back and forth to each other.

 The Ultrix Gearbox function supports the two sample interleave (2SI) format of quad link. Note 
that Square Division Quad Split is not implemented.

Example Setup for Multiplexing
Assign Gearbox Group 1 on the Ultrix router to be 4:1 (multiplex four 3Gbps inputs into a single 
12Gbps output). The router OUT 1 BNC is the combined signal of IN 1-4. The OUT 2, 3, and 4 BNCs 
are reserved by the system.

Figure 8  Example of Gearbox Workflow of an Ultrix Router — Multiplexing to a 12Gbps Signal

Table 4  Example Mapping for Multiplexing

Name Channel 1 Channel 2 Channel 3 Channel 4
Source
QUAD IN slot2.in[1] slot2.in[2] slot2.in[3] slot2.in[4]

Destination
12G OUT slot2.out[1]

UHD Camera
3Gbps SDI Sources

PORT 1 PORT 2 PORT 3 PORT 4 PORT 5 PORT 6 PORT 7 PORT 8

PORT 9 PORT 10 PORT 11 PORT 12 PORT 13 PORT 14 PORT 15 PORT 16

PSU

ENET 2

ENET 1

1 4 A B

REF

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN

Ultrix-HDNBC-IO

REF

!

3Gbps Channel 1

12Gbps SDI

ULTRIX-FR1
32x32 SDI Router

Server
UHD Destination

3Gbps Channel 2

3Gbps Channel 3

3Gbps Channel 4
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Example Setup for De-multiplexing
Assign Gearbox Group 1 on the Ultrix router to be 1:4 (de-multiplex a single 12Gbps input into four 
3Gbps outputs). The router OUT 1, 2, 3, and 4 BNCs are the split output signals.

Figure 9  Example of Gearbox Workflow of an Ultrix Router — De-multiplexing a 12Gbps Signal

Gearbox Overview
A Gearbox is a group of four consecutive inputs or four consecutive outputs that are automatically 
grouped together in the Ultrix database. The first port of the Gearbox group is used for routing and 
UltriScape, while the remaining three ports in the group are reserved but not used (they are not 
listed in the Third Party Matrices, Sources, and Destinations tabs of the database).

• When you enable a Gearbox input group, Ultrix multiplexes the signals of the four 3Gbps Level A 
channels together. 

• When you enable a Gearbox output group, Ultrix takes the signals of the four 3Gbps Level A 
channels together and provides a single 12Gbps signal to an output.

The most common application of a Gearbox is when there are quad channels coming in and out of 
the Ultrix router. The first channel is used as the port for those I/O to define single level of logical 
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For More Information on...
• cabling for a Gearbox application, refer to the Ultrix Installation Guide.

Table 5  Example Mapping for De-multiplexing
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Signal Medic
The Signal Medic is a function that attempts to ‘repair’ the incoming Gearbox signal group if one of 
the four input stream is temporarily interrupted. The Signal Medic will replace the missing stream 
with an interpolated version derived from the other incoming signals. 

For More Information on...
• the Signal Medic options, refer to Table 68.

Gearbox Timing
Ultrix Gearbox requires all four of the input signals be within 350ns of each other. Cable lengths to 
the Gearbox input should be as matched as practicable.

For More Information on...
• the cable length specifications, refer to the Ultrix Installation Guide.

Configuring the Ultrix Router for Multiplexing Quad Input Signals
When I/O ports are enabled for a Gearbox, the first port of the group is the designated port for 
mapping (the other three ports of the group are reserved but not used). 

Before You Begin
Ensure the following steps are completed before configuring the router to multiplex a 12Gbps 
signal:

1. Install the UltriSpeed software license for the Ultrix router that will multiplex the four 3Gbps 
into one 12Gbps signal.

2. Set up a connection between the external device that will provide the four 3Gbps input signals 
and the Ultrix router, ensuring the four input signals are cabled to the Ultrix rear panel as 
outlined in Table 6. 

3. Set up a connection between the Ultrix router and the external device that will receive the 
12Gbps signal.

4. Make a note of the physical IN BNCs on the Ultrix router that will receive the 3Gbps signals.

5. Make a note of the physical OUT BNC on the Ultrix router that will transmit the 12Gbps signal.

Assigning Physical Router Inputs to a Gearbox Group
The Gearbox inputs are automatically arranged in groups of four (e.g. slot1.in[1] to slot 1.in[4] is 
one group). You can enable up to four Gearbox groups per Ultrix slot.

To assign router inputs to a UHD Gearbox group

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

Table 6  Gearbox Mapping — Default Input Groups

Group Channel 1 Channel 2 Channel 3 Channel 4
1 slot#.in[1] slot#.in[2] slot#.in[3] slot#.in[4]

2 slot#.in[7] slot#.in[8] slot#.in[9] slot#.in[10]

3 slot#.in[13] slot#.in[14] slot#.in[15] slot#.in[16]
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3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Port Configuration page opens.

5. From the top toolbar, select the slot that the UltriSpeed license was installed for.

6. In the Physical Address column, locate the first input port in the Gearbox group you wish to 
configure for multiplexing four 3Gbps signals.

7. In the 2-SI Group column, click the cell for the first input port of the Gearbox group.

A drop-down menu opens.

8. Select Enable.

The new setting is applied to the selected port and the three associated ports in the same 
Gearbox group. Note that only the first input in the Gearbox group (e.g. slot1.in[1]) will display 
in the Matrix I/O lists in the Database > Third Party Matrices and Database > Sources tabs.

Assigning a Multiplexed 12Gbps Signal in the Database

You can assign the new 12Gbps signal in the Ultrix database much like assigning an input of any 
other signal type. However, the new 12Gbps signal is now the first input in the Gearbox group (e.g. 
slot1.in[1]) to a Destination in the database. 

The original 3Gbps signals will still display in the Matrix I/O lists in the Ultrix database and can still 
be managed as individual sources in the database. 

Example of a Gearbox Database for Inputs

Table 7 provides an example of mapping the Gearbox inputs in an Ultrix database.

For More Information on...
• managing the sources in a database, refer to “Defining the Sources in a Database”.

Configuring the Ultrix Router for De-multiplexing a 12Gbps Signal
The Ultrix router is capable of de-multiplexing a 12Gbps SDI sources into four separate 3Gbps SDI 
output signals. 

Before You Begin
Ensure the following steps are completed before configuring the router to de-multiplex a 12Gbps 
signal:

Table 7  Example of Gearbox Input Database Mapping

Source Name SDI Level A1 Level A2
GearBox In 1 Slotx.in[1].sdi.ch1 Slotx.in[1].audio.ch1 Slotx.in[1].audio.ch2

GearBox In 2 Slotx.in[7].sdi.ch1 Slotx.in[7].audio.ch1 Slotx.in[7].audio.ch2

GearBox In 3 Slotx.in[13].sdi.ch1 Slotx.in[13].audio.ch1 Slotx.in[13].audio.ch2
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1. Install the UltriSpeed software license for the Ultrix router that will de-multiplex the 12Gbps 
signal.

2. Set up a connection between the external device that will provide the 12Gbps signal to the Ultrix 
router.

3. Setup a connection between the Ultrix router and the external device that will receive the four 
3Gbps signals.

4. Make a note of the physical IN BNC on the Ultrix router that will receive the 12Gbps.

5. Make a note of the physical OUT BNCs on the Ultrix router that will transmit the processed 
3Gbps signals.

Configuring the Ultrix Router for De-multiplexing a 12Gbps Signal
De-multiplexing an 12Gbps signal produces four 3Gbps SDI signals. These SDI signals can then be 
assigned to separate Ultrix router outputs.

To assign the de-multiplexed signals to a Gearbox group

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Port Configuration page opens.

5. From the top toolbar, select the slot for the Gearbox group.

6. From the Views area of the tab, click the last button and select Outputs from the I/O dialog.

The Port Configuration page updates to displays the ports configured as Outputs for the slot.

7. In the Physical Address column, locate the first output port in the Gearbox group you wish to 
configure for multiplexing.

8. In the 2-SI Group column, click the cell for the first output port of the Gearbox group.

A drop-down menu opens in the column.

9. Select Enable.
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The new setting is applied to the selected port and the three associated ports in the same 
Gearbox group.

Assigning the De-multiplexed 12Gbps Signal to a Destination in the Database

You can assign the new 3Gbps signals as outputs in the Ultrix database much like assigning a 
destination of any other signal type. Refer to “Defining the Destinations in a Database” for details 
on configuring destinations in your database.

You can still assign the original 12Gbps signal as a source in the Ultrix database much like assigning 
a source of any other signal type. Refer to “Defining the Sources in a Database” for information 
on managing the sources in a database.

Example of a Gearbox Database for Outputs

Table 7 provides an example of mapping the Gearbox outputs in an Ultrix database.

Table 8  Example of Gearbox Output Database Mapping

Destination 
Name SDI Level A1 Level A2

GearBox Out 1 Slotx.out[1].sdi.ch1 Slotx.out[1].audio.ch1 Slotx.out[1].audio.ch2

GearBox Out 2 Slotx.out[7].sdi.ch1 Slotx.out[7].audio.ch1 Slotx.out[7].audio.ch2

GearBox Out 3 Slotx.out[13].sdi.ch1 Slotx.out[13].audio.ch1 Slotx.out[13].audio.ch2
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ULTRIX-IP-IO Setup
This chapter outlines how to configure receivers and senders for the Ultrix router to be used in 
video and audio streaming when an ULTRIX-IP-IO blade is installed in a slot of an Ultrix router 
chassis.

 The ULTRIX-IP-IO supports multicast IP Addresses in the range of 225.x.x.x to 239.x.x.x. Note that 
some addresses in this range are reserved by IANA.

For More Information on...
• the installation and cabling of the ULTRIX-IP-IO, refer to the Ultrix Installation Guide.

What are Receivers, Senders, and Streams?
The following terms may be used throughout this chapter:

Device

A physical, virtual, or software application that may include multiple sources, destinations, senders, 
or receivers.

Flow

The continuous raw media content. It can contain more than one essence (e.g. an audio flow can 
contain multiple channels, and an SDI flow may contain audio and video essences).

A flow is independent of the transport protocol. For example, 48kHz LPCM audio is a flow; AES67 is 
one type of stream which can carry the flow.

Flows cannot generally be passed around natively, and need to be encapsulated in a stream. Flows 
from the same source are considered “editorially equivalent”, but may be encoded differently. For 
example, a video source may be encoded as 4:2:2 YCbCr uncompressed, 4:4:4 RGB uncompressed, 
and h.265 encoded. Each of these would be a separate flow from a common source.

Receiver

An element within a device that receives exactly one stream, which contains one flow from a 
network.

Sender

An element within a device which presents exactly one flow, packaged as a stream onto a network.

Stream

One flow, encapsulated within a transport protocol. Examples include SMPTE ST 2022-6, SMPTE ST 
2110-20 Video, or SMPTE ST 2110-30 Audio.

Before You Begin
This section provides information to keep in mind before setting up Ultrix-IP streams.

 Each ULTRIX-IP-IO blade has four ENET ports with 25Gb bandwidth per port. The ports are 
grouped into two pairs where the first pair is ENET 1 and ENET 2; the second pair is ENET 3 and 
ENET 4.
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Audio Streams
Keep the following in mind when setting up audio IP streams:

• Each ENET pair can support a maximum of 8 audio streams.
• Only ENET 1 and ENET 3 support audio streams at this time.
• ENET 2 and ENET 4 are used only for redundant audio streams.
• Each audio stream can carry from 1 to 16 channels.

Video Streams
Keep the following in mind when setting up video IP streams:

• The ULTRIX-IP-IO supports multicast IP Addresses in the range of 225.x.x.x to 239.x.x.x for video 
and audio.

• When using 1080p or lower video formats, each ENET pair can support up to 8 video streams with 
a maximum of 16 streams per ULTRIX-IP-IO blade.

• When using UHD 6G formats (2160p 30/29.97/25Hz), each ENET pair can support up to 4 video 
streams with a maximum of 8 streams per ULTRIX-IP-IO blade.

• When using UHD 12G formats (2160p 60/59.94/50Hz), each ENET pair can support up to 4 video 
streams with a maximum of 8 streams per ULTRIX-IP-IO blade. If the Redundant option is enabled 
for the ENET pair, up to 4 video streams (2 streams in the first port and 2 redundant streams in 
the second port) are available.

• When using a mix of UHD 6G and 12G formats, each ENET pair can support up to 4 video 
streams. For example, 3x12G streams and 1x6G stream.

Redundant Streams
The ULTRIX-IP-IO blade also provides protection switching as per SMPTE 2022-7. This option can be 
enabled for each pair on the blade.

Keep the following in mind when setting up redundant streams:

• You will need to assign a unique IP address to each stream (primary and secondary).
• ENET 2 is reserved for redundant streams when the Redundant option is enabled for that ENET 

pair.
• ENET 4 is reserved for redundant streams when the Redundant option is enabled for that ENET 

pair.
• When an ENET pair is in redundant mode, the stream must be added to the first port of the ENET 

pair (ENET 1 or ENET 3) and a duplicate (secondary) stream is automatically added to the second 
port (ENET 2 or ENET 4 respectively).

Automatic Sender Session Description Protocol (SDP) Updates
When a sender stream is active and its SDI input video format changes to a different and valid 
format, if the new format is allowed by the session (as defined by the Adaptive Input Allowed Input 
Rates setting) and results in an overall system valid configuration (no Ultrix-IP bandwidth limit will 
be exceeded), the sender stream will update itself to use this new format, generating a new version 
of its SDP. The Session and NMOS IDs do not change when the sender stream SDP update is 
performed. This allows the existing streams to adapt so that the Ultrix-IP does not need to track 
new streams. This feature is always enabled and cannot be disabled.

Ultrix-IP monitors all active connections on the system and when senders are updated, the system 
will issue a connection update to all affected receivers with the latest information about the sender 
(the updated SDP description). When using an Ultricore BCS, the Ultricore BCS automatically 
updates the receivers when the subscribed sender changes. 
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This feature is helpful to avoid receivers to be configured with a stale version of the associated 
sender. If the parameters of a sender change, an SDP update is triggered, which is then forwarded 
to all receivers affected by the identified update.

Quick Updates when Streaming from the Ultricore BCS

When the format of the SDI input video changes, the Ultrix-IP updates its own sender and SDP, and 
the Ultricore BCS is notified of this change. The Ultricore BCS then issues a connection update to all 
receivers using this sender. The ST 2110 stream and SDP file are also updated and the video sender 
resumes with the new format.

Protection from Invalid Video Scenarios

If a loss of signal occurs, an automatic SDP update will not occur. In addition, when an input with a 
non-matching frame rate is detected, an alarm in DashBoard is raised. The SDP file remains 
unchanged, but the sender does not transmit the packets. This prevents the entire system from 
switching to an invalid video format or unstable video input.

Using any Supported Control Protocol

The advertised SDP file updates to reflect a valid video format change through all supported control 
protocols, including NMOS, Ember+, and DashBoard advertised network streams. This enables the 
Ultrix-IP to use the new SDP file, and enables the user to update the connections of any active 
receivers to the new format without having to recreate the sender streams.

Requirements

To take advantage of this feature, you will need to:

• Configure the receivers and senders and ensure they are active on the router. If a sender is 
disabled (not active), the incoming changes on the router port of the ULTRIX-IP-IO blade will not 
cause any change on the active configuration.

• When configuring the senders, specify the video format(s) you want to stream via the Adaptive 
Input Allowed Input Rates option for each applicable ULTRIX-IP-IO blade port. 

Overview
The generalized work flow of configuring your ULTRIX-IP-IO is:

1. Download and install the latest version of the DashBoard client software.

2. Contact your IT department for the required IP addresses for your ULTRIX-IP-IO ports.

3. Cable the ULTRIX-IP-IO ports.

4. Configure the protocol settings for the ULTRIX-IP-IO.

5. Configure the Port Network settings.

6. Define the Network Stream Groups.

7. Specify the timing requirements for the ULTRIX-IP-IO.

8. Configure the sender streams for the ULTRIX-IP-IO.

9. Make your connections.

10. Continue to set up your database as outlined in “Database Configuration”.
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Setups with an Ultricore BCS
An Ultricore BCS with the Ultrix-IP license enables the video senders/receiver endpoints to be 
reported as available ports to the router database. The video senders/receivers are seen as part of 
a single video-IP matrix, and the audio senders/receivers are part of a single audio-IP matrix. 

When a video sender stream is active and the video format changes on the SDI input of that 
stream, the Ultricore BCS will automatically detect the update and then updates all the receivers 
subscribed to that sender. This allows the existing streams to adapt.

Refer to the Ultricore BCS User Guide for details on setting up and configuring the Ultricore BCS in 
your routing system.

Figure 10  Example Setup with an Ultricore BCS Redundancy System

Network Switch

PORT 2 PORT 3 PORT 4 PORT 5 PORT 6 PORT 7 PORT 8PORT 1

ULTRIX-FR1
32x32 3G/HD/SD SDI Router

ENET 2

ENET 1

1 4 A B

REF

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN

Ultrix-HDBNC-IO

REF

!

RCP-QE
Remote Control Panel

ETHERNETPSU

PC running DashBoard

Internet / LAN / VPN

Primary Ultricore BCS
System Control and Interface

Secondary Ultricore BCS
System Control and Interface

ULTRIX-FR2
64x64 3G/HD/SD SDI Router

ENET 2

ENET 1

1 4 A B

REF

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN

Ultrix-HDBNC-IO

REF

REF

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN

Ultrix-HDBNC-IO

Ultrix-HDBNC-IO



Ultrix User Guide (v23.0) ULTRIX-IP-IO Setup • 79

Configure the Protocol Settings
The Ultrix-IP supports media distribution based on NMOS, and Ember+. This section outlines each 
protocol.

 Any changes made to the ULTRIX-IP-IO settings requires a frame reboot.

Configuring the NMOS Settings
The Network Media Open Specifications (NMOS) is enabled by default on the device if one or more 
ULTRIX-IP-IO blades are present. The Ultrix router will automatically look for advertised NMOS 
registries using mDNS and will publish the Device Name and other info in the Frame Configuration 
> Ultrix-IP > NMOS interface. You can also choose to register the router when using Registry Service 
Discovery (RDS).

To configure the NMOS settings

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens.

5. Select the Ultrix-IP tab.

The Port Network sub-tab is automatically selected in the left toolbar.

6. Select the NMOS tab on the left toolbar.

 It is not recommended that your media network and management network use the same subnet.

7. Use the Static RDS box to determine how the router will register in an RDS system.

• Selecting the box allows the user to set an RDS IP in the Registry Service Address field and 
forces the router to register to this specific RDS.

• Clearing the box configures the router to use mDNS to automatically register in an RDS on 
the network with the lowest priority.

8. Use the Channel Mapping field to specify the port used for the RDS.

9. Use the Connection Port field to specify the port the NMOS IS-05 Connection service is 
listening on.

10. Use the Node Port field to specify the port the NMOS IS-04 Node service is listening on.

11. Click Apply to save your changes.

Ember+ Communications
Each ULTRIX-IP-IO blade provides two Ember+ ports for controllability. One port will export the first 
8 streams and the second port provides access from streams 9 to 16. The Ember+ port will be 
available on Port 9095 for the IP address assigned to each ULTRIX-IP-IO ports 1 and 3. If accessing it 
through the Ultrix Frame Configuration > Ultrix-IP System interface, the ports will be distributed 
based on slot position as follows:

• Streams 1-8 to Port 500x8
• Streams 9-16 to Port 500x9

where x is the router slot that the ULTRIX-IP-IO is installed in.
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 If the Ultrix router includes two ULTRIX-IP-IO blades, and the intention is to control it via Ember+, 
a total of 4 Ember+ port connections are needed.

To establish a connection between the Ember+ client and the Ultrix, you will need to:

1. Add the Ultrix in the Ember+ client interface using the IP Address assigned to the Ultrix router.

2. Enable SDP patching with the Ember+ client to establish video and audio receivers on the Ultrix.

3. Ensure that all network streams have a consistent audio channel count.

Establishing a Connection

Ensure that SDP patching is enabled with the Ember+ client to establish receivers on the Ultrix.

 Ultrix implements BESS v1.1 for Ember+ support to communicate with third-party controllers.

Mapping

You will need to configure the Senders, and then use the Ember+ controller interface (e.g. Lawo 
VSM) to map the sources to the targets. Refer to the documentation that came with your Ember+ 
controller for details.

Configuring the Port Network
By assigning an IP Address to each port of the ULTRIX-IP-IO blade, you are able to uniquely identify 
it on the network and control it via the DashBoard interface. Each port can be configured separately 
for media traffic.

 All ENET ports are set to DHCP by default.

To assign the network settings for an ULTRIX-IP-IO port

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens.

5. Select the Ultrix-IP tab.

The Port Network sub-tab is automatically selected in the left toolbar.

6. In the Ultrix-IP Port Network table, locate the row for the slot#.port# you wish to configure.

7. If you are manually configuring the Ethernet settings:

a. Click the cell in the IP Mode column and select Static.

b. Use the IP field to specify the static IP Address for the port. This is the IP Address that is used 
to control and communicate with the specified port.

c. Use the Subnet Mask field to specify the subnet mask for the port. 

d. Use the Gateway field to specify the gateway for communications outside of the local area 
network (LAN) the ULTRIX-IP-IO will use.

8. If you want the network settings for the port to be automatically obtained, and DHCP service is 
available on your control network, click the cell in the IP Mode column and select DHCP.

9. Click Apply to save the new settings.
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10. Repeat this procedure for the second port you wish to configure.

11. Click Reboot to apply the new settings. This button is located at the bottom of the interface.

The Ultrix is temporarily taken off-line during the reboot.

12. Verify the new settings reported on the Frame Configuration status fields.

Configuring the Timing Settings
The Ultrix supports the Precision Time Protocol (PTP) as defined in the IEEE 1588-2008 standard and 
the SMPTE ST-2059 specification.

 The Ultrix behaves only as a follower and cannot be used as a Boundary Clock or Grandmaster.

Configuring the PTP Settings
You can synchronize the Ultrix to real-time clocks of other devices in the same network. You create 
a profile (use the default settings or create a custom profile) that identifies the Ultrix to the 
Grandmaster clock.

 There are several criteria that PTP clocks compare to determine who will be master and who will 
be follower (called the Best Master Clock Algorithm, or BMCA), and they are evaluated in order: 
Priority1, clock class, accuracy, scaled log variance, Priority2, clock ID (similar to the MAC address). 
Practically, Priority1 is the only setting configured on all clocks to control the outcome of the 
Grandmaster election. If Priority1s are equal, the next criterion is evaluated (clock class) and the 
criteria are evaluated in succession until a Grandmaster is determined.

To configure a PTP default profile for the Ultrix

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens.

5. Select Ultrix-IP > PTP.

6. Use the Profile menu to specify the standard/specification used for PTP. The default is SMPTE 
ST 2059-2.
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 The Domain is automatically set if the Custom PTP Profile is not selected.

7. Click Apply.

To create a custom PTP profile for the Ultrix

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens.

5. Select Ultrix-IP > PTP.

6. Select the Custom PTP Profile box.

7. Use the Domain menu to specify the sub-domain the PTP clock is assigned to. The default is 
127.

 There can be multiple PTP domains operating concurrently within a network. The domain is a 
field in all PTP message headers. Messaging between entities are segregated by domain (e.g. the 
Ultrix is an endpoint configured for domain 128 and ignores messages from a neighboring clock 
configured for domain 127).

Configuring the PTP Settings for a Specific Port
Once you create a PTP profile for the Ultrix, you may want to uniquely define the PTP settings for 
each ULTRIX-IP-IO port. 

To configure the PTP settings for a specific port

1. In the Ultrix-IP > PTP tab of the Frame Configuration page, select the Custom PTP Profile box 
for the required port.

2. Use the Name field to assign a unique identifier to the port.

3. Use the Sync Interval field to specify the number of seconds at which synchronization 
messages are sent from the master clock to the specified ULTRIX-IP-IO port.

4. Use the Announce Interval field to specify the rate of announce messages that the specified 
ULTRIX-IP-IO port requests from the master clock during a unicast session.

5. Use the Announce Receipt Timeout field to specify the number of seconds the specified 
ULTRIX-IP-IO port waits for an announce interval message before timing out.

6. Click Apply.

Enabling Redundant Mode
The ULTRIX-IP-IO enables a user to protect their streams to ensure mission critical operation. Using 
SMPTE ST 2022-7, they can run the same video and audio over two separate, redundant networks in 
case an error occurs.

 This section is only applicable if your system requires protection switching.

Before You Begin
Ensure that:

• your source is capable of sending SMPTE ST 2022-7 streams
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• the Ultrix is set up within a protection switching network

Enabling the Redundant Mode
By default, the Redundant mode is disabled. 

To enable the Redundant Mode for an ENET pair

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens.

5. Select the Ultrix-IP tab.

The Port Network sub-tab is automatically selected in the left toolbar.

6. In the Ultrix-IP Port Network table, locate the ENET pair you wish to configure.

Each row in the table is an ENET port on an installed ULTRIX-IP-IO blade. 

7. Select the Redundant box for the ENET pair you wish to configure for protection switching.

8. Click Apply.

Configuring the Ultrix for Protection Switching
You will need to assign a unique IP address to each stream (primary and redundant) in the same 
multicast range 

To configure the Ultrix for protection switching

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Port Configuration page opens.

5. Select the first port of the ENET pair you enabled the Redundant mode for in the router rear 
panel map, located at the top of the Port Configuration page.

The Port Configuration page updates to display the Summary, and Details tabs for the port. 
The port label, on the router panel map, also displays with a light-blue background. In the 
example below, the user selected slot3.port3 to configure.
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6. Configure the primary Senders as outlined in “Configuring the Senders”.

7. Configure the redundant Sender stream for the ENET pair as follows:

a. In the Details > Senders tab, select the first port of the ENET pair you enabled Redundant 
Mode for.

b. Click Edit. This button is located in the bottom right corner of the tab.

The Edit Senders dialog opens.

c. Use the Secondary IP menus to specify the IP address for the secondary (redundant) 
stream. Ensure that it is the same IP Address as the primary stream.

d. Use the Secondary UDP port to specify the UDP port for the secondary (redundant) stream. 
Ensure that it is not the same value as the primary stream.

e. Click OK.

f. Verify the new settings are reported in the Redundancy column of the Senders tab.

8. Configure the primary Receivers as outlined in “Configuring the Receivers”.

9. Configure the redundant Receiver stream as follows:

a. Select Details > Receivers.

b. Select the row for the first port of the ENET pair you enabled Redundant Mode for.

c. Click Edit.

d. Use the Secondary IP menus to specify the IP address for the secondary (redundant) 
stream. Ensure that it is the same IP Address as the primary stream.

e. Use the Secondary UDP port to specify the UDP port for the secondary (redundant) stream. 
Ensure that it is not the same value as the primary stream.

f. Click OK.

g. Verify the new settings are reported in the Redundancy column of the Receivers tab.

Configuring the Senders
You will need to specify the IP encapsulation properties for the active video and audio. For each 
input signal, you need to specify the IP encapsulation properties for the active video and audio. A 
sender stream on the ULTRIX-IP-IO can be configured with any multicast IP address in the range of 
225.x.x.x to 239.x.x.x.
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Make note of the bandwidth allocation for the ULTRIX-IP-IO port to determine the available 
capacity of the port. You can add as many streams to fill up the 25Gb bandwidth of the selected 
ENET port. Once that maximum is reached, new streams will not be accepted and updates will 
only be accepted if the new bandwidth used does not exceed 25Gb.

To display the Senders tab for a port in DashBoard

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. On the router rear panel map, locate the required ULTRIX-IP-IO slot.

5. Select the port on the ULTRIX-IP-IO slot you wish to configure.

The Port Configuration page updates to display the options for the port with the Summary tab 
automatically selected. 

6. Select the Senders sub-tab.

To add advertised sender streams

1. Click Default. This button is located in the bottom right corner of the tab.

The Setup Default Senders dialog opens.
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2. Use the IP Address field to specify the IP range for the sender.

In the above example, the user entered 239.8.7.1 as the starting point for the sender streams. 
Each subsequent advertised stream after this IP Address (e.g. 239.8.7.2, 239.8.7.3, 239.8.7.4 
etc.) will be added to the Senders tab.

3. Use the UDP Port field to specify the RTP port for the advertised stream.

4. Use the Video RTP Payload and Audio RTP Payload fields to specify the Real-time Transport 
Protocol (RTP) payload IDs used by that sender stream.

5. Use the Video Format field to specify the video format of the signal available for the advertised 
stream.

6. Use the options in the Adaptive Input Allowed Input Rates area to specify the video formats 
that the stream is allowed to follow should the input SDI video format change while the sender 
is enabled.

 This is not a bandwidth reservation. If a sender is set to allow 12G inputs, it is not guaranteed that 
it would follow that video format as all device setups is constrained by the available bandwidth 
on the Ethernet side. If the new video input is valid, but the overall system configuration is invalid, 
the sender will be updated but an alarm is still raised to the user to alert of a video mismatch.

When the sender is updated, all protocols or interfaces that advertise it will be updated with a 
new configuration set and SDP. This includes NMOS, Ember+, and all DashBoard tabs where the 
sender is visible.

7. Use the Audio Codec field to specify the audio compression format for the advertised stream.

8. Use the Audio Channels field to specify the maximum number of audio channels in each 
stream.

9. Select the Add Ancillary Stream box to include the ST 2110-40 ancillary data.

10. Click OK. 

The Setup Default Senders dialog closes and the Senders tab updates to list the sender 
streams advertised using the IP Address specified in step 2.

Make a note of the automatically assigned label in the Name field for each stream. This name will 
be used in the database to represent the specific stream as an output (destination).

To manually add a sender stream

1. Click Add. This button is located in the bottom right corner of the tab.

The Add Senders dialog opens.
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2. Use the IP Address field to specify the sender. 

The audio and ancillary (ANC) data will receive the selected IP address with one for audio and 
the second for the ANC.

3. Edit the UDP Port to specify the source port to transmit the data.

4. Use the Type menu to select the type of stream that will be available at the specified IP Address.

 It is recommended to not edit the UDP Port field as this field is auto-populated by the advertised 
stream.

5. Use the Output menu to assign the SDI input signal to the sender stream.

6. If you selected Video & Audio, or Video in step 4, use the Video Format menu to specify the 
video format of the signal available to the sender.

7. Use the options in the Adaptive Input Allowed Input Rates area to specify the video formats 
that the stream is allowed to follow should the input SDI video format change while the sender 
is enabled.

 This is not a bandwidth reservation. If a sender is set to allow 12G inputs, it is not guaranteed that 
it would follow that video format as all device setups is constrained by the available bandwidth 
on the Ethernet side. If the new video input is valid, but the overall system configuration is invalid, 
the sender will be updated but an alarm is still raised to the user to alert of a video mismatch.

When the sender is updated, all protocols or interfaces that advertise it will be updated with a 
new config set and SDP. This includes NMOS, Ember+, and all DashBoard tabs where the sender 
is visible.

8. If you selected Video & Audio, or Audio in step 4:

a. Use the Audio Codec menu to specify the audio compression format for the sender.

b. Use the Audio Channels menu to specify the maximum number of audio channels in the 
specified stream.

9. Click OK.

The Add Senders dialog closes and the new stream is added to the Senders tab.

Make a note of the automatically assigned label in the Name field for the stream. This name will 
be used in the database to represent the specific stream as an output (destination).

To edit a sender stream

1. Select the row for the sender stream you wish to edit in the Senders tab.

2. Click Edit.

3. Edit the fields as required.

 The fields with yellow backgrounds are read-only and cannot be edited.

4. Click OK.

Configuring the Receivers
Receivers are the representation of connections on the router and report the information related to 
all traffic that is received. Receivers can be manually created by manually specifying the IP and UDP 
ports of the sender on the Port Configuration tab, but usually the process of managing receivers is 
done by the external network device. 

This section outlines what is currently present/active on the Port Configuration tab and outlines 
how to manually specify receivers on the router using this interface.
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To display the Receivers tab for a port in DashBoard

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. On the router rear panel map, locate the required ULTRIX-IP-IO slot.

5. Select the port on the ULTRIX-IP-IO slot you wish to configure.

The Port Configuration page updates to display the options for the port with the Summary tab 
automatically selected. 

6. Select the Receivers sub-tab.

To add a series of receivers

1. In the Receivers sub-tab, click Default. This button is located in the bottom right corner of the 
tab.

The Setup Default Receivers dialog opens.
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2. Use the IP Address field to specify the IP range for the receiver.

In the above example, the user entered 239.19.8.1 as the starting point for the receiver streams. 
Each subsequent advertised stream after this IP Address (e.g. 239.19.8.2, 239.19.8.3, 239.19.8.4 
etc.) will be added to the Receivers tab.

3. Use the UDP Port field to specify the RTP port the receivers will use.

4. Use the Video Format field to specify the video format of the signal the receivers will output.

5. Use the Audio Codec field to specify the audio compression format for the receiver streams.

6. Use the Audio Channels field to specify the maximum number of audio channels in each 
stream.

7. Click OK. 

The Setup Default Receivers dialog closes and the Receivers tab updates to list the receiver 
streams using the IP Address specified in step 2.

Make a note of the automatically assigned label in the Name field for each stream. This name will 
be used in the database to represent the specific stream as an input (source).

To manually add a single receiver

1. In the Receivers tab, click Add. This button is located in the bottom right corner of the tab.

The Add Receivers dialog opens.

2. Use the IP Address menu to specify the IP Address for the transport stream for the receiver.

3. Use the UDP port menu to specify the UDP port number of the transport stream for the 
receiver.

4. Use the Type field to specify the type of signal.

 Selecting Video+Audio automatically creates table entries for one video and multiple audio 
streams.

5. If you selected Video or Video+Audio in step 4, use the Video Format field to specify the video 
format for the stream.

6. If you selected Audio or Video+Audio in step 4, use the # of Audio Channels field to specify 
the audio channels in the stream.

7. Use the Transport IP field to specify the UDP IP address of the transport stream for the signal.

8. Click OK to create a new entry in the Receivers tab.

The Add Receivers dialog closes and the Receivers tab updates with the new receiver stream.

Make a note of the automatically assigned label in the Name field for the stream. This name will 
be used in the database to represent the specific stream as an input (source).

Troubleshooting
Table 9 provides brief explanations for some common stream setup messages.
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Using Senders and Receivers in the Router Database
Throughout the Dashboard interface, the senders and receiver streams (outputs and inputs 
respectively) of a router (or matrix) are referred to by hierarchical dotted notation: 
Slot.Port[x].Type.Channel where:

• Slot identifies which slot in the router chassis the ULTRIX-IP-IO blade is located in.
• Port[x] identifies the physical port on the ULTRIX-IP-IO blade.
• Type identifies the generic signal type (e.g. SDI, audio).
• Channel identifies the audio channel within the stream. If the stream is video, the channel 

number is fixed to 1.

Table 9  Troubleshooting the Error Messages

Error Message Cause
Cannot set default due to 
maximum allowable streams has 
reached

ENET pair has reached the maximum number of allowable 
streams

Cannot add 2160P59 video due to 
maximum allowable UHD streams 
has reached

Primary and Secondary UDP port 
cannot be the same

When in Redundant mode, the primary and secondary 
streams must have the same IP address but different UDP 
ports assigned.

This IP port does not have enough 
bandwidth to add 2160P29 video 
stream

The ENET port has reached the maximum 25G bandwidth.

slot#.port# is a redundant IP port. 
It is reserved for redundant 
senders.

The ENET pair is in Redundant mode and you cannot edit 
the second port (ENET 2 or ENET 4) of the pair.

UHD video must be assigned to 
output 1, 2, 3, 4, 9, 10, 11, or 12.

The UHD video stream (6G or 12G) format must be assigned 
to one of the inputs/outputs 1-4 or 9-12.

Address x.x.x.x:x is being used by 
slotx.out[y].#.chz

Each stream must have a unique network address

Video Format mismatch detected The input video format does not match those 
selected/enabled in the Adaptive Input Allowed Input 
Rates setting of the sender stream, or input is not valid.
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Figure 11  Example of Senders in the Port Configuration Interface

These designators may be assigned more user friendly names if required by editing the Port Labels 
interface.

Figure 12  Example of Senders in the Database Interface

Integration Examples
This section describes use cases for video streams.

Using 3G HD Video
The following setups use 3G HD video or lower formats. All streams can fit within the first ENET port 
but there is a maximum of eight video streams per pair.

Redundancy Mode is Disabled

Figure 13 shows two ULTRIX-FR5 routers with the first router (Frame A) transmitting eight 3G HD 
video streams and the second router (Frame B) receiving eight 3G HD streams.
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Figure 13  Example of ULTRIX-IP-IO with 3G HD Video Streams

In this setup you would configure eight video streams with 1080p 59.94 format (including the audio 
streams) without redundancy. 

1. For Frame A you would configure eight video sender streams with 1080p 59.94 format (pairing 
two audio sender streams per video stream).

2. For Frame B you would configure eight video receiver streams with 1080p 59.94 format (pairing 
two audio receiver streams per video stream).

3. Ensure that the receiver IP address on Frame B matches the existing sender address on Frame 
A.

Redundancy Mode is Enabled

In this setup, there are eight video streams with 1080p 59.94 format (including the audio streams) 
but the Redundancy Mode is enabled. All streams can fit within the first ENET port but there is a 
limit of eight video streams per pair. The second ENET port is reserved for the redundant streams.

Figure 14 shows two ULTRIX-FR5 routers with one router (Frame A) transmitting eight 3G HD 
primary video streams and eight 3G HD secondary streams. The second router (Frame B) receives 
two sets of eight 3G HD streams (primary and secondary).
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Figure 14  Example of ULTRIX-IP-IO with 3G HD Video Streams — Redundancy Mode

In this setup you would configure eight video streams with 1080p 59.94 format (including audio 
streams) with the Redundancy Mode enabled for each ENET pair in use.

1. For Frame A you would:

a. configure two sets of eight video sender streams with 1080p 59.94 format (pairing two audio 
sender streams per video stream).

b. enable Redundant Mode for the ENET pair where ENET 1 will transmit the primary streams 
and ENET 2 will transmit the secondary (redundant) streams.

2. For Frame B you would:

a. configure two sets of eight video receiver streams with 1080p 59.94 format (pairing two 
audio sender streams per video stream).

b. enable Redundant Mode for the ENET pair. ENET 1 will receive the primary streams and 
ENET 2 will receive the secondary (redundant) streams.

Using UHD 12G Video Format
When using UHD 12G video formats (60/59.94/50Hz), there is a limit of two video streams per ENET 
port with a maximum of three video streams per ENET pair.
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Redundancy Mode is Disabled

Figure 15 shows two ULTRIX-FR5 routers with one (Frame A) transmitting three 12G UHD video 
streams and the second router (Frame B) receiving three 12G UHD streams.

Figure 15  Example of ULTRIX-IP-IO with 12G UHD Video Streams

In this setup you would configure three video streams with 2160p 59.94 format without 
redundancy. 

1. For Frame A you would configure two video sender streams with 2160p 59.94 format on ENET 1 
and one 2160p 59.94 video sender stream on ENET 2.

2. For Frame B you would configure two video receiver streams with 2160p 59.94 format on ENET 
1 and one 2160p 59.94 video receiver stream on ENET 2.

3. Ensure that the receiver IP addresses on Frame B match the existing sender addresses on 
Frame A.

Redundancy Mode is Enabled

In this setup, there are two video streams with 2160p 59.94 format (including the audio streams) 
but the Redundancy Mode is enabled. There is a limit of two video streams per ENET port. The 
second ENET port is reserved for the redundant streams.
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Figure 16 shows two ULTRIX-FR5 routers with one router (Frame A) transmitting two 12G UHD 
primary video streams and two 12G UHD secondary streams. The second router (Frame B) receives 
a primary set of two 12G UHD streams and a secondary set of two 12G UHD streams.

Figure 16  Example of ULTRIX-IP-IO with 12G UHD Video Streams — Redundancy Mode

In this setup you would configure two video streams with 2160p 59.94 format with Redundancy 
enabled for each ENET pair in use.

1. For Frame A you would:

a. enable Redundant Mode for the ENET pair where ENET 1 will transmit the primary streams 
and ENET 2 will transmit the secondary (redundant) streams.

b. configure two sets of two 12G UHD video sender streams with 2160p 59.94 format.

2. For Frame B you would:

a. enable Redundant Mode for the ENET pair. ENET 1 will receive the primary streams and 
ENET 2 will receive the secondary (redundant) streams.

b. configure two sets of two video receiver streams with 2160p 59.94 format.

Using Multiple Video Streams with Different Formats
In this setup, there are multiple video streams with different video formats with a total bandwidth 
of all streams totaling less than 25Gb. 
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Figure 17 shows two ULTRIX-FR5 routers with one router (Frame A) transmitting four 3G HD video 
streams and one 12G UHD video stream on ENET 1. The second router (Frame B) receives four 3G 
HD streams and one 12G UHD video stream on ENET 1.

Figure 17  Example of ULTRIX-IP-IO with Multiple Streams with Different Video Formats

In this setup you would configure a total of five video streams on each ENET port of each router. 

1. For Frame A you would configure:

a. four video sender streams with 1080p 59.94 format on ENET 1.

b. one 2160p 59.94 video sender stream on ENET 1.

2. For Frame B you would configure:

a. four video receiver streams with 1080p 59.94 format on ENET 1.

b. one 2160p 59.94 video receiver stream on ENET 1.

3. Ensure that the receiver IP addresses on Frame B match the existing sender addresses on 
Frame A.
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ULTRIX-SFP-IO Setup
This chapter outlines how to utilize the ports for the Ultrix router when an ULTRIX-SFP-IO blade is 
installed in a slot of an Ultrix router chassis.

For More Information on...
• the installation and cabling of the ULTRIX-SFP-IO, refer to the ULTRIX-FR1, ULTRIX-FR2, and 

ULTRIX-FR12 Installation Guide.

Overview
The Ultrix router automatically detects when the ULTRIX-SFP-IO blade is installed. Each signal is 
made available in the Ultrix routing system much like those available via the standard IN and OUT 
HD BNCs for each slot. The signals are initially named using the standard 
Frame.Slot.Port.Type.Channel nomenclature where Port is reported as the physical AUX and/or SFP 
port on the Ultrix rear panel that the module is installed in. The options in the SFP Configuration 
interface for a module are the same as those for video and audio signals on the BNCs.

  MADI SFP modules are only supported in the AUXA and AUXB ports.

For More Information on...
• the supported modules for the ULTRIX-SFP-IO blade, refer to the ULTRIX-FR1, ULTRIX-FR2, and 

ULTRIX-FR12 Installation Guide and Ultrix SFP Modules Guide.

Figure 18  Example of the SFP Configuration Interface

Before You Begin
You may also need to install an:

• UltriSpeed license if the ULTRIX-SFP-IO includes an SFP-HDB-IN-12G, SFP-FIBER-12G, and/or 
SFP-HDB-OUT-12G.

• UltriScape license for each port that will be used to provide an UltriScape head output.
• UltriSRC license for each AUX port configured for asynchronous MADI input.



98 • ULTRIX-SFP-IO Setup Ultrix User Guide (v23.0)

Configuring an SFP Port
Once the SFP module is installed in a port, you must specify the port type. Select SDI video for video 
SFP types, or MADI for Audio SFP types. MADI audio SFP type allow you to specify the channel 
quantity - either 56 or 64 as per your facilities' standard.

The SFP Configuration interface is organized into two sections: AUX settings, and SFP settings. The 
AUX Settings lists all the AUX port settings for all blades in the frame. The SFP Settings list all the SFP 
I/O port settings.

To configure the settings for an SFP port

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The SFP Configuration page opens.

5. Select the tab appropriate to the port location you wish to configure.

6. From the Slots table on the left, select the required ULTRIX-SFP-IO blade.

 Click ALL to display the available SFP/AUX ports available in the router.

The Settings table updates to display the port name, and the type of signals for each populated 
port.

7. Locate the row for the port you want to configure.

8. In the SFP column for the port, verify the type of signal the port will provide. 

9. If applicable, use the MADI I/O Size menu for the AUX port to specify the input and output 
configuration for the port.

MADI is only available in the AUX ports. The SFP I/O ports 1-16 does not support MADI I/O.

10. Click Apply to save your changes. 

To monitor an SFP port

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.
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3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Port Configuration page opens.

5. Select the button for the slot that houses the port you want to verify.

In the example below, the user selected Slot 1.

6. Select the SFP port you want to verify.

The label under the selected port is now lit blue and the page updates with information about 
the port. In the example above, the user is monitoring all ports on the blade.
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Device Communication Setup
A single Ultrix router can communicate with external devices such as remote control panels, Ross 
NK devices, and automation devices running third-party protocols.

Figure 19  Example of System Connectivity Options with an Ultrix Router

Communication between an external device and the Ultrix router is over Ethernet via an 
established connection point. A connection point defines the interface and the protocol to be used 
for communications. By default, Ultrix provides several server connections points as listed in 
Table 10 for incoming control/communications. Client connection points from the router to an 
external device are configured using the connection definition options in the Ultrix Connections 
interface of DashBoard. This step is only required if external routing systems are connected to the 
Ultrix router.

Communications between Ultrix and the Devices in a Routing System
The Ultrix Connections tab allows you to monitor and configure the various communications 
protocols. To enable the Ultrix to function as the ‘master’ of the routing system, you must establish 
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communications with the devices it is connected to and define how they are connected. Each 
external device must have a connection point defined. For those devices that are not directly 
connected to your network, such as Ross NK Series routers and remote control panels, you must 
supply their connection information (communication protocol, IP address, and port number) in the 
Connections interface. Once this information is entered into the interface, Ultrix can communicate 
directly with the device and list it as a node under the Devices interface.

 External device protocols must be configured before connections can be established. By default, 
the various third-party protocols are disabled, and should be enabled as required. Refer to 
“Enabling Network Services” for details.

Enabling Network Services
The Ultrix supports communication with external devices via a set of third-party protocols. Before 
creating connection points between the Ultrix and the devices in your routing system, you must first 
enable each protocol the devices require via the Ultrix > System Status > Network tab.

 By default, the third-party protocols are disabled on the Ultrix, and should only be enabled as 
required. 

To enable a network services on the Ultrix

1. Locate the Ultrix in the Tree View of DashBoard.

2. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

3. Double-click the System Status node.

4. Select the Network tab.

5. Locate the Services area.

6. Click Change.

The Change Service Settings dialog opens.

7. Select the box for each third-party protocol required by your device(s).

8. Click Apply.
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Connecting to Ross Remote Control Panels
A single Ultrix router can communicate with external remote control panels such as the Ross 
RCP-NK series, RCP-ME, and RCP-QE. Communication with Ethernet enabled panels is direct from 
the panel to Ultrix. Refer to the panel user manual for specific configuration details.

RCP-ME and RCP-QE Panels
The connection from the remote control panel to Ultrix is configured on the panel’s DashBoard 
interface.

1. Display the RCP Connection Editor in DashBoard for your remote control panel. Refer to the 
user guide for your remote control panel for details.

2. Locate the Servers to Connect table.

3. In the first row of the table, use the IP address column to specify the IP address of the Ultrix 
router that the remote control panel will communicate with.

4. Send the current configuration file to the remote control panel. Refer to the user guide for your 
remote control panel for details.

The remote control panel will connect to the Ultrix router and receive a copy of the current 
database labels.

Connecting to Ross NK Series Devices
Ross NK routers and remote control panels are linked via the T-Bus Control System, a multi-drop 
RJ-45 control system. These T-Bus devices can communicate over Ethernet via a Ross NK-IPS or 
NK-NET.

A connection point between the Ultrix router and an NK-IPS or NK-NET is defined using the 
auto-populated fields in the Connections tab of the Ultrix interface. Once a connection point is 
established, the Ultrix router gains control over those Ross NK devices connected to the NK-IPS or 
NK-NET.

For More Information on...
• a workflow with Ross NK devices in a routing system, refer to “Using Remote Control Panels”.

To establish communication between Ultrix and an NK-IPS or NK-NET

1. Launch the Walkabout utility in DashBoard as follows:

a. Expand the NK Utilities node in the Tree View.

b. Double-click Show Walkabout to open the Walkabout utility in the DashBoard window.

c. Verify that the NK-IPS or NK-NET is listed in the table of the Walkabout utility. Make a note of 
its name and IP Address.

 If the device you want to connect to Ultrix is not detectable in Walkabout, you can still establish 
communications with it in Ultrix using the Connections > Settings menu to manually enter/edit 
the device settings.

2. Display the Connections tab for Ultrix as follows:

a. Expand the Database node in the Tree View.

b. Double-click the Connections node.

The Connections tab opens that lists the current database connection points.

3. Click Edit > Add.

The Add Connections dialog opens.
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4. In the Add Connections dialog, perform the following:

a. Use the Protocol menu to select Ross NK.

b. Use the Type menu to select tcp.

c. Use the Count menu to specify the number of new connection entries to make in the 
Servers table.

d. Click Apply to create the new device row(s) in the Servers table and close the Add 
Connection dialog.

5. In the Name column, click the cell of the new row to display the drop-down menu.

6. From the drop-down menu, select the device you which to establish a connection to.

 If Walkabout does not auto-populate this menu, manually type in a unique name for the device. 
The same unique identifier should be typed into the Device ID column field.

7. In the Enabled column of the new row, select Enable.

8. Click the [...] button to verify the IP Address and TCP port values for the device.

9. Click Apply at the bottom of the Connections tab to save the new settings.

RCP-NK Series Panels
Communication with RCP-NK series panels is via an established connection point with either an 
NK-IPS or NK-NET network bridge.

Defining a Database with a Ross NK Router Matrix
Once a connection point is established between Ultrix and the Ross NK router, the NK router ports 
are automatically included in the Available Ports lists of the Ultrix database. 

Defining the Levels for an NK Router

Once a connection point is established between Ultrix and the Ross NK router, you can define levels 
for the router via Ultrix and save them to the Ultrix database.

For More Information on...
• defining the levels, refer to “Defining the Levels in a Database”.

Defining the Sources and Destinations for an NK Router

Once a connection point is established between Ultrix and the Ross NK router, you can define a 
physical input/output socket as a source destination in a specific level within the Ultrix database. 

When creating a virtual label for a source or destination, it is recommended to use a short or 
abbreviated name as this text is used to identify the specific signal on the remote control panels 
which have limited display areas.

For More Information on...
• defining the sources, refer to “Defining the Sources in a Database”.
• defining the destinations, refer to “Defining the Destinations in a Database”.

Connecting to Ultricore Central Controllers
The Ultricore Central Controller (Ultricore-CC) and the Ultricore Broadcast Central Controller 
(Ultricore-BCS) may act as a master controller for one or more Ultrix routers as well as legacy Ross 
NK series devices. A connection is made from the controlling Ultricore panel to the Ultrix router(s). 
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The controlling Ultricore (primary) contains the full database configuration for the entire operation 
of the system.

All control devices, such as a remote control panel (RCP) or third-party controller, must be 
configured for and communicate with the master Ultricore. Any Ultrix configured as a sub-device 
will only accept control commands via the master Ultricore.

 Any Ultrix devices to be controlled by the Ultricore Central Controller must have the Remote 
Controller Mode enabled. Refer to “Enabling Remote Controller Mode on the Client Ultrix 
Routers” for details.

 Ultricore redundancy is only available when using Ultricore-BCS units.

For More Information on...
• configuring a connection point from an Ultricore to an Ultrix router, refer to the Ultricore User 

Guide or the Ultricore BCS User Guide.

Connecting to Third-Party Devices
Ultrix provides support for many industry standard protocols for interfacing to external devices 
such as control systems, external routing matrices, and tally systems.

 Before proceeding, ensure that your third-party device is installed and configure according to its 
documentation.

 Verify that the required third-party protocol is enabled in the Ultrix > System Status > Change 
Service Settings dialog. Refer to “Establish Communications” for details.

Connection to third-party devices may be categorized into two broad groups: controller and 
controllee.   

• Controllers are devices that will control the Ultrix router and connect via what may be termed an 
incoming connection.

• Controllees are devices to be controlled by Ultrix router and connect via what may be termed an 
outgoing connection.

Incoming Ethernet connections must have the service enabled and any options set as required 
before use. Outgoing connections require service enabling and a connection definition set before 
use. Refer to Table 10 for a list of the available Ethernet protocols and ports. Serial connections, via 
USB, must be defined before either incoming or outgoing connection styles may be utilized by Ultrix

Third-party Connection via Ethernet
The Ultrix router can communicate with third-party external devices via a TCP connection. By 
default, Ultrix provides a server process for the following Ethernet protocols:

Table 10  Supported Protocols — Ethernet Connection

Protocol Default Port
GVG Native Series 7000 TCP: 12345

Probel SW-P-08 TCP: 8910

RossTalk TCP: 7788

TSL UMD v3.1 TCP: 5727
UPD: 4490
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These Ethernet services must be enabled before use. Some protocols services have further 
configuration options. 

Figure 20  Example of the Protocol Server Option Dialog

The available Protocol Server options depends on the type of protocol. Refer to “External Control” 
for details.

To set up an outgoing connection over Ethernet between Ultrix and a third-party device

1. Expand the Database node.

2. Double-click the Connections node located under the Database node.

The Connections tab opens that lists the current database connection points.

3. Click Edit > Add.

The Add Connection dialog opens.

4. In the Add Connection dialog, perform the following:

a. From the Protocol menu in the Add Connection dialog, select the communication protocol 
the third-party uses. Refer to Table 73 for a list of options.

b. From the Type menu in the Add Connection dialog, select tcp.

c. Use the Count menu to specify the number of devices you want to establish a connection 
point to.

d. Click Apply to create the new device row(s) in the Servers table and close the Add 
Connection dialog.

5. In the Name field, type a unique identifier for the third-party device. This name is used to 
identify the specific device within the Ultrix database.

6. Click the [...] button in the new row to display the Communications dialog.

7. To manually create a connection point via the TCP protocol:

a. From the Type menu in the Communications dialog, select tcp.

The table in the Communications dialog updates to display the settings for TCP 
communication.

TSL UMD v4.0 TCP:5728
UDP: 4491

TSL UMD v5.0 TCP: 5729
UDP: 4492

Table 10  Supported Protocols — Ethernet Connection

Protocol Default Port
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b. Use the IP Address field to specify the IP Address assigned to the third-party device.

c. Use the Port field to specify the Port Number assigned to the third-party device that the 
Ultrix router will try to connect to.

d. Use the Wrapping field to specify the TSL UMD v5.0 TCP wrapping is enabled or disabled. 
This setting is ignored for other protocol types.

e. Click Apply to save your settings and close the dialog.

8. Edit the Description field to your requirements.

9. In the Enabled column of the new row of the Servers table, select Enabled.

10. Click Apply in the Connections tab to save the new settings.

Defining a Serial Connection
Ultrix may communicate directly with third-party devices using a native serial protocol. A 
USB-to-Serial converter must be used to give the Ultrix a serial communication port. Refer to 
Table 11 for information on the supported protocols.

Only USB-serial devices based on these chip-sets are supported: FTDI Chip, Belkin, Prolific PL 
2303, and Silicon Labs CP210x.

 A serial connection point must be implemented on the Connections tab in the Ultrix database 
before communications can start. The settings may be changed from the protocol defaults to suit 
your requirements.

To set up a serial connection between Ultrix and a third-party device

1. Double-click the Connections node located under the Database node.

The Connections tab opens.

2. Click Edit > Add.

The Add Connections dialog opens.

Table 11  Supported Protocols — Serial Connections

Protocol
Settings

Type Baud Data Bits Parity Stop Bits
GVG Native Series 7000 RS232 or RS422 38400 8 None 1

Probel SW-P-08 RS232 or RS422 38400 8 None 1

TSL UMD v3.1 RS422 or RS485 38400 8 Even 1

TSL UMD v4.0 RS422 or RS485 38400 8 Even 1

TSL UMD v5.0 RS422 or RS485 38400 8 Even 1
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3. In the Add Connections dialog, perform the following:

a. Use the Protocol menu to select the protocol standard.

b. Use the Type menu to select Serial.

c. Use the Count menu to specify the number of new connection entries to make in the 
Servers table.

d. Click Apply to create the new device row(s) in the Servers table.

4. In the Name field, type a unique identifier for the third-party device. This name is used to 
identify the device within the Ultrix database.

5. Click the [...] button in the new row to display the Communication dialog.

6. Use the Port field to specify the Port Number assigned to the third-party device that Ultrix will 
connect to.

7. From the Type menu in the Communication dialog, select RS232 or RS422.

The table in the Communication dialog updates to display the settings for serial 
communication.

8. Use the Type field to specify the serial transmission standard for the third-party device.

9. Use the Baud Rate field to specify the bit rate for the third-party device.

10. Use the Parity field to specify the parity.

11. Click Apply to save your settings and close the Communication dialog.

12. In the new row of the Servers table, select the Enabled box.

13. Click Apply to save your settings.

The Connected field in the Connections tab reports “Connect” when the ability to 
communicate with the serial port is confirmed and enabled. The system does not poll or query 
the serial link to verify the validity of the setup.

Connecting to Other Ultrix Routers
Ultrix may act as a master controller for additional Ultrix routers. A connection is made from the 
controlling (primary) Ultrix to the sub-device (client) router(s). The primary Ultrix contains the full 
database configuration for the entire operation of the routing system.

Setup Overview
1. Set up any Ultrix licensing requirements within each Ultrix router.

2. Set up any UltriScape requirements within each Ultrix router.

3. Enable Remote Controller Mode on the client Ultrix routers.
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4. Create a database within the primary Ultrix to accommodate the inputs/outputs provided by 
the client routers.

5. Create a connection point from the primary Ultrix to any/all clients.

6. Edit the primary database to map logical source and destinations to client inputs/outputs, and 
any UltriScape heads/PiPs.

Setup Notes

Keep the following in mind when establishing a connection point from a primary Ultrix to client 
Ultrix routers:

• Ensure unique device names for each Ultrix router. This allows identification of each individual 
router throughout the setup process. You can edit the name via the Ultrix front panel interface as 
outlined in “Re-naming the Ultrix Router”.

• Client device configuration (licensing, port configuration, etc.) is achieved via its own device node 
within the DashBoard tree.

• Client UltriScape Multiviewers are configured via the UltriScape node within the DashBoard tree 
of the Client that physically hosts that Multiviewer.

• Routing commands are issued to the primary device via remote control panels, external 
protocols or DashBoard soft panels1. Any client Ultrix will ignore routing commands not 
originating from the primary while in this connected mode.

Enabling Remote Controller Mode on the Client Ultrix Routers
Before establishing a connection point between routers, each client Ultrix router must have its 
Remote Controller Mode enabled. This allows the client Ultrix router to be controlled by the primary 
Ultrix router in the routing system.

To enable the Remote Controller Mode on a client Ultrix router

1. In the Tree View, double-click the System Status node for the client Ultrix router.

The System interface displays in the DashBoard window.

2. Select the Database tab.

3. Select the Remote Controller Mode box.

4. Reboot the client Ultrix router to apply the new setting.

Adding an Ultrix Connection Point
Once a connection point is established between the primary Ultrix router and its clients, the 
physical inputs and outputs the clients provide will display in the Port Labels tab of the primary 
database. These input and outputs ports are now ready for renaming (if required) and mapping to 
logical source and destinations. 

 A connection point is created using the primary router’s interface. Do not create a connection 
from a client router to the primary router.

 UltriScape PiP and head destination mapping is required in the primary Ultrix database for each 
UltriScape Head in use. The procedure is the same as the UltriScape configuration for a 
stand-alone Ultrix router. 

1. Only the soft panels defined within the database of the primary Ultrix may control the system.
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To create a connection point between the two Ultrix routers

1. Ensure each Ultrix router is installed, configured, and listed in the Basic Tree View of your 
DashBoard client.

2. Expand the Database node for the primary Ultrix router.

3. Double-click the Connections node located under the Database node.

The Connections tab opens.

4. Click Edit > Add.

The Add Connection dialog opens.

5. In the Add Connection dialog, perform the following:

a. From the Protocol menu in the Add Connection dialog, select ultrix.

b. From the Type menu in the Add Connection dialog, select tcp.

c. Use the Count menu to specify the number of client Ultrix routers you want to connect.

d. Click Apply to create the new device row(s) in the Servers table.

The Add Connection dialog closes.

6. In the Name column of the Servers table, click the cell of the new row to display the drop-down 
menu.

7. From the drop-down menu, select the client Ultrix router you wish to establish a connection to.

8. If the client Ultrix router name is not listed in the drop-down menu:

a. Close the Connections tab.

b. Launch Walkabout to detect the on-line devices in your system.

c. Double-click the Connections node for the master Ultrix router to display the Connections 
tab.

d. Repeat steps 4 to 7.

9. In the Enabled column of the new row, select Enabled.

10. Repeat steps 6 to 9 for each additional client Ultrix router.

11. Click Apply at the bottom of the Connections tab to save the new settings.

Deleting an Ultrix Connection Point
If requirements change, an Ultrix to Ultrix connection point may be deleted from the Servers table. 
Devices listed in the Clients table are automatically deleted when the connection point to Ultrix is 
no longer valid.
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To delete a connection point between Ultrix routers

1. Expand the Database node for the primary Ultrix router.

2. Double-click the Connections node located under the Database node.

The Connections tab opens.

3. In the Servers table, select the row for the Ultrix connection point to be deleted.

4. Click Edit > Delete.

5. Power cycle the client Ultrix router.

 You must power cycle the client router to re-establish its internal database.

6. Re-configure the primary Ultrix and the client Ultrix routers as per the new requirements.
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Database Configuration
Procedures in this chapter assume that you have DashBoard launched and the Ultrix router 
displayed in the Tree View.

 Ultrix does not support Unicode characters.

How a Database Determines the Routing System
The various tables within an Ultrix router determine if a signal/route can be made from input to 
output.

For a given level, if there is a physical port mapped, for the same physical device, in both the Source 
and Destination tabs, and the controlling device has the level enabled, then a crosspoint switch can 
be issued and executed on the router(s). Table 12 outlines a database with four levels. Level 1 has 
mapped valid Sources and Destinations, and the level is enabled on the controlling device. 

Defining a Database for the Router
The Database interface in DashBoard for an Ultrix enables you to create system input and output 
lists, assign those signals to system sources and destinations, define multiple levels and matrices. 
You may wish to use the following process when defining the database for your router.

Configuration Overview
The generalized work flow of configuring a database for the Ultrix router is:

1. Create a database as outlined in “Creating a New Database”.

2. Establish connection points to external devices. This step is only required if external routing 
systems are connected to the Ultrix router. Refer to “Device Communication Setup” for 
details.

3. Verify the available IN/OUT ports to ensure correct system connections. The default port 
naming convention of frame.slot.port.type may be overwritten (if required) at this stage.

4. Create levels as outlined in “Defining the Levels in a Database”.

5. Create destination labels and assign physical ports to the labels as outlined in “Defining the 
Destinations in a Database”.

6. Create source labels and assign physical ports to the labels as outlined in “Defining the 
Sources in a Database”.

Table 12  Example of a Multi-Level Database Setup

Level 1 Level 2 Level 3 Level 4
Is a physical source assigned?  Xa

a. An entry is not present in the corresponding Level column of the Source tab.

 

Is a physical destination assigned?   Xb

b. An entry is not present in the corresponding Level column of the Destinations tab.

X

Is the Level enabled on the Controller device?    X

Can a switch be executed? c

c. A switch will be executed.

Xd

d. A switch will not be executed. Physical ports from the same logical matrix must be entered in the 
same control level before a connection can be made.

Xd Xd
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7. Define a soft panel or establish a connection from a remote control panel (RCP).

Database File Management Overview
Each Ultrix database consists of a collection of configuration files necessary for Ultrix operation. The 
database resides within the Ultrix storage system. Multiple databases may be saved and accessed 
at any time, but only one database can be active at a time. 

Use the System Status > Database tab to create, load, and delete databases. Use the System 
Status > Transfer tab to backup and restore databases.

For More Information on...
• the System Status tabs and menus, refer to “System Status Interface”.

Database management consists of the following tasks:

Creating a New Database

A database manages the configuration file and settings for your Ultrix router. A router may use a 
number of database configurations depending on its role in the routing system. Refer to “Creating 
a New Database” below.

Loading an Existing Database

Use the System Status > Database tab to load a configured database to your Ultrix router. Refer to 
“Loading a Database”.

Exporting a Database

Enables you to capture a database configuration in a *.uda file that is saved to a location on your 
network that you can specify. Refer to “Exporting a Database”.

Importing a Database

Enables you to import a saved *.uda file and make it available in the System Status > Database 
tab. Refer to “Importing a Database” for details.

Deleting an Existing Database

You can choose to permanently delete any configured database on your Ultrix router. Refer to 
“Deleting a Database” for details.

Creating a New Database
When you define a database, the information you enter into the Levels, Sources, and Destinations 
fields will auto-populate the applicable fields in the other interfaces for that Ultrix router. You can 
change the labels for the destinations and sources at any time using the options in the Destinations 
and Sources interfaces. There are two methods for creating a new database: using the Database 
Builder, or using the options in the System Status > Database tab. Both methods are described 
below.

Using the Database Builder
Use the Database Builder to easily create a working database. Once you define the basic 
parameters of the new database using the settings in the Quick Start interface, you can then define 
the levels, destinations, and sources for the new database. This makes it very easy to build basic 
configurations as well as get a system up and running quickly. 
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 Before proceeding, ensure that the required license keys are installed for your router(s). Refer to 
the chapter “Software License Keys” for more information.

To create a new database using the Database Builder

1. Display the Database nodes as outlined in “To access the Database interfaces in DashBoard”.

2. Double-click the Database Builder sub-node.

The Database Builder interface opens in the DashBoard window with the Quick Start page 
displayed.

3. Use the Provide a Name field to type a unique identifier for the database.

4. Select the box(es) from the provided list of detected routers the routers to make the database 
available to. 

5. If you wish to leave the remaining settings at their default values and quickly setup a database, 
you can click Finish and the database will be generated based on selected routers in step 4.

 Click Next, located at the bottom of the DashBoard window, to display the next page of options 
in the Database Builder interface.

6. If any AUX Ports are populated with SFP modules, use the Include AUX ports menu to specify 
how to label the I/O in the database.

 The default is Insert at Slot, which labels the I/O in each slot as 1-18 with the AUX Ports as 17 and 
18.

7. Use the Support Video Signal and Number of Audio Channels menus to define the Levels in 
the database.

8. Use the Breakaway Source Support menus to implement audio shuffling. The options for SDI 
and MADI channels are as follows: 

• None — no audio-only breakaway sources are created.
• Mono — sources are created to enable individual mono audio channel routing.
• Stereo — sources are created for stereo pair audio routing (1-2, 3-4, 5-6 etc.).
• Quad — sources are created for four channel groups or quad-audio routing (1-4, 5-8, 9-12 

etc.).
• Oct — sources are created for eight group audio routing (1-8, 9-16, 17-24 etc.).
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 You must have SFP modules installed that support MADI to implement the MADI routing with 
breakaway support.

9. Use the Disconnect Source menu to create a disconnect source. This enables the routing 
silence to audio channels (muting).

10. Use the Passthrough Source menu to create a pass-through source definition. This enables 
setting an audio source to follow video bypassing the audio processing and other routing.

11. If you have an UltriScape license installed, use the last set of menus to define the heads, 
including the number of Picture in Picture (PIPs) that new layouts can include. 

 You can still create and edit layouts in a database with settings that differ from these.

12. Click Finish to save the new settings and:

a. Use the Levels page to review or rename the level labels if required.

b. Use the Destinations page to review the destination label to physical port mapping. 
Renaming the labels is also possible from this page if required.

c. Use the Sources page to review the source label to physical port mapping. Renaming the 
labels is also possible from this page if required.

 Click the Rename button on a page to define multiple elements. For example, clicking Rename on 
the Sources page enables you to define a prefix (e.g. SRC) and apply from a starting point (input 
4).

13. Click Finish to create the new database and apply it to the router(s) selected in step 4.

Using the Database Tab
You can use the Database tab in the System Status interface when only configuring a database for a 
single router.

For More Information on...
• assigning destinations, refer to “Defining the Destinations in a Database”.
• assigning sources, refer to “Defining the Sources in a Database”.

To create a new database using the options in the Database tab

1. In the Tree View of DashBoard, double-click the System Status node under the Ultrix node.

The System Interfaces display in the DashBoard window.

2. Select the Database tab.

3. Locate the Add Database options in the Database Management area of the tab.

4. In the Add Database Name field, type a unique identifier for the database.

When the database is currently loaded in the system (in use), the Database node displays the 
database name in the tree view under the Ultrix node.

5. Select the Include I/O Maps box to create a database to match the quantity of BNC I/O ports 
available in the current Ultrix router.
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 Each SDI IN/OUT ports will be mapped to the default labels of SRC# and DST# respectively for 
Level 1 only (SDI). The Destinations and Sources fields are ignored, but the Level field is applied.

6. Use the Levels field to specify the total number of levels available in the database for this 
router.

7. Use the Sources field to specify the total number of inputs available in the database for this 
router.

8. Use the Destination field to specify the total number of outputs in the database for this router.

9. Click Database Add to create the new database and save it to the Ultrix memory.

10. Load the database to ensure it is active before proceeding to customize.

Loading a Database
Each active database includes a unique setup saved to the Ultrix file system. You must load a 
database before you can configure the matrices, levels, sources and destinations, and soft panels 
for a particular setup. This also enables you to quickly load a saved (configured) routing setup just 
by recalling a different database. 

To load a saved database

1. In the Tree View, double-click the System Status node.

The System interface displays in the DashBoard window.

2. Select the Database tab.

3. From the Name menu in the Load Database area, select the database you want to load.

4. Click Load.

5. Verify the following to ensure the database was loaded:

• The Name, Levels, Sources, and Destination read-only fields in the Current Database area 
in the Database tab report the correct values.

• The Database node in the Tree View for the Ultrix router reports the correct Database name. 

Defining the Levels in a Database
A level is a term used to describe a section or layer of the routing system (e.g. video level, audio 
level). Ultrix uses level definitions for easy identification and control of various routing matrices or 
parts of the system. The levels defined in the Levels tab have a direct relationship with the Level 
entries in other database configuration tabs. 

Before You Begin
Determining the number of levels needed requires a little planning:

• Ultrix can operate with as little as one level to define control of the SDI switching matrix. Ultrix 
contains the UltriMix audio sub-system which allows independent routing of SDI embedded 



118 • Database Configuration Ultrix User Guide (v23.0)

audio channels as well as MADI channels. Using a single level control, Ultrix can limit the 
independent selection of embedded audio and/or MADI streams. 

• Any Ross NK series routers or other third-party routers attached to the Ultrix system will require 
their own control levels.

 The quantity of levels determines how many independent IN/OUT ports (including embedded / 
MADI channels) may be grouped together as one source or destination selection.

Example 1

A single control level can be used when there is no requirement for independent embedded 
audio/MADI channel switching. For example: 

 If AFV (audio-follow-video) is desired on a single level database, the Audio Bypass must be 
enabled for each IN and OUT port. Alternatively, the UltriMix audio routing sub-system may be 
disabled on a per slot basis. Refer to “Applying Proc Amps to the Embedded Audio Input” and 
“Applying Proc Amps to the Embedded Audio Outputs” respectively.

Example 2

A single Ultrix level setup with NK-A64 analog audio router attached would require the following 
levels: 

Example 3

A setup using SDI with 4 embedded audio levels. This can allow independent switching of 4 of the 
embedded SDI channels and grouping of 4 MADI channels.The following levels would be required:

To define a level in the database

1. Double-click the Levels node located under the Database node.

The Levels tab opens.

2. Verify the ID field to specify the priority of the level.

 The ID field is a row number automatically defined by the routing system. This ID value 
corresponds to level numbers when used in remote control panel (RCP) configurations and 
third-party communications.

3. To re-name a level:

ID Name
1 SDI

ID Name
1 SDI

2 AnAud L

3 An Aud R

ID Name
1 SDI

2 A1

3 A2

4 A3

5 A4
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a. In the Name column, type a unique identifier for the level. It is recommended to use words 
that describe the level such as 3G, Audio, etc.

b. Click Apply to update the name.

4. To select a unique color that will represent the level in the soft panels:

a. In the Color column, click the cell for the level you want to configure to display the Color 
Select dialog.

b. Select the hue from the provided vertical color grid in the Color Select dialog.

c. Use the Saturation options to specify the depth of the color.

d. Use the Lightness options to specify the amount of white or black mixed with the selected 
hue.

e. Confirm that the field beneath the color grid displays the correct color for the level.

f. Apply your changes using one of the following options:

• Click Live to preview the color scheme and apply it but not close the Color Select dialog; 
or

• Click OK to apply the new color to the level and close the Color Select dialog.

5. Use the Description column to enter a brief summary of the level or provide additional 
information about the level use or purpose.

 The Description column is for identification purposes only and not required for operation.

6. Click Apply to save your changes.

To create additional levels

1. Select a row in the Levels tab.

 It is recommended to insert below the last row in the table.

2. Click Edit.

 You can also copy and paste an existing level by clicking Copy, then Paste from the Edit dialog.

3. To add a single level, select Add.

4. To add multiple levels:

a. Select Add Series to display the Fill Cell Values dialog.

b. In the Prefix field, type the phrase. For example, to create levels as AUDIO 1, AUDIO 2, etc., 
you would type AUDIO into the Prefix field.

c. In the Start Value field, type the first number to be used in the series.

d. In the End Value field, type the last number to be used in the series.

e. Click Apply.

To delete an entry from the Levels table

1. Select the row for the destination to delete in the Levels tab.

2. Click Edit > Delete.

Defining the Destinations in a Database
Ultrix uses a database to assign inputs and outputs, as well as define levels and matrices. Table 13 
outlines the available outputs for mapping to the destinations in your database. 
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For More Information on...
• defining a database, refer to “Creating a New Database”.

Specifying a Destination Label
The Destinations tab allows the definition of names (or labels) for your routing system outputs. 
When a database is initialized, default labels of Dest # are automatically filled in to the quantity 
specified by the database. These destination labels may be changed to suit your naming 
conventions.

To specify a label for a destination

1. Double-click the Destinations node located under the Database node.

The Destinations tab opens.

2. Select the cell in the Name column of the label to alter.

Table 13  Mapping Outputs to Database Destinations

Default Slot Label

Physical 
or 

Virtual 
Port?

Description

Slotx.out[y].sdi.ch1 P Digital video output slot x port y

flex.out[y].sdi.ch1 P Digital video output flex slot port y (ULTRIX-FR5 only)

Slotx.out[y].audio.chn P Digital audio channel n of output slot x port y

flex.out[y].audio.chn P Digital audio channel n of flex slot output port y (ULTRIX-FR5 only)

Slotx.head[y].sdi.ch1 V Ultriscape video output slot x head y 

Slotx.heady-pip[z].sdi.ch1 V Video destination for PiP z of slot x Ultriscape Head y

Slotx.heady-pip[z].meter.chn V Audio destination for meter n PiP z of slot x Ultriscape Head y

Slot0.mixer-in[y].audio.ch1 V Audio destination mixer input port y

Slot0.virt-out[y].sdi.ch1 V Acuity AUX BUS output port y
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3. Type the required label.

 Take care to limit the amount of characters as these labels are displayed on Remote Control 
Panels (RCPs) which have a limited display area.

4. Repeat steps 2 to 3 for each destination you want to specify a virtual label for.

5. Click Apply at the bottom of the Destinations tab to save your changes.

Mapping an Output to a Destination
The Destinations tab is organized into a table with each row representing a Destination and each 
column representing a Level. The table cells are the output ports assigned to the Destination for 
that level. Initially, the table cells are empty (e.g. the destination labels are not assigned to physical 
output sockets). These may be populated as described in “To map a physical output to a 
destination”, or, via the Advanced Fill tool.

The Advanced Fill tool is provided to create new destination labels that are automatically assigned 
to physical outputs depending on options set by the user. The audio routing features provided by 
Ultrix can result in an extensive source and destination definition map requiring some time to 
manually enter. The Advanced Fill tool will speed the assignment of physical ports greatly.

Various editing options are available from the editing menus, accessed via the Edit button located 
on the bottom toolbar of the tab. Refer to “Additional Dialogs, Menus, and Toolbars in the 
Database Interfaces” for details on these menus.

  If you are defining the destinations in a database for use with UltriScape, it is recommended to 
first define the destinations using the Advanced Fill tool, then re-name the UltriScape Heads as 
required. Otherwise there may be duplicate assignments of channels in the database.

For More Information on...
• the Advanced Fill tool, refer to “Using the Advanced Fill Tool”.
• assigning Tally IDs to destinations, refer to “Assigning the Tally IDs to the Destinations”.

To map a physical output to a destination

1. Double-click the Destinations node located under the Database node.

2. If desired, type a new name for the destination in the Name cell as outlined in the procedure 
“To specify a label for a destination”.

3. In the table of the Destinations tab, locate the column for the level you wish to include in the 
destination definition.

4. To map a single output, perform one of the following:

• Select the cell of the row in the table to display a list of available outputs; or 
• Choose an output from the available Matrix Outputs list, located to the far right, and click 

Assign.

 Cell ranges may be horizontal as well as vertical. For example, a common operation would be to 
assign SDI embedded channels 1 to 16 to levels 2 to 17. The selected range would be horizontal 
across many levels but the selection would be vertical from the available outputs. The 
assignment operation will take the top-most of the available outputs selection and assign it to the 
left-most of the horizontal selection etc. through the range.

5. To map a range of outputs:

a. Select the first cell in the table column.

b. Press and hold Shift.

c. Select the last cell in the table column. 

d. Select a range in the available Matrix Outputs list with same click, shift-click method.
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e. Click Assign.

6. Click Apply at the bottom of the Destinations tab to apply the changes to the database.

To map a series of outputs to multiple destinations on the same level

1. In the table of the Destinations tab, select the first row in the series you want to define for the 
level.

2. Press and hold Shift.

3. Click the last row in the series to select a range of cells within a Level column.

4. Select a range of outputs as outlined in step 5 of the procedure “To map a physical output to a 
destination”.

5. Click Assign.

6. Click Apply at the bottom of the Destinations tab to apply the changes to the database.

To delete an entry from the Destination table

1. Select the row for the destination to delete in the Destinations tab.

2. Click Edit > Delete.

 Ensure the ID numbers are correctly sequenced when deleting and inserting entries in the 
Destinations table. To re-order the Destinations ID numbers in the database, click Edit > Reset 
All IDs in the Destinations tab.

3. Click Apply.

Configuring the Destination Follow Feature
The Destination Follow feature enables you to route a specific destination’s source signal to another 
destination. For example, set Dest 1 to follow Dest 6 so when Dest 6 is switched to a different 
source, Dest 1 is also switched to that same source. You can set multiple destinations to follow 
another single destination, or each following their own unique destination.

Controlling a destination that has a follow directly will overwrite the current status. Any subsequent 
changes to the followed destination will again update that destination. For example, if Dest 1 
follows Dest6 and a a controller requests a new source to Dest1, that source is routed to Dest1. If a 
controller then requests a new source to Dest6, Dest1 will then also change status to the new 
source.

 Destinations defined as UltriScape Heads or UltriScape PiPs are not enabled for DestFollow 
configuration. A PiP DestFollow is configured via the UltriScape interface.

To configure the Destination Follow feature

1. Double-click the Destination Follow node located under the Database node.

The Destination Follow tab opens.
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2. Locate the row for the destination to configure.

3. Use the Following menu to specify the output that the selected Destination will follow.

In the example below, the user is configuring Dest1 to follow Dest6.

 To delete a DestFollow, use the Following menu to select the required DestFollow and click 
Delete.

Defining the Sources in a Database
Ultrix uses a database to assign inputs, as well as define levels and matrices. Table 13 outlines the 
available inputs for mapping to the sources in your database. 
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Specifying a Label for a Source
The Sources tab allows the definition of labels for your routing system inputs. When a database is 
initialized, default labels of Src # are automatically filled in to the quantity specified by the 
database. These source labels may be changed to suit your naming conventions.

For More Information on...
• assigning Tally IDs to sources, refer to “Assigning the Tally IDs to the Sources”.

To specify a label for a source

1. Double-click the Sources node located under the Database node.

The Sources tab opens.

Table 14  Mapping Inputs to Database Sources

Default Slot Label

Physical 
or 

Virtual 
Port?

Description

Slotx.in[y].sdi.ch1 P Digital video input slot x port y 

flex.in[y].sdi.ch1 P Digital video output flex slot port y (ULTRIX-FR5 only)

Slotx.in[y].audio.chn P Digital audio channel n of input slot x port y 

flex.in[y].audio.chn P Digital audio channel n of flex slot input port y (ULTRIX-FR5 only)

Slot0.disconnect[1].sdi.ch1 V A ‘no signal/disconnected’ video source 

Slot0.disconnect[1].audio.ch1 V A ‘no signal/disconnected’ audio source 

Slot0.passthrough[1].audio.ch1 V Audio on this channel will follow video regardless of audio matrix 

Slot0.layout:name[n].mv.ch1 V Ultriscape Head layout file name id n – route a layout to a head 
to change Ultriscape layouts 

Slot0.mixer-out[y].audio.ch1 V Audio source for mixer output port y

Slot0.mixerd-out[y].audio.ch1 V Audio source for mixer channel strip direct output port y

Slot0.virt-in[y].sdi.ch1 V Acuity AUX BUS Input port y
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2. Select the cell in the Name column of the label to alter.

3. Type the required label.

4. Press Enter to apply the change.

 Take care to limit the amount of characters as these labels are displayed on Remote Control 
Panels (RCPs) which have a limited display area.

5. Repeat steps 2 to 4 for each source you want to specify a virtual label for.

6. Click Apply at the bottom of the Sources tab to save your changes.

Mapping an Input to a Source
The Sources tab allows the mapping of physical and virtual input ports to your routing system 
inputs. The tab is organized into a table with each row representing a Source and each column 
representing a Level. At the top of the column is the name of the Level. The table cells are the input 
ports assigned to the source for that level.

An Advanced Fill tool is provided to create new source labels that are automatically assigned to 
inputs depending on options set by the user. The audio routing features provided by Ultrix can 
result in an extensive source and destination definition map requiring some time to manually enter. 
The Advanced Fill tool will speed the assignment of ports greatly.

Various editing options are available from the editing menus, accessed via the Edit button located 
on the bottom toolbar of the tab. Refer to “Additional Dialogs, Menus, and Toolbars in the 
Database Interfaces” for details on these menus.

To map an input to a source

1. Double-click the Sources node located under the Database node.

2. If desired, type a new name for the source in the Name cell as outlined in “To specify a label 
for a source”.

3. In the table of the Sources tab, locate the column for the level you wish to include in the source 
definition.

4. To map a single input, perform one of the following:

• Select the cell of the row in the table to display a list of available input sockets.
• Choose an input from the available Matrix Inputs list and click Assign.

 Cell ranges may be horizontal as well as vertical. For example, a common operation would be to 
assign SDI embedded channels 1 to 16 to levels 2 to 17. The selected range would be horizontal 
across many levels but the selection would be vertical from the available inputs. The assignment 
operation will take the top most of the available inputs selection and assign it to the left most of 
the horizontal selection and so on through the selection range.

5. To map a range of inputs:

a. Select the first cell in the table column.

b. Press Shift.

c. Select the last cell in the table column. 

d. Select a range in the available Matrix Inputs list. 

e. Click Assign.

6. Click Apply at the bottom of the Sources tab to apply the changes to the database.
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To map a series of inputs to multiple sources on the same level

1. In the table of the Sources tab, select the first row in the series you want to define for the level.

2. Press and hold Shift.

3. Click the last row in the series to select a range of cells within a Level column.

4. Select a range of inputs as outlined in step 5 of “To map an input to a source”.

5. Click Assign.

6. Click Apply at the bottom of the Sources tab to apply the changes to the database.

To delete an entry from the Sources table

1. Select the row for the destination to delete in the Sources tab.

2. Click Edit > Delete.

3. Click Apply at the bottom of the Sources tab to apply the changes to the database.

Using the Advanced Fill Tool
The Advanced Fill operation is typically a tool used to initially set up an Ultrix database. Edits and 
customization may then be performed after the Advanced Fill tool has done the bulk of the work.

The following examples are shown on a new database with only database default settings loaded.

 Take care when determining label names. While a long name may be nice and descriptive for the 
Source and Destination tabs, many control devices have limited screen space and labels may be 
truncated.

For More Information on...
• the settings and menus available in the Advanced Fill tool, refer to “Advanced Fill Tool”.

Create Source Labels with Assignments for SDI Video Levels
The objective of this example is to insert new labels and assignments for inputs for the entire Ultrix 
router on SDI Levels only.

To create source labels with assignments for SDI video levels

1. Define the levels as outlined in the section “Defining the Levels in a Database”.

2. Select an entry point in the Sources tab from where the new labels and assignments will begin.

a. Double-click the Sources node located under the Database node.

b. Select the cell of the row for the entry point. The new entries will be inserted below this row.

c. Click Edit > Fill to open the Breakaway Fill dialog.
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3. If required, select Fill > Entire Device.

4. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the 
prefix and the numerical counter.

5. From the AUX Port menu, define the AUX ports. Refer to Table 103 for a list of options.

6. From the Slot menu, select the first slot in the Ultrix router. (e.g. Ultrix.slot1)

7. From the Port menu, select the first IN port of the first slot. (e.g. Ultrix.slot1.in[1])

8. From the Starting Channel menu, select the first channel of the selected port. (e.g. 
Ultrix.slot1.in[1].sdi.ch1)

9. In the Levels table of the dialog, select the fully qualified input name from the I/O Assignment 
column.

10. Click Apply.

The dialog closes, and the Source tab updates with the newly created and insert labels with 
assignments.

Create Destination Labels with Assignments for SDI Video Levels
The objective of this example is to insert new labels and assignments for Ultrix outputs for the SDI 
only level.

To create destination labels with assignments for SDI video levels

1. Define the levels as outlined in the section “Defining the Levels in a Database”.

2. Select an entry point in the Destinations tab from where the new labels and assignments will 
begin.

a. Double-click the Destinations node located under the Database node.

The Destinations tab opens. 

b. Select the cell of the row for the entry point. The new entries will be inserted below this row.

c. Click Edit > Fill.

The Fill dialog opens.
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3. If required, select Fill > Entire Device.

4. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the 
prefix and the numerical counter.

5. From the AUX Port menu, define the AUX ports. Refer to Table 103 for a list of options.

6. From the Slot menu, select the first slot in the Ultrix router. (e.g. Ultrix.slot1)

7. From the Port menu, select the first OUT port of the first slot. (e.g. Ultrix.slot1.out[1])

8. From the Starting Channel menu, select the first channel of the selected port. (e.g. 
Ultrix.slot1.out[1].sdi.ch1)

9. In the Levels table of the dialog, select the fully qualified Output assignment name from the I/O 
Assignment column.

10. Click Apply.

The dialog closes, and the Source tab updates with the newly created and insert labels with 
assignments.

Create Source Labels with Assignments for SDI and Embedded Audio
The objective of this example is to create source labels and assignments for the SDI video and the 
first four embedded audio channels for an entire Ultrix enabled slot. The remaining twelve audio 
channels are not used.

To create source labels with assignments for the SDI video and embedded audio levels

1. Ensure that you have the UltriMix licensed feature enabled for the slot. Refer to “Installing a 
License Key” for details.

2. Define one level for SDI Video and 16 levels for the embedded audio. Refer to “Defining the 
Levels in a Database”.

3. Select an entry point in the Sources tab from where the new labels and assignments will begin.
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a. Double-click the Sources node located under the Database node.

The Sources tab opens. 

b. Select the cell of the row for the entry point. The new entries will be inserted below this row.

c. Click Edit > Fill.

The Breakaway Fill dialog opens.

4. If required, select Fill > Entire Slot.

5. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the 
prefix and the numerical counter.

6. From the AUX Port menu, define the AUX ports. Refer to Table 103 for a list of options.

7. From the Slot menu, select the UltriMix enabled slot in the Ultrix router. (e.g. Ultrix.slot1)

8. From the Port menu, select the first port of the UltriMix enabled slot. (e.g. Ultrix.slot1.out[1])

9. From the Starting Channel menu, select the first channel of the selected port. (e.g. 
Ultrix.slot1.in[1].sdi.ch1)

10. In the Levels table of the dialog, select a range of Level rows by clicking the first row level 
name, then holding the Shift button, click the last row level name. 

 Ensure to select the SDI Video level and the first four embedded audio levels.

11. Click Assign to automatically fill the I/O Assignment column for the selected levels.

The Breakaway Fill dialog updates but does not close.

To set the unused audio channels to disconnect

1. From the Slot menu in the Breakaway Fill dialog, select Ultrix.slot0.

2. From the Port menu, select Ultrix.slot0.

3. From the Starting Channel menu, select Ultrix.slot0.disconnect[1].audio.ch1.

4. In the Levels table of the dialog, select the remaining twelve audio levels (e.g. A5-A16) from the 
I/O Assignment column.

5. Select Ultrix.slot0.disconnect[1].audio.ch1 from the I/O Assignment cell for the first selected 
row (e.g. A5).

The disconnect[1].audio will be applied to all the selected rows1.

1. Pass through may also be selected. Pass through has the effect of passing through any audio (silence or otherwise) 
on the channels A5 to A16. Disconnect effectively mutes those channels on the output stream.
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6. Click Apply.

The dialog closes.

7. Click Apply in the Sources tab.

 The Sources tab updates with the newly created and insert labels with assignments.

Creating Labels with Assignments for SDI and Embedded Audio, with Audio 
Breakaways
The objective of this example is to create and insert a series of source labels with assignments for 
SDI video and embedded audio. Also, audio breakaway sources will be required to implement audio 
shuffling.

To enable the ability to shuffle audio (that is to take an audio channel and route into another 
stream in a different position within that stream), we need to define that audio channel as a source 
and assign it across all required levels. For example, we may wish to take channel 3 audio from an 
input SDI stream, and route (just that individual channel) to channel 2 of an output SDI stream. To 
facilitate this, the following definitions are needed; 

 If only four audio levels are defined as shown in Table 15, and assuming no other level 
definitions, the user can only route SDI 1 ch3 to any of the corresponding levels in the 
destination, i.e. cannot route SDI 1 ch3 to a destination stream channel 8 as Out[1].audio.ch8 is 
not defined in any of the destination levels.

To enact the previous example, the user selects the destination channel by selecting the 
appropriate level button on the control panel (in this case, the A2 level) before actuating the 

Table 15  Example 1

SDI Level Level A1 Level A2 Level A3 Level A4
Source Name

SDI 1 ch3 <blank> In[1].audio.ch3 In[1].audio.ch3 In[1].audio.ch3 In[1].audio.ch3

Destination Name

SDI out1 Out[1].sdi.ch1 Out[1].audio.ch1 Out[1].audio.ch2 Out[1].audio.ch3 Out[1].audio.ch4
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crosspoint switch (destination button SDI out1, then, source button SDI 1 ch1). The Advanced Fill 
tool can automate the creation of these audio breakaway sources saving a great deal of setup time.

To create source labels with assignments for SDI and embedded audio, with audio 
breakaways

1. Define one level for SDI Video and 16 levels for the embedded audio as outlined in the section 
“Defining the Levels in a Database”.

2. Select an entry point in the Sources tab from where the new labels and assignments will begin.

a. Double-click the Sources node located under the Database node.

The Sources tab opens. 

b. Select the cell of the row for the entry point. The new entries will be inserted below this row.

c. Click Edit > Fill.

The Breakaway Fill dialog opens.

3. If required, select Fill > Entire Slot.

4. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the 
prefix and the numerical counter.

5. From the Slot menu, select the UltriMix enabled slot in the Ultrix router. (e.g. Ultrix.slot1)

6. From the AUX Port menu, define the AUX ports. Refer to Table 103 for a list of options.

7. From the Port menu, select the first port of the UltriMix enabled slot. (e.g. Ultrix.slot1.out[1])

8. From the Starting Channel menu, select the first channel in the series.

9. In the Levels table of the dialog, assign physical ports to the levels. 

10. Select the BRK I/O box for the Levels assignment to be broken out to a separate 
label/assignment definition.

11. Select the BRK Level box for each level to be included in that label/assignment definition.

12. Click Apply.

The dialog closes.

13. Click Apply in the Sources tab.

The Sources tab updates with the newly created and insert labels with assignments, and the 
audio breakaways definitions.
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 Notice the chx automatic suffix to the label. This may be overridden by placing text in the BRK 
Suffix cell of the Breakaway Fill dialog.

Creating Categories
You can assign each destination, source, and level to a specific category in the router database. 
Defining multiple categories enable you to filter the sources, destinations, and level and organize 
them into logical groups. Each database provides up to six categories that you can define.

For More Information on...
• managing the categories for your Ultrix router, refer to the chapter “Using Categories”.

Acuity AUX Bus Mapping
When setting up the Ultrix router to support an Acuity switcher, you must also map the switcher 
aux buses to router sources and destinations so that video can be assigned to them. Aux bus 
routing is done virtually within the router. When a source is selected on an aux bus in the switcher, 
the switcher tells the router to connect a video source to an aux bus destination. The video does not 
pass through the switcher, only the router. An aux bus source must be assigned to a router 
destination for that video stream to be available on an output. Refer to the switcher documentation 
for details on setting up an Ultrix with an Acuity switcher.

For More Information on...
• setting up an Ultrix with an Acuity switcher, refer to the switcher documentation.

Managing your Databases
A database can be archived by saving it as a *.uda file to a specified location. This enables you to 
import and export an archived database which is useful for:

• creating a safe, off-frame copy of a default database configuration for that router
• importing a copy of a reference database that can be tailored to a specific application for that 

router
• restoring a known backup copy of a database to a specific router 

 This feature requires DashBoard v8.2 or higher and Ultrix software v2.0 or higher.
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Overview
The following information is captured when you archive a database:

• Definitions of levels, sources, and destinations
• Salvos
• Category assignments
• Soft panels
• User assigned port labels
• Current crosspoint status

 The following information is not captured: hardware specifics, and license settings.

Exporting a Database
You create an archive of a database (as a *.uda file) using the options in the System Status > 
Transfer tab.

 You cannot export a database if SSH is disabled.

To export a database to the archive

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Transfer tab.

3. Select the Ultricore Database sub-tab.

4. Locate the Export area on the tab.

5. Use the Database field to specify the database to export.

6. Click Browse... to specify the location to save the *.uda file to.

The Archive read-only field updates with the selected path and database name.

7. Click Apply.

The Downloading Archive dialog opens to report the status of the export.

Importing a Database
Once a database is imported from the archive to your system, you can select it from the list of 
databases to load via the System Status > Database tab.

 The database is not automatically loaded. Refer to “Loading a Database” to load a database.

To import a database to an Ultrix router

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Transfer tab.

3. Select the Ultricore Database sub-tab.

4. Locate the Import area.

5. Select the *.uda file you wish to import as follows:

a. Click Browse... to display the Open dialog.

b. Use the Open dialog to specify the *.uda file to import.

c. Click Open to close the dialog and load the file.
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6. Click Apply.

The Uploading Archive dialog opens to report the status of the transfer.

7. Verify that the imported database is now available for selection in the System Status > 
Database tab.

Deleting a Database
 You cannot delete the active database.

To delete a database

1. In the Tree View, double-click the System Status node.

2. Select the Database tab.

3. From the Delete Database Name menu, select the database you want to delete.

4. Click Database Delete.
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ULTRIMIX-MXR
The ULTRIMIX-MXR licensed feature is a virtual audio mixer that can be configured up to 128×64. It 
can be partitioned into smaller mixers so you can have multiple instances within the frame. 

The ULTRIMIX-MXR has access to every input in the system, and its outputs can be routed to any 
output in the frame, providing tremendous flexibility for audio work-flows. Each input has a 4-band 
parametric equalizer, noise gate and compressor/limiter. In addition, ULTRIMIX-MXR has 128 direct 
outputs for simple audio processing as part of its standard feature set. It is controllable via a 
DashBoard user interface as well as application-specific panels for both the Ultritouch-2 and 
Ultritouch-4 control panels.

Key Features
• Licensed in 32×16 blocks
• Multiple licenses can be purchased to build a maximum size of 128×64
• 4 Band Parametric EQ per input
• Noise Gate per input
• Compression/Limiter per input
• DashBoard control
• Ultritouch-2 and Ultritouch-4 panel support

Flexible Mapping
Any Ultrix audio input (embedded SDI, MADI, or IP based) may be routed to any mixer input, and 
any mixer output may be routed to any audio output channel. You may route any audio signal 
within Ultrix via any mixer input. Also, the mixer outputs may be routed to any Ultrix audio 
destination, including back into the mixer.

Each ULTRIMIX-MXR license provides an I/O (Input/Output) block of 32 inputs by 16 outputs. A 
maximum of 4 licenses provides an I/O block of 128 inputs by 64 outputs.The ULTRIMIX-MXR may 
be partitioned into smaller blocks to provide multiple small audio mixers. 

Figure 21 is an example of one audio mixer (one license) with 64 stereo inputs (128 channels) and 
32 stereo outputs (64 channels). Figure 22 is an example of partitioning to obtain two smaller 
independent ULTRIMIX-MXR I/O blocks. Each partition is stereo 32x16.

Figure 21  One Audio Mixer — 64x32 Figure 22  Two Audio Mixers — Each 32x16
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Soft Panels
An Audio Mixer soft panel type allows for real-time adjustment of audio levels and audio 
processing, and provides a familiar interface similar to other audio consoles. Each channel strip is a 
stereo pair (i.e. two audio channels). Similarly, each output bus is a stereo pair.

By default, the Home View of an audio mixer soft panel is similar to Ross RAVE. The window is 
divided into channel strips and includes the features you enabled during the soft panel 
configuration. You also have the option to add drawers to the left and/or right margins of the soft 
panel window (like an Ultritouch soft panel). 

When the router is under Ultricore BCS control, the soft panel provides audio mixing capability 
only (and not crosspoint switching as the Sources are automatically set to None). To perform 
crosspoint switching, you must first load the audio mixer soft panel onto the Ultricore BCS panel 
and then select the sources via that Ultricore BCS panel.

For More Information on...
• audio mixer soft panels, refer to “Creating Audio Mixer Soft Panels”.

Figure 23  Example of an Audio Mixer (Desktop) Soft Panel

Setup Overview
This chapter summarizes how to set up an audio mixer soft panel. This requires you to:

1. Install a ULTRIMIX-MXR license(s) for each audio mixer partition you require. You can install up 
to 4 licenses in a single router. 

2. Specify the audio mixer I/O partitions.

3. Create sources and destinations with audio mixer I/O mappings.

4. Configure an audio mixer soft panel.

5. Load the audio mixer soft panel to your desktop or an Ultritouch panel.

The following sections outline each step.

Installing the License Key for an Audio Mixer
Install the ULTRIMIX-MXR software license for the Ultrix router as outlined in the chapter “Software 
License Keys”.
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Configure the Audio Mixer I/O Partitions
Each ULTRIMIX-MXR license provides a block of audio mixer Inputs and Outputs (I/O). The block size 
is determined by how many ULTRIMIX-MXR licenses are enabled. This I/O block may be partitioned 
to create smaller independent mixers.   

For example, an Ultrix with all four ULTRIMIX-MXR licenses enabled will yield a single audio mixer 
with an I/O matrix of 64 stereo inputs × 32 stereo outputs. The Device Configuration interface in 
DashBoard enables you to create the following matrices based on how you want to partition the 
inputs and outputs:

• 1 Mixer where the mixer is a 64×32 (stereo)
• 2 Mixers where each mixer is a 32×16 (stereo)
• 4 Mixers where each mixer is a 16×8 (stereo)
• 8 Mixers where each mixer is a 8×4 (stereo)

 It is strongly recommended to configure your audio mixer partitions at the same time as 
configuring the other ports for your router. Changes to mixer partition is a major operation due 
to existing mixer I/O maps in sources and destinations are no longer valid, and mixer partition 
assigned to a mixer panel may no longer available.

Master and Monitor Outputs
Each partition has two defined outputs named Master and Monitor. The physical outputs the 
Master and Monitor buses are assigned to is user configurable. By default, Master is assigned to the 
first output bus and Monitor is assigned to the last output bus of the partition.

For example, an Ultrix with one ULTRIMIX-MXR license allows a single block of 32×16 audio mixer 
I/O. This equates to a possible mixer with 16 stereo inputs and 8 stereo outputs, or buses. By 
default, a single partition on this I/O block will set the Master bus to mixer I/O OUT 1 and the 
Monitor bus to OUT 8.

With Master set to bus OUT 1 and Monitor set to bus OUT 8, this leaves the remaining 6 outputs as 
Auxiliary (AUX) buses. 

Figure 24  Master and Monitor Outputs within a Partition

The Master and Monitor buses operate in conjunction as follows;

• The Monitor bus follows the Master unless a channel strip has SOLO activated.
• When no channel strip SOLO is activated, the Monitor bus has the same audio mix as the Master 

bus.
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• When a channel strip SOLO is activated, the Monitor bus mutes other channels except for those 
in SOLO mode. The SOLO button is highlighted (this applies whether the active bus is Master or 
an AUX).

• Any Master channel strip with SOLO activated does NOT affect the Master bus.
• Multiple channel strip SOLOs are allowed, and they all appear in the Monitor simultaneously.
• Selecting the SOLO Clear button will clear all currently active SOLO channel strips.

The SOLO mode on an auxiliary bus operates differently as there is no specific monitoring bus 
output for the Auxiliary buses.

• Any channel strip with SOLO activated will MUTE the other channels on that AUX bus.
• When an AUX strip SOLO is activated, the Monitor bus has the same audio mix as an AUX bus 

with SOLO activated.

Configure the Audio Mixer Partitions
The number of default partitions is determined by the license key you installed.

To configure an audio mixer partition

1. Locate the Ultrix in the Tree View of DashBoard.

2. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

3. Expand the Devices node.

4. Expand the Controllers + Matrices node.

5. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

6. Select .

The Frame Configuration page opens.

7. Select the Audio Mixer tab.

8. Click Audio Mixer Partitions.

9. Use the Mixer Partition menu to specify the number and types of audio partitions you require.

In the example below, the user has four licenses installed but selected the option for 2 stereo 
partitions.

10. Click Apply.
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Mapping the Sources and Destinations for the Audio Mixer
An Audio Mixer Fill Tool is provided in the Destination and Source interfaces to help quickly map the 
audio mixer I/O. The Audio Mixer Fill tool enables you to specify:

• one or more partitions to create destinations/sources based on the I/O available in those 
selected partition(s).

• the starting audio level for the I/O mapping for each destinations/sources.
• how many audio levels for each destinations/sources.
• a prefix for each destinations/sources and a starting number (if there are more than one 

destination).

Before You Begin
When mapping your audio mixer I/O:

• Mixer Inputs (channel strips) are mapped to Router Destinations 
• Mixer Outputs (output strips) are mapped to Router Sources 

Figure 25  Block Diagram of Mapping Audio Mixer I/O to Router Destinations and Sources

Mapping the Router Destinations to the Audio Mixer Inputs
The Audio Mixer Fill Tool prevents a user from mapping I/Os from two different mixers into one 
logical matrix since each source/destination can have I/O mappings from only one mixer partition.

By default, the Audio Mixer Fill Tool assigns consecutive mixer inputs across the table starting at the 
defined Starting Level and continuing each level column for the channels per Destination quantity. 
Note the chosen Channels per destination setting will impact the total number of logical labels 
created. For example, when creating mixer input logical label for a 64×32 mixer, a setting of Quad 
will result in 32 logical destinations (mixer inputs) created or 32 destinations × 4 levels (Quad) with 
128 mixer inputs (64 stereos channel strips).

When mapping stereo pairs, each channel strip in the soft panel Home View represents a stereo 
pair with the first strip automatically assigned to the first pair of the selected partition. For 
example, slot0.mixer-in[1] and slot.mixer-in[2] is mapped to Channel strip 1, and slot0.mixer-in[3] 
and slot.mixer-in[4] is mapped to channel strip 2 etc. This is also true for the mixer outputs. 

To map the destinations to the audio mixer

1. Display the Database nodes as outlined in “To access the Database interfaces in DashBoard”.

2. Double-click the Destinations sub-node.
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3. Select an entry point in the Destinations tab from where the new audio mixer assignments will 
begin.

4. Click Edit > Audio Mixer Fill.

The Fill Audio Mixer dialog opens.

5. Select the Include box for each audio mixer partition you want to add router destinations for.

6. Use the Starting Level field to specify the starting audio level for the I/O mapping for each 
destination.

7. Use the Channels per Destination menu and field to specify how many audio levels for each 
destination. 

 If you selected Custom, use the provided field to specify the number of audio levels for each 
destination.

8. When mapping multiple destinations, specify a prefix for each destinations and a starting 
number as follows:

a. Select Insert New Destinations.

b. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the 
prefix and the numerical counter.

c. Use the Starting menu to select the cell of the row for the entry point. The new entries will 
be inserted below this row.

9. Click Apply.

The dialog closes and the Destinations tab updates with the newly created and insert labels 
with assignments.
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Mapping the Router Sources to the Audio Mixer Outputs
When mapping sources, ensure to use the same mixer partition(s) that was selected in step 5 of 

“To map the destinations to the audio mixer”.

To map the inputs for an audio matrix

1. Display the Database nodes as outlined in the procedure “To access the Database interfaces 
in DashBoard”.

2. Double-click the Sources sub-node.

3. Select an entry point in the Sources tab from where the new audio mixer assignments will 
begin.

4. Click Edit > Audio Mixer Fill.

The Fill Audio Mixer dialog opens.

5. Select the Include box for each audio matrix you want to add router source to.

6. Use the Starting Level field to specify the starting audio level for the I/O mapping for each 
source.

7. Use the Channels per Source menu and field to specify how many audio levels for each source. 

 If you selected Custom, use the provided field to specify the number of audio levels for each 
source.

8. When mapping multiple sources, specify a prefix for each source and a starting number as 
follows:

a. Select Insert New Source.

b. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the 
prefix and the numerical counter.

c. Use the Starting menu to select the cell of the row for the entry point. The new entries will 
be inserted below this row.

9. Click Apply.

The dialog closes and the Sources tab updates with the newly created and insert labels with 
assignments.
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Creating Audio Mixer Soft Panels
Much like other types of soft panels, when you create a new audio mixer soft panel, you select from 
an existing soft panel type (templates). You then assign a Panel Name and ID to display in the tree 
view using the nomenclature “Panel Name [#]” where [#] is the Panel ID.

 If you prefer to manually perform crosspoint switching on the panel, you also have the option to 
add router destinations and sources to the audio mixer soft panel.

To create a new audio mixer soft panel

1. Double-click the Panels node located under the Database node.

The Panels tab opens.

2. Click Edit > Add.

The Add Panel dialog opens.

3. Type a unique identifier in the Name field. This will be used to identify the panel in the tree 
under the Soft Panels node.

4. Use the Style menu to specify the type of audio mixer panel to create. Choose from the 
following:

• Audio Mixer — Creates a soft panel suitable for a desktop monitor where multiple rows of 
channel strips are possible.

• Audio Mixer 4RU — Creates a soft panel formatted for an Ultritouch-4 panel.
• Audio Mixer 2RU — Creates a soft panel formatted for an Ultritouch-2 panel.

5. Click Apply to save your settings and close the Add Panel dialog.

The new panel name is added to the Saved Panels list and automatically selected for editing.

6. Use the Panel ID menu to determine the position of the panel in the Soft Panels tree where a 
value of “1” is the highest priority (and listed at the top).
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 Ensure that the new soft panel does not use the same Panel ID as a previously saved soft panel.

7. Use the Description field to provide a textual summary of the panel. 

8. Click Apply (located at the bottom of the Panels tab).

Adding Operation Features to the Soft Panel
You can customize the soft panel to include, or not, specific operational buttons used when 
switching crosspoints.

To set the operation modes for your audio mixer soft panel

1. Select the Info tab.

2. Set the Take Operation to Direct.

The audio mixer soft panel does not display a Take button. A crosspoint switch occurs 
automatically after each destination/source selection is made by the user on the soft panel.

3. Click Apply.

4. If required, add router (video) levels, destinations, and sources to your audio mixer soft panel 
according to the following sections.

Levels

For consistent crosspoint status reporting, the levels for an audio mixer soft panel should be 
assigned database audio levels only. (Figure 26)

Figure 26  Example of Router Levels for an Audio Mixer Soft Panel

Destinations

Audio mixer soft panels can be enabled to route the mixer outputs to Ultrix router destinations. The 
destinations located in the assigned list are available for selection to route mixer outputs to Ultrix 
destinations in the soft panel. In Figure 27, only Ultrix router destinations DST1 - DST9 will be 
available for this soft panel.

Figure 27  Example of Router Destinations for an Audio Mixer Soft Panel



144 • ULTRIMIX-MXR Ultrix User Guide (v23.0)

If destinations are assigned to an audio mixer soft panel, you must assign a mixer destination 
drawer window. If no destinations are assigned, the audio mixer soft panel cannot route mixer 
outputs to Ultrix destinations. Another panel must perform this function.

Sources

Audio mixer soft panels can be enabled to route the Ultrix sources to mixer inputs. The sources 
placed in the assigned list are available for selection to route mixer Ultrix sources to mixer inputs in 
the soft panel. In Figure 28, only Ultrix router sources SRC1 - SRC10 will be available for this soft 
panel to choose mixer inputs

Figure 28  Example of Router Sources for an Audio Mixer Soft Panel

If sources are assigned to an audio mixer soft panel, you must assign a mixer sources drawer 
window.

If no sources are assigned, the audio mixer soft panel cannot route Ultrix sources to mixer inputs. 
Another panel must perform this function.

Audio Mixer Partitions

Select one or more audio mixer partition that this soft panel has access to. The mixer source and 
mixer destination lists provide information of the selected partition inputs and outputs as per the 
database definitions. (Figure 29)

Figure 29  Example of Partitions for an Audio Mixer Soft Panel

Assign an Audio Matrix to the Soft Panel
To assign an audio matrix to the soft panel

1. Select the Mixer tab.

2. From the Mixer Selection list, select the audio matrix you want to assign to the soft panel.

The Mixer Source and Mixer Destination lists update to display the available 
sources/destinations that have mixer I/O maps.
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 The Mixer Source and Mixer Destination lists are read-only.

3. Click Apply to save your new soft panel.

Customizing the Soft Panel Layout
When creating an audio mixer soft panel, you also have the option to customize the different areas 
(windows) of the panel, and determine the width of each window, drawer, and their elements. A 
Home Page can be a collection of windows as defined during the soft panel configuration using the 
options in the Panels > Home View tab.

Table 16 summarizes the options for the types of windows you can assign to the Home Page of an 
audio mixer panel.

Defining the Home Window Elements of a Soft Panel
The options for defining the Home Windows of a soft panel are arranged in a table format of the 
Home View tab. You can chose to use the default settings, or customize the width and number of 
rows/columns in each window independently.

 The order of the rows in the Home Windows table determine the order of the windows that 
display on the soft panel. For example, if the first row is assigned to Sources, the first window 
next to the main toolbar of the soft panel will display the Sources buttons.

To customize the layout of your audio mixer soft panel

1. To re-size the scroll bars on your soft panel:

a. Select the Info tab.

b. Use the Vertical Scrollbar Width field to determine the size of the bar that enables the user 
to scroll along the vertical axis of the soft panel.

c. Use the Horizontal Scrollbar Height field to determine the size of the bar that enables the 
user to scroll along the horizontal axis of the soft panel. 

d. Click Apply.

2. Select the Home View tab.

Table 16  Home Page — Types of Windows

Window Type Description
Channel Strip Displays the controls for the inputs of the selected audio mixer

Output Strip Displays the controls for the outputs of the selected audio mixer

Mixer Destination Displays the audio mixer destination selection buttons

Monitor Displays read-only status information of the selected audio 
mixer

Sources Displays the router source selection buttons 
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3. Use the Display Icons menu to specify whether buttons will display the default icons based on 
window type (Enable) or will only display the label text as determined by the database 
(Disable).

4. To add a window to the Home View:

a. Select a row in the Home Windows table.

b. Use the Up, Down, Top, Bottom, Sort buttons (located in the toolbar to the right of the 
table) to move a highlighted row to the desired position.

c. Click Add.

The Add Window dialog opens.

d. Use the Window menu to specify the first window to include in the soft panel. Choose from 
the following:

 You cannot have multiples of the same window in either Home windows or Drawer windows.

e. Click Apply.

The Add Window dialog closes and the Home Windows table updates to include the 
selection.

5. Repeat step 4 for each window you want to include in the soft panel.

6. Specify the order that the windows will display in the completed soft panel layout as follows:

 By default, the windows are organized in the following order (left to right): Channel Strip, and 
Output Strip.

a. In the Home Windows table, select the row for the window you want to move to on the soft 
panel layout.

b. Use the buttons in the toolbar to move the row to the desired position.

7. Adjust a window size as follows:

• Use the Percent field to specify the size of the window as a percentage of the total soft panel 
area.

• Use the Rows field to specify the number of button rows the window will display.
• Use the Columns field to specify the number of button columns the window will display

8. Click Apply to save your changes.
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Defining the Drawers on a Soft Panel
Soft panels to control an audio mixer can also include fly-out menus (drawers) that operate like 
horizontal drop-down menus. You can specify what menus, functions, and settings each drawer 
includes.

 By default the Drawer window is populated with a right-side Mixer Output window, a left-side 
Mixer Selection window, and a right-side Mixer Filters window. When multiple windows are 
assigned to either left or right drawers, the user must first select the drawer handle, then the 
window that is required.

Table 17 summarizes the options for the types of windows you can assign to the drawers of an 
audio mixer panel.

Table 18 summarizes the default sizes for the types of drawers for each type of audio mixer panel.

Table 17  Drawers — Types of Windows

Window Type Description
Mixer Outputs Displays the available audio mixer outputs. Select to switch the 

mixer panel current output bus.

Mixer Partition Displays the audio matrix (partition) selection buttons.

Audio Filters Displays the audio filter page for the currently selected channel 
strip.

Channel Balance Displays the audio channel balance slider.

Mixer 
Destinations

Displays the router destination selection buttons in the specified 
drawer. Select to route the current mixer output to one or more 
Ultrix destinations.

Sources Displays the router source selection buttons in the specified 
drawer. Select to route an Ultrix source to the current mixer 
channel.

Table 18  Drawer Windows — Default Settings

Window Type Default Percent
Audio Mixer Desktop

Mixer Output 30

Mixer Selection 30

Mixer Filters 50

Audio Mixer 4RU

Mixer Output 30

Mixer Selection 30

Mixer Filters 100

Audio Mixer 2RU

Mixer Output 30

Mixer Selection 30

Mixer Filters 100
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To define the drawer elements of the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Home View tab.

3. Locate the Drawer Windows area of the tab.

4. Select a row in the Drawer Windows table.

 The order of the rows in the Drawer Windows table determine the order of the windows that 
display on the soft panel. For example, if the first row is assigned to Sources, the first window 
next to the main toolbar of the soft panel will display the Sources buttons.

5. Click Add.

The Add Drawer dialog opens.

6. Use the Type menu to specify the location of the drawer, in relation to the window it will be 
assigned to.

For example, if you select Type > Left and Window > Sources, the drawer will display on the 
left side of the Sources window.

7. Use the Window menu to specify the window to assign to the drawer to.

8. Click Apply.

The Add Window dialog closes and the Drawer Windows table updates to include the 
selection.

9. Repeat steps 5 to 8 for each drawer you want to include in the soft panel.

10. To customize a drawer size:

a. Use the Width field to specify the percentage of the allocated drawer space.

b. Use the Rows field to specify the number of rows in the drawer will display.

c. Use the Columns field to specify the total number of columns in the drawer will display.

 You can also use the Drawer Width menu, located near the top of the Home View tab, to specify 
the width of the drawer handle size.

11. Repeat step 10 for each drawer of the soft panel you wish to re-size.

12. Click Apply to save your settings.

Soft Panel Features
The panel UI design are similar to Ultritouch approach where UI sections are categorized into UI 
windows. These UI windows can be placed in main display and/or drawers. 

Home View Window
By default, the channel strips are placed from left to right, and the output strips are placed at the far 
right.
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Figure 30  Example of an Audio Mixer Soft Panel

1. Channel Strips

Each strip controls the input from that audio channel and are color coded for where the audio 
comes from. Each strip includes the name of the audio channel and the router source assigned to 
it. Clicking the router source name opens the router source selection drawer window if defined.

 If a source is grayed out, the crosspoint is currently set to Lock or Protect by another panel.

2. Noise Gate

Opens the Noise Gate page in the Audio Filters window. Refer to “Noise Gate” for details.

3. Compressor/Limiter

Opens the Compressor/Limiter page in the Audio Filters window. Refer to “Compressor/Limiter” 
for details.

4. Equalizer

Opens the Equalizer page in the Audio Filters window. Refer to “Equalizer” for details.

5. Mute

Turn off the audio from this source. This does not change the level.

6. Audio Fader and Meter

Adjust the level of the audio from the source. 

7. Solo, Solo Clear

The solo action is dependant on the current mixer output.

› Master output — Selecting solo will route that channel to the defined Monitoring output. It 
does not affect the master output. Only those channels with solo activated will be connected to 
the Monitoring output.  If no channels have solo activated, the monitoring output follows the 
Master output.

› Aux outputs — Selecting solo MUTES all other inputs to the selected output bus.

Any channels with solo active will illuminate the Solo Clear button - even channels not currently 
visible.

Clicking Solo Clear disables any solo action for the selected output bus.
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8. Output Strips

The output channel strip fader controls the over-all level for that mixer output. Use the scroll bar 
at the bottom or the mixer output drawer window to select a mixer output bus. 

9. Drawers

A navigation drawer is available on the left and right sides of the interface. Tap the drawer icon 
once to open a pane that provides access to additional menus and functions of your soft panel. 
Tap the drawer icon again to close the pane. The contents of a drawer is determined when the 
soft panel was configured.

10.Monitor Strip

The Master layer also has a Monitor output and level. By default, the Monitor strip reports the 
status of the last channel pair of the partition.

Audio Filters
By default, the audio filters are located in the right drawer of the soft panel. The following audio 
filters are available for each channel strip: audio equalizer, noise gate, and compressor/limiter. 

 At the top of each audio filter setting is a Clipping indicator to warn you if clipping is occurring in 
the Equalizer stage (EQ) or Compressor/Limiter stage (CL).

Equalizer
The audio equalizer (EQ) allows you to enhance the sound quality of audio sources. An independent 
equalizer is available for every audio fader in the system and allows for adjustment in four bands 
(low-shelf, mid-range, high mid-range, and high-shelf).

 You can adjust the EQ settings using the EQ graph or the specific slider control.

To configure an equalizer

1. Expand the applicable drawer to display the Audio Filters window.

2. Click Equalizer.

In the example below, the Audio Filters window displays in the right drawer.

3. Select an audio channel to modify.
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In the example above, the user is modifying Channel 1.

4. Use the Low Shelf slider to adjust the gain of the low frequency band.

 You can also move the L point around on the graph to adjust the low shelf values.

• Gain — set the audio level of the frequency band (-20dB to 20dB).
• Max Freq — set the maximum frequency that you want the low shelf audio band limited to 

(20Hz to 1kHz).

5. Use the Midrange 1 slider to adjust the gain of a midrange frequency band.

 You can also move the M1 point around on the graph to adjust the midrange 1 values. The dot 
below the M1 allows you to adjust the Q ratio.

• Gain — set the audio level of the frequency band (-20dB to 20dB).
• Center Freq — set the middle frequency of the audio band (20Hz to 20kHz).
• Q — set the bandwidth of the Q ratio filter (0.51 to 9.91). Note that adjusting the bandwidth 

also changes the frequency range the filter affects.

6. Use the Midrange 2 slider to adjust the gain of a midrange frequency band.

 You can also move the M2 point around on the graph to adjust the midrange 2 values. The dot 
below the M2 allows you to adjust the Q ratio.

• Gain — set the audio level of the frequency band (-20dB to 20dB).
• Center Freq — set the middle frequency of the audio band (20Hz to 20kHz).
• Q — set the Q ratio.

7. Use the High Shelf slider to adjust the gain of the high frequency band.

 You can also move the H point around on the graph to adjust the high shelf values.

• Gain — set the audio level of the frequency band (-20dB to 20dB).
• Min Freq — set the minimum frequency that you want the high shelf audio band limited to 

(20kHz to 1kHz).

Noise Gate
A noise gate allows a signal above a certain selected threshold to pass through. Noise gates are 
typically used to reduce unwanted external sounds, and/or reduce natural channel noise.

To configure the noise gate

1. Expand the applicable drawer to display the Audio Filters window.

2. Click Noise Gate.

In the example below, the Noise Gate window displays in the right drawer.
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3. Select an audio channel to modify.

In the example above, the user is modifying Channel 1.

4. Use the Threshold slider to specify the level at which the gate opens.

5. Use the Gain Reduction slider to specify the amount of gain are reduced.

6. Use the Attack slider to specify how quickly sounds louder than the threshold are affected.

7. Use the Release slider to specify how quickly sounds softer than the threshold are affected.

8. Select the Enable Clipping to 

 Click Reset Noise Gate to return all Noise Gate settings to the default values.

Compressor/Limiter
The audio compressor allows you to restrict audio levels from passing a threshold level. These are 
often used to prevent digital clipping of audio levels that are too high for output equipment. Once 
the threshold is reached, the compressor starts to reduce the gain at a specific ratio. The higher the 
compression ratio, the harsher the reduction in gain. The compression continues until the audio 
level falls below the threshold. You can adjust how quickly the compressor is applied once the 
threshold is surpassed as well as how long after the level drops below the threshold that the 
compressor is still applied.

 The compressor is said to be acting as a limiter when the compression ratio is set very high, or to 
infinity, and the attack time is set very low. This has the effect of causing a very abrupt flattening 
of the audio level once the threshold is reached.

To configure the Compressor/Limiter settings for the audio matrix inputs

1. Expand the applicable drawer to display the Audio Filters window.

2. Click Compressor/Limiter.

In the example below, the Compressor/Limiter window displays in the right drawer.
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3. Select an audio channel to modify.

In the example above, the user is modifying Channel 1.

4. Use the Threshold slider to select the level (dB) at which the compressor is applied.

5. Use the Compression slider to select the ratio for the amount of compression you want to 
apply. The higher the ratio the more compression is applied to lower the level. At infinity the 
audio level is limited to the threshold.

6. Use the Attack slider to select the amount of time (ms) you want to pass between the level 
surpassing the threshold and the full compression ratio being applied.

7. Use the Release slider to select the amount of time (ms) you want to pass between the level 
falling below the threshold and the compression ratio returning to 1:1 (no compression 
applied).

8. Use the Makeup slider to increase the gain of the audio after compression.

Adjusting the Balance an Audio Source
Adjusting the balance of an audio source adjusts the volume of the left and right stereo channel. For 
example, as you move the Balance slider to the right the volume of the right channel is increased 
and the volume of the left channel is decreased.

To adjust the balance of an audio source

1. Expand the applicable drawer to display the available window options.

2. Click Pre-Processors & Balance Control.

In the example below, the Pre-Processors & Balance Control window displays in the right 
drawer.
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3. Select an audio channel to modify.

In the example above, the user is modifying Channel 1.

4. Use the slider in the Balance area to adjust the volume of the left and right stereo channel.

Audio Processing Options
The audio mixer panel enables you to adjust the gain and phase invert, individually, each of the 
audio sources.

To configure the audio proc-amps for an audio source

1. Expand the applicable drawer to display the available window options.

2. Click Pre-Processors & Balance Control.

3. Select an audio channel to modify.

4. Use the Pre-Gain field to specify the amount of gain (dB) applied to the input channel. 

5. To invert a channel:

• Click Left Channel Phase Invert to inverts the audio signal of the left channel.
• Click Right Channel Phase Invert to inverts the audio signal of the right channel.

6. Click Input Sum to sum the left and right input channels. Both channels will carry the average 
((A+B)/2) of the two input (Left and Right) channels. 

Loading the Audio Mixer Soft Panel
The audio mixer soft panels are only available in DashBoard. You can load a soft panel to the 
DashBoard window on your PC, or to an Ultritouch panel. Both methods are presented here.

To load an audio mixer soft panel to a desktop

1. Launch DashBoard on your PC as described in the section “Launching DashBoard”.

2. Locate the Ultrix in the Tree View of DashBoard.

3. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

4. Expand the Soft Panels node for the Ultrix. 
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5. Double-click the node for the newly edited soft panel.

The selected soft panel opens in the DashBoard window of your PC.

To load an audio mixer soft panel to an Ultritouch

1. On the Ultritouch hard panel display, tap .

The All Connections interface displays.

2. Tap the router you want to control via the Ultritouch.

3. Tap the second button.

The panel updates to display the router hierarchy much like the tree view in the router menu 
system.

4. Tap Soft Panels.

A list of available soft panels displays.

5. Tap the audio mixer soft panel for the Ultrix.

6. Tap Open.

The Ultritouch interface updates to display the selected soft panel.

Notes on Audio Mixing via a Soft Panel
If your audio mixer soft panel includes partitions, you can switch between matrices as follows:

1. Expand the applicable drawer to display the Mixer Selection window.

 By default, the Mixer Selection window is located in the left drawer of the soft panel.

2. Click the Partition button for the required mixer (partition).

• The channel strips and output strips are auto-populated.
• The mixer inputs are automatically routed to the mixer outputs.
• The soft panel recognizes a take transition from an external panel.

If your audio mixer soft panel includes router levels, sources, and destination, you can perform 
crosspoint switches as outlined in the“Soft Panels in DashBoard”.

Audio Mixer Operation
This section provides examples two possible audio mixer setups: a generic system and a.

Generic Setup
This example assumes the following generic setup seen in Table 19. Note that generic physical IO 
names shown for brevity.

Table 19  Example Mapping for Router Sources and Destinations

Video A1 A2
Source
SRC1 slot1.in[1].sdi slot1.in[1].audio.c

h1
slot1.in[1].audio.c
h2

SRC2 slot1.in[2].sdi slot1.in[2].audio.c
h1

slot1.in[2].audio.c
h2
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To perform a simple route of audio mixer channels

1. To route a mixer output to a destination:

a. Choose a destination to receive the mix.

b. Choose a source for the destination.

2. To route a source audio to a mixer input:

a. Select the mixer input.

b. Select the required source.

SRC3 slot1.in[3].sdi slot1.in[3].audio.c
h1

slot1.in[3].audio.c
h2

... ... ... ...

MXR MSTR slot0.mixer-out[1] slot0.mixer-out[2]

MXR AUX1 slot0.mixer-out[3] slot0.mixer-out[4]

... ... ... ...

Destination
Dest1 slot1.out[1].sdi slot1.out[1].audio.

ch1
slot1.out[1].audio.
ch2

Dest2 slot1.out[2].sdi slot1.out[2].audio.
ch1

slot1.out[2].audio.
ch2

Dest3 slot1.out[3].sdi slot1.out[3].audio.
ch1

slot1.out[3].audio.
ch2

... ... ... ...

MXR IN1 slot0.mixer-in[1] slot0.mixer-in[2]

MXR IN2 slot0.mixer-in[3] slot0.mixer-in[4]

... ... ... ...

Table 19  Example Mapping for Router Sources and Destinations

Video A1 A2
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With these route operations, we have routed the output of the Mixer Master bus (assuming 
Master is set to Out1 in the mixer partition settings), to our router destination DST 1, and then 
routed audio channels 1 and 2 (as the mixer map is only configured for two channels in this 
example), of our router source SRC 3 to the mixer Channel strip 1.

Or, to look at it another way; audio channels 1 and 2 on router destination DST 1 are connected 
to the mixer Master bus. The Master bus has router source SRC 3 audio channels 1 and 2 via 
Channel strip 1.

3. To add another source to the mix:

a. Select another mixer input.

b. Select the source of the extra channels.

After this route, audio mixer Channel strip 2 receives the audio channels 1 and 2 of SRC 2. The 
MXR MSTR can have a mix of SRC 3 channels 1 and 2, and SRC 2 channels 1 and 2. Channel strip 
faders 1 and 2 control the mix of their respective sources. The Mixer Master fader controls the 
overall level of the mix.

Using Audio Mixer Direct Outputs
ULTRIMIX-MXR provides a direct channels strip output (pre-fader). This allows the use of the 
equalizer, compressor/limiter, and noise gate without requiring the effects to be routed through a 
mix bus.

In this example, we assume the mapping seen in Table 20.

Table 20  Example Mapping for Router Sources and Destinations

Video A1 A2
Source
SRC1 slot1.in[1].sdi slot1.in[1].audio.c

h1
slot1.in[1].audio.c
h2

SRC2 slot1.in[2].sdi slot1.in[2].audio.c
h1

slot1.in[2].audio.c
h2

SRC3 slot1.in[3].sdi slot1.in[3].audio.c
h1

slot1.in[3].audio.c
h2

... ... ... ...

FX1 slot0.mixerda-out[
1]

slot0.mixerd-out[2
]

FX2 slot0.mixerd-out[3
]

slot0.mixerd-out[4
]

... ... ... ...

Destination
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With the above mapping, we can feed the output of the filters (noise gate, equalizer, 
compressor/limiter) to any destination.

1. Route a channel strip direct output to a destination:

a. Select the required destination.

b. Select an output of the mixer as the source.

2. Route a source to the channel strip:

a. Select a mixer input as a destination for the source.

b. Select the required source.

With these route operations, we have routed the direct outputs of mixer Channel strip 1 to our 
router destination DST1, and then routed audio channels 1 and 2 of our router source SRC3 to 
the mixer Channel strip 1.

Or, to look at it another way; audio channels 1 and 2 on router destination DST1 are connected 
to router source SRC3 audio channels 1 and 2 via mixer Channel strip 1 filters (gate, 
compressor/limiter, and equalizer). The settings of the filters will effect the audio channels 1 
and 2 of destination DST1.

Dest1 slot1.out[1].sdi slot1.out[1].audio.
ch1

slot1.out[1].audio.
ch2

Dest2 slot1.out[2].sdi slot1.out[2].audio.
ch1

slot1.out[2].audio.
ch2

Dest3 slot1.out[3].sdi slot1.out[3].audio.
ch1

slot1.out[3].audio.
ch2

... ... ... ...

MXR IN1 slot0.mixer-in[1] slot0.mixer-in[2]

MXR IN2 slot0.mixer-in[3] slot0.mixer-in[4]

... ... ... ...

a. The “d” in the mixer physical label represents Direct Out.

Table 20  Example Mapping for Router Sources and Destinations

Video A1 A2
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Tallies
The Ultrix accepts TSL UMD tally messages, and passes tally status notifications to configured 
UltriScape Heads. Tally messages associated with a router source may also be passed to the routed 
destination tally status. Tally information may be associated with either routing system sources or 
destinations.

For More Information on...
• the TSL UMD protocols that Ultrix supports, refer to “External Control”.

Tally Types
Tally information may be associated with either routing system sources or destinations.

 Ultrix does not support Unicode characters.

Source Association
Tally IDs associated with routing system sources may serve two purposes:

1. Trigger any UltriScape Multiviewer to display tally status (this requires that the Ultrix router has 
at least one UltriScape Head enabled and configured).

2. Enable the tally status to be mapped to other Tally IDs based on router crosspoint status (the 
destination must have a Tally ID associated and Tally Re-direct enabled).

To associate Tally IDs to sources in the database you must:

• Use the Sources tab in the Database interface to associate the Tally IDs with logical sources in the 
Ultrix database.

• Specify the UMD “Tally Level” using the Tally Status Level menu in the Levels tab.

Destination Association
A Tally ID may be associated with routing system destinations using the options in the Database > 
Destinations interface. Three modes of operation are available:

• Normal — The database name of the connected source is placed in the Display Data field of the 
destination Tally ID message (an outgoing connection is required; TSL v3.1 only). When the Tally 
ID is associated with an UltriScape PiP (slotn.headx-pip[y] or slot0.pip[y]), any assertion on this 
Tally ID will directly control the PiP tally visual elements and override any Tally associated with the 
PiP video source.

• Redirect — The destination Tally ID follows the connected source Tally ID. For example, when a 
source is switched to a destination on the selected Tally Level, the Ultrix forwards the tally status 
of the source that is active on the destination, but the outbound TSL message has its display ID 
re-mapped to the display ID that is associated with the destination. An outgoing connection is 
required.

• Routed — The connected source Tally ID follows the destination Tally ID. Any configured 
UltriScape PiPs showing this source will use destination Tally ID status to assert Tally Indicators or 
Tally Borders.

 Ensure the destination Tally IDs do not conflict with Tally IDs asserted by other devices.
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Tally ID Format
Table 21 summarizes the format that the TSL protocol defines Display IDs that are associated with 
the tally displays. 

Keep the following in mind when using tally display IDs:

• TSL UMD protocols v3.1 and v4.0 messages will always map to screen 0.
• When using TSL UMD v5.0, the screen ID is assumed to be 0 if no screen ID is entered.
• If the controller is configured for either v3.1 or v4.0 protocol, it is not necessary to enter a screen 

ID.
• If the controller is configured for v5.0, it is only necessary to specify the screen ID if the tally 

controller is configured to send messages to tally displays on ‘screens’ other than the one with 
the screen ID of 0.

UltriScape PiP Tally Operation Overview
Ultrix will track current tally status for all sources or destinations that have an associated TallyID 
configured. When an UltriScape PiP has tally display objects (e.g. border, label, lamp) enabled, the 
PiP determines what is shown on the display based on the configured source and destination 
TallyIDs and the Tally mode setting.

UltriScape PiPs may be configured to follow the TallyID of the currently displayed source, or, a direct 
Tally mode, over-riding any information from the currently displayed source.

The three tally modes are:

1. Redirect — UltriScape PiPs will show tally information associated with the currently connected 
source, i.e. the tally information of the currently displayed source is redirected to the PiP.

2. Normal — UltriScape PiPs will show tally information directly associated with the PiP, overriding 
any currently displayed source tally information.

 The signal must have tally data to drive the tally display objects on the PiP it is assigned to. If the 
signal does not include the applicable tally data for an object, that object does not update but still 
displays on the PiP.

3. Routed — An UltriScape PiP tally display can be asserted by which source is routed to a 
particular destination. In this mode, Ultrix will check its crosspoint status to find which input 
signal is connected to the output in question. If that input signal is also currently displayed on 
any UltriScape PiPs, then the received tally ID data associated with the output is also forwarded 
to the PiPs.

For More Information on...
• assigning Tally IDs to sources, refer to “Assigning the Tally IDs to the Sources”.
• defining tally PiP objects, refer to “Configuring PiP Tallies in an UltriScape Head”.
• using Tally Routed mode, refer to “Tally Routed Mode”.

Table 21  TSL Protocol — Tally ID Format

TSL Protocol 
Version Tally ID Format Range

3.1 <displayID> 0 - 127

4.0 <displayID> 0 - 127

5.0 <screenID>:<displayID> 0 - 65535 : 0 - 65535
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Example

In this example, the following sources are configured for Tally IDs: 

Figure 31  Assigning Tally IDs to Src 2 and Src 3 in the Database

Assuming the UltriScape layout has a tally border object defined for the top right hand tile (PiP 2 in 
Figure 32), when the PiP is displaying the source Src 2, the PiP displays the status of Tally ID 10, 
which in Figure 33 is off (no border displays). 

If Src 3 is routed to PiP 2, the PiP now displays the status of Tally ID 15, which in this example is 
on. Now the tally border configuration is displayed. Any changes to Tally ID 15 (from external 
devices) will be displayed by the PiP as long as Src 3 is routed to PiP 2.

Figure 34  Example of a 2x2 Layout with Src 3 Assigned to PiP 2 and Tally ID 15 is On

Router Tally Output Operation
Ultrix will track current Tally Status messages sent by a controller via Tally Display IDs associated 
with router sources. When a source (with a Tally ID) is routed to a destination (with a Tally ID), the 

Table 22  Example of Sources Assigned to Tally IDs

Source Name Tally ID Tally Status
Src 2 10 off

Src 3 15 on

Figure 32  Example of Creating a 2x2 Layout with a 
Tally Border in PiP 2

Figure 33  Example of a 2x2 Layout with Src 2 
Assigned to PiP 2
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router will emit Tally Status messages that reflect the current tally status of the Tally ID associated 
with the source, but that target the Display ID associated with the destination.

 An outgoing connection point must be defined for Ultrix to send the new status out.

Example

Consider the following source and destination configurations:

For the above configuration settings, the following states are possible:

Router Status over TSL UMD v3.1 Operation
Ultrix can use the TSL UMD protocol version 3.1 to send the connected source database name as 
tally text. This requires you to:

1. Set up an outgoing TSL v3.1 connection.

2. Assign Tally ID numbers to the destinations you wish to track.

3. Ensure the Tally mode is set to None.

When a configured destination changes, the name of the new source will be sent as tally text. Ultrix 
will resend all the configured destinations every 1 minute, and immediately for any source change 
on a configured destination.

Getting Started
Before configuring tallies in an UltriScape Head, you must first perform the following in the active 
database:

1. If RS-232 or RS-422 communication is required, add a serial connection point for TSL protocol 
support.

2. If Router Tally Output operation is required, add either a serial or ethernet outgoing connection. 
Refer to “Ultrix Control with Third-Party Systems”.

3. Enable Tally ID support.

4. Assign the Tally IDs to the sources.

5. Assign the Tally IDs to the destinations.

Table 23  Example of Sources and Destinations Assigned to Tally IDs

Name Tally ID Tally Status
Sources

Src 1 5 T1:on

Src 2 10 T1:off

Destinations

Dest 1 33 T1:xxx

Table 24  Example of Sources and Destinations Assigned to Tally IDs

Router Status Tally Status
Src 1 > Dest 1 TallyID 33 T1 = TallyID 5 T1 (on)

TallyID 33 Display Data = Src 1

Src 2 > Dest 1 TallyID 33 T1 = TallyID 10 T1 (off)
TallyID 33 Display Data = Src 2
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6. Set the Tally mode to None.

Adding a Serial Connection Point

Connections may be created via the Edit > Add menu on the Connections tab and selecting the TSL 
protocol from the Protocol menu in the Add Connection dialog.

For More Information on...
• a serial connection point to third-party devices, refer to “Defining a Serial Connection”.

Adding an Ethernet Connection Point

An Ethernet connection point must be added for outgoing TSL protocol support only. Incoming 
Ethernet services are natively available. Refer to “External Control” for settings.

For More Information on...
• Ethernet connection point to third-party devices, refer to “Third-party Connection via 

Ethernet”.

Enabling Tally ID Support in the Active Database

To enable tally ID configuration in an active database, you must select the Enable Tally box on the 
System Status > Database tab, and then define the Status Level for tally operation.

Once support is enabled, the Source and Destinations tabs display a Tally column which is used to 
assign Tally IDs to sources and/or destinations in the active database.

To enable tally ID support in the active database

1. In the Tree View, double-click the System Status node.

The System interface displays in the DashBoard window.

2. Select the Database tab.

3. Verify that the active database is the one you wish to enable tally ID support for.

4. Select the Enable Tally box located in the Current Database area.

The Source and Destinations tabs automatically update to display the Tally column. The 
Levels tab now displays the Tally Status Level menu.

Defining the Status Level for Tally Operation
The Tally Status Level specifies which level in the routing system is used to determine the current 
source switched to a given logical destination. Generally this should be the main SDI Video level; 
which in most systems is the level to which the UltriScape Head PiP and/or Router Video 
destinations are mapped in the system database.
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To define the status level for tally operation

1. Double-click the Levels node located under the Database node.

The Levels tab opens.

2. Use the Tally Status Level menu (located at the bottom of the Levels tab) to specify the Level 
in the active database that will determine the tally status. 

Assigning the Tally IDs to the Sources
Assigning a Tally ID to an Ultrix source enables configured UltriScape displays to show tally 
information.

For example, if an UltriScape Head contains a PiP configured to display tally information (as 
outlined in the section “Configuring PiP Tallies in an UltriScape Head”), and a source with an 
assigned Tally ID is routed to that PiP, that PiP will reflect the incoming messages received by Ultrix 
via the TSL protocol.

 Before proceeding, ensure you verify which TSL protocol you are using. The protocol determines 
how you must enter the information into the Tally cells of the Sources tab. Refer to Table 21 for 
details.

To assign a Tally ID to a source in the database

1. Double-click the Sources node located under the Database node.

The Sources tab opens.

2. Verify that the Tally column displays in the Sources tab. If it does not, refer to the section 
“Enabling Tally ID Support in the Active Database”.

3. Select the cell in the Tally column of the Sources tab to assign the Tally ID to.

4. Type the Tally ID you wish to assign to that source.

5. Press Enter to apply the change.

6. Repeat steps 3 to 5 for each source you wish to assign a Tally ID.

7. Click Apply at the bottom of the Sources tab to save your changes.

TallyID 41 is associated with Src 1 in 
the Ultrix database. (TSL UMD v3.1 
and v4.0)

Tally Screen 5, ID 41 is associated with 
Src 1 in the Ultrix database. (TSL UMD 
v5.0)

Figure 35  Example of a Sources with Assigned Tally IDs
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Assigning the Tally IDs to the Destinations
Assigning a Tally ID to a standard Ultrix destination (e.g. not a PiP, audio mixer destination, etc.), 
enables currently routed source tally data to be output on a defined destination Tally ID, essentially 
routing the tally information along with the video.

 An outgoing connection point (either ethernet server or RS232/422 port) is required for Ultrix to 
emit tally information. Refer to “Connecting to Third-Party Devices” for connection details. 

 Before proceeding, ensure you verify which TSL protocol you are using. The protocol determines 
how you must enter the information into the Tally cells of the Destinations tab. Refer to 
Table 21 for details.

Tally ID 51 follows the connected source 
associated tally. This requires an 
established outgoing connection point. 
(TSL UMD v3.1 and v4.0 TallyID format). 
Refer to “Router Tally Output 
Operation”.

Tally Screen 4, ID 11 follows the 
connected source associate tally. This 
requires an established outgoing 
connection point. (TSL UMD v5.0 TallyID 
format). Refer to “Router Tally Output 
Operation”.

The label of the source currently 
connected to DST 1 will be sent as TSL 
text on Tally ID 5. (TSL UMD v3.1 only). 
Refer to “Router Status over TSL UMD 
v3.1 Operation”.

When Tally ID 8 is asserted, any PiPs 
showing the same source as routed to 
DST 1 also have their tally asserted (if 
defined on the PiP). For example, if DST 1 
has source CAM 1 routed to it, and one or 
more UltriScape PiPs also had source 
CAM 1 displayed, the PiP would display 
tally data from Tally ID 8. Refer to 
“UltriScape PiP Tally Operation 
Overview”.

The label of the source currently 
connected to destination DST 1 will be 
output as text in a TSL 3.1 message with 
Tally ID 11. The UltriScape PiP displays the 
tally information from Tally ID 11 
regardless of the displayed source video. 
Refer to “UltriScape PiP Tally Operation 
Overview”.

The UltriScape PiP displays tally 
information from the connected source 
associated Tally ID. Refer to “UltriScape 
PiP Tally Operation Overview”.

Figure 36  Example of Destinations with Assigned Tally IDs
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To assign a Tally ID to a destination in the database

1. Double-click the Destinations node located under the Database node.

The Destinations tab opens.

2. Verify that the Tally column displays in the Destinations tab. If it does not, refer to the section 
“Enabling Tally ID Support in the Active Database”.

3. Select the cell in the Tally column of the Destinations tab to assign the Tally ID to.

4. Type the Tally ID you wish to assign to that destination.

5. Press Enter to apply the change.

6. Select the Tally Redirect box to enable the connected source Tally ID to be directed to this 
destination Tally ID.

7. Repeat steps 3 to 6 for each destination you wish to assign a Tally ID.

8. Click Apply at the bottom of the Destinations tab to save your changes.

Assigning a Tally ID to an UltriScape PiP Destination
Assigning a TallyID to an UltriScape PiP will cause the PiP to display that TallyID information and 
ignore any tally information from the displayed source.

Figure 37  Example of a TallyID to an UltriScape PiP

Table 25  Examples of TallyIDs for an UltriScape PiP

PiP Destination Configuration Example Notes
The tally will be asserted 
when the tally ID associated 
with source 'CAM 1' is 
asserted, ie; the PiPs video 
source TallyID is redirected 
to the PiP.

The tally will be asserted 
when Tally ID 65 is asserted 
as '65' is entered in the Tally 
column.

No tally information will 
display on the PiP as neither 
tally redirect is enabled, nor, 
a direct TallyID specified.
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UltriScape Tally Settings
The UltriScape Configuration interface provides options for specifying the tally colors for all 
UltriScape Heads, and setting the operation mode.

Specifying the Global Tally Colors for the UltriScape Heads
The Tally Lamp Color enable you to specify the color of Tally 0 and Tally 1 for all the UltriScape 
Heads enabled in the active database. Note that the function of Tally 0 and Tally 1 is determined by 
the TSL UMD protocol version as outlined in “External Control”.

To specify the tally colors used in all UltriScape Heads

1. Double-click the Ultrix router in the Basic Tree View of DashBoard.

The tree for the router expands.

2. Expand the UltriScape node.

3. Double-click the Configuration node.

The Configuration - Layout Editor Settings tab displays in the right side of the DashBoard 
window.

4. Locate the Tally Lamp Color options.

 Changing the Global Tally Settings values on one UltriScape Head tab automatically updates all 
UltriScape Heads in the active database.

5. Use the Tally menus to specify the color used when the tally is active (on). By default, Tally 0 is 
set to Red and Tally 1 is set to Green.

The setting change is automatically applied.

Specifying the Global Tally Label Settings for the UltriScape Heads
Tally label text can be determined by the source of the tally or the labels defined in the Ultrix 
database. An UltriScape UMD label may either show database name, the associated tally text, or, it 
may show tally text appended to the database name.

 If the associated tally contains no text, the UMD label displays as a blank field.

To specify the tally label text used in all UltriScape Heads

1. Double-click the Ultrix router in the Basic Tree View of DashBoard.

The tree for the router expands.

2. Expand the UltriScape node.

3. Double-click the Configuration node.

The Configuration - Layout Editor Settings tab displays in the right side of the DashBoard 
window.

4. Locate the Tally Label Text Settings options.

 The tally label text setting change is automatically applied.

5. Use the Source Mode options to specify the tally label text when any UltriScape Head PiP 
Source is assigned to a Src #. Choose from the following:

• overwrite — the tally label text is entirely replaced with the text provided by the tally.
• append — the tally label text displays as src : tally where src is the name the source is 

assigned in the Ultrix database, and tally is the text provided by the tally.
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6. Use the Follow Dest Mode options to specify the tally label text when any UltriScape Head PiP 
Source is assigned to a Follow Dest #:

• overwrite — the tally label text is entirely replaced with the text provided by the tally.
• append — the tally label text displays as dest : tally where dest is the name the 

destination is assigned in the Ultrix database, and tally is the text provided by the tally.

Specifying the Tally Behavior
You can specify whether only the red tally or both tallies are lit when the tallies are on (tally 
indicator PiP objects only).

To specify the tally behavior in all UltriScape Heads

1. Double-click the Ultrix router in the Basic Tree View of DashBoard.

2. Expand the UltriScape node.

3. Double-click the Configuration node.

The Configuration - Layout Editor Settings tab displays in the right side of the DashBoard 
window.

4. Locate the Tally Behavior Settings area.

5. Choose one of the following:

• Red tally only — the red tally indicator is lit when both tallies are on. The green is unlit.
• Both tallies lit — both the red and green tally indicators are lit.

Configuring PiP Tallies in an UltriScape Head
In the UltriScape Layout Editor interface, you can select PiPs and add a border or a text box to 
represent the status of a tally in the UltriScape Head output. 

Adding a Tally Border to a PiP
A tally border is a PiP border that will change color depending on the associated Tally ID 
information. By default, a tally border is set in blue on the layout and the color cannot be edited. 
The default border width is fixed at 8 pixels.

To add a tally border to a PiP in a layout

1. Load the layout in the Layout Editor as outlined “Loading a Previously Saved Layout”.

2. From the Objects toolbar, click SELECT.

3. Select the tile to add a tally border to.

The tile displays with a dotted yellow border and the Border Width and Border Type menus 
now display under the Main toolbar.

4. Set the Border Type to Tally.

The tile displays with a solid blue border. In the example below, a tally border was added to 
PiP1.
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5. From the top toolbar, use the Border Width field to specify the border width in number of 
pixels and lines.

6. Press Enter to apply the new width value.

7. Save the changes to the layout as outlined in “To save a layout to the database”.

Adding a Tally Label to a PiP
Adding a tally label is similar to adding a static or dynamic text box to a PiP. Once a source is 
assigned to the tile (via the options in the UltriScape Head interface) its Tally ID information 
automatically populates the box contents.

The background color of a tally enabled UMD label will change with the tally information. A blue 
background on a tally enabled UMD label means the Ultrix does not have any tally information to 
display. 

To add a tally label to a PiP

1. Load the layout in the Layout Editor as outlined in “Loading a Previously Saved Layout”.

2. From the Objects toolbar, click UMD.

3. Select the PiP to add a text box.

The Label settings, including the Type menu and the Tally box, display under the main toolbar.

4. From the Type menu, select PiP Source.

5. Select the Tally box.

The box on the tile automatically updates to “PiP Source Unassigned w/ Tally”.
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6. Save the changes to the layout as outlined in “To save a layout to the database”.

Adding Tally Lamps to a PiP
Tally lamps (or Tally Indicators) are blocks on the PiP that emulate the classic UMD tally lamp 
behavior. You can add tally lamps to any PiP in a layout. 

Once a source is assigned to the tile (via the options in the UltriScape Head interface) its Tally ID 
information automatically sets the lamp colors.

To add a tally lamp to a PiP

1. Load the layout in the Layout Editor as outlined in “Loading a Previously Saved Layout”.

2. From the Objects toolbar, click TALLY.

3. Select the PiP in the layout to add the tally lamps to.

The PiP displays a dotted blue border with a lamp box in the bottom left and right corners. By 
default, the left lamp is Tally 0 (red) and the right lamp Tally 1 (green). In the example below, 
tally lamps were added to PiP2.
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4. Save the changes to the layout as outlined in “To save a layout to the database”.

Configuring the UltriScape Head
Each PiP in a layout is assigned a video signal from the current database. If the input signal includes 
tally data and the PiP assigned to that source includes tally objects (e.g. border, label), the tally data 
is included in the UltriScape Head output.

Assigning a Source to a PiP with Tally Objects
If a layout in the UltriScape Head interface includes tally objects in the PiPs, the objects are set in 
blue for quick identification on the layout. In specific:

• Tally labels — this object displays as a text box, in the PiP, with white text on a blue background.
• Tally border — the blue border displays around the PiP.

For More Information on...
• assigning a layout to an UltriScape Head, refer to “Assigning a Layout to an UltriScape Head”.
• assigning a source to a PiP, refer to “Assigning a Source to a PiP”.

Tally Routed Mode
Consider an Ultrix feeding signals to a Ross Carbonite switcher; the switcher can assert tally 
messages based on which signals are contributing to those outputs, but the switcher has no 
knowledge of how Ultrix has routed its inputs to the outputs. 

The Tally Routed mode associates a tally with a specific Ultrix destination. Ultrix knows which input 
is routed to that output, and so can assert tally indicators wherever the input signal is displayed in 
an UltriScape PiP.

In Figure 38, Tally ID 3 is associated with Ultrix destination 11. When the switcher asserts Tally ID 3 
(based on its own configuration rules), Ultrix looks up the input connected to destination 11 (source 
19 - Cam 1). UltriScape will then assert the same tally data as received wherever source 19 - Cam 1 
is displayed. Cam 2 has a different tally asserted because Cam 2 (source 20) is routed to destination 
12 which is associated with Tally ID 4. 
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Figure 38  Example of Tally Routed Mode

Application
Use a routed tally to associate the tally state for a particular router source to ultimately reach the 
on-air path of the Carbonite switcher. For example:

1. The Carbonite generates a tally (ie program or preview) with an assigned Carbonite Tally ID. 

2. The Ultrix looks up which router source is currently connected to the router destination 
associated with that Carbonite Tally ID. 

3. The Ultrix then determines if that source is currently displayed on any Ultriscape PiPs, and if so, 
asserts the appropriate Ultriscape PiP tally.

In this example, the Tally Routed mode would enable the PIP tally to accurately reflect the tally state 
when a different source is routed to a Carbonite switcher input.

Carbonite Requirements
You will need to configure the Carbonite to communicate with the Ultrix router UMD service using 
specific TSL UMD ethernet protocol settings. 

To set up tally communications between Carbonite and the Ultrix UMD

1. On the Carbonite panel menu system, press MENU > SYSTEM > NEXT > NEXT > Device Config.

2. Press Add.

3. Use the Slot knob to select an ethernet connection (Slot #).

4. Use the Type knob to select SerialTally.

5. Press NEXT.

6. Use the SubType knob to select TSLUMD_1.0.
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7. Press NEXT.

8. Enter the IP address of your Ultrix:

a. Use the Field knob to select the segment of the IP address you want to edit.

b. Use the Value knob to enter the IP address of your Ultrix.

9. Press NEXT.

10. Use the Option and Value knobs to complete the setup as outlined in the following table. 

11. Press the Option knob and Confirm to add the Ultrix as a new device.

Ultrix Requirements
For each Ultrix destination that is connected to a Carbonite switcher input:

• Set the switcher's primary input number in the Tally column of the Destinations table in the 
router database.

• Set the Tally mode to Routed.
• Set an ID number in the Tally column and set the Tally mode to Normal for any Ultriscape PIP 

destination that is expected to show UMD tally for sources that are also routed to a switcher 
source. 
This can be any ID as long as it is not used by your destinations that feed your Carbonite inputs. 
To make it simple, on our example below we start at 201, this would be a recommended value 
that should not conflict with anything else.

Option Value
Port Set to 5727 if you are using the default value that Ultrix requires for TSL 

V3.1 over TCP/IP communication.
Set to 4490 for UDP communication.

Transport Select TCP if the Port is set to 5727.
Select UDP if the Port is set to 4490.
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Using Remote Control Panels
When the Ultrix router is configured for Ultricore mode, it responds to switch commands from Ross 
NK Series and Ross series control devices. These commands contain source, destination, and level 
designations. Routers acknowledge the switch request with the selected crosspoint switch status 
after the switch has occurred. The Remote Control Panels (RCP) may operate singularly, or in a 
linked mode where two or more (up to 10) panels may operate as a larger panel with more buttons.

Connection to Ultrix
The method of connection between Ultrix and an RCP will vary depending on the type of panel. 
Ethernet enabled devices such as the RCP-ME and RCP-QE communicate with Ultrix directly. 
Non-ethernet panels such as the RCP-NKQ, RCP-NKM and RCP-NK1 connect through an NK-NET or 
NK-IPS to convert the native T-Bus commands to ethernet.

Native ethernet panels receive their labels automatically from the Ultrix database upon panel 
start-up. Any subsequent changes to the database labels are also automatically pushed out to 
connected ethernet panels. The NK series panels do not automatically get updates from the 
Ultricore control system and must use a manual process via DashBoard. Refer to the user guide for 
your RCP for details.

 For optimal performance when using a Ross RCP with Ultrix, the Comms Retry factor should be 
set to 80ms or greater within the RCP configuration. Refer to the user guide for your RCP for 
details.

RCP-NKM Connection to a Ross NK Router and an Ultrix Router

The RCP connection as shown in Figure 39 requires a connection point between Ultrix and the 
NK-NET. Refer to the section “Connecting to Ross NK Series Devices” for details.

 The NK-NET requires power from the Ross NK Router (over T-Bus).

Figure 39  Example of a Connection from an Ultrix Router to an NK-3G-16 and RCP-NKM

RCP-QE Connection to an Ultrix Router

RCP-QE and RCP-ME remote control panels require a a connection point between Ultrix and the 
panel. Refer to the user guide for your panel for details.
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Figure 40  Example of a Connection from an Ultrix to an RCP-QE

RCP-NKM with a NK-IPS and NK Router to an Ultrix Router

The RCP connection as shown in Figure 41 requires a connection point between Ultrix and the 
NK-IPS. Refer to the section “Connecting to Ross NK Series Devices” for details.

Figure 41  Example of a Connection from an Ultrix Router to an NK-IPS and an RCP-NKM

Remote Control Panel Operation
The control panel functions detailed in this section can be programmed with the Ultricore for full 
functionality. The examples herein are generic functions applicable to all panel types.

For More Information on...
• specific applications, refer to the user documentation that accompanied your device.
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Destination Buttons
Selecting a destination changes the destination the panel controls or switches the next time a 
Source button is pressed. Destinations can be selected by pressing a preset DESTINATION button.

When a preset DESTINATION button is pressed, that button and its source status button (if a preset 
key exists on the current view or menu) will be illuminated.

 Each panel type has slightly differing method of displaying current status depending on the 
display type or lack there-of. Refer to individual RCP manuals for details.

Figure 42 illustrates an RCP-QE36 panel where Outpt1 is the selected destination.

Figure 42  Selecting a Destination Button — Outpt1 Selected

Source Buttons
Source switching is performed by pressing a preset SOURCE button. Selecting a source (when a 
TAKE function button is not assigned), results in the controller requesting the selected source to be 
switched by the router to the panel's current destination. If a TAKE function button is assigned to 
the current view or menu, the TAKE button will be illuminated. This indicates that TAKE is armed 
and the requested switch will be completed upon the user pressing the TAKE button.

Figure 43 illustrates a panel where Outpt1 is the destination, Input 7 is the source, and the TAKE is 
armed.

Figure 43  Selecting a Source Button — Camera 7 Selected

The flow is always destination selection followed by source selection. This switch will be executed 
with the current panel breakaway/level selections.

Level Buttons
Level buttons select individual router levels. These correspond to the levels tab of the current 
Ultricore database. Level buttons are cumulative e.g. you may activate other levels after already 
selecting a level button.

The following sequence of button presses would result in SRC 1 being routed to DEST 1 but only on 
the levels named SDI, SDI A1 and SDI A2. Any other levels defined in the current Ultricore database 
will be ignored and their status will remain as previously selected. If a level is selected in error, press 
that key again to de-select. The switch occurs once the Source selection is made.

RCP-QE36

HOME

CAT
MODE DOWN PROT

UP TAKE

RCP-QE36

HOME

CAT
MODE DOWN PROT

UP TAKE

RCP-QE36

HOME

CAT
MODE DOWN PROT

UP TAKE

RCP-QE36

HOME

CAT
MODE DOWN PROT

UP TAKE



178 • Using Remote Control Panels Ultrix User Guide (v23.0)

1. Select the Destination button.

2. Select the SDI Level button.

3. Select the Level SDI A1 button.

4. Select the Level SDI A2 button.

5. Select the Source button.

Breakaway Buttons
Breakaway buttons are buttons tied to a breakaway definitions. A breakaway is a pre-set pattern of 
levels defined within the panel configuration. Breakaways can be customized from the control 
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panel’s properties settings via the interface in DashBoard. Figure 44 is an example of configuring a 
breakaway for a control panel.

Figure 44  Example of a Breakaway Setup Interface

 The level numbers correspond to the number in the ID column of the Levels tab within the 
current database.

The following sequence of key presses would result in Src 3 being routed to Dest 2 but only on the 
levels included in the SDI Only breakaway pattern as defined within the RCP set-up (Level 1 in this 
example). The switch occurs once the source selection is made.

1. Select the Destination button.

2. Select the SDI Only breakaway button.

3. Select the Source button to activate the switch selection.

In the following example, the user is switching video from one source (Src 1) and embedded audio 
from another (Src 2).
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1. Select the Destination button.

2. Select the SDI breakaway button containing SDI video only level.

3. Select the Source button to activate the switch selection.

4. Select the breakaway button containing the SDI embedded Ch1 and Ch2 levels.

Once BWAY A1, A2 is pressed, BWAY SDI becomes unlit.

5. Select the Source button for the embedded audio.

Crosspoint Buttons
Crosspoint buttons perform a preset single crosspoint switch in a single button press. A crosspoint 
key contains a source (e.g. Src 1), a destination (e.g. Dest 1), and breakaway (e.g. SDI Only) within its 
definition. 
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Using Categories
Category navigation enables you to organize the resources (sources, destinations, and/or levels) in 
a router database to defined categories. There are three types of categories (each with independent 
interfaces):

• Group — allows a user to organize database resources into folders and sub-folders with arbitrary 
group names. Resources may be assigned to multiple groups if required.

• Cat/Index — allows a user to piece together or build up the final resource name from category 
names and index identifiers.

• Legacy — allows compatibility with earlier RCP-QE models. Note that this is not available as a soft 
panel.

Group Categories Overview
 Group category mode is only available when using an Ultrix router or Ultricore CC running 

software version 2.0 or higher.

Group Category allows the user to organize database resources (sources, destinations, and levels) 
into folders and sub-folders with arbitrary group names. The group name is not required to match 
the resource names (it is similar to setting up file folders). This group categorization is useful when 
you need to group resources based on their operational regions, events, personnel credentials etc.

 Ultrix does not support Unicode characters.

Example of a Group Category Setup

A user wants to arrange sources and destinations based on the types of sports the network 
broadcasts: baseball and football. The resources available are: 

The resources need to be arranged into the following groups based on the sport type: 

Sources Destinations

Baseball Football
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The Group Category interface would be used to arrange the resources into group categories:

Figure 45  Example of Group Categories Arrangement Based on Sport Type

Once the group categories are defined, the user can perform switches, on a hard or soft panel, 
based on the group categories.

In Figure 46, an RCP-QE18 is used to select the source labeled as HD 3.

Figure 46  RCP-QE18 — Selecting HD 3 via Category Mode

In Figure 47, an Ultrix soft panel is used to select the destination labeled as SAT 1.

Baseball Football
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Figure 47  Ultrix — Selecting SAT 1 via a Soft Panel

Configuring Group Categories
Group categories are arranged in a hierarchy and displayed in a tree view. Each group is 
represented as a folder or node, and the resources included in that group are sub-nodes. Each type 
of resource is represented within the hierarchy as follows: sources are green, destinations are blue, 
and levels are red. Figure 48 also shows two main groups (MV, and SDI) where the SDI group also 
has four sub-groups (Slot1, Slot2, Slot3, and Slot4)

Figure 48  Example of Group Categories Tree View

Configuring group categories requires:

1. Creating group names

2. Assigning destinations, sources, and/or levels to groups

3. Configuring a soft panel or a hard panel for use

Creating Group Names
For each database, you can create multiple category groups and add sub-groups. Once you create 
your groups, resources can be added. Note that by default, the groups are organized alphabetically 
in the tree view.
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To create a category group

1. Double-click the Group Categories node located under the Database node.

The Group Categories tab opens.

2. Select the Group Categories: node.

3. Click Add.

The Add Group dialog opens.

4. In the Name field, type a unique identifier for the new group.

5. Click Apply.

The Add Group dialog closes and the new group is added as a child of the selected node.

In the example below, a new sub-group “Studio 1” was created in the SDI group.

6. Click Apply in the bottom right corner to apply your changes.

To create a category sub-group

1. In the Group Categories tree, select the group icon that you wish to add a sub-group to.

2. Click Add.

The Add Group dialog opens.

3. In the Name field, type a unique identifier for the new sub-group.

4. Click Apply.

The Add Group dialog closes and the new sub-group is added to the Group Categories tree 
view.

In the example below, a new sub-group “Cameras” was created in the Studio 1 group.

5. Click Apply in the bottom right corner to apply your changes.
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To move a group within the tree view

1. In the Group Categories tree, select the group you want to move.

The Move dialog opens. The dialog header displays the name of the selected group to move.

2. Use the tree view in the dialog to select where to move the group to.

3. Click Apply.

The Move dialog closes.

The group displays in the selected position of the tree view.

4. Click Apply in the bottom right corner to apply your changes.

Auto Generating the Groups
You can also choose to create a group based on the levels, sources, and destinations in your 
database or a combination. This requires the virtual labels for each resource to be consistent. For 
example, if all destinations are labeled as Dest x, a group will be created called “Dest” with each 
destination listed as a separate node.

 Auto generating a group will delete the groups currently listed in the Group Categories tree view.

To auto generate a group

1. Click Auto Generate.

The Auto Generate Groups dialog opens.

2. Select the box to include the resources in the group.

3. Click Apply.

The Auto Generate Groups dialog closes and the Group Categories tree updates.

4. Click Apply in the bottom right corner to apply your changes.

Assigning Resources to a Group
You can assign resources (destinations, sources, levels) once a group is configured.
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To assign a resource to a group

1. In the Group Categories tree, select the group you want to add a resource to.

The middle pane of the Group Categories interface updates to list the sub-groups or resources 
assigned to it.

In the example below the area is blank because nothing is assigned to the selected group.

2. In the right pane, select the tab for the type of resource you wish to assign to the group.

In the example above, the Destinations tab was selected.

3. To assign a single resource, select the resource from the tab.

4. To select a series of resources:

a. In the selected tab, select the first resource in the series you want to assign.

b. Press and hold Shift.

c. Click the last row in the series.

5. Click Assign.

The Group Categories tree updates to display the selected resources in the group.

In the example below, Dest 1 to Dest 6 were assigned to the Studio 1 group.
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6. Click Apply in the bottom right corner to apply your changes.

To move a resource to another group

1. In the Group Categories tree, select the resource you want to move.

2. Click Move.

The Move dialog opens.

3. Select the new location for the resource.

4. Click Apply.

The Move dialog closes.

The Group Categories tree updates to display the resource in the new location. Notice that the 
resource is now removed from the original group.

5. Click Apply in the bottom right corner to apply your changes.

To delete a resource from a group

1. In the Group Categories tree, select the specific resource you want to delete from the group.

2. Click Delete.

The Delete dialog opens.

3. Click Yes.

The Delete dialog closes.

The Group Categories tree updates to no longer display the resource in the group. 

4. Click Apply in the bottom right corner to apply your changes.

To delete a series of resources from a group

1. In the Group Categories tree, select the specific group you want to edit.

The middle pane of the Group Categories interface updates to list the sub-groups or resources 
assigned to it.

2. In the middle pane, select the first resource in the series you want to delete.

3. Press and hold Shift.
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4. Click the last row in the series.

5. Click Delete.

The Delete dialog opens.

6. Click Yes.

The Delete dialog closes.

The Group Categories tree updates to no longer display the resource in the group. 

7. Click Apply in the bottom right corner to apply your changes.

Managing the Groups
 You cannot rename resources using the options in the Group Categories interface.

To rename a group

1. In the Group Categories tree, select the specific group you want to rename.

2. Click Rename.

The Rename Group dialog opens.

3. Use the Name field to enter a unique identifier for the selected group.

4. Click Apply.

The Rename Group dialog closes.

The Group Categories tree updates to display the new name for the group. 

5. Click Apply in the bottom right corner to apply your changes.

To delete a group

1. In the Group Categories tree, select the group you want to delete.

2. Click Delete.

The Delete dialog opens.

3. Click Yes.

The Delete dialog closes.

The Group Categories tree updates to no longer display the group. 

4. Click Apply in the bottom right corner to apply your changes.

Cat/Index Categories Overview
Category Index category mode (also referred to as Cat/Index mode), allows alpha-numeric 
extensions to labels to “build up” the final label selection. For example, VTR 1 - 6 may be expressed 
as a VTR label with numerical extensions 1 through 6. Similarly, alpha extensions may be used, for 
example, VTR A - E for VTRs A through E.

Destination and source names are split into substrings - the first substring is referred to as the 
category, and subsequent substrings as the indexes (e.g. Category VTR index 1 through 6). As 
source/destination names become more complex, an index may not be the final part of the 
selection name. For example, consider the source names CG TX 1 and CG TX 2; Cat/Index category 
mode may be configured so that a user selects CG, then TX, then either 1 or 2. This may be 
extrapolated to cover a large range of sources and destinations.
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Example of a Cat/Index Category Setup

The following resources are available: 

The possible categories and indexes would be: 

Once the Cat/Index categories are defined, the user can perform switches, on a hard or soft panel, 
based on the categories. In Figure 49, a RCP-QE18 is used to select the source labeled as CAM 3. 
Note only the sources are available for the second button selection. In this example, the user would 
need to select TAKE to make the switch.

Figure 49  RCP-QE18 — Selecting CAM 3 via Category Mode

Sources / Destination Names

Categories Indexes

CAM_a

a.The “_” characters represents a blank space. This indicates the 
category will filter resources with a space in the name (e.g. the CAM_ 
category will allow resources named CAM 1, CAM 2 but not CAM3).
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SAT_ 2 A E

CG_ 3 B RX_

EDIT_ 4 C TX_

VTR
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In Figure 50, an Ultrix soft panel is used to select the destination labeled as CG RX 2.

Figure 50  Ultrix — Selecting CG RX 2 via a Soft Panel

Configuring a Cat/Index Category Setup
Configuring Cat/Index categories requires:

1. Assigning categories

2. Assigning indexes

3. Configuring a soft panel or a hard panel for use

Assigning Categories
You can assign each destination to a specific category or multiple categories in a database. Using 
multiple categories enable you to filter the destinations, and organize them into logical groups. By 
default, categories are organized in alphabetical order.

To auto generate categories based on a database

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens.
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2. Click Generate.

The Auto-Generate dialog opens.

3. Click Yes.

The Auto-Generate dialog closes.

All previous categories are deleted from the Categories pane and new ones are listed based on 
the resource labels in your database.

4. Click Apply.

To manually create categories

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens

2. Click Add (located next to the Categories pane).

The Add Category dialog opens.

3. Use the Name field to specify a unique identifier for the new category.

 The entry must match a resource name prefix.

For example:

• “CG_” creates a category to categorize resources named CG_xxxx where xxxx is any index.
• “CG” creates a category to categorize resources named CGxxxx where xxxx is any index.
• “cg” will not categorize any resources as the category names are case sensitive.

4. Select the Insert trailing space box to represent a space character with the “_” symbol.

5. Click Apply.

The Add Category dialog closes.

The new category is listed in the Categories pane.

6. Click Apply.
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To create a category for a specific resource type

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens.

2. Click Create for the resource type you wish to filter. 

The Create Category/Index dialog opens.

3. Use the Category Name field to specify the characters for the new index filter. 

 The entry must match a partial resource name.

4. Select the Insert trailing space box if you wish to include trailing spaces in the filter.

5. Click Apply.

The Create Category/Index dialog closes.

6. Click Apply.

Assigning Index Filters
An index for a category enables you to filter resources. As category names and indexes are entered, 
the Affected Resources pane in the interface will update to indicate which sources or destinations 
of a given category is accessible on a control panel. Select a name in the Categories pane to see 
which source or destinations are in that category and filtered by the available Indices pane. 

To assign an index filter

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens.

2. Click Add (located next to the Indices pane).

The Add Index dialog opens.

3. Use the Name field to specify a new index filter. 

 The entry must match a partial resource name.

For example:

• “TX_” creates a sub-index of TX, meaning further entry is required on the control panel. This 
will filter resources named <category name>TX_xxxx where xxxx is any index.

• “TX 1” creates an ‘end-point’ index, meaning TX 1 is the last substring and no further entry is 
required on a control panel. This will filter resources named <category name>TX 1.

• Note that you would not create an index of “TX 1” and a sub-index of “TX_”. You must choose 
one or the other.

4. Click Apply.

The Add Index dialog closes.

The new index filter is listed in the Indices pane.

5. Click Apply.

To assign an index filter for a specific resource type

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens.

2. Click Create for the resource type you wish to filter. 

The Create Category/Index dialog opens.



Ultrix User Guide (v23.0) Using Categories • 193

3. Use the Index Name field to specify a unique identifier for the new index filter.

 The entry must match a partial resource name.

4. Select the Insert trailing space box if you wish to include trailing spaces in the filter.

5. Click Apply.

The Create Category/Index dialog closes.

6. Click Apply.

Legacy Categories Overview
Legacy Category mode allows some category functionality on legacy RCP-QE control panels (17 
button). There is no soft panel for Legacy Category Mode. Legacy mode is similar in operation to 
Group category mode with some elements of the index functionality of the Cat/Index Category 
mode.

Keep the following in mind when using legacy category mode:

• A destination or source cannot be in more than one category
• Only numerical indexes are supported

For More Information on...
• legacy category mode, refer to the RCP-QE User Guide.

Configuring Legacy Categories
Source and destination selection may be achieved in two ways: direct selection or numerical index 
entry. The setup of the Ultricore Category tables determines the operational functionality.

For More Information on...
• Category mode for the Ultricore, refer to the Ultricore User Guide.

Category Direct Selection Mode
Figure 51 illustrates the Categories configured in the Ultrix database for direct selection mode.

Figure 51  Ultrix — Entries in the Legacy Categories Tab

Figure 52 illustrates direct destination entries and the resulting available destinations in the 
selected category.
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Figure 52  Ultrix — Resulting Operation on a Remote Control Panel

To set up direct selection in categories

1. Expand the Database node in the Tree View.

2. Double-click the Legacy Categories node.

3. Click Destination or Source as required.

4. Type the text for a category name in the Category 1 column for each row that is required to be 
in that category.

5. Copy the items in the name column to the Category 2 column.

This will result in those rows being within the category you named in column Category 1.

 You can use keyboard shortcuts such as Ctrl+C (copy) and Ctrl+V (paste) and Shift+click to select 
a range for ease of data entry.

Numerical Index Entry Mode
Figure 53 illustrates the Categories configured in the Ultrix database for numerical entry mode

Figure 53  Ultrix — Entries in the Legacy Categories Tab

Because we have set the VTRs numbered 6 through 10 in Figure 53, the Ultrix expects a two digit 
entry signified by the two underlines on the button next to the category name. As only numerals 1 
or 0 are the only possible entries to make for the first digit, the Ultrix has blanked the invalid entry 
keys. (Figure 54)

To select VTR 6, press 0 then the remaining available numbers will become available, then press 6 to 
finish the selection. 

Figure 54  Ultrix — Resulting Operation on a Remote Control Panel
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To set up numerical index selection in categories

1. Expand the Database node in the Tree View.

2. Double-click the Legacy Categories node.

3. Click Destination or Source as required.

4. Enter a category name in the Category 1 column for each row that is required to be in that 
category. For example, in Figure 53 the user entered “VTR”.

5. Enter a number in the Category 2 column.

This will result in those rows being within the category you named in the Category 1 column. 
These destinations are accessible via entering the numerical extension of the required 
destination. For example, in Figure 53 the user entered “6” for row 5.

Creating a Soft Panel with Categories
Once you have defined your categories and tags for each level of a database, you can create a 
custom soft panel using the category settings as a basic for arranging the sources, destinations, and 
levels. This topic is covered in the section “Using Category Panels”.
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Soft Panels in DashBoard
A soft panel is a software implementation of a physical remote control panel (RCP). The soft panel 
configurations are part of a database so any instance of DashBoard connecting to a given Ultrix 
router has the defined soft panels available. You can customize a soft panel by defining the sources, 
destinations, levels, and/or salvos that will be available on the panel interface. The Ultricore Control 
Mode in the Ultrix router provides four types of soft panels for router control:

• Matrix — the destinations and sources are organized into a grid layout.
• MultiBus — the destinations and sources are organized into separate a rows (buses) of buttons.
• Group Category — the destinations and sources are grouped by pre-defined categories.
• Cat/Index Category — the resources are defined using a defined set of search criteria (indexes).
• Ultritouch PB — the resources are organized into a customized layout that is pre-sized for an 

Ultritouch hard panel. Refer to the Ultritouch + Ultrix User Guide for details.
• Push Button — similar layout and features of the Ultritouch PB panel but sized for use on a 

computer monitor.
• Ultritouch_MV — enables you to control Multiviewer layouts, switch PiPs, and modify 

follow/non-follow modes directly from an Ultritouch panel. This feature is not supported when 
the router is in a system that is controlled by an Ultricore CC or Ultricore BCS. Refer to the 
Ultritouch + Ultrix User Guide for details.

 For information on the Audio Mixer soft panel options, refer to “ULTRIMIX-MXR”.

Before You Begin
Keep the following in mind when managing your soft panels in DashBoard:

• Soft panels require the setup of the database source/destinations/levels and port assignment to 
be complete.

• If the database changes (source/destination/level/salvo addition or deletion), you will need to edit 
the soft panel configuration to ensure the correct sources/destinations/levels/salvos are visible.

• Ultrix does not support Unicode characters.

For More Information on...
• databases, refer to “Database Configuration”.

Soft Panels Overview
A soft panel is created using the options in the Panels interface for your database. Soft panels are 
listed as sub-nodes under the Soft Panels node in the Tree View of DashBoard. Double-click a 
sub-node to display the corresponding soft panel in the DashBoard window. The hierarchy of the 
nodes in the tree is determined by their Panel ID which is assigned when the soft panel is created in 
the database. In Figure 55 there are seven soft panels in the tree view.
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Figure 55  Example of a Soft Panels Tree View

A soft panel can be as simple or complex in its layout as you require. The Panels interface enables 
you to specify the number of destinations, sources, levels, and salvos displayed on your panel. You 
select one of six soft panel types and specify the elements of the soft panel including giving the 
panel a unique name. 

For More Information on...
• Matrix panels, refer to “Using Matrix Panels”.
• Multibus panels, refer to “Using MultiBus Panels”.
• Category panels, refer to “Using Category Panels”.
• Ultritouch PB panels, refer to the Ultritouch + Ultrix User Guide.
• Push Button panels, refer to “Using Push Button Panels”.
• Audio Mixer panels, refer to “Creating Audio Mixer Soft Panels”.

Enabling Machine Control
Typically, the ports on a data router (such as the NK-M series routers) are bi-directional where there 
is both a transmit (input to output) and reciprocal receive connection that is made for each port. For 
example, a switch from port 1 to port 2 involves a forward path (from port 1 input to port 2 output) 
and the reciprocal connection from (port 2 input to port 1 output).

In some cases however, there is a need to connect on the port’s input to several ports’ output (e.g. 
one device commanding many target devices) without making the reciprocal connection. This 
allows the commanding device to just broadcast commands and not receive from the many devices 
it communicates with. 

When configuring a soft panel, you have the option to add a Machine Control button to the panel. 
When selected on the panel, this Machine Control button sends a Take request directed to an NK-M 
series data router to automatically make the reciprocal port switch. On a video router, the 
connection is all one way from an input port to an output port (e.g. such as from IN 1 to OUT 2). 

Creating a Soft Panel
Soft panels are listed under the Soft Panels node in a hierarchy as determined by their Panel ID. 
When you create a new soft panel, you select from the existing soft panel types. You then assign a 
Panel Name and ID to display in the tree view using the nomenclature “Panel Name [#]” where 
[#] is the Panel ID.

 A Default Panel is available that is a MultiBus style with 1 level, 4 destinations, and 4 sources.

To create a soft panel

1. Double-click the Panels node located under the Database node.

The Panels tab opens.
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2. Click Edit > Add.

The Add Panel dialog opens.

3. Type a unique identifier in the Name field. This will be used to identify the panel in the tree 
under the Soft Panels node.

4. Use the Style menu to specify the type of panel to create. Choose from the following:

• Matrix — Creates a soft panel that organizes the destinations and sources in a grid layout.
• MultiBus — Creates a soft panel where destinations and sources are organized into separate 

buses.
• Group Category — Creates a soft panel where the hierarchy of the destinations and sources 

are determined by the values in the Group Categories tab. Refer to “Using Categories” for 
details.

• Cat/Index Category — Creates a soft panel where the hierarchy of the destinations and 
sources are determined by the values in the Cat/Index Categories tab. Refer to “Using 
Categories” for details.

• Push Button — Creates a soft panel that organizes the destinations and sources in a distinct 
vertical layout.

• Ultritouch PB — Creates a soft panel that is used on an Ultritouch hard panel. Refer to the 
Ultritouch + Ultrix User Guide for details.

5. Click Apply to save your settings and close the Add Panel dialog.

The new panel name is added to the Saved Panels list of the Panels tab and automatically 
selected in the tab for editing. In the example below, the user created “Panel_LS01”.

6. Select the Info tab.
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7. Use the Panel ID menu to determine the position of the panel in the Soft Panels tree where a 
value of “1” is the highest priority (and listed at the top).

 Ensure that the new soft panel does not use the same Panel ID as a previously saved soft panel.

8. Use the Description field to provide a textual summary of the panel. 

9. Use the Protection Operation menu to provides options for preventing crosspoint switches. 
Choose from the following:

• Enable — The Lock, Protect, and Free buttons display on the soft panel. Refer to “Using 
Matrix Panels” or “Using MultiBus Panels” for a description of these buttons. 

• Disable — The Lock, Protect, and Free buttons do not display on the soft panel. These 
protection options are not available for the soft panel.

10. Use the Take Operation menu to configure the Take button for the soft panel. Choose from 
the following:

• Confirm — Displays a Take button on the soft panel. You must select Take to perform a 
crosspoint switch.

• Direct — The soft panel does not display a Take button. A crosspoint switch occurs 
automatically after each destination/source selection is made by the user on the soft panel.

11. If you selected MultiBus in step 4, use the Selection Operation menu to enable multiple 
crosspoint/level selections and display the Multi Select button. Choose from the following:

• Single — Disables this feature. The Multi Select button does not display on the soft panel.
• Multi — The Multi Select button displays on the soft panel.

12. Use the Machine Control menu to control whether a Take request directed to an Ross NK-M 
series data router automatically makes a reciprocal port switch. Choose from the following:

• Enable — Displays a Machine Control button on the soft panel. You must select Machine 
Control to enable the reciprocal port switch on the NK-M series router.

• Disable — The soft panel does not display a Machine Control button. This is the default 
setting.

13. If you set the Style to Push Button, proceed to “Configuring a Push Button Soft Panel”.

14. If you set the Style to Group Category, use the Nongroup Resources options to determine if 
resources that are not assigned to a specific group are not displayed on the soft panel (Hide), or 
if all resources are displayed on the soft panel (Show).

15. Click Apply to save your new soft panel.

The new panel displays in the Soft Panels tree. In the example below, there are seven soft 
panels in the tree view. Note that the Priority ID is the value displayed in the [#] brackets.

16. Continue to the next sections to add levels, destinations, sources, and salvos to your soft panel 
as required.

Levels for the Soft Panel
You can specify the total number of levels available on the soft panel to the user. For example, if 
you set the Viewable levels to 6 but have assigned 8 levels to the panel, only the first six levels in the 
Assigned list are displayed. You can also specify the order in which the levels are displayed on the 
soft panel.

To specify the levels for the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Levels tab.

3. Use the Viewable levels field to specify the total number of levels for the soft panel.
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4. To add a level to the soft panel:

a. From the Available list, select the level(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected level(s).

5. To assign all the available levels in the database to the soft panel, click .

6. To assign multiple levels to the soft panel:

a. From the Available list, select the first level you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other level(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected levels.

7. Use the provided buttons beside the Assigned list to determine the order in which the levels 
are displayed on the soft panel.

8. Click Apply at the bottom of the Panels tab to save your settings.

Destinations for the Soft Panel
You can create a soft panel with a specified number of destinations and determine the order in 
which they are displayed in the crosspoint row of the panel. For example, the router may have 32 
destinations but you only want to make the first 4 outputs selectable on the crosspoint row of your 
soft panel. You would then set the Viewable destinations to 4. You can also specify the order in 
which the destinations are displayed on the soft panel.

To specify the destinations for the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Destinations tab.

3. Use the Viewable destinations field to specify the total number of destinations for the soft 
panel.

4. To add a destination to the soft panel:

a. From the Available list, select the destination(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected destination(s).

5. To assign all the available destinations in the database to the soft panel, click .

6. To assign multiple destinations to the soft panel:

a. From the Available list, select the first destination you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other destination(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected destinations.

7. Use the provided buttons beside the Assigned list to determine the order in which the 
destinations are displayed on the soft panel.

8. Click Apply at the bottom of the Panels tab to save your settings.
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Sources for the Soft Panel
You can create a soft panel with a specified number of sources and determine the order in which 
they are displayed in the crosspoint row of the panel. For example, the router may have 64 sources 
but you only want to make the first 12 inputs selectable on the crosspoint row of your soft panel. 
You could set the Viewable sources to 12 or assign only those 12 inputs to the soft panel. You can 
also specify the order in which the sources are displayed on the soft panel.

To specify the sources for the soft panel

1. Double-click the panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Sources tab.

3. Use the Viewable sources field to specify the total number of sources for the soft panel.

4. To add a source to the soft panel:

a. From the Available list, select the source(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected source(s).

5. To assign all the available sources in the database to the soft panel, click .

6. To assign multiple sources to the soft panel:

a. From the Available list, select the first source you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other source(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected sources.

7. Use the provided buttons beside the Assigned list to determine the order in which the sources 
are displayed on the soft panel.

8. Click Apply at the bottom of the Panels tab to save your settings.

Salvos for the Soft Panel
Before you can add salvos to a soft panel, you must configure them as outlined in “Creating 
Salvos”. 

To specify the salvos available on the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Salvos tab.

3. Use the Viewable salvos field to specify the total number of salvos for the soft panel.

4. To add a salvo to the soft panel:

a. From the Available list, select the salvo you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected source(s).

5. To assign all the available salvos in the database to the soft panel, click .

6. To assign multiple salvos to the soft panel:
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a. From the Available list, select the first salvo you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other salvo(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected salvos.

7. Use the provided buttons beside the Assigned list to determine the order in which the salvos 
are displayed on the soft panel.

8. Click Apply at the bottom of the Panels tab to save your settings.

Copying a Soft Panel
 Ensure the soft panel is currently not in use.

To copy a soft panel

1. Double-click the Panels node located under the Database node.

The Panels tab opens.

2. From the Panels list in the left toolbar, select the soft panel to copy.

3. Click Edit > Copy.

4. Click Edit > Paste.

The Panels tab updates to display the settings for the selected soft panel. New soft panels are 
automatically named “New Panel #” where # is an auto-generated value.

5. Select the Info tab.

6. Type a unique identifier in the Panel Name field. This will be used to identify the panel in the 
tree under the Soft Panels node.

7. Click Apply at the bottom of the Panels tab to save the new panel. This also helps to ensure that 
you do not mistakenly edit the original panel that you copied.

Editing a Soft Panel
Once you edit a soft panel, you must re-load the soft panel if it was in use prior to the edit.

 Ensure the soft panel is currently not in use.

To edit a soft panel

1. Double-click the Panels node located under the Database node.

The Panels tab opens.

2. From the Panels list in the left toolbar, select the soft panel to edit.

The Panels tab updates to display the settings for the selected soft panel. 

3. Edit the settings for the panel using one of the following procedures:

 You cannot edit the Panel Style of a soft panel.

• “To specify the levels for the soft panel”
• “To specify the destinations for the soft panel”
• “To specify the sources for the soft panel”
• “To specify the salvos available on the soft panel”

4. Click Apply at the bottom of the Panels tab to save the new settings.
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5. If a dialog opens to remind you that the affected soft panel is currently in use:

a.  Click OK to close the dialog.

b.  Perform the procedure “To re-load a soft panel”.

To re-load a soft panel

1. Close the newly edited soft panel as follows:

a. Locate the tab for the soft panel in the DashBoard client window.

b. Click  to close the tab.

2. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

3. Double-click the node for the newly edited soft panel.

The tab for the selected soft panel opens.

Deleting a Soft Panel from the Database
 Ensure the soft panel is currently not in use.

To delete a soft panel from the database

1. Double-click the Panels node located under the Database node.

The Panels tab opens.

2. Select the soft panel name from the Panels list in the left toolbar.

3. Click Edit > Delete.

4. Click Apply at the bottom of the Panels tab.

Using the Lock and Protect Features
Whether your soft panel includes the Lock and Protect features depends on the panel type. The 
Matrix and Category panels can include the Lock, Protect, and Free buttons. The MultiBus panels 
can include only the Lock button. Matrix and Category soft panels must have their Protection 
Operation set to Enable to display these buttons.

For More Information on...
• the Protection Operation, refer to Table 91.

Using a Lock
If your soft panel includes a Lock button, you have the option to protect source/level and 
destination/level pairs. When another control panel or DashBoard client attempts to switch that 
combination, the request will be denied.

To lock a source/level pair

1. Display the soft panel in the DashBoard window.

2. Select the source/level pairs from the soft panel interface.

3. Click Lock.

The label on the button changes to Unlock and the button remains lit.

To lock a destination/level pair

1. Display the soft panel in the DashBoard window.

2. Select the destination/level pairs from the soft panel interface.
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3. Click Lock.

The label on the button changes to Unlock and the button remains lit.

To clear a lock

• Click the Unlock button.
The label on the button changes to Lock and the button remains lit.

Using a Protect
A soft panel can be locked by clicking the Protect button. The button is lit until pressed again. A 
protect alarm message is displayed in the System Status tab when an output is protected.

This feature protects the currently selected destination/level pair from use by other sources, as well 
as from other linked panels. The Protect button is especially useful in instances where a 
destination must be held after a switch has been made.

To apply a protect

• Click Protect.
The button is lit. Selecting crosspoints will not take effect and the panel does not update when 
buttons are pressed.

To clear a protect

• Click Protect.
The button is no longer lit and crosspoint switches can be initiated.

Using Matrix Panels
Matrix panels enable you to perform direct take transitions, and local salvo definitions using a grid 
of sources and destinations.

Panel Interface Overview
Each level is represented as a button in the color defined in the current database. Notice that the 
crosspoints are represented in the same color as the applicable level. 

Figure 56  Example of a Matrix Panel
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1. Crosspoints

The number of Destinations and Sources and their labels in the matrix are specified using the 
Destinations and Sources interfaces. Click within the matrix or click the Destination and Source 
buttons to select the crosspoints for switching the selected levels. In Figure 56, crosspoints were 
selected using the Advanced > Diagonal Presets option. 

2. Levels Button

Click a level button to include that level in the next crosspoint switch. A lit button indicates that 
the corresponding level will be included in the next transition. The color and name of the button 
are specified using the Levels interface. Figure 56 illustrates a Matrix panel with nine levels 
selected.

3. Follow Button

Click this button to select all levels in the matrix. Clicking TAKE after pressing Follow will then 
switch all crosspoints at the same time on all available levels.

TAKE Button (not shown)

Click this button to execute the switch between crosspoints. If you are using a soft panel with the 
Take Operation was set to Direct, a TAKE button is not displayed because the transitions will 
occur automatically after a crosspoint switch is selected.

4. Lock Button

Click this button to prevent switching of the selected crosspoints. When creating the soft panel, if 
the Protection Operation was set to Disable, the Lock and Protect buttons are not displayed.

5. Protect Button

Click this button to prevent switching of the selected crosspoints except in the DashBoard client 
session the Protect was initiated in.

6. Free Button

Click this button to end a lock or protect on the selected crosspoints.

7. Salvo Button

Click this button to display the Salvo menu. Refer to “Salvo Menus” for menu options.

8. Advanced Button

Click this button to display the Advanced menu. Refer to “Advanced Menus” for menu options.

Machine Control Button (not shown)

If you are using a soft panel with the Machine Control set to Enabled, the MACHINE CONTROL 
button is displayed. Refer to “Enabling Machine Control” for details on this button.

9. Find Button

Click this button to quickly navigate to known source or destination names.

10.Filter Button

Click this button to reduce the number of source and/or destinations visible in a matrix panel. 
This enable a user to filter a matrix panel view to only source/destinations that match entered 
text.

11.Show Take Errors Button

Click this button to display a summary of the number of failed TAKE transitions.
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Status Quick Navigation
In multi-level systems, the status of any given crosspoint can often be such that a matrix style soft 
panel cannot show all levels. 

Figure 57  Example of Crosspoint Status in a Matrix Panel

In Figure 57, destination DST1 only shows status for the green level. It cannot show the red/blue 
levels status' as the relevant sources are outside the current view.

Right clicking the destination button/label will re-center the source buttons to the next level status. 
Subsequent right-clicking the destination button will cycle to the next level status indicator. (Figure 
58)

Figure 58  Example of a Cycled Status Indicator

Find Dialog
The Find dialog helps you to quickly navigate to known source or destination names. 

Figure 59  Example of the Find Dialog

To access the Find dialog

1. Within the matrix panel control area, click Find.

The Find dialog opens.

2. From the Find in List menu, choose either Source or Destination as required.

3. Type the text to search for in the Find what field.

In Figure 57, the user entered out.

4. If an exact string match is required, select the Exact Match box.

5. If text case matching is required, select the Match Case box.

6. Click Next to begin the search.

The Matrix panel updates to the first match.
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7. Click Next again to navigate to subsequent matches.

8. Click  to navigate to previous matches.

9. Click Close to close the dialog. 

The Matrix panel view will remain with the last match in the middle of the matrix panel view.

Filter Dialog
Use the Filter dialog to reduce the number of source and/or destinations visible in a matrix panel. 
This enable a user to filter a matrix panel view to only source/destinations that match entered text.

 The filter matches any consecutive characters and ignores the case. For example, typing at will 
match to CAT, hat, ATT etc.

Figure 60  Example of the Filter Dialog

To use the Filter dialog

1. To filter the destinations:

a. Enter the filtering text in the Destination field as required.

b. Click  to enable destination filtering.

The Matrix panel view updates to display only those destinations matching the entered text.

2. To filter the sources:

a. Enter the filtering text in the Source field as required.

b. Click  to enable source label filtering.

The Matrix panel view updates showing only those destinations matching the entered text.

3. Click  to clear the associated filter text field.

4. Click Clear All to clear both filter text fields.

5. Click Close to close the Filter dialog.

Crosspoint Switches via a Matrix Panel
Crosspoint selections can be made using the cross-hairs or clicking the required Destination and 
Source buttons on the panel. This section provides instructions using the cross-hairs for crosspoint 
selections.



Ultrix User Guide (v23.0) Soft Panels in DashBoard • 209

To make a crosspoint switch using a single level

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for a matrix soft panel.

The Matrix Panel tab opens.

3. Select a level from the toolbar.

The button is now lit.

4. Select the source and destination intersection inside the matrix.

The selection is represented as an icon set in the color that matches the level. In the example 
below, Level 2, Src 4, and Dest 2 are selected. The TAKE button is now lit.

5. Click TAKE.

The icon on the matrix is solid in the color that matches the level and the TAKE button is no 
longer lit.

To make a crosspoint switch between multiple sources and destinations on a single level

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for a matrix soft panel.

The Matrix Panel tab opens.

3. Select a level from the toolbar.

4. Select the first source and destinations inside the matrix.

 Right-click a destination button to jump to the next pie slice.

5. Select the additional crosspoints to switch.

In the example below, Level 2 is selected but seven crosspoint switches are also selected (each 
is represented with a green icon on the matrix).
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6. Click TAKE.

The icons on the matrix are solid in the color that matches the level and the TAKE button is no 
longer lit.

To make a crosspoint switch using multiple levels

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for a matrix soft panel.

The Matrix Panel tab opens.

3. Select each level from the toolbar or click Follow to include all levels.

4. Select the first source and destination inside the matrix.

5. Select the additional crosspoints to switch.

When multiple levels are selected, the circle on the crosspoint is divided into colored sections 
with each section representing a level. In the example below, Levels 2, 4, and 6 are selected; 
each with multiple crosspoint selections on the matrix.

6. Click TAKE.
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The icons on the matrix are solid in the color that matches the level and the TAKE button is no 
longer lit.

To perform a crosspoint switch on multiple destinations with a single source

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for a matrix soft panel.

The Matrix Panel tab opens.

3. Select each level from the toolbar or select Follow to include all levels.

4. Click Select All located at the top left corner of the interface.

All the Dest buttons on the Matrix panel are now lit and selected.The Select All button is 
labeled Clear All.

5. From the top toolbar, select the Src button to switch.

The matrix updates to indicate the crosspoint switches that will occur on the next transition to 
the same source and the TAKE button is now lit. In the example below, Levels 2, 4 and 6 are 
selected; all destinations will switch to Src 4.

6. Click TAKE.

The icons on the matrix are solid in the color that matches the level and the TAKE button is no 
longer lit.

Using a Default Preset
The Advanced menu provides two pre-configured presets: Diagonal and R-Diagonal.

Diagonal Presets

Crosspoint selection is organized into a diagonal line that starts with the top left corner of the 
matrix (e.g. Src 1 and Dest 1), continues in single step intervals (e.g. Src 2 and Dest 2, Src 3 and 
Dest 3 etc.) and ends with the bottom right corner of the matrix (e.g. Src 16 and Dest 16). 

To use the Diagonal Preset

1. Select each level from the toolbar or select Follow to include all levels.

2. Click Advanced > Diagonal Presets.
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3. Click TAKE.

R-Diagonal Presets

Crosspoint selection is organized into a diagonal line that starts with the top right corner of the 
matrix (e.g. Src 16 and Dest 1), continues in single step intervals (e.g. Src 15 and Dest 2, Src 14 and 
Dest 3 etc.) and ends with the bottom left corner of the matrix (e.g. Src 1 and Dest 16). 

To use the R-Diagonal Preset

1. Select each level from the toolbar or select Follow to include all levels.

2. Click Advanced > R-Diagonal Presets.

3. Click TAKE.
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Creating an Automatic Switching Loop
The Automation feature enables you to set up a crosspoint and create a continuous switch loop 
using the specified crosspoints.

To set up an automated crosspoint selection loop

1. Click Advanced > Setup Automation.

The Automation Setup menu opens.

2. Use the Repeat Interval field to specify the number seconds the crosspoint switch will 
continuously loop for.

3. Use the Levels menu to specify the levels the crosspoint will include.

4. Use the Destinations menu to select the outputs on the router.

5. Use the Sources menu to select the input signals to route to the output for the switch.

6. Click Start.

The menu closes and the crosspoint switch begins. The loop continues for the length of time 
specified in step 2.

 To instantly stop the loop, click Advanced > Stop Automation.

Clearing the Matrix Selections
You can choose to clear all the crosspoint selections, or only the selected Destinations.

To clear all crosspoint selections on the matrix

• Click Advanced > Clear All Presets.

To clear only the Destination selections on the matrix

• Click Advanced > Clear Dest Presets, or
• Click Clear All.
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Using MultiBus Panels
Use the MultiBus Panel to send a source to multiple destinations.

Panel Interface Overview
The MultiBus Panel provides breakaway control and status monitoring of several destinations 
simultaneously. 

Figure 61  Example of a MultiBus Panel

1. Destination Bus

Each button in this crosspoint row represents a configured output for the selected router. 
Selecting a button includes the destination in the next crosspoint switch. The number of 
destinations and label for each button is defined by its entry in the Destinations interface. A 
destination selected to be included in the next crosspoint switch will have a lit button. For 
example, Dest 2 is selected in Figure 61.

2. Lock Button

Click this button to prevent switching of the selected crosspoints. If you are using a soft panel 
with the Protection Operation set to Disable, the Lock button is not displayed.

3. Take Button

Click this button to execute the switch between the selected crosspoints. If you are using a soft 
panel with the Take Operation set to Direct, a TAKE button is not displayed because the 
transitions will occur automatically after a crosspoint switch is selected.

4. Preset Button

When this button is lit, a new crosspoint switch is set up on the soft panel. At least one source, 
once destination, and one level are selected on the interface (the Dest and Src buttons are lit 
blue to indicate their inclusion in the next switch). 

When this button is not lit, the crosspoint switch setup is still valid but is no longer indicated on 
the soft panel.

If you are using a soft panel with the Take Operation set to Confirm, the crosspoint switch will 
take effect the next time the TAKE button is selected. If you are using a soft panel with the Take 
Operation set to Direct, a TAKE button is not displayed because the transitions occurred 
automatically (hot-punch operation).
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5. Clear Button

Clicking this button clears the selections made for the next crosspoint switch in the soft panel 
interface.

6. Multi Select Button

Clicking this button enables you to perform a switch on multiple crosspoint combinations. If you 
are using a soft panel with the Selection Operation set to Single, a Multi Select button is not 
displayed.

7. Level Button(s)

Click a level button to include the level in a crosspoint that you are configuring in the matrix. A lit 
button indicates that the corresponding level will be included in the next transition. The color and 
name of the button are specified using the Levels interface. Figure 61 illustrates a MultiBus 
panel with three levels selected.

8. Follow Button

Click this button to select all levels in the matrix. If you are using a soft panel with the Take 
Operation set to Confirm, pressing TAKE after pressing Follow will then switch all crosspoints at 
the same time on all available levels.

9. Source Bus

Each button in this crosspoint row represents an input in the routing system. Selecting a button 
includes the source in the next crosspoint switch. The label for the button is defined by its entry 
in the Sources tab of the Database. A source selected to be included in the next crosspoint switch 
will have a lit button. For example, in Figure 61 the Src 1 is selected for the next transition while 
the Src 4 is the current source in use. 

10.Machine Control Button (not shown)

If you are using a soft panel with the Machine Control set to Enabled, the MACHINE CONTROL 
button is displayed. Refer to the section “Enabling Machine Control” for details on this button.

Crosspoint Switches via a MultiBus Panel
The layout of a MultiBus panel is similar to a production switcher layout where the destinations are 
arranged into a horizontal row of buttons near the top of the panel and the sources are arranged 
on the row near the bottom. 

To make a crosspoint switch on a single level using a MultiBus panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for your MultiBus Panel.

The MultiBus Panel tab opens.

3. From the left toolbar, select the button for the level you want to perform the crosspoint switch.

4. Select a Src button from the Source bus located at the bottom of the interface.

The button is now lit.

5. Select a Dest button from the Destination bus located at the top of the interface.

The Dest, Preset, and Take buttons are now lit.

In the example below, Level 2 is selected and Dest 4 will switch with Src 6. The Src 1 button is lit 
green to indicate that Source 1 was used in the last crosspoint switch.
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6. Click Take.

To make a crosspoint switch using multiple levels

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for a MultiBus Panel.

The MultiBus Panel tab opens.

3. Select each level from the toolbar or select Follow to include all levels.

When multiple levels are selected, the center row of the panel reports the level status using a 
horizontal bar to represent the level.

4. Select a Src button from the Source bus located at the bottom of the interface.

The button is now lit.

5. Select the Dest buttons for the outputs to include in the crosspoint switch.

The Dest, Preset, and Take buttons are now lit. In the example below, Follow is selected and 
Dest 5 will switch with Src 4 on all levels.

6. Click Take.

Using the Multi Select Function
Use the Multi Select button when you want to group multiple destinations to use a single source 
during the next crosspoint switch. 
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To use the Multi Select 

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for a MultiBus Panel.

The MultiBus Panel tab opens.

3. Select the level(s) from the left toolbar.

4. Click Multi Select.

The Multi Select button is now lit.

5. Select the Dest buttons from the Destination bus located near the top of the interface.

The Dest buttons are now lit.

6. Select a Src button from the Source bus located near the bottom of the interface.

The Src, Preset, and Take buttons are now lit.

In the example below, Levels 2 and 3 are selected, and Dest 2, 3, and 5 will switch with Src 6.

7. Click Take.

Using Category Panels
Category panels organize sources, destinations and levels based on the settings in the Category tab. 
There are two types of category panels: group and classic. This section outlines both types.

For More Information on...
• legacy categories, refer to the RCP-QE User Guide.
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Panel Interface Overview
The soft panel interface for each category type is similar in layout and available buttons. 

Figure 62  Example of a Group Category Soft Panel for an Ultrix Router

1. Group Window

This area of the soft panel interface may include the following buttons:

› SOURCES, DESTINATIONS Buttons — Clicking one of these buttons updates the button matrix 
to display the sources or destinations available as per the selected category. The button labels 
update to display the source or destination labels.

› BACK Button — Click this button to return the navigation to the previous category selection 
(back one level).

› RESET Button — Click this button to clear all selections on the interface. This button is only 
available on the Classic Category soft panels.

› SELECT Button — This button is only available on the Classic Category soft panels.
› TOP Button — This button is only available on the Group Category soft panels.

When using a Group Category soft panel and the Info > Non-group Resources setting is set to 
Hide, only the resources assigned to a group are displayed on the soft panel.

2. Status Window

The bottom right corner of each soft panel includes a status window. For each level in the list of 
available levels, a corresponding status indicator display will indicate the current source for the 
currently selected destination.

The following buttons are located on the right-side of the soft panel interface:

› Individual Level Buttons — Click a level button to include the level in a crosspoint that you are 
configuring in the matrix. A lit button indicates that the corresponding level will be included in 
the next transition. The color and name of the button are specified using the Levels interface.

› CURRENT button — This button updates the level display area to show the current status for 
all displayed levels.

› FOLLOW Button — Click this button to select all levels in the matrix. Clicking TAKE after clicking 
Follow will then switch all crosspoints at the same time on all available levels.

› PENDING button — This button updates the level display area to show status for the currently 
pending operation (if selected source has not been switched yet. e.g. before TAKE is pressed). 
The user may clear individual source selections by selecting the levels to be cleared, then 
pressing CLEAR SRC SEL button.
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› CLEAR Button — Click this button to clear all selections on the interface.
› USER button — This button shows current lock/protect status of each levels (and the soft panel 

name that is currently owned it). Since the soft panel does not recognize the names of remote 
control panels (RCP) to retrieve their name, a “owner #” name is used. 

3. TAKE Control Area

The bottom toolbar of the soft panel interface includes the following buttons:

› PROTECT Button — Click this button to prevent switching of the selected destination except by 
the panel that initiated the protect. If you are using a soft panel with the Protection Operation 
set to Disable, the Protect button is not displayed.

› LOCK Button — Click this button to prevent switching of the selected destination by an control 
device. If you are using a soft panel with the Protection Operation set to Disable, the Lock 
button is not displayed.

› VIEW Button — Click this button to display the VIEW dialog. This dialog lists the current TAKE 
commands in the queue. Individual items may be removed from the queue via the options in 
the VIEW dialog.

› CLEAR Button — Click this button to clear the current TAKE queue.
› PRESET Button — This button is used to queue up multiple TAKE commands. Select a 

destination/source combination, then click PRESET. Select another destination/source 
combination then click PRESET. A following TAKE command will execute all the PRESET 
switches. To view the switch commands queued by the PRESET, click VIEW.

› TAKE Button — Click this button to execute the switch between the selected crosspoints. If you 
are using a soft panel with the Take Operation set to Direct, a TAKE button is not displayed 
because the transitions will occur automatically after a crosspoint switch is selected.

Crosspoint Switches via a Category Panel
The buttons and options in a Category soft panel are dependent on the categories defined for the 
current database, and how the soft panel was defined in the Panels tab. Instead of having access to 
all sources, destinations, and levels at one time, a Category soft panel provides access based on the 
categories and the tags you have created.

To make a crosspoint switch using a Group Category Panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for the Category Panel.

The Category Panel tab opens.

Figure 63  Status Protected — Destination Figure 64  Status Protected — User
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3. From the status window, highlight the level(s) you wish to include in the crosspoint switch.

• Selected levels highlight in the level defined color.
• Non-selected levels are indicated by a gray button with white text.

4. To select a destination:

a. Click DEST from the category navigation tools.

b.  Navigate to the desired group using the displayed groups in the main group window. 

Only groups containing destination assignments will be displayed unless the Non-group 
Resources option for this soft panel is set to Show.

c. Select a DEST button from the available category destinations located in the main group 
window.

The status title bar (if enabled) reports the currently selected destination. In the example 
below, the user has selected Level A1 and destination EDIT 3 from the EDIT group.

5. To select a source:

a. Click SRC from the category navigation tools.

b. Select a SRC button from the Source bus located in the middle of the interface.

 If your Category soft panel was created with the Take Operation set to Confirm, the TAKE button 
is lit. Otherwise the crosspoint switch automatically occurs.
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6. Click TAKE.

Using Push Button Panels
 This soft panel type is not suitable for use on an Ultritouch hard panel. To control the Ultrix via an 

Ultritouch, you must create and load an Ultritouch PB soft panel as outlined in the Ultritouch + 
Ultrix User Guide.

Panel Interface Overview
The Push Button soft panel is organized into three distinct windows. The order and width of each 
window can be customized using the options in the Panels > Home View interface.

Figure 65 is an example of a Push Button soft panel set to portrait.

Figure 65  Example of the Default Push Button Soft Panel — Portrait

Figure 66 is an example of a Push Button soft panel set to landscape.
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Figure 66  Example of the Default Push Button Soft Panel — Landscape

1. Destinations Area

The Destinations area displays the available destinations for router control. Select a 
Destination button to arm that destination for subsequent panel operations. Beneath each 
destination button is displayed the current source for that destination.

This area also includes the Filter field. A filter is available to match destination names against the 
entered text:   

• Enter text in the Filter field.

• Click  (or press Enter). The destinations area updates to display only those destinations 
starting with the filter text.

• To clear the active filter, click .

2. Sources Area

The Sources area displays the available sources for router control. Select a Source button to 
control the crosspoint for the currently selected destination.

This area also includes a Filter field. A filter is available to match source names against the 
entered text:

• Enter text in the field provided

• Click  (or press Enter). The sources area updates to display only those sources starting 
with the filter text.

• To clear the active filter, click .

3. Current Destination

The currently selected destination label is displayed here. All subsequent panel operations 
operate on this destination until a new destination is selected.

›  — the current status is not the same for all levels (ie a breakaway switch has occurred).

›  — the current destination is locked. No switches can be made on this destination.
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›  — the current destination is protected. Only the panel that initiated the protect may 
switch this destination.

4. Levels Area

The Levels area displays the available router levels as individual buttons. The current source for a 
given router level is displayed each level button. Select a Level button to include this level in the 
next source selection operation. Select the button again to toggle the level selection setting.

› FOLLOW Button — toggles the selection for all displayed levels.
› CLEAR Button — toggles the currently active level buttons.

5. Operation Area

This area provides buttons for soft panel and router control.

› PROTECT Button — protect the current destination. The following occurs:
• The destination button displays a blue border.

• The Current Destination area displays . When a destination is protected, only the 
panel that initiated the protect can change the destination status.

• The PROTECT button is now labeled as UNPROTECT. Toggle the button to disable the 
protect.

Only the panel that initiated the protect may change the protect status.

› LOCK Button — locks the current destination. The following occurs:
• The destination button displays a red border.

• The current destination display area displays . A panel cannot change the destination 
status of a locked destination.

• The LOCK button is now labeled as UNLOCK.

Only the panel that initiated the lock may change the lock status.

› VIEW Button — displays the current crosspoint switch requests currently in the preset list. 
Individual crosspoints may be removed via the list view.

› CLEAR Button — clear the preset list of all crosspoint selections.
› PRESET Button — adds the current destination/source/level selection to a preset list. A 

crosspoint is added to the list for every level selected. This enables the user to add more 
switches and execute them all with a single take operation. The preset function is only available 
when the Take Mode is set to Confirm.

› SALVO Button — reveals a list of predefined salvos. A salvo may be executed from the dialog. 
The salvo button is visible only when the panel configuration has one or more salvos assigned.

› TAKE Button — is lit when the current destination/source selection is ready to be requested of 
the router. The Take operation is a configurable and will only be activated if the soft panel Take 
Mode is set to Confirm.

Configuring a Push Button Soft Panel
The Push Button soft panel provides additional configuration options in addition to those outlined 
in “Creating a Soft Panel”.

To configure a Push Button soft panel

1. Create a new soft panel as outlined in the procedure “To create a soft panel”.

2. Select the Home View tab.
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3. Use the Display Icons menu to specify whether buttons will display the default icons based on 
window type (Enable) or will only display the label text as determined by the database 
(Disable).

4. Use the Orientation menu to specify the layout on the monitor. Choose from the following:

• Portrait — a horizontal layout; the panel is taller than it is wide. (Figure 65)
• Landscape — a vertical layout; the soft panel is wider than it is tall. (Figure 66)

5. Specify the order that the windows will display in the completed soft panel layout as follows:

 By default, the windows are organized in the following order (left to right): Destinations, Sources, 
and Status.

a. In the Home Windows table, select the row for the window you want to move to on the soft 
panel layout.

b. Use the buttons in the toolbar to move the row to the desired position.

In the example, the Status window moved to the top of the table and displays on the far left 
of the panel.

6. Adjust a window size as follows:

• Use the Percent field to specify the size of the window as a percentage of the total soft panel 
area.

• Use the Rows field to specify the number of button rows the window will display.
• Use the Columns field to specify the number of button columns the window will display

7. Click Apply to save your changes.
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Crosspoint Switches via a Push Button Panel
The buttons and options in a Push Button soft panel are dependent on the current database, and 
how the soft panel was defined in the Panels tab. You can also use the Filter fields in the 
Destinations and Sources area of the panel to provide access based on the search criteria entered 
into each Filter field.

To make a crosspoint switch on a single level using the Push Button Panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for the Push Button Panel to open the Push Button Panel tab.

3. Select the Level you want to perform the crosspoint switch.

4. Select a DEST button from the Destinations window.

The Status field reports the selected DEST button. In the example below, the user selected 
Level 6 and Dest 54.

5. Select a SRC button from the Sources window.

 If your soft panel was created with the Take Operation set to Confirm, the TAKE button is lit. 
Otherwise the crosspoint switch automatically occurs.
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6. Click TAKE.

To make a crosspoint switch on multiple levels using the Push Button Panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for a Push Button Panel.

The Push Button Panel tab opens.

3. Select each level from the Levels window or click Follow to include all levels.

The Level buttons are lit in the toolbar.

4. Select a DEST button from the Destination window.

The Status area updates to display report the selected DEST button. In the example below, the 
user selected Levels 2, 6, 8 and 11, then Dest 40.

5. Select a SRC button from the Source window.

The Status area updates to display only the selected SRC button. In the example below, Src 6 is 
selected.

 If your soft panel was created with the Take Operation set to Confirm, the TAKE button is lit. 
Otherwise the crosspoint switch automatically occurs.
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6. Click TAKE.

Using an Ultritouch PB Panel
An Ultritouch PB soft panel is organized into a pre-sized layout that can be loaded for use on an 
Ultritouch hard panel. Customize each soft panel by specifying the size of each window, the location 
of each window on the layout, and what operational buttons to include on the panel.

 The Ultritouch PB soft panel can only be loaded and used on an Ultritouch hard panel. 

Figure 67  Example of an Ultritouch PB Soft Panel

For More Information on...
• configuring and using an Ultritouch PB soft panel, refer to the Ultritouch + Ultrix User Guide.
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Using Salvos
Salvos are a selected series of crosspoints to switch in the matrix that can be saved and later 
recalled for use.

Creating Salvos
The Salvos tab enables you to create, delete, re-name, and manage your salvos in an interface that 
is off-line. The Salvo tab layout is similar to the Matrix Panel layout where crosspoints are arranged 
in a grid layout with sources in columns and the destinations in rows. 

To create a salvo

1. In the Basic Tree View, expand the Database node for the Ultrix router.

2. Double-click the Salvos node.

The Salvos tab opens.

3. Create a new salvo in the database as follows:

a. Click Edit > Add. 

The Add Salvo dialog opens.

b. Type a unique identifier in the Name field for the new salvo.

c. Click Apply.

The Add Salvo dialog closes and the Salvos list updates with the new salvo selected.

4. Select the Level(s) button for the level(s) to include in the salvo.

The Level(s) buttons are lit.

5. To create a single crosspoint switch, use the cross-hairs to select the source/destination 
combination on the grid.

In the example below, the user selected Src6 / Dest7.
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6. To assign multiple destinations to the same source:

a. Click the button(s) in the Destination toolbar for each destination to include in the switch; or 
click Select All to include all the available Destinations.

b. Click the button in the Source toolbar for the source to use for the switch.

The Salvos grid updates to indicate the new selections. Notice that each level is represented 
by a corresponding slice of the crosspoint indicator. In the case below, there are three 
crosspoint switches selected that will affect six levels.

7. Click Follow to enable the levels to automatically follow the switches.

 Click Advanced > Clear Dest Presets to cancel the destination selections or click Advanced > 
Clear All Presets to clear the workspace.

8. Click Apply.

The salvo settings are updated.

Saving the Current Crosspoint Status as a New Salvo
The Advanced menu in the Salvos tab provides the option to capture the current state of the 
crosspoint selections and save them as a salvo.

To create a salvo based on the current destination status

 This procedure captures the status of all destinations.

1. Verify the current crosspoint state using one of the soft panels in your database. Refer to “Soft 
Panels in DashBoard”.

2. In the Basic Tree View, expand the Database node for the Ultrix router.

3. Double-click the Salvos node.

The Salvos tab opens.
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4. Create a new salvo in the database as follows:

a. Click Edit > Add. 

The Add Salvo dialog opens.

b. Type a unique identifier in the Name field for the new salvo.

c. Click Apply.

The Add Salvo dialog closes and the Salvos list updates with the new salvo selected.

5. Click Advanced > Capture System Status.

The grid in the Salvos tab updates to reflect the current crosspoint state as verified in step 1.

6. Click Apply.

The salvo settings are updated.

To create a salvo based on selected destinations

 This procedure captures the status for selected destinations.

1. Verify the current destination crosspoint states using one of the soft panels in your database. 
Refer to “Soft Panels in DashBoard”.

2. In the Basic Tree View, expand the Database node for the Ultrix router.

3. Double-click the Salvos node.

The Salvos tab opens.

4. Create a new salvo in the database as follows:

a. Click Edit > Add. 

The Add Salvo dialog opens.

b. Type a unique identifier in the Name field for the new salvo.

c. Click Apply.

The Add Salvo dialog closes and the Salvos list updates with the new salvo selected.

5. Click Advanced > Capture Dest Status.

The grid in the Salvos tab updates to reflect the current Destination states as verified in step 1.

6. Select the Level(s) button for the level(s) to include in the salvo.
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The Level(s) buttons are lit.

7. Select the source(s) to use in the crosspoint switch.

8. Click Apply to update the salvo settings.

Copying and Pasting a Salvo
You can create a copy of a saved salvo and edit its settings or add crosspoint selections separately 
from the original salvo.

To copy and paste a salvo

1. In the Basic Tree View, expand the Database node for the Ultrix router.

2. Double-click the Salvos node.

The Salvos tab opens.

3. Select the salvo to copy from the Salvos list.

4. Click Edit > Copy.

5. Click Edit > Paste.

A new salvo displays at the bottom of the Salvos list in the Salvos tab. By default, the salvo is 
named Salvo # where # is an automatically assigned value.

6. Give the new salvo a unique identifier as outlined in “To re-name a salvo”.

7. Edit the settings of the new salvo as outlined in “To edit a salvo”.

Editing a Salvo
Once a salvo is created in the database, you can edit its crosspoint selections.

To edit a salvo

1. In the Basic Tree View, expand the Database node for the Ultrix router.

2. Double-click the Salvos node.

The Salvos tab opens.

3. Select the salvo from the Salvos list.

The grid updates to display the crosspoint selections currently saved for the salvo.

4. Perform steps 4 to 6 as outlined in “To create a salvo”.

5. Click Apply to save your changes.

To re-name a salvo

1. In the Basic Tree View, expand the Database node for the Ultrix router.

2. Double-click the Salvos node.

The Salvos tab opens.

3. Select the salvo from the Salvos list.

The grid updates to display the crosspoint selections saved for the salvo.

4. Click Edit > Rename.

The Rename Salvo dialog opens.

5. Type a new name for the salvo in the Name field.

6. Click Apply.
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The Rename Salvo dialog closes and the salvo displays with the new name in the Salvos list.

Deleting a Salvo
Deleting a salvo removes it from the database. The corresponding button on any soft panels for the 
deleted salvo are also no longer displayed.

To delete a salvo from the database

1. In the Basic Tree View, expand the Database node for the Ultrix router.

2. Double-click the Salvos node.

The Salvos tab opens.

3. From the Salvos list, select the salvo to delete.

4. Click Edit > Delete.

5. Click Apply to close the dialog.

The salvo no longer displays in the Salvos list to the left of the workspace. If the salvo was 
assigned to a button in a soft panel, the button is automatically deleted from the panel.

Recalling a Salvo
Once you have saved a salvo, you can recall it for use on a soft panel in DashBoard.

 You cannot recall salvos from a Category soft panel.

For More Information on...
• adding salvos to customized soft panels, refer to “Creating a Soft Panel”.

To recall a salvo from a Matrix panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix router.

2. Double-click the node for a Matrix Panel.

The Matrix Panel tab opens.

3. Click Salvo.

4. Click Recall.

The Execute Salvo dialog opens. Notice that the Active column reports whether the salvo is 
currently in use (ON) or not (OFF).

5. Select the salvo to recall.

6. Click Apply to close the dialog.

7. Click Take to apply the salvo.
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To recall a salvo from a MultiBus panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix router.

2. Double-click a MultiBus Panel node.

The MultiBus Panel tab opens. The salvo buttons are located at the bottom of the soft panel 
interface. If a salvo button is lit green, the current router status matches the salvo presets. 

3. Click the button for the salvo you wish to recall.

The salvo button and Take buttons are now lit on the soft panel.

4. Click Take to apply the salvo.

The crosspoint switch is made, and the salvo button is no longer lit.

To recall a salvo from a Category panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix router.

2. Double-click a Category Panel node.

The Category Panel tab opens. The salvo buttons are located at the bottom of the soft panel 
interface. If a salvo button is lit green, the current router status matches the salvo presets. 

3. Click the button for the salvo you wish to recall.

The salvo button and Take buttons are now lit on the soft panel.

4. Click Take to apply the salvo.

The crosspoint switch is made, and the salvo button is no longer lit.

Using the Find and Filter Options
The Salvos tab includes two buttons in the bottom right corner: Find and Filter. These enable you to 
navigate the sources and destinations of a loaded salvo when using a larger database.

Find
The Find dialog helps you to quickly navigate to known source or destination names. 

Figure 68  Example of the Find Dialog

To access the Find dialog

1. Within the matrix panel control area, click Find.

The Find dialog opens.

2. From the Find in List menu, choose either Source or Destination as required.



Ultrix User Guide (v23.0) Using Salvos • 235

3. Type the text to search for in the Find what field.

In Figure 68, the user entered out.

4. If an exact string match is required, select the Exact Match box.

5. If text case matching is required, select the Match Case box.

6. Click Next to begin the search.

The Matrix panel updates to the first match.

7. Click Next again to navigate to subsequent matches.

8. Click  to navigate to previous matches.

9. Click Close to close the dialog. 

The Matrix panel view will remain with the last match in the middle of the matrix panel view.

Filter Dialog
Use the Filter dialog to reduce the number of source and/or destinations visible in a matrix panel. 
This enable a user to filter a matrix panel view to only source/destinations that match entered text.

 The filter matches any consecutive characters and ignores the case. For example, typing at will 
match to CAT, hat, ATT etc.

Figure 69  Example of the Filter Dialog

To use the Filter dialog

1. To filter the destinations:

a. Enter the filtering text in the Destination field as required.

b. Click  to enable destination filtering.

Using the Find and Filter Options
The Salvos tab includes two buttons in the bottom right corner: Find and Filter. These enable you to 
navigate the sources and destinations of the Salvos grid when using a large database.

Find
The Find dialog helps you to quickly navigate to known source or destination names. 
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Figure 70  Example of the Find Dialog

To access the Find dialog

1. Click Find.

The Find dialog opens.

2. From the Find in List menu, choose either Source or Destination as required.

3. Type the text to search for in the Find what field.

In Figure 70, the user entered out.

4. If an exact string match is required, select the Exact Match box.

5. If text case matching is required, select the Match Case box.

6. Click Next to begin the search.

The Salvos grid updates to the first match.

7. Click Next again to navigate to subsequent matches.

8. Click  to navigate to previous matches.

9. Click Close to close the dialog. 

The Salvos grid will remain with the last match.

Filter Dialog
Use the Filter dialog to reduce the number of source and/or destinations visible in a Salvos grid. 
This enable a user to filter the grid view to only source/destinations that match entered text.

 The filter matches any consecutive characters and ignores the case. For example, typing at will 
match to CAT, hat, ATT etc.
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Figure 71  Example of the Filter Dialog

To use the Filter dialog

1. To filter the destinations:

a. Enter the filtering text in the Destination field as required.

b. Click  to enable destination filtering.

The Salvos grid updates to display only those destinations matching the entered text.

2. To filter the sources:

a. Enter the filtering text in the Source field as required.

b. Click  to enable source label filtering.

The Salvos grid updates showing only those destinations matching the entered text.

3. Click  to clear the associated filter text field.

4. Click Clear All to clear both filter text fields.

5. Click Close to close the Filter dialog.

The Salvos grid updates to display only those destinations matching the entered text.

6. To filter the sources:

a. Enter the filtering text in the Source field as required.

b. Click  to enable source label filtering.

The Salvos grid updates showing only those destinations matching the entered text.

7. Click  to clear the associated filter text field.

8. Click Clear All to clear both filter text fields.

9. Click Close to close the Filter dialog.
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Operation with Ross Devices
Ultrix may also connect to Ross NK series devices to expand functionality for signal types the Ultrix 
router itself does not handle. The Ross NK series devices must be connected to the Ethernet 
network by virtue of an Ross NK-IPS or NK-NET devices to enable the Ultrix router to communicate 
with them.

Overview
Introducing an Ultrix router to a Ross NK system will require specific configuration to enable the 
Ultrix routing system to manage them.

Using RCP-NKx Remote Control Panels
When adding the Ultrix router to an existing system with one or more RCP-NKx devices, each 
remote control must:

• have the Virtual routing enabled on their Configuration page
• have the Comms Retry Delay Factor set to 80ms or greater
• ensure that the level numbers correspond to the Ultrix Level ID number

Be aware that the RCP-NKx devices do not:

• support Ultrix salvos
• automatically get source and destination labels from the Ultrix router. They must be entered 

manually or via a global labels file.

Using Ross NK Series Routers
The Ross NK router partitioning not supported. The logical mapping of the Ultricore control system 
is far more capable and should be implemented there if required.

Keep the following in mind:

• The NK-IPS requires version 2.23 or greater to communicate with an Ultrix router.
• The SCP/A is not supported.
• The SCP/K2 is not supported.
• NK-A64 control level is not supported.

Table 26 outlines the nomenclature that Ultrix automatically uses for Ross NK devices. 
Table 26  Default Ultrix Naming for Ross NK Devices

Ross NK Device Matrix Name Port Name
NK-3Gxxx deviceName.SDI deviceName.slot1.in/out[socket number].SDI.ch1

NK-Axxx deviceName.An Aud L deviceName.slot1.in/out[socket number].An Aud L.ch1

deviceName.An Aud R deviceName.slot1.in/out[socket number].An Aud R.ch1

NK-Dxxx deviceName.AES deviceName.slot1.in/out[socket number].AES.ch1

NK-Mxx deciceName.Machine 
Control

deviceName.slot1.in/out[socket number].Machine 
Control.ch1

NK-MDxxx deviceName.SDI deviceName.slot1.in/out[socket number].SDI.ch1

NK-Vxxx deviceName.An Vid deviceName.slot1.in/out[socket number].An Vid.ch1
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Using Ross Analog Audio Devices (NK-A16, NK-A32, NK-A64)
The Ross NK Analog Audio devices (NK-A16, NK-A32, NK-A64) will present as two matrices: Left and 
Right respectively. Note that the NK-A64 control level is not supported.

Connection Diagrams
Figure 72 provides an example of a routing system with an Ultrix router, an NK-NET, and several 
Ross NK devices. Communication between the NK-NET and the Ross NK devices is over T-Bus.

 The NK-NET requires any Ross NK router to supply phantom power for operation.

Figure 72  Connection Example with an NK-NET

Figure 73 provides an example of a system with an Ultrix router, an NK-IPS, and several NK devices. 

Figure 73  Connection Example with an NK-IPS
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Adding Ross NK Series Devices to the Ultrix Routing System
To add a Ross NK series device to the Ultrix routing system:

1. Define a connection point between the Ultrix router and each Ross NK series device. Refer to 
the chapter “Device Communication Setup” for details.

2. Review the logical matrices for the Ultrix database.

3. Assign outputs to the logical destinations in the database as outlined in “To map a physical 
output to a destination”.

4. Assign inputs to the logical sources in the database as outlined in “To map an input to a 
source”.

Machine-Control (RS-422) Logical Mapping
Connecting an NK-M series router to Ultrix requires some special consideration;

Machine control routing requires two crosspoints for a point to point connection due to the 
bi-directional nature of the signal. Each physical socket contains a transmit/receive pair. This can be 
thought of as a source-destination combination and is known as a port. 

It is necessary to configure the input and output of the machine control port on the same row ID on 
the logical mapping tables.

Figure 74  Destination Mapping

Figure 75  Source Mapping

It does not matter where the machine control is mapped (either row 3 or 300), but the input and 
outputs physical ports must be mapped to the same row ID.

Conditions for Machine Control
Three conditions must be met before machine control can be switched.

1. The NK machine control router is attached and configured within Ultrix (level, destination. and 
source maps).

2. Selected breakaway or level must include the machine control level.

3. Machine control reciprocal must be enabled on the controller.

Using Ultricore-CC as a System Controller
Ultricore-CC may control one or more Ultrix routers. Ultricore has the advantage of supporting 
more external connections so is ideal for systems with many external connections (RCPs, 
DashBoard instances, third-party control).

 Ensure a unique device name is assigned for each Ultrix within a system.
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Figure 76  Example Setup Using an Ultrix and an Ultricore

Configuration
The workflow of enabling an Ultricore as a system controller for multiple Ultrix routers:

1. Setup any Ultrix licensing requirements within each Ultrix router.

2. Enable Remote Controller Mode on each Ultrix as outlined in “Enabling Remote Controller 
Mode on the Client Ultrix Routers”.

3. Create a basic database within each Ultrix to accommodate the inputs/outputs. Ensure to:

a. use generic names 

b. a basic level of routing is functional.

4. Create a connection point (via the Ultricore interface) from the Ultricore-CC to each Ultrix.

5. Edit the Ultricore-CC database to control Ultrix specific resources.

6. Configure all RCP devices to connect to the Ultricore-CC system controller.

Ross MC1 Master Control System
The MC1 Master Control System (MC1-MK or the MC1-UHD) is a dedicated card-based solution that 
provides complete program path protection using input bypass relays, protecting your channel 
output. Communication between the MC1 card and Ultrix is via an ethernet connection. Any router 
source can be mapped to any crosspoint button on the MC1 On Air Control interface. Refer to the 
user documentation for your MC1 card for details on crosspoint button assignment.

Communications between an MC1-MK and the Ultrix Router

 Router control on the MC1-MK requires v5.0 software or higher.
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Keep the following in mind when configuring the options in the Configuration > Router interface 
of the MC1-MK:

• Ensure the Virtual menu is set to Virtual.
• Ensure the Delay value is set to a minimum of 6 frames.

Keep the following in mind when configuring the options in the Remote Control tab of the 
MC1-MK:

• The Ultrix router uses the NK Router protocol in the Ethernet Port area.
• Set the Role to Client.
• Set the Protocol to TCP.
• Use the IP Address field to specify the IP Address of the Ultrix router.
• Set the Port field to 5000.

For More Information on...
• the communications setup for the MC1-MK, refer to the MC1-MK Installation Manual.

Communications between an MC1-UHD and the Ultrix Router

 Router control on the MC1-UHD requires the MC1-MASTERCTRL-LICENSE.

Keep the following in mind when configuring the options in the Remote Control tab of the 
MC1-UHD:

• The MC1-UHD uses the GVG Series 7000 Ethernet protocol to communicate with the Ultrix router.
• Set the Role to Network Client.
• Set the Packet Type to TCP.
• Use the Remote IP field to specify the IP Address of the Ultrix router.
• Set the Port field to 5000.

For More Information on...
• the communications setup for the MC1-MK, refer to the MC1-UHD User Guide.
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External Control
This chapter summarizes the third-party protocols the Ultrix router supports. 

Ultrix Control with Third-Party Systems
Ultrix may be controlled by third-party control or automation systems via the GVG Native Series 
7000 or Probel SW-P-08 protocols.

Ethernet Communication
The Ethernet interfaces to these protocols are automatically started with Ultrix and no further 
configuration is necessary. However, you must configure your external control systems to match 
the settings outlined in Table 10. 

For More Information on...
• defining an Ethernet connection between Ultrixand an external device, refer to “Third-party 

Connection via Ethernet”.

Serial Communication
If you are using a serial connection, you must first define the serial connection point as outlined in 
“Defining a Serial Connection” and selecting GVG Native or Probel SW-P-08 from the Protocol 
menu and the settings as outlined in Table 11.

Third-Party Matrix Control with Ultrix
The Ultrix control system is able to control third-party matrix devices. Two popular routing 
protocols are available to enhance compatibility: GVG Series 7000 and Probel SW-P-08.

To configure third-party matrix control

1. Create an outgoing connection point from the Ultrix to the third-party matrix device.

2. Define the external matrix.

3. Mapping the external matrix inputs and outputs.

4. Define the Ultrix operating level.

5. Assign external matrix to the Ultrix source and destination levels.

The following sub-sections outline each step required to configure third-party matrix control.

Create an Outgoing Connection Point
You must define an interface for the system to access third-party matrix devices. The connection 
point must be compatible with the settings of the external device you are trying to control.

Before proceeding, ensure that you have the following connection specifics:

• Communication protocol (GVG Native Series 7000 or Probel SW-P-08)

• Communication type (TCP/IP or serial1)

Refer to “Connecting to Third-Party Devices” details.

1. Only available natively on the Ultrix Central Controller. Serial connections from Ultrix requires an external USB-serial 
converter.
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Defining the External Matrix
The system does not automatically know the details of any connected third-party matrix. The user 
must manually define the size and operating level within the Ultrix database.

Creating a Logical Matrix for an External Device

Once you establish a valid connection point between the Ultrix router and an external device, you 
can create logical matrices in an Ultrix database using the device inputs and outputs. Creating a 
logical matrix from the external device enables Ultrix to include the inputs and outputs for selection 
in the Sources and Destination tabs of the Ultrix database.

 The input/output range and level you specify in the Ultrix database must match the settings 
within the external matrix. 

To create a logical matrix from an external device

1. Expand the Database node.

2. Double-click the Third Party Matrices node located under the Database node.

The Third Party Matrices tab opens. 

3. Click Edit > Insert to display the Insert Matrix dialog.

4. In the Name field, type a unique identifier for the third-party matrix. This name is used to 
identify the matrix within the Ultrix database.

5. Click Apply to close the Insert Matrix dialog and add a blank row to the Third Party Matrices 
table.

In the example below, a new matrix named “Matrix 2A” was added.

6. From the Device ID drop-down menu, select the device you want to define the logical matrix 
for. This is the name given to the device when you established a connection point with it on the 
Connections tab.

 The Device ID menu lists only the third-party devices that have a valid connection point with the 
Ultrix router.

7. Define the matrix size as follows:
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a. Use the First Output and Last Output fields to define the range of destinations from the 
device within the Ultrix database.

b. Use the First Input and Last Input fields to define the range of sources from the device 
within the Ultrix database.

 These created inputs and outputs will use the nomenclature DeviceID.Slot.Port.Type.Channel 
where DeviceID represents the Name assigned to the external device on the Connections tab.

8. Use the Level field to specify the number of levels for the device within the Ultrix database.

9. Use the Type field to specify the signal type for the matrix. 

10. Click Apply to save the new matrix to the database and add it to the list of available matrices in 
the Port Labels tab.

Mapping the External Matrix Inputs and Outputs
Once the connection point and matrix are defined in the Ultrix database, you can map the external 
matrix inputs and outputs in the same manner as we do with Ross device matrices. However, you 
will instead select an external matrix output from the Outputs list (or an external matrix input from 
the Inputs list) in the database interfaces. The available inputs and outputs will display in the 
format of DeviceID.slot#.in[x].Type.ch# or DeviceID.slot#.out[x].Type.ch#. 

 It may be necessary to create a new level in the Ultrix database for the assignment of inputs and 
outputs to logical labels. Refer to “Defining the Levels in a Database” for details.

For More Information on...
• assigning destinations, refer to “Defining the Destinations in a Database”.
• assigning sources, refer to “Defining the Sources in a Database”.

Using Index Numbers
Some protocols refer to source and destinations with a numerical index number. This number is 
listed in the ID column of the Source and Destination tabs of the Ultrix database.

For example, the GVG protocol reference to destination ‘00h’ correlates to Ultrix destination ID 1 in 
the case shown below for the Dest 1 entry in the table.

Figure 77  Example of ID Numbers Listed in a Destinations Tab

Protocol Options
Some protocols provide additional configuration options via the Protocol Options dialog. These 
options can be accessed via the Protocol Servers table on the Database > Connections interface. 
Selecting an Options button to on the table opens this dialog.

The Protocol Options are outlined with the respective protocol details in the following sections.



248 • External Control Ultrix User Guide (v23.0)

GVG Series 7000 Native Protocol Commands
Ultrix supports the GVG Series 7000 Native protocol and is available over an RS-422 or RS-232 serial 
connection, as well as ethernet connection.(Table 27)  

Table 28 summarizes the settings in the Protocol Options dialog for the GVG Series 7000 Native 
protocol.  

To send GVG Native commands to Ultrix

1. Create a network connection to the Ultrix router on TCP/IP Port 12345.

2. A successful connection will be displayed in the listed client devices under the Device 
Configuration interface.

3. Refer to Table 29 for a list of GVG Native Protocol commands that Ultrix supports.

Table 27  Default GVG Native Connection Types

Setting
Serial

Connection Type RS422 or RS232

Baud 38400

Data Bits 8

Parity None

Stop Bits 1

Ethernet

Port (incoming) 12345

Port (outgoing) 12345a

a.For outgoing connections, port 12345 is the default value but is 
user configurable.

Table 28  Protocol Options — GVG Series 7000 Native

Option Setting Notes
L4 Echo Yes Send command acknowledgments on 

protocol layer 4 (Ethernet only)

No Do not send acknowledgments. This 
is the default.

Table 29  GVG Native Protocol Commands

Message
NotesCommand Description

BK[,parameter]
BK,D Force next QD command to 

return status of all destinations
Clears the flags associated with the D,no_parameter 
command. After BK,D is sent, the next QD,no_parameter 
command will result in destination statuses or all 
destinations being returned.

BK,E Request status of level 4 echo 
setting
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For More Information on...
• these commands, refer to the GVG protocol documentation.

BK,E,ON Set level 4 echo to on An err=00 response will be returned for successful 
commands that do not generate their own response (eg. 
Take commands).
This is a per session setting.

BK,E,OFF Set level 4 echo to off (default) No response will be given for commands that do not 
generate their own response.

PR,dest_name,level_bitmap Protects a specific destination 
from having its source changed

ER error-code response is currently not supported.

QC[,dest_name] Query Combined Destination 
status by name

QD[,dest_name] Query Destination status by 
name

No information is returned for unmatched destination levels

Qd[,dest_name] Query Destination status by 
name

Sets response src_name to NO_XPT for unmatched 
destination levels

QI,destIndex,lvlIndex Query Destination status by 
indexa

Qi,destIndex,lvlIndex Query Destination status by 
indexa

The srcIndex returned will be 0xfffe if an error condition 
applies to the crosspoint being reported.

QJ[,destIndex] Query Destination status by 
indexa

No information is returned for unmatched destination levels

Qj Query Destination status by 
indexa

Sets response srcIndex to 0xFFFe for unmatched destination 
levels

QN,parameter
QN,S Query source names/labels As defined inactive database

QN,D Query destination names/labels As defined inactive database

QN,L Query level names/labels As defined inactive database

QN,IS Query names via source indexa

QN,ID Query names via destination 
indexa

QT Query date and timea

TA,dest_name,nbr_sources,src_name
_entry1[,...src_name_entryn]

Takes sources (on specified 
levels) to specified destination, by 
name rather than index

Src_name_entryn = src_name,level_bitmap

TD,dest_name,src_name_entry Takes same source to all or 
specified levels

Src_name_entryn = src_name[,levelbitmap]
No levelbitmap=all destination levels

TI,destIndex,srcIndex[,levelIndex] Request take by index with level 
indexa

TJ,destIndex,nbr_sources,srcIndex,lev
el_bitmap[,...,srcIndex,level_bitmap]

Takes sources (on specified 
levels) to specified destinations 
by index rather than name; allows 
breakaways

TS,salvo_name Request Take Salvo TS,salvo_name

UP,dest_name,level_bitmap Removes Protect from specified 
destination

ER, error-code response is currently not supported.

a.Zero-based hex logical index numbering.

Table 29  GVG Native Protocol Commands

Message
NotesCommand Description
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RossTalk Commands
The RossTalk protocol is a plain text based protocol that allows control of Ross Video equipment.

 Each command should be terminated by a carriage return and a line feed (CR/LF).

To send RossTalk commands to Ultrix

1. Create a network connection to the Ultrix router on Port 7788.

2. At the prompt, enter the commands you wish to send. Refer to Table 30 for a list of supported 
commands.

For More Information on...
• adding a RossTalk label to an Ultriscape layout, refer to the Ultriscape User Guide.

Table 30  RossTalk Protocol Commands

Message
NotesCommand Description

GPI ## Execute the salvo number corresponding to the 
numerical ## extension of the command

For example, GPI 04 triggers the salvo 
<salvo_name>[4] as listed in the Ultrix 
database

TIMER ##:RUN Request Timer ID to start/resume

TIMER ##:STOP Request Timer ID to stop

TIMER ##:PAUSE Request Timer ID to pause

TIMER ##:END Request Timer ID to end

TXTLABEL ID:<id>; TEXT:<text>; 
BGCLR:<bgcolor>; TXTCLR:<textcolor>

Where:
• <id> is a unique "rosstalk id" associated with 

an Ultriscape RossTalk display object. This 
field is compulsory.

• <text> is the text to be displayed. This field is 
optional.

• <bgcolor> is the background color of the text 
label. Specified in comma separated RGB 
format using 2 byte hex values (eg RR,GG,BB). 
This field is optional.

• <textcolor> is the text color of the text label.                
Specified in comma separated RGB format 
using 2 byte hex values (eg RR,GG,BB). This 
field is optional.

There is a 20 character maximum.
Messages with only the id field will be ignored. 
The following is an example of a message:
TXTLABEL ID:25; TEXT:CAM1; 
BGCLR:0x00,0x00,0x00; 
TXTCLR:0xFF,0xFF,0xFF

Note that <bgcolor> and <textcolor> are 
specified as R,G,B triplet. For example:
• 255,255,255 or 0xff,0xff,0xff is white

• 0,0,0 or 0x0,0x0,0x0 is black

• 255,0,0 or 0xff,0x0,0x0 is red 

XPT D:<dest> S:<source> I:<user_id> [L:<levels>] Crosspoint command for a router TAKE where:
• <dest> is the logical destination ID from the 

active database (1-based)

• <source> is the logical source ID from the 
active database (1-based)

• <user_id> is the numeric user/panel ID that 
will be used to request the switch

• <levels> is an optional parameter specifying 
comma-separated list of 1-based level IDs to 
switch (for breakaway, e.g. L:1,2,4). If no 
levels are specified, a follow switch (all valid 
levels) is requested. 

• <levels> supports ranges specified by two 
numbers separated by dash (e.g. L:1-16)

Range start value must be less than the end 
value
Single levels and ranges can be mixed in the 
list (eg. L:1,3,4-8,12-17)
There are no spaces between numbers or 
ranges
Invalid numbers or improperly specified 
ranges will be ignored 
An argument is separated from its value using 
a single colon (:)
Command arguments are separated single 
spaces
The arguments may be specified in any order, 
(e.g. these are equivalent: XPT D:1 S:4 I:2 and 
XPT S:4 I:2 D:1)
Examples:
• ID 7 requesting to switch Dest 2 to Source 1 

on Levels 1,3,5 and 12-16

• XPT I:7 D:2 S:1 L:1,3,5,12-16
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Probel SW-P-08 Protocol Commands
Ultrix supports the Probel SW-P-08 protocol and is available over an RS-422 or RS-232 serial 
connection, as well as ethernet connection. Table 31 provides the default values for this protocol. 

Table 32 summarizes the settings in the Protocol Options dialog for the Probel SW-P-08 protocol.  

Table 31  Default Probel SW-P-08 Connection Types

Setting
Serial

Connection Type RS422 or RS232

Baud 38400

Data Bits 8

Parity None

Stop Bits 1

Ethernet

Port (incoming) 8910

Port (outgoing) 8910a

a.For outgoing connections, port 8910 is the default value but is 
user configurable.

Table 32  Protocol Options — Probel SW-P-08 protocol

Option Setting Notes
Protocol Variant Non-extended Use non-extended commands only

Extended Use extended commands only

Use Last Request Use command set as per last received command 
format (e.g. if received a non-extended 
command, reply in a non-extended format). This 
is the default.

Matrix Mode Yes Swap matrix and level fields

No Do not swap matrix and level fields. This is the 
default.

Unused Field # Send number (0-15) in either Level or Matrix field 
- which ever is not used as per Matrix Mode 
setting. The default is 0.

Do not wait for ACK Yes Ultrix will not wait for message 
acknowledgments between connect responses

No Ultrix will wait for message acknowledgments 
between connect responses. This is the default.

Batch Collate Timea # milliseconds Wait up to 100 milliseconds for multiple 
commands received before processing. The 
default is 0 (which disables this feature). 

Batch Collate Split 
Size

# received 
commands

Wait up to 100 received commands before 
processing. The default is 0 (which disables this 
feature). 
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Table 33 lists the Probel SW-P-08 Serial Protocol commands the Ultrix supports.

a.When both Batch Collate Split Size and Batch Collate Time are both active, the option that occurs first will release the 
batch, and the Batch Collate Split Size and the Collate Time values are reset.

Table 33  Probel SW-P-08 Native Protocol Commands

Request Message Response Message

Notes
Cmd 

ID
Description Cmd 

ID
Description

01 Crosspoint Interrogate 03 Crosspoint Tally Get single crosspoint status

02 Crosspoint Connect 04 Crosspoint connected Take single crosspoint

10 Protect Interrogate 11 Protect Tally Get destination protect 
status

12 Protect Connect 13 Protect connected Set destination protect

14 Protect Disconnect 15 Protect dis-connected Turn off destination protect

17 Protect Device Name Request 18 Protect Device Name Response Get name of device that hold 
protect

19 Protect Tally Dump Request 20 Protect Tally Dump Get all protect status

21 Crosspoint Tally Dump Request 22, 23 Crosspoint Tally Dump Get all crosspoint status
Cmd22: Byte max dest 191
Cmd23: Word max. dest. 
65535 

97 Implementation Request 98 Implementation Status Get list of commands 
supported

100 All Source Names Request 106 Source Name Response Get all source names (8 char. 
max.)

101 Single Source Name Request 106 Source Name Response Get single source names (8 
char. max.)

102 All Destination Association Name 
Request

107 Destination Association Name 
Response

Get destination names (8 
char. max.)

103 Single Destination Association Names 
Request

107 Destination Association Name 
Response

Get single destination name 
(8 char. max.)

104 All UMD Labels Request 108 UMD Label Response Only one set of labels is 
currently supported. UMD 
Labels replicate source 
labels. (16 char. max.)

105 Single UMD Labels Request 108 UMD Label Response Get single source label (16 
char. max.)

120 Crosspoint Connect On Go Group Salvo 122 Crosspoint Connect On Go Group Salvo 
Acknowledge

Add crosspoint to preset 
group

121 Crosspoint Go Group Salvo 123 Crosspoint Go Done Group Salvo 
Acknowledge

Switch/clear preset group

124 Crosspoint Salvo Group Interrogate 125 Crosspoint Group Salvo Tally Preset group status

EXTENDED
129 Extended Crosspoint Interrogate 131 Extended Crosspoint Tally Get crosspoint status

130 Extended Crosspoint Connect 132 Extended Crosspoint Connected Take single crosspoint

138 Extended Protect Interrogate 139 Extended Protect Tally Get destination protect 
status

140 Extended Protect Connect 141 Extended Protect Connected Protect a destination

142 Extended Protect Disconnect 143 Extended Protect Disconnected Turn off protect for a 
destination

147 Extended Protect Tally Dump 148 Extended Protect Tally Dump Message Get all protect status for 
given level

149 Extended Crosspoint Tally Dump 151 Extended Crosspoint Tally Dump Word 
Message

Get destination status for 
given level
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NVISION Commands
This section outlines the NVISION protocol commands supported by Ultrix.

 Ensure that the Ultricore-NVISION license is installed for your router. Refer to the section 
“Installing a License Key” for details.

Table 32 summarizes the settings in the Protocol Options dialog for the NVISION protocol.  

NVISION NP16 Ethernet Protocol
Ultrix supports the NVISION NP16 Ethernet protocol. Table 35 outlines the default values for the 
Ultrix when using NP16.

NP16 Commands

The NP16 protocol defines the message format: Protocol ID | Sequence Number | byte count | 
Command

228 Extended All Source Names 234 Extended Source Name Response Get source names (8 char 
max.)

229 Extended Single Source Name 234 Extended Source Name Response Get single source name (8 
char max.)

230 Extended All Destination Association 
Names

235 Extended Destination Association 
Names Response

Get all destination names (8 
char. max.)

231 Extended Single Destination 
Association Name

235 Extended Destination Association 
Names Response

Get single destination name 
(8 char. max.)

232 Extended Single UMD Label Request 236 Extended UMD Labels Response Get all source labels (16 char. 
max.)

233 Extended Single UMD Label Request 236 Extended UMD Labels Response Get single source label (16 
char. max.)

248 Extended Crosspoint Connect On Go 
Group Salvo

250 Extended Crosspoint Connect On Go 
Group Salvo Acknowledge

Preset group acknowledge

124 Crosspoint Group Salvo Interrogate 253 Extended Crosspoint Group Salvo Tally Preset group status

Table 34  Protocol Options — NVISION protocol

Option Setting Notes
Offset 0 The Ultrix level matches the NVISION 

level

1 The Ultrix level is the NVISION level 
plus 1

Table 35  Default Connection Types — NVISION NP16

Setting
TCP Port 5194

Table 33  Probel SW-P-08 Native Protocol Commands

Request Message Response Message

Notes
Cmd 

ID
Description Cmd 

ID
Description
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Each field consists of a 32bit number where:

•  Protocol ID — 0x0000000C (Router Control Protocol)
•  Sequence number — controller generated and added to Ultrix response message
•  byte count — total number of bytes in message including header (<8176)
•  Command — refer to Table 36

 The protocol is zero based, meaning that destination 0 in the protocol relates to destination ID#1 
in Ultrix. This is true for sources, destinations, and level values.

Refer to Table 36 for a list of supported NP16 commands.

NVISION NP0010 Serial Protocol
Ultrix supports a limited sub-set of the NVISION serial NP0010 protocol.

Table 37 outlines the default values for the Ultrix for an NP0010 serial connection.

Refer to Table 38 for a list of supported NP0010 commands.

Table 36  NP16 Protocol Commands

Message
NotesCommand Description

0x0000 0050 Performs a TAKE

0x0000 0051 Set Output LPR Sets or releases a lock or protect on a 
destination

0x0000 0052 Get Status of Outputs Retrieves the crosspoint status

0x0000 0059 Router Partition Information

0x0000 005E Crosspoint Tally Retrieves the crosspoint status

0x0000 0070 Machine Control Take Format 1 only

Table 37  Default Connection Types — NVISION NP0010

Setting
Connection Type RS232, RS422

Baud 9600, 19200, 38400, 56700, 
115200

Data Bits 8

Parity No

Stop Bits 1

Table 38  NP0010 Protocol Commands

Message
NotesCommand Description

0x50 Take Non-timestamped version only

0x51 Destination status Get destination status

0x55 Lock destination Assert a destination lock

0x56 Protect destination Assert a destination protect
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TSL UMD Protocol v3.1 Commands
Table 39 outlines the default values for the Ultrix when using TSL UMD v3.1.

Protocol Implementation
Ultrix implements the protocol with the following structure: DisplayID|Control|DisplayData.

Table 40 lists the TSL UMD Protocol v3.1 commands the Ultrix supports.

0x58 Release destination lock/protect Releases the destination lock and protect

0x66 Destination LPR state Get destination locked/protect/released 
status

Table 39  Default Connection Types — TSL UMD v3.1

Setting
Serial

Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet

TCP Port 5727

UDP Port 4490

Table 40  TSL UMD Protocol v3.1 Commands

Protocol 
Breakdown Description UltriScape System Use

Display Address 0 - 126 display identification enumeration DisplayID associated with source or 
destination

Control Byte

Bit 0 Tally 1 status (1=on, 0=off) Tally 1 (Red)a

a.Green/Red may be swapped by configuring the Global Tally Settings in the UltriScape Head interface.

Bit 1 Tally 2 status Tally 2 (Green)a

Bit 2 Tally 3 status Not used

Bit 3 Tally 4 status Not used

Bits 4-5 Brightness value Not used

Bit 6 Reserved Not used

Bit 7 0 Not used

Display Data 16 ASCII display characters (20h-3Eh) UMD display text

Table 38  NP0010 Protocol Commands

Message
NotesCommand Description
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Refer to Table 41 when using TSL UMD v3.1 and configuring PiP Tallies in an UltriScape Head.

TSL UMD Protocol v4.0 Commands
 Table 42 outlines the default values for the Ultrix when using TSL UMD v4.0.

Protocol Implementation
Ultrix implements the protocol with the following structure: Header | Control | DisplayData | VBC | 
XData.

Table 43 lists the TSL UMD Protocol v4.0 commands the Ultrix supports.

Table 41  UltriScape Tally Display — TSL UMD v3.1

Red Tally Green Tally Display
ON ON RED IS ON

ON OFF RED IS ON

OFF ON GREEN IS ON

OFF OFF OFF (no tallies are lit)

Table 42  Default Connection Types — TSL UMD v4.0 

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet

TCP Port 5728

UDP Port 4491

Table 43  TSL UMD Protocol v4.0 Commands

Protocol 
Breakdown Description UltriScape System Use

Header 0x80 + 0 - 126 display address DisplayID associated with source or 
destination

Control Byte

Bit 0 Tally 1 status (1=on, 0=off) Not used

Bit 1 Tally 2 status Not used

Bit 2 Tally 3 status Not used

Bit 3 Tally 4 status Not used

Bit 4-5 Brightness value Not used

Bit 6 0=display data, 1=command data Display data only (0)

Bit 7 0 Not used
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TSL UMD Protocol v5.0 Commands
Table 44 outlines the default values for the Ultrix when using TSL UMD v5.0.

Display Data 16 ASCII display characters (20h - 7Eh) UMD display text

VBC

Bits 3-0 Byte count of XData

Bits 6-4 Minor protocol version (v4.0=0)

Bit 7 0

XData1

Bits 0-1 Right Hand tally valuea Not implemented

Bits 2-3 Text display valuea Sets text background color

Bits 4-5 Left hand tally valuea Displayed in either border or text 
background; can be either or both

Bit 6 Reserved

Bit 7 0

XData2

Bits 0-1 Right Hand tally value Not implemented

Bits 2-3 Text display value Not implemented

Bits 4-5 Left hand tally value Not implemented

a.Where 0=off, 1=Red, 2=Green, 3=Amber

Table 44  Default Connection Types — TSL UMD v5.0

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet

TCP Port 5729

UDP Port 4492

Table 43  TSL UMD Protocol v4.0 Commands

Protocol 
Breakdown Description UltriScape System Use
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Table 45 summarizes the settings in the Protocol Options dialog for the TSL UMD v5.0 protocol.  

Protocol Implementation
Ultrix implements the protocol with the following structure: PBC | Ver. | Flags | Screen | DMSG 
(Index, Control, Length, Text).

Table 46 lists the TSL UMD Protocol v5.0 commands the Ultrix supports. 

Enabling SNMP Support
Ultrix routers running software version 3v4 or higher provide optional support for remote 
monitoring and control of your router using SNMP (Simple Network Management Protocol). This 
protocol is compatible with many third-party monitoring and control tools. 

Table 45  Protocol Options — TSL UMD v5.0 protocol

Option Setting Notes
Wrapping Yes Wrap commands for TCP mode

No Do not wrap commands (UPD mode). 
This is the default.

PBC in Count 
Value

Yes Include the Packet Byte Count field 
when calculating the byte count value

No Do not include the Packet Byte Count 
field in the byte count value. This is 
the default.

Table 46  TSL UMD Protocol v5.0 Commands

Protocol 
Breakdown Description UltriScape System Use

PBC Total byte count of packet

Ver. Minor version number (0=v5.00)

 Flags

Bit 0 0=ASCII strings, 1=UTF-16LE

Bit 1 0=display data, 1=screen control Display data only (0)

Bits 2-7 Reserved (0) Not used

Screen 16bit Screen ID ScreenID associated with source or 
destination

DMSG

Index 16bit Display Address DisplayID associated with source or 
destination

Control

Bits 0-1 Right hand tally valuea

a.Where 0=Off, 1=Red, 2=Green, 3=Amber

Sets right-hand tally indicator color

Bits 2-3 Text display valuea Sets text background and border color

Bits 4-5 Left hand tally valuea Sets left-hand tally indicator color

Bits 6-7 Brightness value (0-3) Not implemented

Bits 8-14 Reserved (0)

Bit 15 0=display data, 1=command data Display data only (0)

Length Byte count of text

Text Text as defined by Flag 0 setting UMD display text
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 The MIB file provides SNMP traps for the configurable alarms on Ultrix as well as on the power 
supplies and fans.

Enabling SNMP Support
The SNMP Agent on the Ultrix router uses SNMP version 2 to allow queries of the configured system 
alarms, and state changes to configured alarms will be sent out as SNMP traps to the specified Trap 
Destination IP Address(es).

Whenever the options in the SNMP area are edited, the SNMP Agent is restarted on the Ultrix 
router. It can take up to 10 seconds for all monitored states to be updated. This latency only 
applies once on startup.

The SNMP monitoring and control feature for your Ultrix is a software option that you enable in the 
System Status > Network tab.

To enable SNMP support on the Ultrix

1. Verify that the Ultricore-SNMP license key is installed for the Ultrix router. Refer to “Installing a 
License Key” for details.

2. In the Tree View of DashBoard, double-click the System Status node under the Ultrix node.

The System Interfaces display in the DashBoard window.

3. Select the Network tab.

4. Locate the SNMP area of the tab.

5. Select the Enable SNMP box.

6. Ensure that the Alarms you want to monitor via SNMP are also enabled on the Ultrix router. 
Refer to “Monitoring the Hardware”.

To configure the SNMP Agent using DashBoard

1. In the Tree View of DashBoard, double-click the System Status node under the Ultrix node.

The System Interfaces display in the DashBoard window.

2. Select the Network tab.

3. Locate the SNMP area of the tab.

4. Use the SNMP Community Name field to specify the SNMP password for GET requests. For 
example, public.

5. Use the SNMP Trap Destination IP Address field to specify the target address to which traps 
should be sent.

An example of a valid target is provided in the SNMP area.
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 A maximum number of six strings are displayed in the SNMP Trap Destination IP Address field 
at one time. If at the maximum number, you must select a string from the field and delete it 
before adding a new target entry.

6. Press [Enter] to apply the changes.

Ember+ Registration and Discovery
This section provides information on the setup and operation for the Ultrix to communicate with a 
third-party control system via the Ember+ media distribution protocol.

Establishing a Connection
To establish a connection between the Ember+ client and the Ultrix

1. Configure your network streams as outlined in “ULTRIX-IP-IO Setup”.

2. Configure your router database as outlined in “Database Configuration”.

3. Install the Ultricore-EMBER+ license on the Ultrix. Refer to “Installing a License Key”. This 
enables the Ultrix to start an Ember+ server and listen to incoming connections.

4. Add the Ultrix in the Ember+ control system interface using the IP Address assigned to the 
Ultrix.

5. In the Ember+ controls system, set the TCP port to 9000 for the Ultrix.

Specifying the Operation Mode
Ultrix can be controlled via Ember+ in two modes: Virtual Mode (table mapped IO) or Physical Mode 
(direct socket control). 

To specify the Ember+ operation mode on the Ultrix

1. Display the Connections tab for Ultrix as follows:

a. Expand the Database node in the Tree View.

b. Double-click the Connections node.

2. Click Options in the Protocol Servers area.

The Server Options dialog opens.
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3. Use the Ember Plus menu to specify the operation mode required by your Ember+ control 
system. Choose from the following:

• Virtual Mode — each level is represented by a Matrix and the Labels will be the one defined 
in the Destinations and Sources tabs.

• Physical Mode — the whole router is represented as a single Matrix and the physical socket 
labels are used. The external control system using Ember+ commands bypasses the virtual IO 
mapping and directly controls the Ultrix physical socket connections. Therefore the Ultrix 
should not be switched by any other devices.

4. Click Apply to close the dialog.

5. Click Apply at the bottom of the Connections tab to apply the new setting.

Supported Commands
We support the Get Directory and Connect commands. The router is represented using the 
Ember+ Matrix object including Labels. This allows the Ember+ control system to see the number of 
levels, number of sources and destinations and their labels, the per destination status, and issue 
switch commands.

 If you make changes to the router database (such as Levels, Destinations and Sources) after 
establishing communications, you may need to refresh/reload/reconnect the connection.
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ULTRIX-UCCI Redundancy
This chapter outlines the ULTRIX-UCCI Control redundancy feature for the ULTRIX-FR5. This feature 
is not available for the ULTRIX(-NS)-FR1 or the ULTRIX(-NS)-FR2.

Before You Begin
The following are required for ULTRIX-UCCI Control redundancy:

• Two ULTRIX-UCCI Control cards physically installed and configured in the ULTRIX-FR5
• The ULTRIX-FR5 is installed, fully configured, and running software 4v10 or higher

 Contact Ross Technical Support for installing the second ULTRIX-UCCI Control card in your 
ULTRIX-FR5.

Overview
The ULTRIX-UCCI Control redundancy feature provides built-in redundancy for your routing system. 
In the event that one ULTRIX-UCCI Control card is affected, the router communications and traffic 
automatically routes to the second card. When the primary ULTRIX-UCCI Control card is back 
on-line, communications automatically switch from the secondary to the primary without user 
interaction. A DashBoard option also exists that enables a user to manually switch from one card to 
the other.

Monitoring
Communications can be monitored via the LEDs on the ULTRIX-UCCI Control hardware or via the 
Device Configuration interface in DashBoard.

Using the Physical LEDs
There are two ULTRIX-UCCI Control Card slots in the top-right corner of the ULTRIX-FR5. Each slot 
houses an Ultricore-CC Internal board which includes a Micro SD Card slot, a USB port, and four 
status LEDs.

Figure 78  Location of ULTRIX-UCCI Control Slots in an ULTRIX-FR5
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Table 47 describes the Ultrix-UCCI status LEDs. 

Using DashBoard
The Device Configuration interface in DashBoard enables you to monitor the ULTRIX-FR5 hardware 
including each ULTRIX-UCCI Control slot.

To monitor an ULTRIX-UCCI Control card via DashBoard

1. Display the Device Configuration interface as outlined in “To access the Device Configuration 
interfaces in DashBoard”.

The Frame View (Home page) automatically displays with a rear panel map. This map 
represents the Ultrix rear panel. In the example below, the router has nine slots populated with 
HD-BNC I/O blades, and two ULTRIX-UCCI Control cards.

2. Refer to Table 48 for the ULTRIX-UCCI Control status LEDs. 

Table 47  Hardware — Ultrix-UCCI LEDs

LED Status Description
STATUS Green Indicates the ULTRIX-UCCI Control card is powered and the last 

re-boot was successful

Flashing 
Green

Indicates the ULTRIX-UCCI Control card is powered and in the 
progress of a re-boot

Red Indicates the ULTRIX-UCCI Control card is powered but requires 
a re-boot

PRIM/SEC Green Indicates the ULTRIX-UCCI Control card is configured and 
functioning as the Primary

Flashing 
Green

Indicates the ULTRIX-UCCI Control card is in standby 
(Secondary) mode 

ALARM Red Indicates the ULTRIX-UCCI Control card is experiencing an error 
condition; verify the message(s) on the router front panel LCD 
display and DashBoard

Off Indicates the ULTRIX-UCCI Control card is operating correctly 
and is not experiencing any errors

AUX This LED is not implemented.
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Upgrading an ULTRIX-UCCI Control Card
Contact Ross Technical Support for information on upgrading the software on your ULTRIX-UCCI 
Control card.

Table 48  DashBoard — Ultrix-UCCI LEDs

LED Status Description
STATUS Green Indicates the ULTRIX-UCCI Control card is powered and the last 

re-boot was successful

Red Indicates the ULTRIX-UCCI Control card is powered but is 
currently re-booting

PRIM/SEC Green Indicates the ULTRIX-UCCI Control card is configured and 
functioning as the Primary

Off Indicates the ULTRIX-UCCI Control card is in standby 
(Secondary) mode 

ALARM Red Indicates the ULTRIX-UCCI Control card is experiencing an error 
condition; verify the message(s) on the router front panel LCD 
display and DashBoard

Off Indicates the ULTRIX-UCCI Control card is operating correctly 
and is not experiencing any errors

AUX This LED is not implemented.
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Managing your Ultrix Settings
The System Status > Transfer interface provides options to import and export archived files (*.ufs) 
of your Ultrix frame settings to another Ultrix. The *.ufs file captures the settings of the Device 
Configuration interface except for:

• database configuration
• UltriScape layouts
• device name
• network settings
• NTP server settings
• installed license keys

 This feature requires DashBoard v8.2 or higher and Ultrix software v2.0 or higher.

For More Information on...
• the settings available in the Device Configuration interface, refer to “Device Configuration 

Interfaces”.

Exporting the Device Configuration Settings
You create an archive of your frame settings using the options in the System Status > Transfer tab.

To export your settings to an archived file

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Transfer tab.

3. Click Ultrix Frame Settings.

4. Locate the Export area on the tab.

5. Click Browse... to specify the name and location to save the *.ufs file to.

The Save As read-only field updates with the selected path and file name.

6. Click Apply.

The Downloading Archive dialog opens to report the status of the export.

Importing a Frame Settings File
You must re-boot the Ultrix to apply the settings of the imported *.ufs file. 

To import an Ultrix Frame Settings file

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Transfer tab.

3. Click Ultrix Frame Settings.

4. Locate the Import area.

5. Select the *.ufs file you wish to import as follows:



268 • Managing your Ultrix Settings Ultrix User Guide (v23.0)

a. Click Browse... 

The Open dialog opens.

b. Use the Open dialog to specify the *.ufs file to import.

c. Click Open to close the dialog and load the file.

6. Click Apply.

The Uploading Archive dialog opens to report the status of the transfer.
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Monitoring the Hardware
The Device Configuration interface in DashBoard provides status fields for monitoring the 
individual Power Supplies (PSU), the internal chassis fans, the SD Card, Ethernet ports, and the flash 
storage space of your Ultrix router.

Primary and Redundant Power Alarms
The Primary and Redundant Power alarms in the Frame Configuration interface do not consider 
what ports the PSU are connected on the Ultrix rear panel. The alarms trip only if the required 
minimum state for main or redundant power is not met. Refer to Table 49 for the power 
requirements.

Enabling the Alarms for the Router PSU Ports
You can customize the monitoring of the PSU by selecting which units to monitor and display an 
alarm message when the unit is not detected. The Alarms table fields in the Frame Configuration 
interface vary in severity from green (valid), yellow (caution), to red (alarm). DashBoard reports the 
most severe alarm for a single field.

For More Information on...
• the messages displayed in the Fans & Power tab, refer to Table 50.

To monitor the hardware status of an Ultrix router

1. In the Tree View of DashBoard, expand the node for the Ultrix router you want to monitor.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens.

5. Select the Alarms tab.

6. To add a new item to monitor:

 The ULTRIX-FR5 has an option of triggering a GPI contact closure for use with external 
equipment. Select the Alarm Relay box to activate for each alarm type required.

a. Click the Type cell in a row that is not assigned to an item to monitor. The row will report 
“Not Configured” with a yellow indicator in the State cell.

b. Select a PSU to monitor from the drop-down menu. Choose from the following:

› PSU # — Monitors the specified PSU port on the Ultrix rear panel.

Table 49  PSU Requirements based on Frame Size

Frame Size Min. PSU
Min. PSU for 

Redundancy (N+1)
Min. for Fully 

Redundant (2N) Max. Redundancy
ULTRIX(-NS)-FR1 1 2 2 4N

ULTRIX(-NS)-FR2 2 3 4 2N

ULTRIX-FR5 1 x Ultripower
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› Primary Power — Monitors the main power connection (non-PSU port specific) to the 
Ultrix rear panel and determines whether a sufficient number of power supplies are 
connected and operating for the router to run reliably (one PSU for an ULTRIX(-NS)-FR1, 
two PSU for a ULTRIX(-NS)-FR2, and one Ultripower for the ULTRIX-FR5). Refer to Table 49 
for details. 

› Redundant Power — Monitors additional power supplies connected to the Ultrix rear 
panel. When the Primary PSU is unavailable and no other PSU ports are in use, an alarm 
message will be raised to indicate that in the event of a power loss on the primary PSU, the 
router will lose power. Refer to Table 49 for details.

7. Refer to Table 50 for a summary of the possible messages displayed in the Alarms status fields. 
Table 50  Alarms — Status Messages

Item Parameters Description
System Error OK (Green) The last re-boot (power cycle) of the router was successful 

and no errors are detected.

Failed (Red) The last re-boot/power cycle of the router failed. You must 
re-boot/power cycle the router. If the issue still persists, 
contact Ross Technical Support.

None Not Configured 
(Yellow)

The row in the table is not currently monitoring any 
component of the Ultrix router.

Fan # OK (Green) Normal operation; no hardware errors are associated 
with the specified fan

x/y Indicates the fan speed in RPM where:
• x represents the current speed
• y represents the maximum speed

Stalled (Red) Indicates the specified fan is not running

Primary 
Power

OK (Green) Normal operation; no hardware errors associated with 
the PSU
• ULTRIX-FR5— an Ultripower connection is detected
• ULTRIX(-NS)-FR2 — at least 2 connected PSU are 

detected
• ULTRIX(-NS)-FR1 — at least 1 connected PSU is detected

Failed (Red) Indicates the minimum number of PSUa are not detected

Redundant 
Power

OK (Green) Indicates extra PSU are detected/available; normal 
operation; no hardware errors associated with the PSU
• ULTRIX(-NS)-FR2 — at least 3 connected PSU are 

detected
• ULTRIX(-NS)-FR1 — at least 2 connected PSU are 

detected

Failed (Red) Indicates the minimum number of PSUb are not detected

Temperature OK (Green) Indicates that the chassis core components temperature 
is within the normal range

Warning (Yellow) Indicates that at least one chassis core component 
temperature is between 75°C and 80°C (167°F and 176°F)

Failed (Red) Indicates that at least one chassis core component 
temperature is above 80°C (176°F)
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Setting the Chassis Fan Speed
The Ultrix router enables you to control the cooling fan speed of the interior chassis fans for 
optimum cooling.

To set the fan speed

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens.

5. Select the Fans & Power Supplies tab.

6. Use the Minimum Fan Speed slider to specify how fast the fans the will run.

Monitoring the Internal Memory
The Device Configuration interface enables you to monitor the flash storage space of your Ultrix 
router. This is useful when managing a large number of databases or during upgrades.

To monitor the flash storage space

1. In the Tree View of DashBoard, expand the node for the Ultrix router you want to monitor.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens.

5. Select the Alarms tab.

6. To enable the Flash Storage alarm:

a. Click the Type cell in a row that is not assigned to an item to monitor. The row will report 
“Not Configured” with a yellow indicator in the State cell.

b. Select Flash Storage.

Battery OK (Green) The battery installed in the Cooling Fan Module of the 
chassis is operating normally.

Warning (Yellow) The battery power is between 1.5V and 2.7V.

Failed (Red) The battery power is below 1.5V and requires 
replacement. Refer to “Monitoring the Battery”.

a. An ULTRIX(-NS)-FR2 requires a minimum of 2 PSU to be connected at all times. For ULTRIX(-NS)-FR1 
routers, a minimum of 1 PSU is required.

b. An ULTRIX(-NS)-FR2 requires a minimum of 2 PSU to be connected at all times. For ULTRIX(-NS)-FR1 
routers, a minimum of 1 PSU is required.

Table 50  Alarms — Status Messages

Item Parameters Description
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7. Refer to Table 51 for a summary of the possible messages displayed in the Flash Storage 
status field.

Monitoring the SD Card
The Device Configuration interface provides two methods for monitoring the SD Card:

• SD Card Free Space — provides an estimate of how much memory is currently allocated on the 
SD Card.

• SD Card Presence — monitors the physical state of the SD Card within the Ultrix chassis.

To monitor the SD Card storage space 

1. In the Tree View of DashBoard, expand the node for the Ultrix router you want to monitor.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens.

5. Select the Alarms tab.

6. To enable the SD Card Free Space alarm:

a. Click the Type cell in a row that is not assigned to an item to monitor. The row will report 
“Not Configured” with a yellow indicator in the State cell.

b. Select SD Card Free Space.

7. Refer to Table 52 for a summary of the possible messages displayed in the SD Card Free Space 
status field.

Table 51  Alarms — Flash Storage

Parameter Description Solution
OK Database and layout storage space is available

WARNING Database and layout storage space is low • Export unused databases and 
layouts as outlined in 
“Exporting a Database”; or

• Delete unused databases as 
outlined in “Deleting a 
Database”

CRITICAL Database and layout storage is nearly 
depleted

Table 52  Alarms — SD Card Free Space

Parameter Description Solution
OK Storage space is available

WARNING Less than 20% of the storage space is 
available

Contact Ross Technical 
Support

CRITICAL Less than 10% of the storage space is 
available
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To monitor the physical state of the SD Card

1. In the Tree View of DashBoard, expand the node for the Ultrix router you want to monitor.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens.

5. Select the Alarms tab.

6. To enable the SD Card Presence alarm:

a. Click the Type cell in a row that is not assigned to an item to monitor. The row will report 
“Not Configured” with a yellow indicator in the State cell.

b. Select SD Card Presence.

7. Refer to Table 53 for a summary of the possible messages displayed in the SD Card Presence 
status field.

Monitoring the Ethernet LEDs via the Rear Panel
Each RJ45 connector on the Ultrix rear panel include two LEDs that report the ethernet 
communication activity and speed. Refer to Figure 79 for LED locations on the Ultrix rear panel.

Figure 79  ENET Ports on Rear Panel — ULTRIX(-NS)-FR1 and ULTRIX(-NS)-FR2 LEDs

Table 53  Alarms — SD Card Presence

Parameters Description
OK (Green) There are no SD Card issues detected

FAIL The SD Card is not properly installed in the router 
chassis. Contact Ross Technical Support.

ENET 2

ENET 1

ENET 1 Port Speed LED
ENET 1 Port Link/Activity LED

ENET 2 Port Speed LED
ENET 2 Port Link/Activity LED
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Figure 80  ENET Ports on Rear Panel — ULTRIX-FR5 LEDs

Table 54 provides basic LED descriptions.

Table 54  ENET Port LEDs

LED Status Description
ENET # - 
Link/Activity

Green When lit green, this LED indicates a valid link is established 
on the specified ENET port.

Flashing When flashing green, this LED indicates communication 
activity is occurring on the specified ENET port.

Off When unlit, this LED indicates an invalid link is detected on 
the specified ENET port. Verify the cable connection on the 
rear module port and your network connections.

ENET # - Port 
Speed

Green When lit green, this LED indicates the ENET Port 
communication speed is at 1Gbps.

Yellow When lit orange, this LED indicates the ENET Port 
communication speed is at 100Mbps.

Off When unlit, this LED indicates the ENET Port 
communication speed is at 10Mbps.

ENET 1

ENET 2
ENET 2 Port Speed LED

ENET 2 Port Link/Activity LED

ENET 1 Port Speed LED

ENET 1 Port Link/Activity LED
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Monitoring the Battery
The Ultrix router uses a Panasonic® CR2032 battery to serve as an emergency backup power 
source for the essential memory of the router. This enables the router to power up with the same 
crosspoint selection as when it was powered off. This battery is located on the Cooling Fan Module 
installed inside the Ultrix router chassis.

 A spare battery was included in the Ultrix Shipping Kit (Ross P/N 2101KR-084) when your router 
was shipped from the factory.

Enabling the Battery Status Monitoring Feature in DashBoard
You can monitor the battery status via the Alarms table in the Frame Configuration interface. 

To configure an alarm for battery status monitoring

1. To In the Tree View of DashBoard, expand the node for the Ultrix router you want to monitor.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens.

5. Select the Alarms tab.

6. Click the Type cell in a row that is not assigned to an item to monitor. The row will report “Not 
Configured” with a yellow indicator in the State cell.

The Type menu opens.

7. Select Battery from the Type menu.

Replacing a Failed Battery in an ULTRIX-FR5
This section describes how to replace a failed battery within the ULTRIX-FR5 chassis.

Removing the Door from the Chassis

If the Battery alarm displays a red indicator in the Alarms table of the Frame Configuration 
interface, you will need to replace the battery installed inside the Cooling Fan Module of the chassis. 
This module is accessed via the front of the router chassis and requires that you remove the door 
first. The door is secured to the front of the router chassis with a rare earth magnet on each side. 

Caution — For reliable performance, the Ultrix router should not run without the Cooling Fan Module 
for more than 5 minutes.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semi-conductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.
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To remove the door from the ULTRIX-FR5

1. With your left hand, grasp the top and bottom of the door at the left sides.

2. With your right hand, grasp the middle of the door on the right side.

Figure 81  ULTRIX-FR5 Front Panel — Where to Grasp the Door

 If you have trouble removing the door from the chassis, use your right-hand fingers in the space 
between the door and the chassis for added leverage.

3. Pull the right side of the door towards you to disengage it approximately 1.0” from the chassis.

4. Pull the left side of the door towards you to fully disengage the door from the chassis.

Figure 82  ULTRIX-FR5 — Front Panel — Removing the Door

Caution — The door of the ULTRIX-FR5 is heavy. Ensure that you have a firm grip on the door, or that 
the door is otherwise supported, before removing it from the chassis.

Caution — Pull the door off without twisting or rotating it at too steep of an angle. 
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Removing a Battery from the ULTRIX-FR5
The battery is located on the Main Board inside the ULTRIX-FR5 chassis. You do not need to remove 
the Cooling Fan Module to replace the battery in an ULTRIX-FR5. 

To remove the battery from an ULTRIX-FR5

1. Locate and note the orientation of the failed battery on the Main Board. Refer to Figure 23.12 
for battery location.

Figure 23.1  ULTRIX-FR5 — Battery Location inside the Chassis

2. Gently move the latch to the left and away from the failed battery.

3. Remove the battery from its slot by pulling it away from the Main Board.

Installing a New Battery in the ULTRIX-FR5
Installing a new battery requires you to orient the battery on the Main Board, and secure the 
battery to the board. 

To install a new battery in the ULTRIX-FR5

1. Hold the battery in one hand and orient it so that the Positive side (+) faces away from you.

2. Pull the latch slightly away to make room for the new battery installation.

3. Slide the battery into the empty slot the failed battery was in.

4. Secure the battery to the Main Board using the latch.

To re-install the door on the ULTRIX-FR5

1. Align the door to the front of the router, ensuring that:

• the door is oriented upright
• the corner with the Ultrix logo is in your left hand, and
• the corner with the Ross logo is in your right hand. (Figure 24)

Caution — Only instructed persons may change or service the lithium coin batteries used in this 
apparatus.

Caution — Only instructed persons may change or service the lithium coin batteries used in this 
apparatus.

Battery
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Figure 24  ULTRIX-FR5 — Aligning the Door to the Chassis 

2. Align the left-side of the door against the chassis.

3. Align the right-side of the door, gently rotating the door into position.

4. Verify that the door is fully seated in place with the magnets securing it to the chassis.

Replacing a Failed Battery in an ULTRIX(-NS)-FR2
This section describes how to replace a failed battery within the ULTRIX-FR2 or ULTRIX-NS-FR2 
chassis. Note that the battery location differs depending on the model. 

Removing the Door from the Chassis

If the Battery alarm displays a red indicator in the Alarms table of the Frame Configuration 
interface, you will need to replace the battery installed inside the Cooling Fan Module of the chassis. 
This module is accessed via the front of the router chassis and requires that you remove the door 
first. The door is secured to the front of the router chassis with a rare earth magnet on each side. 

To remove the door from the ULTRIX(-NS)-FR2

1. With your left hand, grasp the top and bottom of the door at the left sides.

2. With your right hand, grasp the top and bottom of the door at the right side.

Caution — For reliable performance, the Ultrix router should not run without the Cooling Fan Module 
for more than 5 minutes.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semi-conductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.

IP: ###.###.##.###
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3
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Figure 23.1  ULTRIX-NS-FR2 Front Panel — Where to Grasp the Door 

 If you have trouble removing the door from the chassis, you can insert a flathead screwdriver into 
the notch on either side of the door for added leverage.

3. Pull the right side of the door towards you to disengage it approximately 1.0” from the chassis.

4. Pull the left side of the door towards you to fully disengage the door from the chassis.

Figure 23.2  ULTRIX-NS-FR2 Front Panel — Removing the Door

Removing the Cooling Fan Module from the ULTRIX(-NS)-FR2
This section only applies if you are replacing a battery in the ULTRIX(-NS)-FR2.

To remove the Cooling Fan Module from the ULTRIX(-NS)-FR2

1. With the door removed, use a #1 Phillips screwdriver to loosen the screw that affixes the 
Cooling Fan Module to the Main Board.

Caution — Pull the door off without twisting or rotating it at too steep of an angle. 
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Figure 23.3  ULTRIX(-NS)-FR2 — Location of Screw for Cooling Fan Module

2. Gently pull the Cooling Fan Module towards you to unseat it from the backplane and to 
disengage the module from the chassis.

Figure 23.4  ULTRIX(-NS)-FR2 — Removing the Cooling Fan Module from the Chassis

3. Pull the Cooling Fan Module free from the chassis and set it on a static-free surface.

Removing a Battery from the ULTRIX(-NS)-FR2
The battery is installed in a slot on the side of the Cooling Fan Module and secured in place with a 
small latch. 

To remove a failed battery from the ULTRIX(-NS)-FR2 Cooling Fan Module

1. Locate and note the orientation of the failed battery inside the Cooling Fan Module. (Figure 
23.5) 

2. Gently move the latch to the right and away from the failed battery.

3. Remove the battery from its slot by pulling it away from the Cooling Fan Module.

Caution — Only instructed persons may change or service the lithium coin batteries used in this 
apparatus.

Main Board

Screw
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Figure 23.5  Battery Location inside the Cooling Fan Module — ULTRIX-FR2 and ULTRIX-NS-FR2

Installing a New Battery in the ULTRIX(-NS)-FR2
Installing a new battery requires you to orient the battery on the module, secure the battery to the 
module, and then re-install the front door on the chassis. 

Caution — Only instructed persons may change or service the lithium coin batteries used in this 
apparatus.

Battery
Latch

ULTRIX-NS-FR2
Battery
Latch

ULTRIX-FR2
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To install a new battery in the Cooling Fan Module

1. Hold the battery in one hand and orient it so that the Positive side (+) faces away from you. 
(Figure 23.13)

Figure 23.6  New Battery Orientation —ULTRIX-FR2 and ULTRIX-NS-FR2

2. Slide the battery into the empty slot the failed battery was in.

3. Secure the battery to the module using the latch.

Re-installing the Cooling Fan Module
Once you have installed the new battery into the new Cooling Fan Module, you can re-install the 
Cooling Fan Module into the Ultrix chassis and replace the door on the front panel.

To install the Cooling Fan Module into the chassis

1. Align the new Cooling Fan Module in its slot inside the chassis.

2. Gently push the Cooling Fan Module into the slot until the module is fully seated. You will feel 
the back connector of the module engaged with its connector inside the chassis.

ULTRIX-NS-FR2

ULTRIX-FR2
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3. Use the screw from step 1 in the procedure “To remove the Cooling Fan Module from the 
ULTRIX(-NS)-FR2” to affix the Cooling Fan Module to the frame. 

Re-installing the Door on the Chassis  

To re-install the door on the ULTRIX(-NS)-FR2

1. Align the door to the front of the router, ensuring that the door is oriented upright, the corner 
with the Ultrix logo is in your left hand, and the corner with the Ross logo is in your right hand. 
(Figure 23.14)

Figure 23.7  ULTRIX(-NS)-FR2 — Aligning the Door to the Chassis

2. Align the left-side of the door against the chassis.

3. Align the right-side of the door, gently rotating the door into position.

4. Verify that the door is fully seated in place with the magnets securing it to the chassis.

Replacing a Failed Battery in an ULTRIX(-NS)-FR1
This section describes how to replace a failed battery within the ULTRIX-FR1 or ULTRIX-NS-FR1 
chassis. Note that the battery location differs depending on the model. 

Caution — The Cooling Fan Module includes a connector that must be fully seated. Reinstalling the 
Cooling Fan Module retention screw is required to ensure proper contact.

Caution — Re-installing the door incorrectly or misaligned can damage the door or internal 
components.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semi-conductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.

IP: ###.###.##.###
IP: ###.###.##.###
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Removing the Door from the Chassis

If the Battery alarm displays a red indicator in the Alarms table of the Frame Configuration 
interface, you will need to replace the battery installed inside the Cooling Fan Module of the chassis. 
This module is accessed via the front of the router chassis and requires that you remove the door 
first. The door is secured to the front of the router chassis with a rare earth magnet on each side.

To remove the door from the ULTRIX(-NS)-FR1

1. With your left hand, grasp the top and bottom of the door at the left sides.

2. With your right hand, grasp the top and bottom of the door at the right side.

Figure 23.8  ULTRIX-FR1 Front Panel — Where to Grasp the Door 

 If you are having trouble removing the door from the chassis, you can insert a flathead 
screwdriver into the notch on either side of the door for added leverage.

3. Pull the right side of the door towards you to disengage it approximately 1.0” from the chassis.

4. Pull the left side of the door towards you to fully disengage the door from the chassis.

Caution — For reliable performance, the Ultrix router should not run without the Cooling Fan Module 
for more than 5 minutes.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semi-conductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.

Caution — Pull the door off without twisting or rotating it at too steep of an angle. 
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Figure 23.9  ULTRIX-NS-FR1 Front Panel — Removing the Door

Removing the Cooling Fan Module from the ULTRIX(-NS)-FR1
This section only applies if you are replacing a battery in the ULTRIX(-NS)-FR1.

To remove the Cooling Fan Module from the ULTRIX(-NS)-FR1

1. With the door removed, use a #1 Phillips screwdriver to loosen the screw that affixes the 
Cooling Fan Module to the Main Board.

Figure 23.10  ULTRIX(-NS)-FR1 — Location of Screw for Cooling Fan Module

2. Gently pull the Cooling Fan Module towards you to unseat it from the backplane and to 
disengage the module from the chassis.

Figure 23.11  ULTRIX(-NS)-FR1 — Removing the Cooling Fan Module from the Chassis

3. Pull the Cooling Fan Module free from the chassis and set it on a static-free surface.

IP: ###.###.##.###
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Removing a Battery from the ULTRIX(-NS)-FR1
The battery is installed in a slot on the side of the Cooling Fan Module and secured in place with a 
small latch. 

To remove a failed battery from the ULTRIX(-NS)-FR1 Cooling Fan Module 

1. Locate and note the orientation of the failed battery inside the Cooling Fan Module. (Figure 
23.12)

Figure 23.12  Battery Location inside the Cooling Fan Module — ULTRIX-FR1 and ULTRIX-NS-FR1

2. Gently move the latch to the right and away from the failed battery.

3. Remove the battery from its slot by pulling it away from the Cooling Fan Module.

Installing a New Battery in the ULTRIX(-NS)-FR1
Installing a new battery requires you to orient the battery on the module, and secure the battery to 
the module. 

To install a new battery in the Cooling Fan Module

1. Hold the battery in one hand and orient it so that the Positive side (+) faces away from you. 
(Figure 23.13)

2. Pull the latch slightly away to make room for the new battery installation.

3. Slide the battery into the empty slot the failed battery was in.

Caution — Only instructed persons may change or service the lithium coin batteries used in this 
apparatus.

Caution — Only instructed persons may change or service the lithium coin batteries used in this 
apparatus.

Battery
Latch

ULTRIX-NS-FR1 Battery
Latch

ULTRIX-FR1
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Figure 23.13  New Battery Orientation —ULTRIX-FR1 and ULTRIX-NS-FR1

4. Secure the battery to the module using the latch.

5. Proceed to the section “Re-installing the Cooling Fan Module”.

Re-installing the Cooling Fan Module
Once you have installed the new battery into the new Cooling Fan Module, you can re-install the 
Cooling Fan Module into the Ultrix chassis and replace the door on the front panel.

To install the Cooling Fan Module into the chassis

1. Align the new Cooling Fan Module in its slot inside the chassis.

2. Gently push the Cooling Fan Module into the slot until the module is fully seated. You will feel 
the back connector of the module engaged with its connector inside the chassis.

3. Use the screw from step 1 in the procedure “To remove the Cooling Fan Module from the 
ULTRIX(-NS)-FR1” to affix the Cooling Fan Module to the frame. 

Caution — The Cooling Fan Module includes a connector that must be fully seated. Reinstalling the 
Cooling Fan Module retention screw is required to ensure proper contact.

ULTRIX-NS-FR1

ULTRIX-FR1
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Re-installing the Door on the Chassis  

To re-install the door on the ULTRIX(-NS)-FR1

1. Align the door to the front of the router, ensuring that the door is oriented upright, the corner 
with the Ultrix logo is in your left hand, and the corner with the Ross logo is in your right hand. 
(Figure 23.14)

Figure 23.14  ULTRIX-NS-FR1 — Aligning the Door to the Chassis

2. Align the left-side of the door against the chassis.

3. Align the right-side of the door, gently rotating the door into position.

4. Verify that the door is fully seated in place with the magnets securing it to the chassis.

Caution — Re-installing the door incorrectly or misaligned can damage the door or internal 
components.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semi-conductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.

IP: ###.###.##.###
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Monitoring the 
Communications
This chapter summarizes how to verify communications on an Ethernet port, an Ultricore 
connection, and the overall communication status of the Ultrix router.

Monitoring the Network Status
The Ethernet ports on the Ultrix rear panel are used to connect to an Ethernet network for 
communications. An ENET port is set to active when Ultrix automatically detects a valid network link 
on the port. When a valid link is detected on both ports, the ENET 1 port is set to active and is the 
primary connection. 

 There are two ENET ports on the Ultrix rear panel. A fail-over feature enables the Ultrix router to 
automatically use the second ENET port when the primary ENET connection is lost or unavailable.

To verify the communication status of an Ethernet Port via DashBoard

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens.

5. Locate the Status field in the Network Settings area.

This field reports which Ethernet port is currently active.

6. Refer to Table 55 for a summary of the possible messages displayed in the Status field.

Table 55  Frame Configuration — Status Field

Item Parameters Description
Status ENET # is Active 

(Green)
Ethernet communications for the specified 
port are valid. The specified ENET port on 
the Ultrix rear panel is the currently active 
(in use).

Inactive (Red) Ethernet communications for the router are 
invalid. The following conditions may be 
occurring:
• The ethernet cables are disconnected 

from the rear panel.
• A valid network connection may be 

unavailable.
• The IP Address is for the router is no 

longer valid. 
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Monitoring the Ultricore Mode Status
The primary Ultrix router passes all commands to each client Ultrix router in the system. Each client 
Ultrix router responds back to the primary in minute intervals.

Primary Status
If the Ultrix router is configured as a primary, the Frame Configuration > Communications tab 
reports on the status between it and each client router connected to it. Each client is listed in the 
table, with the most recently connected router displayed at the bottom of the list. 

Figure 24  Communications Tab — Example of the Ultricore Mode Field

Client Status
If the Ultrix router is configured as a client, the Communications tab reports on the 
communications between it and the primary.

Troubleshooting
If you have lost communication between the primary Ultrix router and its clients:

1. Verify that each router is installed correctly.

2. Verify that each router is installed with a network connection to your facility.

3. Verify the ethernet settings for each router are valid.

4. Verify that the primary Ultrix router reports a list of valid connections to clients in its Ultricore 
Clients table. 

5. Verify that each client Ultrix router is running software compatible to the primary Ultrix router.

Monitoring the Ultrix System Status
The System Status node displays an indicator that varies in severity from green (valid) to red 
(alarm). This indicator reports the most severe alarm the Ultrix is experiencing. The types of alarms 
the Ultrix reports is configured via the Frame Configuration > Alarms tab.

When you hover your mouse cursor over a red System Status node in the Tree View of DashBoard, 
as seen below, a tool tip displays with a brief error message. The message and indicator continue to 
report an error until the condition is addressed or the alarm is disabled in the Alarms tab.
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Figure 25  Example of a Master Alarm Message

For More Information on...
• the options available in the Alarms tab, refer to “Alarms Tab”.

Using the System Logs in DashBoard
An entry in each log includes a timestamp, a code number, and a description. Messages are written 
to the log when significant changes occur in the operation of the Ultrix router. These could include: 
changes to video, reference, audio or time inputs; power-on or reboot cycles; configuration changes 
that can have an effect on the routing path; alarm conditions.

To access the system logs in DashBoard

1. In the Tree View of DashBoard, double-click the System Status node under the Ultrix node.

The System Interfaces display in the DashBoard window.

2. Select the Logs tab.

The Logs tab opens.

3. To view the communication log for Ultrix only, select the System Log option.

4. To view the log for communications between Ultrix and other devices, select Controller 
Communications Log.

5. To view the log for executed tasks in DashBoard for the router, select DashBoard 
Communications Log.

6. Click Refresh to update the entries for the currently selected log.
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Monitoring the Signals
This section outlines how to monitor the reference signal, the inputs and outputs signals via the 
options in the Frame Configuration interface.

Monitoring the Reference Signal
The Sync area of the Frame Configuration interface reports on the signals connected to the REF 
ports on the Ultrix rear panel.

For More Information on...
• setting the default reference, refer to “Specifying a Default Reference Format”.

To monitor the Ultrix reference signal

1. In the Tree View of DashBoard, expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens.

5. Select the References tab.

6. Refer to Table 56 to troubleshoot the messages displayed in the status fields.

Table 56  Frame Configuration — References Status

Item Parameters Description
Status Active (Green) A valid reference signal is connected to the 

REF port on the Ultrix rear panel

No Sync (Yellow) No signal detected on the REF port on the 
Ultrix rear panel
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Triggers Status
The Triggers area of the Frame Configuration interface reports on the signals connected to the 
reference ports on the Ultrix rear panel.

To monitor the Ultrix reference signal

1. In the Tree View of DashBoard, expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Frame Configuration page opens.

5. Select the References tab.

6. Refer to Table 57 to troubleshoot the messages displayed in the Detected and Format status 
fields for each sync trigger.

Monitoring the SDI Outputs
The Port Configuration interface enables you to monitor the signal status of the SDI outputs of the 
Ultrix.

To monitor the status of all the SDI outputs of the Ultrix router

1. In the Tree View of DashBoard, expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

Format Unknown A reference signal is detected but the 
format is not supported by the router

# Indicates the video format of the reference 
signal

Table 57  Frame Configuration — Triggers Status

Item Parameters Description
Detected Unknown The format of the reference signal is not 

supported by the router

# Indicates the video format of the reference 
signal that is used when the specified 
Trigger ID is used by an output

Format Custom The switching line is specified by the user 
via the Custom menu

# Indicates the video format of the reference 
signal that the specified Trigger will use

Table 56  Frame Configuration — References Status

Item Parameters Description
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The Port Configuration page opens.

5. From the top row of buttons, click the button for the slot you want to monitor.

6. Locate the row for the output port you wish to monitor.

7. Refer to Table 58 to troubleshoot the messages displayed in the status fields for each physical 
output port.

Monitoring the SDI Inputs
The Port Configuration interface enables you to monitor the signal status of the SDI inputs of the 
Ultrix router.

To monitor the status of all the inputs of the Ultrix router

1. In the Tree View of DashBoard, expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Port Configuration page opens.

5. From the top row of buttons, click the button for the slot you want to monitor.

6. Locate the row for the input port you wish to monitor.

7. Refer to Table 59 to troubleshoot the messages displayed in the status fields for each physical 
input socket.

Table 58  Port Configuration — Output Messages

Item Parameters Description
Physical Address slot#.out[#] Indicates the physical socket on the Ultrix 

rear panel

Error Status OK (Green) Indicates a valid output signal is detected 
on the specified socket

No Signal (Red) Indicates that a valid output signal is not 
detected on the specified socket 

Video # Indicates the SDI signal type detected on 
the specified socket

Audio # Indicates the audio signal type detected on 
the specified socket

Table 59  Port Configuration — Input Messages

Item Parameters Description
Physical Address slot#.in[#] Indicates the physical socket on the Ultrix 

rear panel

Error Status OK (Green) Indicates a valid input signal is detected on 
the specified socket

No Signal (Red) Indicates that a valid input signal is not 
detected on the specified socket 
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Monitoring a Specific BNC
The Port Configuration tab enables you to monitor the video and/or audio signal status of a specific 
port and/or a group of selected ports on the Ultrix rear panel.

To monitor the status of a specific port for the Ultrix router

1. In the Tree View of DashBoard, expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Select .

The Port Configuration page opens.

5. From the top row of buttons, click the button for the slot you want to monitor.

6. From the blade map, select the port(s) you wish to monitor.

The label under each selected port is highlighted in blue and the Port Configuration tab 
updates to display information on the selected port(s). In the example below, Port 4 in slot 1 
was selected on an ULTRIX-FR2.

7. Click Video to monitor the status of the video signal on the selected port. 

8. Click Audio to monitor the status of the audio channels on the selected port.

Video # Indicates the SDI signal type detected on 
the specified socket

Audio # Indicates the audio signal type detected on 
the specified socket

Table 59  Port Configuration — Input Messages

Item Parameters Description
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Software Upgrades
The Ultrix router is upgraded through the DashBoard client. To obtain the most recent upgrade 
package, contact Ross Technical Support.

 Ensure that you are running DashBoard software version 8.7.1 or higher and that the computer 
running the DashBoard client is located on the same network as the Ultrix router.

To upgrade the Ultrix software

1. Contact Ross Technical Support for the latest software version file.

2. Ensure the router has a valid Ethernet connection.

3. Launch DashBoard by double-clicking its icon on your computer desktop.

4. Locate the Ultrix in the Tree View of DashBoard.

5. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

6. Expand the Ultrix sub-node.

7. Double-click the System Status node.

The System Status interface displays in the DashBoard window.

8. Click Upload, located near the bottom of the tab.

The Select File to Upload dialog opens.
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9. Navigate to the *.bin file you want to upload.

10. Click Open.

11. Click Finish to start the upgrade.

12. Monitor the upgrade.

An Upload Status dialog enables you to monitor the upgrade process.

 Avoid clicking Reboot until the Ultrix has successfully completed the file upload process and the 
OK button, located in the bottom right corner of the dialog, is enabled.

13. Click OK to reboot the Ultrix. 

The Reboot Confirm dialog opens, indicating the Ultrix will reboot.

14. Click Yes to continue the upgrade process. 

 The router is temporarily taken off-line during the reboot process. The process is complete once 
the status indicators for the router return to their previous status.
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DashBoard Interface Overview
The DashBoard client software enables you to monitor and configure your Ultrix routers. Using the 
interfaces provided via the DashBoard client software, you can:

• Configure the network connection for your router
• Configure router levels and assign level names
• Assign physical router inputs and outputs to logical sources and destinations
• Configure source and destination labels
• Perform crosspoint preset/takes
• Monitor the status of multiple levels
• Create and use salvos

For More Information on...
• the DashBoard client software, refer to the DashBoard User Manual.
• navigating the interfaces in DashBoard, refer to “Accessing the Ultrix Interfaces in 

DashBoard”.

Ultrix in DashBoard
Ultrix groups the configuration, monitoring, and operating features in a Tree View in the DashBoard 
client window. Each node of the tree opens to reveal one or more sub-nodes, giving access to the 
features for your router.

Figure 26  Example of the Ultrix Nodes in a DashBoard Window

Ultrix includes the following interfaces, as separate nodes, in the DashBoard Tree View.

UltriScape

The first node provides access to the UltriScape Layout Editor, and UltriScape Head interfaces. 
UltriScape is the integrated Multiviewer for Ultrix routers. Use the UltriScape Layout Editor to 
manage the layouts and the UltriScape Head to assign sources to the UltriScape Head outputs. You 
must have at least one UltriScape license key installed to access the UltriScape interfaces.
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System Status

Double-clicking the System Status node displays two types of tabs within the same DashBoard 
window: Status (read-only) tabs located on the left, and a series of Configuration tabs located on the 
right. This interface is similar to an openGear® card tab system.

Database

Expanding the Database node enables you to configure the connection points, matrices, 
destinations, sources, group, levels, soft panels, and salvos for the router. The settings are saved 
locally on the router.

Devices

The sub-nodes under Devices provide a list of devices in the routing system currently 
communicating with the Ultrix router.

Soft Panels

The Soft Panels tree provides access to the Matrix, MultiBus, and Category soft panels for the Ultrix 
router. From these panels you can perform crosspoint switches, and manage salvos.

Terminology
Throughout the Dashboard interface, actual sockets (inputs and outputs) of a router (or matrix) are 
referred to by hierarchical dotted notation: Frame.Slot.Port.Type.Channel where:

• Frame identifies the physical router chassis housing the matrix/matrices.
• Slot identifies which slot in the matrix the socket is located in.
• Port identifies the physical input or output socket.
• Type identifies the generic signal type (e.g. SDI, audio).
• Channel identifies the audio channel within an SDI stream.

These designators may be assigned more user friendly names if required by editing the Port Labels 
interface.
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System Status Interface
The System Status interface provides hardware information, IP Address settings, and general 
database management for your router. The interface is organized into two distinct areas in the 
DashBoard window: Status tabs (located on the left), and Configuration tabs (located on the right). 

Figure 27  Example of a System Status Interface

Status Tabs
The Status tabs display read-only information about the Ultrix hardware and software.

Product Tab

Table 60 summarizes the read-only information displayed in the Product tab.

Table 60  Product Tab

Item Parameters Description
Product Indicates the Ultrix product name

Vendor Indicates the supplier/manufacturer of the router

System Version Indicates the build version of the Ultrix router

Serial Number Indicates the serial number of the Ultrix router

Uptime #h #m #s Indicates the number of hours since the last reboot 
of the Ultrix router

System Time DD mm dd yyyy 
hh:mm:ss

Indicates the current date based on the Ultrix 
internal clock (if no connection to an NTP Server is 
available) where:
• DD represents the calendar day
• mm represents the month
• dd represents the day
• yyyy represents the year
• hh:mm:ss represents the current local time
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Other Tab

Table 61 summarizes the read-only information displayed in the Other tab.

Configuration Tabs
The Configuration tabs are located on the right side of the DashBoard window. This series of tabs 
provide network setup options for the Ultrix router and managing the databases for your router.

Network Tab

Table 62 summarizes the fields and menus displayed in the Network tab.

Table 61  Other Tab

Item Parameters Description
Frontend Software 
Date

<number>

Read-only information used by Ross Technical 
Support.Backend Software 

Date
<number>

Device FW Rev <number>

Table 62  Network Tab

Item Parameters Description
Information (Read-only)

Active ENET ENET # Indicates which Ethernet port on the router is 
the primary Ultrix network connection

ENET # LINK Connected (x, y) Indicates that a valid network link is configured 
on the specified Ethernet port of the Ultrix 
router where:
• x represents the connection speed in number 

of Mbps
• y represents the link type (e.g. full duplex)

Not Connected Ethernet communications for the Ultrix router 
are invalid. The Ethernet cable may be 
disconnected on the rear panel or the Ethernet 
network may be down or experiencing 
problems.

ENET MAC <number> Indicates the MAC Address for the Ultrix router 

Settings

Address ###.###.###.#
##

Specifies the IP address for the Ultrix router

Subnet Mask ###.###.###.#
##

Specifies the subnet mask for the Ultrix router

Gateway ###.###.###.#
##

Specifies the gateway for communication 
outside of the local area network (LAN)

Cancel Ignores any unsaved changes made to the Address, Subnet Mask, 
and Gateway settings and reverts back to the current running 
values.

Apply Updates the Address, Subnet Mask, and Gateway settings
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Services

SSH Selected Enables the ability to log onto the Ultrix via an 
SSH server. 
Secure Shell (SSH) Login is a client-server 
protocol used by system administrators to 
securely log onto remote systems and execute 
commands over an unsecured network. SSH 
may also be used by Technical Support for 
advanced troubleshooting.

Cleared Disables this service

FTP Selected Enables the ability to communicate with the 
Ultrix over an FTP connection

Cleared Disables this service

Walkabout Selected Enables the Ultrix to communicate with devices 
in the Walkabout system. Refer to “Using 
Walkabout in DashBoard”.

Cleared Disables this service

Change Applies changes to the settings in the Services menus

SNMPa

Enable SNMP Selected Enables the SNMP Agent on the Ultrix

Cleared Disables the SNMP Agent on the Ultrix

SNMP Community 
Name

# Specifies the SNMP Agent identifier for 
communications

SNMP Trap 
Destination IP 
Address

###.###.###.#
##

Specifies the target address the Ultrix sends 
SNMP traps to

Permitted Clients

DashBoards: ###.###.###.#
##

Lists the IP Address of each DashBoard client 
that is allowed to communicate with this Ultrix 
router

Add Enables you to add a new DashBoard client to 
the Permitted Clients list

Delete Deletes the selected DashBoard client from the 
Permitted Clients list

Delete All Clears all entries in the Permitted Clients list

Edit Enables you to modify the selected entry in the 
Permitted Clients list

Cancel Ignores any unsaved changes made to the 
Permitted Clients list and reverts back to the 
current running values. 

Apply Updates the Permitted Clients list settings

a. Requires the Ultricore-SNMP license key.

Table 62  Network Tab

Item Parameters Description
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Database Tab

Table 63 summarizes the fields and menus displayed in the Database tab. The options in the 
Database tab are organized into two sections: Current Database, and Database Management.

Table 63  Database Tab

Item Parameters Description

Current Databasea

Remote Controller 
Mode

Selected This Ultrix router will be controlled by a remote 
(primary) Ultrix router or Ultricore device. You must 
reboot this router before the change can take 
effect.

Cleared This Ultrix router is a standalone router or is the 
primary router (system controller) for the routing 
system.

Name (read-only) <name> Indicates the database currently loaded in the Ultrix 
router

Levels (read-only) # Indicates the number of levels the database is 
configured for

Sources (read-only) # Indicates the number of inputs the database is 
configured for

Destinations 
(read-only)

# Indicates the number of outputs the database is 
configured for

Enable Tally Selected Select this box to enable Ultrix to read tally 
identifiers from the input signals. This information 
is used by the database for displaying in the PiPs of 
the UltriScape head(s), and passed through to any 
assigned outputs.
Selecting this box also updates the Sources and 
Destinations tabs with a new column “Tally” that is 
used to assign Tally IDs to sources and/or 
destinations.

Cleared Tally information from the input signals is not read 
into the Ultrix database

I/O Ports Refresh Updates the Matrix Inputs and Outputs lists in the 
Sources and Destinations tabs respectively

Crosspoint Status Refresh Updates the Status field located directly below this 
button

Status (read-only) Loaded The active database was successfully loaded. 

Errorb One of the following has occurred:
• the selected database is no longer available
• an attempt was made to delete a non-existent 

database
• an attempt was made to save a database with an 

existing name

Database Management - Load Database

Name <name> Selects the database to load for the Ultrix router
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Transfer Tab

Table 64 summarizes the sub-tabs displayed on the Transfer tab. 

Database Load Loads the specified database to the Ultrix router

Database to RCPs Send Forces the currently loaded database to 
refresh/update all connected devices (i.e. RCPs, etc.)

Database Management - Add Database

Name <name> Provides a unique identifier for the new database 
(up to 32 characters)

Include I/O Maps Creates a database to match the quantity of BNC 
I/O fitted in the Ultrix router. Each input / output 
SDI port will be mapped to default labels of SRC xx 
and DST xx respectively.
• I/O mapping occurs for Level 1 only (SDI)
• the Sources field is ignored
• the Destination field is ignored
• the Level field is applied

Levels # Specifies the total number of levels the database 
will make available

Sources # Specifies the total number of sources the database 
will make available

Destinations # Specifies the number of destinations the database 
will make available

Database Add Uses the settings in the Database Management 
fields to create a new database

Database Management - Delete Database

Name <name> Specifies the database to delete

Database Delete Deletes the currently selected database

Status Management

Snapshot Save

a. The Levels, Sources, and Destinations fields indicate the initial values when the database was created. 
Levels, Sources, and Destinations can be removed from or added to the database on their respective 
configuration tabs. Doing so will not alter the fields in the Database tab.

b. This message displays for a maximum of 10 seconds only.

Table 64  Transfer Tab

Section Item Parameters Description
Ultricore Database Tab

Table 63  Database Tab

Item Parameters Description
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Export Database <database 
name>

Selects the database to be exported

Save As: 
(read-only)

*.uda Automatically updates with the name of the 
database archive

Browse... Enables you to save or re-name the database to a specific 
location

Apply Click to begin exporting the file to specified location

Import Archive File: 
(read-only)

*.uda Indicates the last file that was selected for 
restore

Browse... Enables you to specify the database to import

Retrieve 
Database As:

<database 
name>

Indicates the file currently selected for 
importing

Apply Click to begin the import

Ultricore Credentials Tab

Export Database: It is recommended that an export of the 
current users is made prior to import if 
there is any requirement to restore the user 
data to the original information in the 
database

Save As: *.uuc Creates a file that captures the current user 
login data, usernames, and passwords. 
Note that passwords are encrypted in this 
file so users will only need to enter their 
passwords once.

Browse...

Apply Click to begin the export

Import User 
Credentials 
File:

*.uuc Allows the user login data, usernames, and 
passwords, to be imported. Importing this 
file will overwrite the user information in 
the current database.

Browse... Enables you to specify the *.uuc to import

Apply Click to begin the import

Ultricore Profiles Tab

Export Database: Export the database with the user data (user accounts and 
profiles)

Save As: *.uup Creates a new user data file 

Browse... Enables you to save or re-name the user data file to a specific 
location

Apply Click to begin exporting the file to the specified location

Table 64  Transfer Tab

Section Item Parameters Description
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Setup Tab

Table 65 summarizes the options displayed in the Setup tab. 

Import User Profile 
File:

*.uup Imports a database with the user data (user 
accounts and profiles)

Browse... Enables you to specify the user data file to import

Apply Click to import the user data file to the current database

Ultriscape Layout Tab

Export Layout <layout name> Selects the layout to be exported

Save As... 
(read-only)

*.lay Automatically updates with the name of the 
layout archive

Browse... Enables you to save or re-name the layout to a specific location

Apply Click to begin exporting the file to the specified location

Import Layout File 
(read-only)

*.lay Indicates the last layout file that was 
imported

Browse... Enables you to specify the layout to import

Retrieve 
Layout As:

<layout name> Indicates the file currently selected for 
importing

Apply Click to send the file to the device

Ultrix Frame Settings Tab

Export Save As: 
(read-only)

*.ufs Automatically updates with the name of the 
frame settings archive

Browse... Enables you to save or re-name the frame file to a specific 
location

Apply Click to begin exporting the file to the specified location

Import Settings File: *.ufs Indicates the last frame file that was 
imported

Browse... Enables you to specify the frame file to import

Apply Click to send the file to the device

Table 65  Setup Tab

Item Parameters Description
Device Identification

Device Name <name> Provides a unique identifier for the router in the 
Tree View of DashBoard 

System Name <name> Provides a unique identifier for the routing system

Log Settings

Logging Selected Enables the router to update the entries in the Logs 
tab

Cleared Disables this feature

Table 64  Transfer Tab

Section Item Parameters Description
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Storage Tab

Table 66 summarizes the read-only displayed in the Storage tab.

Output Debug 
Messages

Selected Only use this feature under the guidance of Ross 
Technical Support.Cleared

DashBoard Interface

DashBoard Timeout 10-300s Sets the maximum number of seconds that 
DashBoard waits until it queries Ultrix. The default 
is 70 seconds. 

Update Applies the new value in the DashBoard Timeout menu.

Password Protected Settings

Protect all licensed 
features with a 
password

Selected Enables the password-protected feature that 
prevents unauthorized changes to license keys. 
When the Port License tab is locked, users require a 
password to access/edit the license key 
information. 

Cleared Disables this feature (the Port License tab is 
editable). This is the default.

Change Password... Enables you to specify a password at least 8 characters long.
It is recommended to change the password from the default value that 
is assigned at the factory.

Status

Status (read-only) mm/dd/yy 
ERROR: 
Duplicate device 
name [abc] for 
ID [#]

Reports when multiple devices, with the same 
name, are communicating with the Ultrix router 
where:
• mm/dd/yy represents the date of the error
• [abc] represents the device name
• [#] represents the ID number assigned to the 

device

Clear Clears the Status field entry

Ultricore Profile Settings

User Credentials Selected All users have full access to all settings and 
interfaces of the Ultrix. This is the default.

Cleared Users must enter their credentials as defined by the 
Ultricore Profiles feature.

User Profiles Selected Users must enter their credentials as defined by the 
Ultricore Profiles feature

Cleared All users have full access to all settings and 
interfaces of the Ultrix. This is the default.

Table 65  Setup Tab

Item Parameters Description
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Logs Tab

There are three logs that can be viewed from the Logs tab: System Log, Controller Communications 
Log, and DashBoard Communications Log. The read-only information displayed in the logs is used 
by Ross Technical Support for diagnostic and troubleshooting purposes.

Device Configuration Interfaces
The Device Configuration interfaces enable you to define the physical outputs, inputs, and 
communication ports of the Ultrix router. You can also monitor the overall status of the Ultrix 
router, or just the status of a specific signal path or port on the rear panel. The Device Configuration 
menus are accessed by clicking the corresponding button on the top toolbar of the interface: Frame 
View, Port Configuration, Frame Configuration, SFP Configuration, and Licenses. This section briefly 
summarizes each interface.

For More Information on...
• displaying the Device Configuration interfaces, refer to “To access the Device Configuration 

interfaces in DashBoard”.

Navigation Toolbar
A toolbar always displays at the top of each Device Configuration interface. From this toolbar you 
can quickly monitor the overall status, verify the IP address, and navigate between the Device 
Configuration interface. This section outlines the read-only fields and buttons on the toolbar (from 
left to right).

Figure 28  Example of the Navigation Toolbar

Table 67 outlines the read-only fields and buttons on this toolbar.

Table 66  Storage Tab

Item Parameters Description
Internal OK There are no storage space issues detected

WARNING Less than 20% of the storage space is available

CRITICAL Less than 10% of the storage space is available

SD Card OK There are no storage space issues detected

Table 67  Device Configuration — Toolbar

Item Parameters Description
Frame Reports the unique identifier assigned to the router

Type Reports the model of the router. Figure 28 shows an ULTRIX-NS-FR2.

IP Reports the current TCP/IP network address assigned to the router

Displays the home page (frame view) that includes a map of the router rear 
panel. Selecting a blade displays the options for that blade. Selecting one or 
more ports display the options for the port(s). Refer to “Frame View” for details.

Displays the configuration options for the ports on the rear panel. Refer to “Port 
Configuration” for details.
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Frame View
The Frame View page provides a map of the rear panel. The number of slots and the available 
connections depends on the router model and the type of blade(s) installed in each slot. Colors and 
icons indicate port status.

Figure 29  Example of the Frame View Page — ULTRIX-FR5 with ULTRIX-HDBNC-IO Blades

Displays the global configuration options for the router, such as network 
settings, specifying a reference source, and enabling alarms. Refer to “Frame 
Configuration” for details.

Displays the options to configure an ULTRIX-SFP-IO blade or a port that is 
populated with an SFP module. Refer to “SFP Configuration Tab” for details.

Displays options for managing the license keys for your router. Refer to 
“Licenses” for details.

Status

Select this button to display a list of changes for the active slots

Table 67  Device Configuration — Toolbar

Item Parameters Description
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Figure 30  Example of the Frame View Page — ULTRIX-FR5 with ULTRIX-HDX-IO Blades

The top row of the router map represents the power connections (left side), and any UCCI blades 
installed (right side). Selecting a power connector displays the Frame Configuration > Fans & Power 
tab. Selecting a port from an Ultrix-UCCI blade displays its options in the Port Configuration page.

Each subsequent row represents a populated slot in the chassis. Selecting a slot displays its options 
in the Port Configuration page. 

Selecting a port displays its options and status on the Port Configuration page. When a port is 
selected, its label (located under the port image) is lit blue. Refer to “Port Configuration” for 
information on the types of menus and fields on this page.

Each port is lit green, yellow, or red to indicate its status:

• Red — no signal is present or is a type/format that is not supported.
• Yellow — an SDI signal is present without embedded audio.
• Green — an SDI signal is present with embedded audio.

Selecting any other ports navigates directly to the relevant configuration and status page.

Port Configuration
The Port Configuration page reports individual I/O port status and settings. Selecting a slot updates 
the table for all installed ports. Selecting a port displays only the options for that port (the label 
under the port icon is lit blue). You can also choose to filter the information displayed in the table 
(e.g. only inputs, or only outputs). 
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Figure 31  Example of the Port Configuration Page

1. Populated Slots

A row of buttons representing the slots available on the rear panel. Selecting a button displays 
the options specific to that slot. This provides quick I/O module selection to view status and port 
configuration. Figure 31 shows that Slot 1 was selected.

2. View Options

The Views options in this area enable you to filter the information displayed on the Port 
Configuration page. Choose from the following:

› Baseband/IP — Toggle this button to select between baseband (SDI) signals or IP signals (blade 
dependent).

› Ports/Channels — Toggle this button to select between primary signal view (SDI) or embedded 
audio channel view.

› Inputs/Outputs — Toggle this button to specify the type of port to display in the table. 
› Select All — Select this button to change the port view to see all ports of a specific type (input or 

output).
› Clear All — Select this button to clear the port view to allow individual port selection.

3. Slot Map

This area provides a graphic representing the physical ports of the selected slot. Select a port 
image to display its details in the Port Configuration Table. A port label is highlighted in blue 
when the table displays information specific to that port. The color of the port denotes its signal 
status as follows:

› Red — no signal present or is of type not supported.
› Yellow — an SDI signal is present but does not include embedded audio.
› Green — an SDI signal is present and includes embedded audio.
› Gray — the port is not in use or it is not populated with an SFP module. 

A port may also display a character above it:

› M — the port is currently assigned as an UltriScape (Multiviewer) output.
› i — the port is currently assigned as part of a Gearbox quad-link group.

1) Populated Slots 3) Slot Map

2) View Options 4) Port Configuration Table

4
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› / — the port is currently configured with UltriSync (frame sync) license.

Select individual ports to toggle port details list. The port identifying number/letter is highlighted 
when included in the port details list.

 Selecting a non-signal port (such as a power connector, or reference port) opens the status and 
configuration page for the port type.

4. Port Configuration Table

A table that displays details on each port for the selected slot. The columns and rows depend on 
the blade type that populates the slot. Refer to the following sub-sections for blade-specific 
details. The table is filtered by the selections made via the View Options. For example, to 
monitor/configure a single audio input:

a. From the Selection Options, click Clear All.

b. From the Views Options, click Channels.

c. Select the required I/O port. 

The table updates to display only the selected port. You may add more ports to view simply 
by selecting them on the rear panel graphic display.

SDI I/O Blades

Selecting any blade (HD-BNC, SFP, HDX, etc.) using the buttons located in the Populated Slots 
selection bar, displays the Port Configuration table for the selected blade. The location of the port is 
reported at the top of the page. Figure 32 shows the page for an HD-BNC I/O blade installed in Slot 
2 with only the information for the outputs displayed.

Figure 32  Example of Port Configuration Interface — HD-BNC I/O Blade 

Table 68 summarizes the columns that may display on the Port Configuration page. 

Table 68  Port Configuration Tab

Item Parameters Description
Physical Address Frame.Slot.Port.Type.

Channel
Lists the physical ports, in ascending order, of the 
Ultrix router. Each row represents a port.

Video # If a port is used for video signals, this field indicates 
the type of video (e.g. HD, 3G, UHD, etc.).

Audio # If a port is used for audio signals, this field indicates 
the type of audio detected (e.g. PCM, AES etc.).
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Timing Lines 
(read-only)

# Reports the value of timing difference between 
input and frame reference in number of lines.

Detecting The timing difference is being detected; updates the 
field approximately every 33 seconds.

Async There is no timing relationship between the input 
signal and the frame reference.

Timing Pixels 
(read-only)

# Reports the value of timing difference between 
input and frame reference in number of pixels. 

Detecting The timing difference is being detected; updates the 
field approximately every 33 seconds.

Async There is no timing relationship between the input 
signal and the frame reference

Frame Sync 
Delay

# frame(s) Specifies the frame buffer size for the selected input 
port

LoS Statea,b Black Sets the input to black during the loss of signal

Freeze Sets the input to the last valid frame of video before 
the loss of signal

2-SI Group Enable Gearbox is available on the indicated I/O Group in 
groups of 4 consecutive I/O. For example, selecting 
Enable in the row for slot1.in[1] creates a Gearbox 
group from slot1.in[1] to slot1.in[4].
Note that I/O Groups for Gearbox are defined in the 
table using colored backgrounds. In Figure 31, the 
first Gearbox group is set in dark red, the second 
group is set in dark green.

Disable The indicated I/O is not included in a Gearbox 
configuration

Signal Medic 
(read-only)c

Not available This port does not support the Gearbox feature.

Good This port is included in a Gearbox setup.

Replaced This port can be included in a Gearbox setup but is 
currently not included in the 12G link.

Matte Gen Disable Disable an internally generated test pattern. This is 
the default.

Static Generates a static color matte

Bouncing Box Generates a static color matte with a 
complimentary colored moving box

Luma Sequence Generates a luminance shifting sequence based on 
chosen color

Matte Format # Specifies the signal format of the generated test 
pattern. If you select Auto, the test pattern 
automatically matches the incoming signal type.

Matte Color # Specifies the color of the test signal

Table 68  Port Configuration Tab

Item Parameters Description
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ULTRIX-IP Blade

When an ULTRIX-IP-IO blade is installed in a router slot, selecting a specific port on the rear panel 
map displays configurable options for that port. You can configure the sender, and receiver streams 
the port will manage. Refer to “ULTRIX-IP-IO Setup” for details on using this interface.

Audio Bypass Selected When Audio Bypass is enabled for an input, the 
audio will follow the SDI regardless of any individual 
audio channel routing or configuration on the 
output. 
The individual channels of an input in Bypass mode 
are still de-multiplexed and available for audio 
routing via the audio matrix.

Cleared Disables this feature

Sub-Image ID 3G Some legacy equipment does not accept a 2SI 
SMPTE-352 payload identifier for quad-link SDI. You 
may need to select this if you are connecting legacy 
equipment to the specified output on the Ultrix.

2SI Set the SMPTE-352 payload identifier to 2SI for 
quad-link.

Clean Switch 
Status 
(read-only)

Locked The specified output is locked to its input.

Not Locked The specified output is not locked to its input.

Clean Switch Selected Clean Switch is applied to the specified output. The 
Clean Switch Delay value is applied.

Cleared Clean Switch is not applied to the specified output.

Clean Switch 
Mode

Reference Clean Switch is based on the reference signal 
available on the REF port of the router

Input Clean Switch is based on the input signal available 
on the specified port of the router

Clean Switch 
Delay

# Specifies the Clean Switch buffer depth. Select 
between 1/16 to full line to clean switch between 
signals with slight timing offsets.

a. This affects UltriScape and routed destinations.
b. Requires the UltriSync license.
c. Use this field to replace a missing 3G signal when one or more of the four 3G signals for a Gearbox 

configuration are unavailable.

Table 68  Port Configuration Tab

Item Parameters Description
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Figure 33  Example of Port Configuration Interface — ULTRIX-IP Port Selected

Table 73 summarizes the fields displayed in the options in the Port Configuration page for the 
ULTRIX-IP-IO blade.

 
Table 69  Port Configuration — ULTRIX-IP

Item Parameters Description
Port Status 
(read-only)

OK (Green) The selected port is ready to accept stream setting 
changes

NOT READY 
(Red)

Failure to communicate with the port. The router 
will continue to re-establish connection with the 
port until it is successful.

Sender Bandwidth 
(read-only)

# of 25Gb used Reports the amount of data the router is currently 
transmitting on the specified port

Receiver Bandwidth 
(read-only)

FREE Reports the amount of data the router is currently 
receiving on the specified port

Senders

Port slot.port.type.ch Specifies the ULTRIX-IP-IO port when subscribing to 
streams

Name <text> Specifies a unique identifier for the sender stream

Type Indicates whether the stream includes video or 
audio data

Signal Format # Indicates the video format detected on the stream

Codec # Specifies the AES67 standard that the ULTRIX-IP-IO 
will default to for all IP-based audio sender streams

Channels # Specifies the maximum number of audio channels 
available for configuration within the specified 
stream

Transport IP # Specifies the IP address for the stream

UDP Port # Indicates the port associated with the IP address 
and the communication protocol for the stream
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Frame Configuration
The Frame Configuration page is organized into a series of sub-tabs that provide options for 
configuring the global settings of the router. By default, the Communications tab is selected.

Redundancy Indicates if Redundancy Mode (protection 
switching) is enabled for the specified ULTRIX-IP-IO 
port

Session ID # Indicates the ID number assigned to the 
ULTRIX-IP-IO within the system

Stream ID # Indicates the ID number assigned to the specific 
stream within the system

Alarm Severity Indicates any detected errors for the specific 
streamAlarm Description

Receivers

Port slot.port.type.ch Specifies the ULTRIX-IP-IO port for the receiver 
stream

Name <text> Specifies a unique identifier for the receiver stream

Type Indicates whether the stream includes video or 
audio data

Signal Format # Indicates the video format detected on the stream

Codec # Specifies the AES67 standard that the ULTRIX-IP-IO 
will default to for all IP-based audio receiver 
streams

Channels # Specifies the maximum number of audio channels 
available for configuration within the specified 
stream

Transport IP # Specifies the IP address for the stream

UDP Port # Indicates the port associated with the IP address 
and the communication protocol for the stream

Redundancy # Indicates if Redundancy Mode (protection 
switching) is enabled for the specified ULTRIX-IP-IO 
port

Session ID # Indicates the ID number assigned to the 
ULTRIX-IP-IO within the system

Stream ID # Indicates the ID number assigned to the specific 
stream within the system

Alarm Severity Indicates any detected errors for the specific 
streamAlarm Description

Table 69  Port Configuration — ULTRIX-IP

Item Parameters Description
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Figure 34  Example of a Frame Configuration Page

Communication Tab

The Communications tab shows the network settings and Network Time Protocol (NTP) settings. 
You can also monitor the status of the Ethernet connection of the Ultrix router. From here you can 
verify the network settings of the active Ethernet port on the router, and view the mode of the 
control system (primary/client). Refer to “Getting Started” for details on configuring these settings.

Alarms Tab

From the Alarms tab you can specify what components the Ultrix router monitors such as the 
power supplies, fans, network status, the SD Card, the chassis battery, and the interior chassis 
temperature. 

By default, the Ultrix monitors the following components (these options are enabled):

• System Error
• Temperature
• Primary Power
• Redundant Power
• SD Card Presence
• Battery
• Storage Space
• Fan 1
• Fan 2
• Fan 3 (applicable only to the ULTRIX-NS-FR1, ULTRIX-NS-FR2, and ULTRIX-FR5)
• Fan 4 (applicable only to the ULTRIX-NS-FR2, and ULTRIX-FR5)
• Fan 5 (applicable only to the ULTRIX-FR5)

The Alarms tab also displays read-only State column that reports the status of each enabled alarm 
using color indicators which vary in severity from green (valid), yellow (caution), to red (alarm). For 
example, if the SD Card status is set to red in the Alarms tab, an SD Card is not detected or the SD 
Card not mounted correctly inside the chassis.
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Fans & Power Tab

The Fans & Power tab displays read-only fields that report on the fan status and PSU connections of 
the Ultrix router. Color indicators vary in severity from green (valid), yellow (caution), to red (alarm). 
In the case of multiple messages, the most severe alarm is reported for a single row in the tables.

Table 70 summarizes the fields and menus displayed in the Fans & Power tab.

Table 70  Frame Configuration — Fans & Power

Item Parameters Description
Fans

Fan Name FAN # Indicates the specific fan within the chassis

Slot #, x Indicates the specific fan within the chassis where # 
represents the physical slot and x the location 
(front, middle, back)

Fan State Active (Green) Indicates that the chassis core componentsa 
temperature is within the normal range (below 
70°C (158°F)) and the fans are running without 
errors detected

Inactive (Yellow) The chassis fan is not currently enabled or installed. 

Warning (Red) An error condition is detected on the chassis fan 
and an alarm is raised. Verify that the fan is 
installed correctly.

Fan Speed (%) # Indicates the current speed of the chassis fans

Fan Speed State OK (Green) The fans are running at the specified Minimum Fan 
Speed value

Caution (Yellow) Indicates that at least one chassis core component 
temperature is between 70°C and 80°C (158°F and 
176°F). The Minimum Fan Speed value is 
overridden.

Warning (Red) Indicates that at least one chassis core component 
temperature is above 80°C (176°F). The Minimum 
Fan Speed value is overridden and the fans are 
running at the maximum speed.

Minimum Fan 
Speed

40-100 Sets the speed of the interior chassis fans. This 
value will be overridden when a chassis core 
component is detected to be at a temperature 
above 70°C (158°F).

Power Supplies

PSU # Indicates the specific power supply unit installed 
within the chassis

Power State Active (Green) Normal operation; no hardware errors associated 
with the PSU 

Inactive (Yellow) A hardware error is detected on the specified PSU. 
Verify that the PSU is correctly installed, and that 
power is available.

Warning (Red) Indicates the minimum number of PSUb are not 
detected
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References Tab

The References tab is organized into two areas: Detect References, and Triggers.

• The Detect References area displays read-only fields that report the status on the reference 
signal. 

• The Triggers area provides options for configuring the reference signal for the routing system. 
From this table you can configure up to four reference triggers which then can be assigned to the 
inputs and outputs of the router. Refer to “Specifying a Default Reference Format” and 
“Configuring a Reference Trigger for the Ultrix Router” for details.

Audio Mixer Tab

Configures the inbuilt audio mixer (if an ULTRIMIX-MXR license is enabled on the frame). Refer to 
“ULTRIMIX-MXR” for details on configuring the settings on this tab.

Ultrix-IP Tab

 The Ultrix-IP settings are only available when using an ULTRIX-IP-IO blade installed in at least one 
of the rear panel slots.

The Ultrix-IP tab provides options for configuring the individual SFP+ ports, the transport protocol, 
and PTP settings that are required for the streaming of video and/or audio. Refer to “ULTRIX-IP-IO 
Setup” for details. 

The options are organized into sub-tabs: Port Network, PTP, and NMOS.

Table 71 summarizes the fields and menus displayed in the Ultrix-IP tabs.

Ultricool Server 
Enabled

Selected Enables the ability for the router to accept control 
connections from an Ultricool. 

Cleared Disables this feature. Select this option if your 
routing system does not include an Ultricool.

a. This term refers to the installed I/O blades (e.g. HD-BNC I/O, ULTRIX-IP-IO, ULTRIX-SFP-IO), and the 
ULTRIX-UCCI module.

b. The ULTRIX-FR5 requires a valid connection to an Ultripower. An ULTRIX(-NS)-FR2 requires a minimum of 2 
PSU to be connected at all times. For ULTRIX(-NS)-FR1 routers, a minimum of 1 PSU is required.

Table 71  Frame Configuration — Ultrix-IP

Item Parameters Description
Port Network

Port slotx.porty Specifies the port on the ULTRIX-IP blade you are 
configuring where:
• x represents the physical slot the ULTRIX-IP blade 

is installed in
• y represents the physical port on the ULTRIX-IP 

blade

Name <text> Assigns a unique identifier to the port. This name is 
displayed in the router database tables

MAC Address #:#:#:#:#:# Indicates the MAC Address currently assigned to 
the Ultrix router for the specified ULTRIX-IP port

Table 70  Frame Configuration — Fans & Power

Item Parameters Description
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IP Mode Static The user manually supplies the network settings for 
the specified ULTRIX-IP port

DHCP Automates the assignment of the network settings 
for the specified ULTRIX-IP port. This is the default.

IP #.#.#.# Indicates the IP Address currently assigned to the 
selected ULTRIX-IP port. The default is 128.0.0.0 
<port #>

Subnet Mask #.#.#.# Indicates the subnet mask for the specified 
ULTRIX-IP port. The default is 255.255.255.0.

Redundant Selected Enables the router port to send SMPTE ST 2022-7 
streams within a protection switching network

Cleared Disables this feature

PTP

Custom PTP Profile Selected Enables the user to create and assign a custom PTP 
profile for the ULTRIX-IP ports. The Domain, 
Priority1, Priority2, Sync Interval, Announce Interval, 
and Announce Receipt Timeout fields can be edited 
to create a custom PTP profile.

Cleared The Domain, Priority1, Priority2, Sync Interval, 
Announce Interval, and Announce Receipt Timeout 
fields do not display and cannot be edited. This is 
the default.

Profile IEEE 1588 Default The ULTRIX-IP timing uses the IEE1588 standard

AES67 Media The ULTRIX-IP timing uses the AES67 Media 
standard

SMPTE ST 2059-2 The ULTRIX-IP timing uses the SMPTE ST 2059-2 
standard. This is the default.

Custom PTP Options

Domain # Specifies that the ULTRIX-IP is within the specified 
group of clocks in your network

Sync Interval # Specifies often the ULTRIX-IP port sends Sync 
messages

Announce Interval # Specifies how often the ULTRIX-IP sends Announce 
messages

Announce Receipt 
Timeout

# Controls how long the ULTRIX-IP port will wait 
before declaring the Grandmaster absent and 
initiating a new election

NMOS

Static RDS Selected Allows the user to set an RDS IP in the Registry 
Service Address field and forces the router to 
register to this specific RDS

Cleared The router uses mDNS to automatically register in 
an RDS on the network with the lowest priority

Table 71  Frame Configuration — Ultrix-IP

Item Parameters Description
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Versions Tab

This tab summarizes the firmware and what is installed in each slot of the router. 

Filters Tab

Use the options in the Filters tab to determine what information is reported/monitored based on 
the signal type.

SFP Configuration Tab
The SFP Configuration page is applicable when:

• at least one ULTRIX-SFP-IO blade is installed; or, 
• at least one AUX port is populated in a router chassis.

From this interface you can configure each populated AUX and/or SFP port on the blade. This 
interface is organized into two sub-tabs: AUX Settings and SFP Settings.

For More Information on...
• the physical SFP ports of your router, refer to the ULTRIX-FR1, ULTRIX-FR2, and ULTRIX-FR12 

Installation Guide.

Figure 35  Example of the AUX Ports Configuration Page

AUX Ports Tab

The information in the AUX Ports tab is organized into two areas: a table on the left that lists the 
slots with available AUX ports, and a table on the right that provides details on each SFP port of a 
selected slot. Each row of the table reports the port name, type of SFP module installed, and the 
number of MADI channels set for that SFP (if applicable). Refer to “Configuring an SFP Port”.

Channel Mapping 
Port

# Specifies the port used for the corresponding RDS

Connection Port # Specifies the port the NMOS IS-05 Connection 
service is listening on

Node Port # Specifies the port the NMOS IS-04 Node service is 
listening on

Table 71  Frame Configuration — Ultrix-IP

Item Parameters Description
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SFP Ports Tab

The information in the SFP ports tab is organized into two areas: a table on the left that lists the 
slots with available SFP ports, and a table on the right that provides details on each SFP port of a 
selected slot. Each row of the table reports the port name, and type of SFP module installed. Refer 
to “Configuring an SFP Port”.

Licenses
The Licenses page displays the following tabs: License Keys, UltriMix, UltriScape, UltriSync, and 
UltriSRC.

Figure 36  Example of the Licenses Page

 The Licenses page takes up to 35 seconds to register any changes to the table entries.

License Keys Tab

Use the fields in this tab to manage the licenses for your router. From here you can view which 
licensed features on which slots are enabled, and enter license keys for new features. Refer to 
“Software License Keys” for details.

UltriMix Tab

Use the options on this tab to enable or disable embedded audio support per slot. Refer to 
“Configuring an Audio Matrix” for details.

UltriScape Tab

The UltriScape tab reports on the number of UltriScape licenses installed, and the number of 
UltriScape Heads enabled on the Ultrix router. From this tab, you can assign an UltriScape Head to a 
physical OUT socket on the router. Refer to “UltriScape Configuration” for details.

 At least one UltriScape license must be installed for a slot before you can assign an UltriScape 
Head to a router output in that slot.

The UltriScape tab is organized into three columns:

• Head — read-only fields that report the physical address name of an UltriScape output.
• Port — used to enable/assign an UltriScape Head.
• Format — used to select the an UltriScape output format.
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UltriSync Tab

The UltriSync tab reports on the number of UltriSync-3G and UltriSync-UHD licenses installed, and 
the number of slots with the licensed enabled on the Ultrix router. The UltriSync tab is organized 
into three columns:

• Port — read-only fields that report the physical address name of an Ultrix router output.
• 3G License — used to enable the UltriSync-3G on the specified port.
• UHD License — used to enable the UltriSync-UHD on the specified port.

 The UltriSync-UHD is only available for the following ports of a slot depending on the type of 
blade installed in that slot. Refer to “UltriSync Configuration” for details..

UltriSRC Tab

The UltriSRC tab reports on the number of UltriSRC licenses installed, and the number of AUX ports 
with the licensed enabled on the Ultrix router. The UltriSRC tab is organized into two columns:

• Port — read-only fields that report the physical address name of the Ultrix AUX port.
• License — used to enable the UltriSRC on the specified port.

Database Interfaces
The Database interfaces enable you to configure control aspects of your router. Note that the 
currently active database name is displayed in parentheses beside the Database node in the tree 
view. For example, Figure 37 illustrates a router with the NCUltrix database loaded. Unicode 
names are supported so that names may be defined in other languages or writing systems.

Figure 37  Expanded Database Node in the Tree View

Most of the interfaces are organized into a table format with a row of buttons at the bottom of the 
interface. You can select individual cells, columns, or rows of entries to define.
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Figure 38  Example of Filling a Column of Entries

Figure 39  Example of Filling a Row of Entries

 A summary of each interface is provided in the following sub-sections.

Database Builder
The Database Builder interface helps you to quickly create a database by grouping basic controls on 
four pages: Quick Start, Levels, Destinations, and Sources. The same controls are available as 
sub-nodes of the Database interface.

Quick Start

The Quick Start options display by default when the Database Builder displays in DashBoard. From 
this page you can define the database properties including: type of signals (video, audio) the 
number of Ultrix routers that the database includes, the audio elements of the database, and basic 
UltriScape parameters.



326 • DashBoard Interface Overview Ultrix User Guide (v23.0)

Figure 40  Example of the Database Builder — Quick Start Page

Table 73 summarizes the fields displayed in the options in the Quick Start page. 
Table 72  Database Builder — Quick Start

Item Parameters Description
Database name <name> Assigns a unique identifier for the device in the 

routing system. This name is also used when 
matrices are defined in the Ultrix system.

Frame select table Displays a list of detected routers in your network. 
Select a box to apply the database to the specified 
router.

Include AUX ports None Do not create entries for AUX ports in the database

Insert at slot Create AUX port entries as they are physically 
located within the Ultrix chassis (e.g. ports 17 and 
18).

At the end Create AUX ports after BNC entries

Video support Yes Creates a database that includes video and audio 
signals

No Creates an audio-only database

Audio channels # Specifies the quantity of audio channels (levels) 
required

Breakaway source 
support

Yes Create sources for audio breakaways/shuffles

No Audio breakaways are not included in this database

SDI audio per 
channel

Creates audio breakaway sources using the 
selected audio channel grouping size

MADI channels per 
source

Creates MADI sources using the selected audio 
channel grouping size

Disconnect source? Yes Creates a source that will disconnect (mute) SDI and 
audio channels

No This option is not included in the database
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Levels

Once you defined the options on the Quick Start interface, you can proceed to preview and 
customize the levels, destinations, and sources this database will include. Clicking Next on the 
Quick Start page displays the Levels page. (Figure 41)

The options in the Levels page are organized into a table where each row represents a level and the 
columns provide the options for configuring that level. From this page you assign a unique name to 
each level, a color that represents the level to make it easier to identify the level in a soft panel. 

Figure 41  Example of the Database Builder — Levels Page

Destinations

Clicking Next on the Levels page displays the Destinations page. (Figure 42)

The Destinations page enables the assignment of logical labels (used by remote control panels and 
soft panels) to physical outputs of the attached matrices or routers. The options in the Destination 

Passthrough 
source?

Yes Sources are routed without changes/edits

No This option is not included in the database

UltriScape support? Yes Enables UltriScape heads and PiPs to be included in 
the database

No UltriScape heads and PiPs are not included in the 
database

Number of 
Multiviewer heads

# Specifies the number of UltriScape heads the 
database will support

Number of 
Multiviewer pips per 
head

# Specifies the maximum number of PiPs available 
per layout

Include detected 
Multiviewer layout

Creates sources for detected UltriScape layouts to 
enable layout changing from control panels

Table 72  Database Builder — Quick Start

Item Parameters Description
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page are organized into a table where each row associates a name of the destination with one or 
more logical matrix output sockets. 

Figure 42  Example of the Database Builder — Destinations Page

Sources

Clicking Next on the Destinations page displays the Sources page. (Figure 43)

The Sources page enables the assignment of labels (used by remote control panels and soft panels) 
to inputs of the attached matrices or routers. The options in the Sources page are organized into a 
table where each row associates a name of the source with one or more logical matrix input 
sockets.

Figure 43  Example of the Database Builder — Sources Page

Connections Tab
The Connections tab lists and configures the Ultrix communications systems. The first two tables, 
Protocol Servers and Incoming Connections, configure and list server connections from an external 
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client. The third table, Outgoing Connections, lists and configures client connections to an external 
server.

Figure 44  Example of Entries in a Connections Tab

Protocol Servers Table

The protocol servers table lists the currently active servers running on the Ultricore control system. 

Server Options Dialog

Click Options to display a dialog that provides settings for the supported protocol servers. 

For More Information on...
• configuring the protocol settings, refer to the chapter “External Control”.

Incoming Connections Table

The Clients table lists the connection details of remote client devices (e.g. devices that are under the 
supervision of this Ultrix router control system) currently communicating with the Ultrix router. 

Table 73 summarizes the fields displayed in the Clients table in the Connections tab. 
Table 73  Connections Tab — Incoming Connections

Item Parameters Description
Device ID <name> Specifies the external device for the connection 

point

Name <name> Assigns a unique identifier for the device in the 
routing system. This name is also used when 
matrices are defined in the Ultrix system.
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Outgoing Connections Table

The Servers table lists the connection details of remote server devices (e.g. devices that are 
controlling this Ultrix router control system) currently communicating with the Ultrix router. 

Protocol (read-only) GVG Native The device uses the third-party GVG protocol to 
communicate. Refer to “GVG Series 7000 Native 
Protocol Commands”.

NVISION This device communicates via the third-party 
NVISION protocol. Refer to “NVISION Commands”.

OGP This device uses the openGear Protocol to 
communicate

Probel SW-P-08 The device communicates via the Probel SW-P-08 
protocol

Ross NK The device uses the Ross NK protocol to 
communicate (T-Bus or TCP only). Refer to 
“Connecting to Ross NK Series Devices”.

Protocol (read-only) TSL UMD v3.1 The device uses TSL UMD protocol version 3.1

TSL UMD v4.0 The device uses TSL UMD protocol version 4.0

TSL UMD v5.0 The device uses TSL UMD protocol version 5.0

Ultrix The device uses the Ross Ultrix protocol to 
communicate (TCP only). Refer to “Adding an Ultrix 
Connection Point”.

Communication type: tcp   The device is communicating over a network 
connection. Note that the DashBoard client 
computer, the Ultrix router, and the external device 
must be on the same network.   

ip: 
###.###.###.#
##

Specifies the IP Address of the device on the 
network.

ip: localhost Specifies that the device is the router you are 
currently configuring

port:##### Specifies the ethernet port the devices is associated 
with on the network.

TBUS | port: The device is communicating via the specified T-Bus 
port.

... This button opens a dialog allowing further 
connection point setting adjustments such as 
specifying an IP address, IP port, etc.

Details Provides additional information on the device such 
as device type, and firmware version

Table 73  Connections Tab — Incoming Connections

Item Parameters Description
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Table 73 summarizes the fields displayed in the Outgoing Connections table. 
Table 74  Connections Tab — Outgoing Connections

Item Parameters Description
ID # Auto-numbered field (read-only).

Device ID <name> Specifies the external device for the connection 
point

Name <name> Assigns a unique identifier for the device in the 
routing system. This name is also used when 
matrices are defined in the Ultrix system.

Enabled Enable Direct communication is established between Ultrix 
and the device.

Disable Communication between the router and the device 
is unavailable.

Connected 
(read-only)

Connect A valid connection is established between the 
device and the Ultrix on your network. This box is 
automatically selected when communication is 
established.

Disconnect The connection is invalid or absent between the 
device and the Ultrix on your network.

Protocol (read-only) GVG Native The device uses the third-party GVG protocol to 
communicate. Refer to “GVG Series 7000 Native 
Protocol Commands”.

NVISION This device communicates via the third-party 
NVISION protocol. Refer to “NVISION Commands”.

Probel SW-P-08 The devices uses the third-party protocol known as 
Probel SW-P-08.

Ross NK The device uses the Ross NK protocol to 
communicate (T-Bus or TCP only). Refer to 
“Connecting to Ross NK Series Devices”.

TSL UMD v3.1 The device uses TSL UMD protocol version 3.1

TSL UMD v4.0 The device uses TSL UMD protocol version 4.0

TSL UMD v5.0 The device uses TSL UMD protocol version 5.0

Ultrix The device uses the Ross Ultrix protocol to 
communicate (TCP only). Refer to “Adding an Ultrix 
Connection Point”.

Communication type: tcp   The device is communicating over a network 
connection. Note that the DashBoard client 
computer, the Ultrix router, and the external device 
must be on the same network.   

ip: 
###.###.###.#
##

Specifies the IP Address of the device on the 
network.

ip: localhost Specifies that the device is the router you are 
currently configuring

port:##### Specifies the Ethernet port the devices is associated 
with on the network.
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Third Party Matrices Tab
Once connection points are established with the devices in your routing system, use the Third 
Party Matrices tab to define the size and type of the external device for use in assignment within 
the Ultricore control system database.

Figure 45  Example of Entries in a Third Party Matrices Tab

Table 75 summarizes the options displayed in the Third Party Matrices tab. 

Communication TBUS | port: The device is communicating via the specified T-Bus 
port.

... This button opens a dialog allowing further 
connection point setting adjustments such as 
specifying an IP address, IP port, etc.

Table 75  Third Party Matrices Tab

Item Parameters Description
ID # Auto-numbered field (read-only).

Name <name> Assigns a unique identifier for the imported third 
party matrix to be used by the Ultrix database. 

First Output # Specifies the first destination for the device within 
the Ultrix database

Last Output # Specifies the last destination for the device within 
the Ultrix database

First Input # Specifies the first source for the device within the 
Ultrix database

Last Input # Specifies the last source for the device within the 
Ultrix database

Table 74  Connections Tab — Outgoing Connections

Item Parameters Description
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Port Labels Tab
The Port Labels tab lists the matrices automatically discovered (Ultrix and NK Series), and those 
defined via the Third Party Matrices tab. A matrix (or router) socket is identified via the 
Frame.Slot.Port.Type.Channel nomenclature. Custom labels may be applied to the ports if 
required. These may be also known as actual labels in other terminology (the name the cable would 
be assigned). This re-naming is not necessary for router operation, but it may make your 
assignment of source and destination labels easier to identify when using your internal cable 
naming conventions.

Figure 46  Example of Entries in a Port Labels Tab

Table 76 summarizes the options displayed in the main area of the Port Labels tab (from left to 
right on the interface). 

Level # Specifies the number of levels for the device in the 
Ultrix database

Type Specifies the signal type of inputs and outputs this 
device provides within the Ultrix database

Device ID Specifies the external third-party device the 
imported logical matrix applies to

Table 76  Port Labels Tab

Item Description
Matrix: Provides a list of configured label matrices for the currently loaded 

database. Click an item in the list to reveal the physical port names and 
associated labels for the given matrix selection in the right-hand table 
area.

Table 75  Third Party Matrices Tab

Item Parameters Description
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Bottom Toolbar

Refer to Table 100 for a summary of the buttons displayed in the Bottom toolbar of the Database 
interfaces. 

Levels Tab
A level is a specific grouping of signal input and output ports, that may be controlled separately 
from other groups (a breakaway). Typically a level is associated with input/output ports that are 
used with sets of similar or related signals, such as SDI Video, AES Audio, Analog Video, Analog 
Audio, Timecode, or Machine Control, and often include routing matrices that are dedicated to 
controlling that specific type of signal.

The options in the Levels tab are organized into a table where each row represents a level and the 
columns provide the options for configuring that level. From this tab you assign a unique name to 
each level, a color that represents the level to make it easier to identify the level in a soft panel, and 
add a description of the level to aid identification. 

For More Information on...
• the buttons located in the bottom toolbar of the Levels tab, refer to Table 100.
• the Tally Status Level menu, refer to “Defining the Status Level for Tally Operation”.

Figure 47  Example of Entries in a Levels Tab

Destinations Tab
The Destinations tab enables the assignment of logical labels (used by remote control panels and 
soft panels) to physical outputs of the attached matrices or routers. The options in the Destination 

Port Indicates the physical socket on the Ultrix router that is included in the 
currently selected logical matrix using the nomenclature 
Frame.Slot.Port.Type.Channel.

Label Provides a text label that identifies the port in other interfaces of the 
database. This virtual label is used instead of the 
Frame.Slot.Port.Type.Channel format for logical label assignment. For 
example, you might re-name port: Ultrix.slot1.in[1].SDI.ch1 to IN 1.

Table 76  Port Labels Tab

Item Description
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tab are organized into a table where each row associates a name of the destination with one or 
more logical matrix output sockets. 

Figure 48  Example of Entries in a Destinations Tab

Table 77 summarizes the options displayed in the main area of the Destinations tab (from left to 
right on the interface). 

Table 77  Destinations Tab

Item Parameters Description
ID # Auto-numbered field (read-only). This is not used 

within the Ultrix system itself, however, 
third-party protocols that do not support labels 
will reference this field in their communications.

Tally TSL v3.1 <displayID> Displays the TSL protocol Tally ID entry. The 
Enable Tally box is selected in the Database tab. TSL 4.0 <displayID>

TSL v5.0 <screenID>:<displayID>

Tally Mode Enables/disables the re-direction of connected 
source Tally ID to destination Tally ID as set by 
the Tally field

Name <name> Assigns a unique identifier (label) for the 
destination in the routing system. This label is 
used by control interfaces/devices.

Description Provides additional information or user entered 
notes about the output

Level # Specifies the physical output port associated 
with the destination and assigns it to the 
specified level. Unless you have given the port a 
different label via the Port Labels tab, the port is 
labeled as Frame.Slot.Port.Type.Channel.
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Sources Tab
The Sources tab enables the assignment of labels (used by remote control panels and soft panels) 
to inputs of the attached matrices or routers. The options in the Sources tab are organized into a 
table where each row associates a name of the source with one or more logical matrix input 
sockets.

Figure 49  Example of Entries in a Sources Tab

Table 78 summarizes the options displayed in the main area of the Sources tab (from left to right 
on the interface). 

Matrix 
Outputs

# Lists all the physical output ports available that 
can be assigned to a destination in the routing 
system

Assign Click this button to add the selected physical 
output port(s) to the list of Destinations for the 
database

Table 78  Sources Tab

Item Parameters Description
ID # Auto-numbered field (read-only). This is not used 

within the Ultrix system itself, however, third-party 
protocols that do not support labels will reference 
this field in their communications.

Tally <displayID>   or 
<screenID>:<displayI
D>

Displays the TSL protocol tally ID entry. The Enable 
Tally box is selected in the Database tab. 

Name <name> Assigns a unique identifier (label) for the source in 
the routing system. This label is used by control 
interfaces/devices.

Description Provides additional information or user entered 
notes about the input

Table 77  Destinations Tab

Item Parameters Description
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Cat/Index Categories Tab
The Cat/Index Categories tab enables you to categorize sources, destinations, and levels via a 
hierarchal system of tags. You can use categories to filter sources, destinations or levels into 
manageable groups for a Category soft panel.Refer to the section “Category Panels” for more 
information.

Figure 50  Example of Entries in a Cat/Index Categories Tab

Categories Area

Table 79 summarizes the options displayed in the Categories area of the Cat/Index Categories tab. 

Level # Specifies the physical input port associated with the 
source and assigns it to the specified level. Unless 
you have given the port a different label via the Port 
Labels tab, the port is labeled as 
Frame.Slot.Port.Type.Channel.

Matrix Inputs # Lists all the physical input ports available that can 
be assigned as a source in the routing system

Assign Click this button to add the selected physical input 
port to the Source label in the database

Table 79  Cat/Index Categories — Categories Area

Item Parameters Description
Categories: Lists the category tags defined for this database

Add Adds a category tag

Delete Deletes the selected tag

Delete All Deletes all tags listed in the Categories: pane

Table 78  Sources Tab

Item Parameters Description
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Assigned Resources Area

Table 80 summarizes the options displayed in the Assigned Resources area of the Cat/Index 
Categories tab. 

Indices Area

Table 81 summarizes the options displayed in the Indices area of the Cat/Index Categories tab. 

Unassigned Resources Area

Table 82 summarizes the options displayed in the Inaccessible Resources area of the Cat/Index 
Categories tab. 

Generate Automatically generates category tags based on the 
entires in your database.
Categories are automatically defined by searching 
for space characters within the database logical 
source and destination names.

Table 80  Cat/Index Categories — Assigned Resources Area

Item Parameters Description
Destinations: <text> Lists the destinations that are accessible via the 

defined Category/Index combinations

Find Performs a search for destinations in the database 
to add to the category

Sources: <text> Lists the sources that are accessible via the defined 
Category/Index combinations

Find Performs a search for sources in the database to 
add to the category

Levels: <text> Lists the levels that are accessible via the defined 
Category/Index combinations

Find Performs a search for level in the database to add 
to the category

Table 81  Cat/Index Categories — Indices Area

Item Parameters Description
Indices: Creates search terms to define category tags

Add Adds a new entry to the Indices list

Delete Deletes the selected entry from the Indices list

Delete All Deletes all entries from the Indices list

Default Creates indexes 0-9 and A-F

Table 79  Cat/Index Categories — Categories Area

Item Parameters Description
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Group Categories Tab
The Categories tab enables you to categorize sources, destinations, and levels via a hierarchal 
system of tags. You can use categories to filter sources, destinations or levels into manageable 
groups for a Category soft panel.Refer to the section “Category Panels” for more information.

Figure 51  Example of Entries in a Group Categories Tab

The Group Categories tab is organized into three panels and a bottom toolbar.

Table 82  Cat/Index Categories — Unassigned Resources Area

Item Parameters Description
Destinations: <text> Lists the destinations in the current database that 

are not included in any Cat/Index categories

Generate Automatically generates category tags based on the 
destinations in your database

Create Enables you to create a new Cat/Index filter for 
destinations

Sources: <text> Lists the sources in the current database that are 
not included in any classic categories

Generate Automatically generates category tags based on the 
sources in your database

Sources: Create Enables you to create a new Cat/Index filter for 
sources

Levels: <text> Lists the levels in the current database that are not 
included in any classic categories

Generate Automatically generates category tags based on the 
levels in your database

Create Enables you to create a new Cat/Index filter for 
levels
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Table 83 summarizes the options displayed in the left panel of the Group Categories tab. This panel 
displays all the created groups and sub-groups, and/or resources in a top-down hierarchy. Note 
that the nodes are sorted by type and then by alphabetical order.

Table 84 summarizes the options displayed in the middle panel of the Group Categories tab. This 
panel shows the assigned contents (groups and/or resources) of the currently selected group from 
the tree view (in the left panel). 

 

Table 85 summarizes the options displayed in the right panel of the Group Categories tab. This 
panel displays the available destinations, sources, and levels that can be arranged into group 
categories.

 

Table 83  Group Categories Tab — Left Panel

Item Description
Group Categories: Displays the groups as folders arranged in a tree view

Find Displays the Find dialog that enables you to search for a category or 
resource name

Move Displays the Move dialog that enables you to move a selected group 
and its contents to another group

Rename Renames a selected group; the resource type will be not re-named

Delete Deletes a selected group and all of its contents

Add Adds a new group to the selected group

Table 84  Group Categories Tab — Middle Panel

Item Description
Name Indicates the name of a resource

Type Indicates the type of resource

Delete Deletes the selected resource(s) from the currently selected group

Table 85  Group Categories Tab — Right Panel

Item Description
Destinations Displays the unassigned destinations

Sources Displays the unassigned sources

Levels Displays the unassigned levels

Database/alphabet 
Sort

Toggles the sorting style of the unassigned labels

Assign Select the resource(s) and click Assign to assign it to the group selected 
in the left table
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Table 86 summarizes the bottom toolbar.

Legacy Categories Tab
The Legacy Categories tab enables you to categorize sources, destinations, and levels via a 
hierarchal system of tags. You can use legacy categories to filter sources, destinations, or levels into 
manageable groups for legacy RCP-QE panels (identified by 17 LCD buttons and firmware versions 
prior to 1.55). Refer to the RCP-QE User Guide for details.

 It is recommended for new installations to utilize the Cat.Index or Group Category methods.

Table 87 summarizes the options displayed in the top toolbar. 

 

Table 88 summarizes the options displayed when the Edit button is selected from the bottom 
toolbar.

Salvos Tab
A salvo is a set of pre-defined switch events. The Salvos tab provides a list of the global salvos 
available in the currently selected database. From this tab you can create salvos, rename, edit, and 
delete salvos.

The workspace in the Salvos tab displays a grid pattern with sources at the top and the destinations 
along the left side. A list of currently available (saved) salvos displays on the far left-side of the tab. 
The toolbar on the far right-side displays a button for each level available in the database with each 
button set in the color specified for the level. Click the Follow button, located below the level 
buttons, to include all the Levels in the salvo. The toolbar in the bottom right corner of the interface 
displays three buttons: Advanced, Cancel, and Apply. 

Table 86  Group Categories Tab — Bottom Toolbar

Item Description
Auto Generate Click to auto-generate group categories based on the resource names 

from the current database

Cancel Ignores all unsaved changes and reverts the tab back to the last saved entries

Apply Applies all change made in the Group Categories tab

Table 87  Legacy Categories Tab — Top Toolbar

Item Description
Destination Lists the destination category/index assignments

Source Lists the source category/index assignments

Level Lists the level category/index assignments

Table 88  Legacy Categories Tab — Bottom Toolbar

Item Description
Copy Copies the selected cells in the tab

Paste Pastes the previously copied items to the current cell selection

Clear Clears the data from the selected cells

Clear All Clears all category/index assignments

Fill Auto fills a range of cells

Auto Generate Auto fills the cells based on spaces in the source/destination names
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Figure 52  Example of a Salvos Tab

Table 89 summarizes the options displayed in the Salvos tab. 
Table 89  Buttons on the Salvos Interface

Button Description
Salvos: Provides a list of configured salvos for the currently loaded database. 

Double-click an item in the list to update the grid in the Salvos tab.

Edit... Displays the Edit dialog for the soft panel. Refer to “Edit Dialogs”.

Select All Click this button to select all the Destinations in the matrix of the Salvos 
tab. This will include all the destinations in the matrix in the salvo 
configuration.
All the Destination buttons are lit red in the matrix.
The button now displays the Clear All label. Click the button again to 
remove all the Destinations from the salvo configuration.

Level # A button is assigned to each level available in the currently loaded 
database. The color and label of the button is specified in the Levels 
tab.

Advanced Displays the Advanced options outlined in Table 90.

Find Helps you to quickly navigate to known source or destination names.

Filter Use the Filter dialog to reduce the number of source and/or 
destinations visible in the Salvos tab. This enable a user to filter a salvos 
tab view to only source/destinations that match entered text. 

Cancel Discards any recent changes made in the Salvos tab, and clears the 
matrix. Note that the Destinations are still selected (buttons are lit red) 
if you clicked Select All.

Apply Applies changes made in the Salvos tab and updates the salvo settings.
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Advanced Menus

Clicking the Advanced button in the Salvos tab displays the options outlined in Table 90. 

Ultricore Profiles Tab
The Ultricore Profiles operate as a form of hierarchical database where user permissions are 
organized into a tree-like format. A profile determines which groups and pages that a user can 
access. 

When the ULTRICORE-PRO license is enabled, the Ultricore Profiles interface is organized into five 
distinct areas. Figure 53 Each area is briefly described in this section starting with the leftmost area 
of the DashBoard window.

Figure 53  Example of the Ultricore Profiles Interface with the ULTRICORE-PRO license

Users

When the system is configured to use the Ultrix user login mechanism, a list of all currently 
configured usernames along with their current online status displays in this area.

Profiles

A list of all currently configured profiles. Selecting a profile (row) in this area automatically updates 
the items displayed in the Profile Details, Device Tree, and Options areas.

Table 90  Salvos Tab — Advanced Menu Items

Button Description
Clear All Presets Clears the workspace in the Salvos tab and resets all settings to the default 

values.

Clear Dest Presets Clears all selections made in the Destinations column of the workspace.

Capture System 
Status

Captures the current routing state of the Ultrix router. 

Capture Dest Status Updates the workspace to reflect only the status of the destinations of the 
Ultrix router.
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Profile Details

This area displays the details of the profile showing the conditions under which the tree in the 
following section will be applied. 

Tree Nodes

A visual representation of the tree view that is defined in the Profile Details. Note that certain 
entries that are specific to licenses or other conditions may be visible but not in the actual tree view. 
Should conditions change that enable those entries, they will appear as shown in this display. A 
profile also maintains the position of items in groups allowing the most relevant items to be the 
easiest to reach.

The tree nodes are organized in a hierarchy where the top level (blue icons) list system specific 
options, and secondary levels (yellow icons) list specific functions. 

 This area only displays when the ULTRICORE-PRO license is enabled.

Group Tabs

This area displays all the available items that have not yet been assigned to the currently selected 
profile but are available to define.

 This area only displays when the ULTRICORE-PRO license is enabled.

Panels Tab
The Panels tab includes a series of sub-tabs that enable you to customize the soft panels (control 
panels within the DashBoard environment). You can choose to assign the levels, sources, and 
destinations, from an Ultrix database to the panel buttons. The soft panels display as sub-nodes in 
the Soft Panels tree using the name specified in the Info tab. When you save a soft panel to the 
database, a node for the panel automatically displays under the Soft Panels node in the Tree View. 
The soft panels display in the tree according to their assigned Panel ID number (where an ID of 1 is 
the highest, and ID of 2 is the second highest etc.).

Figure 54  Example of Entries in a Panels Tab

Panels Area

The Panels area displays on the left side of the interface. This area displays a list soft panels saved 
in the current database. Selecting a soft panel from the list updates the tab entries in the Panels tab 
with the settings for that soft panel.
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Info Tab

Use the options in the Info tab to assign a panel a unique identifier, select the panel style template 
to use, and how the panel will perform tasks such as Take transitions. This is the default tab that the 
interface opens on. Table 91 summarizes the fields and menus displayed in the Info tab. 

Table 91  Info Tab

Item Parameters Description
Panel Style 
(read-only)

<name> Specifies the panel type that was assigned to the 
soft panel when it was created.

Panel ID <integer> Assigns an ID number to the panel. This value 
determines the panel node placement in the 
hierarchy of the Soft Panel tree.

Panel Name <name> Provides a unique identifier for the soft panel. This 
name also displays as a sub-node in the Soft Panels 
tree.

Description # Provides a textual summary of the soft panel or 
additional information about the panel.

Protection 
Operation

Lock Displays only the Lock button in the panel interface.

Protect Displays only the Protect button in the panel 
interface.

Both Displays the Lock and Protect buttons in the panel 
interface

Take Operation Confirm Confirmation dialog displays, prompting the user to 
confirm a Take before the transition occurs.

Direct The Take transition occurs automatically.

Machine Control Enable Displays a Machine Control button on the panel. 
When selected on the panel, this Machine Control 
button sends a Take request directed to a Ross 
NK-M series data router to automatically make the 
reciprocal port switch. On a video router, the 
connection is all one way from an input port to an 
output port (e.g. such as from IN 1 to OUT 2). 

Disable Does not display a Machine Control button on the 
panel

Selection Operation Single The Multi Select button does not display on the soft 
panel

Multi Displays the Multi Select button on the soft panel. 
Use this button to quickly select multiple 
destinations for a crosspoint switch.
This button is only applicable for MultiBus and 
Category panels.

Nongroup 
Resourcesa

Hide Resources that are not assigned to a specific group 
are not displayed on the soft panel.

Show All resources are displayed on the soft panel.
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Levels Tab

Use the options in the Levels tab to specify the number of levels for the panel, and organize them in 
a hierarchy for the panel. Table 92 summarizes the fields and menus displayed in the Levels tab. 

Destinations Tab

Use the options in the Destinations tab to specify which outputs will be available in Destination bus 
of the soft panel. Table 93 summarizes the fields and menus displayed in the Destinations tab. 

Vertical Scrollbar 
Width

Small

Medium

Large

Horizontal Scrollbar 
Height

Small

Medium

Large

a. This menu is only available when the Panel Style is set to Group Category.

Table 92  Levels Tab

Item Parameters Description
Viewable Levels <integer> Specifies the maximum number of levels, as 

selectable buttons, that can display on the panel

Available <integer> Lists all the levels in the current database

Assigned <integer> Specifies which levels will be available in the soft 
panel

Table 93  Destinations Tab

Item Parameters Description
Viewable 
Destinations

<integer> Specifies the maximum number of destinations 
available, as selectable buttons, on the panel. This 
field is not displayed when the Panel Style is set to 
Group Category or Cat/Index Category.

Available <integer> Lists all the destinations in the current database

Assigned <integer> Specifies which destinations will be available in the 
soft panel

Table 91  Info Tab

Item Parameters Description



Ultrix User Guide (v23.0) DashBoard Interface Overview • 347

Sources Tab

Use the options in the Sources tab to specify which router inputs will be available in the Source bus 
of the soft panel, and their hierarchy. Table 94 summarizes the fields and menus displayed in the 
Sources tab.

Salvos Tab

Use the options in the Salvos tab to specify the total number of salvos displayed in the soft panel 
and their hierarchy. Table 95 summarizes the fields and menus displayed in the Salvos tab. 

Favorites Tab

 The Favorites tab only displays when the Panel Style is set to Ultritouch PB.

Table 95 summarizes the fields and menus displayed in the Favorites tab. 

Table 94  Sources Tab

Item Parameters Description
Viewable Sources <integer> Specifies the maximum number of sources 

available, as selectable buttons, on the panel. This 
field is not displayed when the Panel Style is set to 
Group Category or Cat/Index Category.

Available <integer> Lists all the sources in the current database

Assigned <integer> Specifies which sources will be available in the soft 
panel.

Table 95  Salvos Tab

Item Parameters Description
Viewable salvos <integer> Specifies the maximum number of salvos that will 

be listed on the Recall Salvos dialog for the panel. 
This field is not displayed when the Panel Style is 
set to Matrix.

Available <integer> Lists all the salvos in the current database

Assigned <integer> Specifies which salvos will be available in the soft 
panel.

Table 96  Favorites Tab

Item Parameters Description
Name <name> Provides a unique identifier for the type of Favorite 

for this soft panel.

Type Crosspoint Creates a Favorites button on the soft panel that 
recalls a specific crosspoints switch

Group Creates a Favorites button on the soft panel that 
loads a specific Group Category in the database

Salvo Creates a Favorites button on the soft panel that 
recalls a specific salvo in the database

Sources Creates a Favorites button on the soft panel that 
selects a specific source in the database

Destinations Creates a Favorites button on the soft panel that 
selects a specific destination in the database
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Home View Tab

 The Home View tab only displays when the Panel Style is set to Ultritouch PB or Push Button.

Table 97 summarizes the options displayed in the Home View tab. 

Field 1 Specifies the first item for the Favorite. For 
example, if the type is set to Crosspoint, Field 1 
reports the destination.

Field 2 Specifies the second item for the Favorite. For 
example, if the type is set to Crosspoint, Field 2 
reports the source.

Up Moves the selected row higher in the table

Down Moves the selected row lower in the table

Top Moves the selected row to the top of the table

Bottom Moves the selected row to the bottom of the table

Sort Sorts by window type

Table 97  Home View Tab

Item Parameters Description
Display Icons Enable The Destination and Source buttons on the soft 

panel display icons

Disabled The Destination and Source buttons do not display 
icons; only the labels are displayed on each button.

Orientation Portrait The windows are organized into columns (vertical 
panes) on the soft panel

Landscape windows are organized into rows (horizontal panes) 
on the soft panel

Home Windows

Window (read-only) <text> Specifies the window type

Percent # Specifies the width of the window in a percentage 
of the overall soft panel size

Rows # Specifies the number of button rows in the window

Columns # Specifies the number of button columns in the 
window

Reset Loads the default window layout and widths

Up Moves the selected row higher in the table

Down Moves the selected row lower in the table

Top Moves the selected row to the top of the table

Bottom Moves the selected row to the bottom of the table

Sort Sorts by window type

Table 96  Favorites Tab

Item Parameters Description
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Buttons

Table 98, “Button on the Panels Interface,” on page 349 summarizes the buttons displayed in all 
Panel sub-tabs. 

Destination Follow Tab
Table 99 summarizes the options displayed in the Destination Follow tab. 

Table 98  Button on the Panels Interface

Button Description

In the Available area, clicking this button toggles the sorting order between 
alphabetical or database-index (based on the current order listed in the Levels, 
Destinations, or Sources tabs)

Moves the selected items in the Available list to the Assigned list.

 
Moves the selected item(s) from the Assigned list back to the Available 
list. These items will not be available in the soft panel window.

Moves all the available labels to the Assigned list

Removes all the items from the Assigned list back to the Available list. 
These items will not be available in the soft panel window.

Up Moves the selected item in the Assigned list up one position. This 
changes the order of the displayed items on the soft panel.

Down Moves the selected item in the Assigned list down one position. This 
changes the order of the displayed items on the soft panel.

Top Moves the selected item in the Assigned list to the top of the list. This 
changes the order of the displayed items on the soft panel.

Bottom Moves the selected item in the Assigned list to the bottom of the list. 
This changes the order of the displayed items on the soft panel.

In the Assigned area, clicking this button arranges the items into alphanumerical 
order.

In the Assigned area, clicking this button arranges the items in the Assigned list 
according to the order established in the Levels, Destinations, or Sources tabs.

Edit... Displays the Edit dialog for the soft panel

Cancel Discards any recent changes made in the soft panel, and reverts to the 
previously saved settings.

Apply Applies changes made in the soft panel and updates the Ultrix 
database

Table 99  Destination Follow Tab

Item Parameters Description
Destination # Specifies the Destination you want to configure

Following # Specifies the router output that the specified 
Destination will follow
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Additional Dialogs, Menus, and Toolbars in the Database Interfaces
Each tab displays a toolbar located at the bottom that provides buttons that display additional 
editing dialogs (e.g. insert, cut, paste, search). Also, right-clicking a row in any tab also displays a 
menu of editing dialogs. This section briefly outlines those additional editing dialogs.

Bottom Toolbar

The bottom toolbar of a tab in the Database includes buttons for applying changes made to settings 
in the interface, or adding elements to the table in the interface. Table 100 summarizes the buttons 
displayed in a bottom toolbar. Note that not all buttons display in all tabs. 

Edit Dialogs

Table 101 summarizes the buttons displayed in the Edit dialogs. Note that not all options display in 
all tabs. 

Table 100  Bottom Toolbar Items

Button Description
Edit Displays the Edit dialog for the tab. Refer to Table 101 for details.

Find Displays the Find dialog that enables the entering of criteria for 
searching of the tab contents.

Fill Label Applies a custom label to the selected port

Reset Label Reverts the label content to the previously saved text

Delete Removes the selected port from the list for the matrix

Add Adds the selected port from the list for the matrix

Cancel Discards any recent changes made in the tab, and reverts to the 
previously saved table settings.

Apply Applies changes made in the tab and updates the Ultrix database

Table 101  Edit Dialogs Items

Button Description
Add In interfaces with lists on the left toolbar (e.g. Panels, Port Labels, 

Salvos), selecting a list item and then clicking Add creates a copy of the 
selected item. The name to the newly created item includes the name 
from the copied item with the prefix “New”.

Auto Generate Automatically fills the cells in the table with a default value. For 
example, clicking this button in the Destinations tab automatically fills 
all the cells with the text “Dest”.

Clear Removes the data from the selected cell.

Clear All Removes the text or entry in all cells of the interface.

Copy Copies the selected cell data to the clipboard. In some interfaces, such 
as in the Salvo tab, the salvo settings are copied in entirety.

Cut Copies the cell data to the clipboard and then delete it from the table.
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Find Dialogs

Table 102 summarizes the buttons displayed in the Find dialogs. 

Deletea When working in an interface with a table layout, clicking this button 
removes the currently active row from the table.
When working in an interface with lists on the left toolbar, clicking this 
button removes the selected item from the list. You will still need to 
click Apply to completely remove the item from the database.

Fill A range of name cells may be filled with consecutive numerical data. 
For example, VTR1 to VTR4 may be entered quickly by defining a prefix 
(in this case VTR) and a suffix that will numerically increment. 
Selecting Fill from the Insert toolbar, a dialog displays prompting you to 
enter a prefix (alphanumeric) and the start/end numerical values.
This method adds rows to the destination table inserting below the 
active row. 
Refer to the section “Advanced Fill Tool” for details.

Fill & Replace Enables you to overwrite a range of cells in the table. Rows beneath the 
currently active row are overwritten with data from the Fill & Replace 
dialog.

Insert Above Inserts a new row above the currently active row in the table. Any 
existing data is moved down the table by one row.

Insert Below Inserts a new row below the currently active row in the table. Any 
existing data is moved up one row.

Insert Series Inserts a sequential range of labels below the currently selected row.

Paste Pastes the copied cell data from the clipboard. In some interfaces, such 
as in the Salvo tab, the copied salvo settings are pasted in entirety.

Paste Below Pastes the copied cell data, from the clipboard, to currently selected 
cell.

Rename When working in an interface with lists on the left toolbar, clicking this 
button enables you to provide a different name/label to the selected 
item.

Reset All IDs Resets the source/destination ID numbers based on their current row 
number.
It is recommended to verify the interfaces that reference IDs (such as 
Soft Panels, Salvos, etc.)

a. Ensure the ID numbers are correctly sequenced when deleting and inserting entries in the tabs. Refer to 
the Reset All IDs row in this table.

Table 102  Find Dialogs Items

Item Description
Column A pull-down menu that lists the columns available in the current 

interface. Select the column to perform the search within.

Find What: Specifies the characters, or text, to search the table contents.

Direction Begins the search by searching below the currently selected row 
(Down), or above the selected row (Up).

Table 101  Edit Dialogs Items

Button Description
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Advanced Fill Tool
The Advanced Fill tool is provided to create new destination and source labels where physical 
outputs and inputs are automatically assigned depending on options set by the user. The audio 
routing features provided by Ultrix can result in an extensive source and destination definition map 
requiring some time to manually enter. The Advanced Fill tool will speed the assignment of 
physical sockets greatly.

For More Information on...
• using the tool to set up your database, refer to the section “Using the Advanced Fill Tool”.

Breakaway Fill Dialog

The Breakaway Fill dialog is the Advanced Fill tool for the Sources tab. This dialog is displayed 
when you click Edit > Fill.

Figure 55  Example of a Breakaway Fill Dialog

Table 103 summarizes the options displayed in the Breakaway Fill dialog. 

Match whole word 
only

Select the check box to search only for the characters in the Find What: 
field as they are typed in the field. For example, typing “put” will search 
for instances of the word “put” and not “input” or “output”.

Cancel Cancels the search criteria and closes the Find menu.

Find Performs a search through the table contents based on the specified 
criteria.

Table 103  Breakaway Fill Dialog

Item Parameters Description
Fill Custom Insert labels with assignments for a custom range 

defined by the Range setting

Entire Slot Insert labels with assignments for a single Ultrix slot 
(including the AUX ports)

Entire Device Insert labels with assignments for the entire Ultrix 
router (including the AUX ports)

Table 102  Find Dialogs Items

Item Description
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Name <text> The prefix for the label creation. For example, 
typing VTR results in labels VTR1, VTR2, etc. 
Take care when determining label names. While a 
long name may be nice and descriptive for the 
Source tab, many control devices have limited 
screen space and labels may be truncated.

Starting # The starting numerical extension for the label 
creation. For example, typing 3 results in labels 
Name3, Name4, etc. 

Count # The quantity of labels for custom fill range

AUX Ports None AUX ports will not be included in the resulting 
definitions

Insert at Slot AUX ports will be defined immediately following a 
given slot BNC definitions

Add at End AUX port definitions will be defined immediately 
following ALL BNC definitions

AUX only Defines only AUX port settings (useful when adding 
in one AUX port to a system)

Slot # The Ultrix slot number to start the label 
assignmenta

Port # The Ultrix port to start the label assignment froma

Starting Channel # The Ultrix channel to start the label assignment 
froma

Level # This column lists the levels defined as per user 
entries in the system Levels setup table

I/O Assignment # This column lists the starting assignment for the 
given Level row

Fixed Select the box to fix the I/O assignment selection 
even though it may be out of order compared to 
other I/O assignments.
For example, Ultrix.slot1.in[1].audio.ch1 and 
Ultrix.slot2.in[1].audio.ch1.

BRK I/O Select the box to insert a label with this I/O 
assignment on all BRK Level selections.
For example, IN 1 ch1  | slot1.in[1].audio.ch1 | 
slot1.in[1].audio.ch1 | slot1.in[1].audio.ch1.

BRK Level Select the box to include this level when creating a 
breakaway label. For example, IN 1 ch1.

BRK Suffix <text> By default, breakaway label naming uses the chx 
part of the Ultrix name. A user defined suffix may 
be entered here.

Assign Click this button to automatically fill the I/O 
Assignment column based on the Slot, Port, 
Starting Channel settings to the selected row(s).

Table 103  Breakaway Fill Dialog

Item Parameters Description
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Destinations Fill Dialog

The Destinations Fill dialog is the Advanced Fill tool for the Destinations tab.

Figure 56  Example of a Destinations Fill Dialog

Table 104 summarizes the options displayed in the Destinations Fill dialog. 

Apply Click this button to insert labels with assignments 
based on dialog settings into the source 
assignment table below the current selected row.

Cancel Click this button to cancel the settings and close the 
dialog. No changes to the Source table will be 
made.

a. The Breakaway Fill dialog uses the default naming convention of FrameName.slot n.in/out[p].type.chx.

Table 104  Destinations Fill Dialog

Item Parameters Description
Fill Custom Insert labels with assignments for a custom range 

defined by the Range setting

Entire Slot Insert labels with assignments for a single Ultrix slot 
(including the AUX ports)

Entire Device Insert labels with assignments for the entire Ultrix 
device (including the AUX ports)

Name <text> The prefix for the label creation. e.g. typing VTR 
results in labels VTR 1, VTR 2, etc. 
Take care when determining label names. While a 
long name may be nice and descriptive for the 
Destination tab, many control devices have limited 
screen space and labels may be truncated.

Starting # The starting numerical extension for the label 
creation. e.g. typing 3 results in labels Name3, Name4, 
etc. 

Count # Specifies the quantity of labels for custom fill range

AUX Ports None AUX ports will not be included in the resulting 
definitions

Table 103  Breakaway Fill Dialog

Item Parameters Description
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UltriScape Interfaces
The UltriScape licensed feature provides the following nodes in the tree view: Configuration, Layout 
Editor, and Head Selection. Double-click a node to displays its interface in the DashBoard window. 
Refer to the UltriScape User Guide for details on the UltriScape feature and its interfaces.

Devices Interfaces
The Devices node summarizes the hardware components of the routing system. The nodes 
represent a hierarchy of the devices in the routing system communicating with the Ultrix router.

For More Information on...
• how Ultrix communicates with remote control panels, refer to “Using Remote Control Panels”.
• how Ultrix communicates with Ross devices, refer to “Operation with Ross Devices”
• general control of external devices via third-party protocols, refer to “External Control”.

Controllers and Matrices
Under the Controllers and Matrices node provides an inventory of remote control devices and 
routers that make up your routing system, and have a defined connection to Ultrix.

• A Matrix is, generally speaking, a simple router consists of a matrix and a limited control system. 
• A Controller is a complex router consisting of many matrices and its own control system.

AUX Ports Insert at Slot AUX ports will be defined immediately following a 
given slot BNC definitions

Add at End AUX port definitions will be defined immediately 
following all BNC definitions

AUX only Defines only AUX port settings (useful when adding 
in one AUX port to a system)

Slot # The Ultrix slot number to start the label assignment 
froma

Port # The Ultrix port to start the label assignment froma

Starting Channel # The Ultrix channel to start the label assignment 
froma

Level # Defines the levels as per the entries in the Levels 
tab

I/O Assignment # Starting assignment for the given level row

Assign Click to automatically fill the I/O Assignment column based on the Slot, 
Port, and Starting Channel settings to the selected row(s)

Apply Click to insert labels with assignments based on dialog settings into 
the source assignment table below the current selected row

Cancel Click to cancel the settings and close the dialog

a. The Fill Destination dialog uses the default naming convention of FrameName.slot n.in/out[p].type.chx.

Table 104  Destinations Fill Dialog

Item Parameters Description
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Expanding the Controllers and Matrices reveals devices defined by rows in the Connections tab. 
Double-click the node for a device to open the setup options for that particular device in 
DashBoard.

Ross Video devices that previously displayed in the Tree View as a sub-node of their IP connection 
point (i.e. NK-NET or IPS), are now relocated to the Controllers and Matrices node of Ultrix once 
they are defined in the Connections tab. This indicates the device in question is now part of the 
Ultrix control system.

Soft Panels Interfaces
The Soft Panels interface represents the routing system crosspoint control in the virtual space of 
the Ultrix router. Each available soft panel in the database displays as a sub-node under the Soft 
Panels main node in a tree layout. The soft panels display in a hierarchy based on their Panel ID. 
Double-click a soft panel node in the tree to display its interface in the DashBoard window.

 You must configure your connections, sources, destinations, and levels, before you can create a 
soft panel and perform crosspoint switches. 

For More Information on...
• creating a database for your routing system, refer to “Creating a New Database”.
• the interface for creating soft panels, refer to “Panels Tab”.
• using soft panels, refer to “Soft Panels in DashBoard”.
• creating and using salvos, refer to “Using Salvos”.

Matrix Panel
The Matrix Panel provides a visual representation of multi-level crosspoints, in a grid layout, and 
offers a convenient and easy way to select and switch crosspoints. The columns of the grid 
represent the configured Sources and are labeled with the global names specified in the Input 
Name cells of the Sources tab. The rows of the grid represent the configured Destinations and 
display the virtual labels specified in the Destination tab.

Figure 57  Example of a Matrix Panel

Right-side Toolbar

Table 105 summarizes the buttons displayed in the toolbar on the right-side of the interface. 
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Salvo Menus

Table 106 summarizes the options displayed in the Salvo menu. 

Advanced Menus

Table 107 summarizes the options displayed in the Advanced menu. 

Table 105  Matrix Panel Toolbar Items

Button Description
Lock Locks the Matrix panel from all switches or function button operation.

Protect Protects the currently selected source/destination level pair from use 
by other sources, as well as from other linked panels.

Free Removes the Lock and Protect from the next crosspoint switch.

Salvo Displays the options for managing the salvos for your soft panel. Refer 
to “Salvo Menus” for details.

Advanced Displays the options for managing crosspoint switches on your soft 
panel. Refer to “Advanced Menus” for details.

Find Helps you to quickly navigate to known source or destination names.

Filter Use the Filter dialog to reduce the number of source and/or 
destinations visible in a matrix panel. This enable a user to filter a 
matrix panel view to only source/destinations that match entered text. 

Show TAKE Errors Reports the number of failed TAKE transitions

TAKE Performs a Take transition to the next crosspoint selection.

Table 106  Matrix Panel — Salvo Menus

Button Description
Recall Recalls and applies the last saved salvo settings.

Edit Enables you to load a salvo, update its settings, and then save your 
changes.

Save Saves the current crosspoint selection as a salvo.

Capture Current 
Status

Automatically creates a salvo based on the currently selected 
destination and source positions.

Capture Dest Status Automatically creates a salvo based on the currently selected 
destination positions.

Table 107  Matrix Panel — Advanced Menus

Button Description
Clear All Presets Removes all selections currently made on the soft panel and returns 

the panel to its default destination and source selections.

Clear Dest Presets Removes only the selections made on the Destinations bus.

Diagonal Presets The destination and source crosspoint selections are automatically 
made starting at the top left corner and progressively moving down the 
grid in a 1:1 pattern. For example, Src1 and Dest1, Src2 and Dest2, Src3 
and Dest3 etc.



358 • DashBoard Interface Overview Ultrix User Guide (v23.0)

MultiBus Panel
The MultiBus Panel provides breakaway control and status monitoring of several destinations 
simultaneously. The MultiBus Panel interface is organized into two buses with a central status row 
of indicators for the levels. The toolbar on the far left of the interface provides options for locking 
and protecting crosspoints, setting up the transition, and selecting the levels. The bottom row of the 
interface is populated with buttons for the salvos defined in the database.

Figure 58  Example of a MultiBus Panel

Left Toolbar

Table 108 summarizes the fields and information displayed in the left toolbar of the MultiBus 
Panel. 

R-Diagonal Presets The destination and source crosspoint selections are automatically 
made starting at the top right corner and progressively moving down 
the grid in a 1:1 pattern. For example, Src10 and Dest1, Src9 and Dest2, 
Src8 and Dest3 etc.

Setup Automation Automatically loops the crosspoint switches for the specified length of 
time.

Stop Automation Stops the automatic loop of crosspoint switches that was initiated using 
the Setup Automation option.

Table 108  MultiBus Panel — Left Toolbar Items

Button Description
Lock Locks the MultiBus panel from all switches or function button 

operation.

Take Performs a Take transition to the next crosspoint selection.

Preset When lit, it indicates both the current crosspoint switch results (buttons 
are lit green) and the newly-selected crosspoints that have not taken 
effect (buttons are lit blue).

Table 107  Matrix Panel — Advanced Menus

Button Description
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Destinations Bus

Each Destination is represented as a distinct box on the top bus of the MultiBus Panel. The 
Destination bus only displays the destinations selected, and their hierarchy, specified when the soft 
panel was configured.

Table 109 summarizes the information displayed for each Destination in the MultiBus Panel. 

Sources Bus

Each Source is represented as a distinct button on the bottom bus of the MultiBus Panel. The 
Source bus only displays the sources, and in the hierarchy, specified when the soft panel was 
configured.

Category Panels
There are two types of Category Panels: Classic and Group. Each Category Panel organizes the 
sources and destinations according to the definitions set in the applicable Category interface for the 
database. The top toolbar is used in conjunction with the central button matrix for selecting sources 
and destinations. The left side of the interface provides access to level selection, and reports on the 
breakaway status with fields for each level. Some functions are category type specific.

Clear Clears the selections in the crosspoint buses. No buttons are lit and the 
fields in the Destination buses are blank.

Multi Select Enables you to assign a single source to multiple destinations for a 
multi-switch configuration.

Level # Each configured level in the currently active database is represented 
with a button. When selected, the button is lit with the color assigned to 
the level. Crosspoint selections on the matrix are also lit this color when 
the level is included in the next switch.

Follow Automatically selects all the Level buttons listed on the Matrix panel 
(buttons are now lit). All levels are now included in next crosspoint 
selection.

Table 109  MultiBus Panel — Destination Items

Button Description
Name The Destination name/label is reported at the top of each area and 

displays as a selectable button. This enables for quick identification on 
the bus when selecting crosspoint switches.
The Destinations available on the bus is dependent on the database 
currently loaded on the router and how many destinations were 
specified when the soft panel was configured.

Level # This field reports the level(s) that the destination was associated with 
on the last crosspoint switch.

Source # This field reports the source(s) currently selected on the Source bus 
located near the bottom of the MultiBus Panel interface.

Lock Locks the Destination from all switches or function button operation.

Protect Protects the currently selected Destination from use by other sources, 
as well as from other linked panels.

Table 108  MultiBus Panel — Left Toolbar Items

Button Description
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For More Information on...
• the items in a Category soft panel, refer to  “Using Category Panels”.

Ultritouch PB Panels
You can control an Ultrix router via Ultritouch by loading a saved soft panel using the Ultritouch 
hard panel interface. Loading a soft panel to Ultritouch requires a similar method as loading a soft 
panel in the Ultrix and/or Ultricore menu system. You select the device in the Ultritouch > All 
Connections interface, navigate to the specific soft panel you wish to load, and select it from the 
provided list. 

Figure 59  Example of an Ultritouch Soft Panel

For More Information on...
• the creating and using Ultritouch soft panels, refer to the Ultritouch + Ultrix User Guide.

Push Button Panels
The Push Button Panel interface is organized into four distinct areas. The top area displays the 
Destinations, the middle row includes the Source buttons, and each area can include an 
independent method for filtering the buttons. A toolbar provides access to the level buttons, and 
includes a status field. A second toolbar provides options for locking and protecting crosspoints, 
setting up the transition, selecting salvos, and other functions. 

Figure 60  Example of a (Landscape) Push Button Soft Panel
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For More Information on...
• the creating and using Push Button soft panels, refer to “Using Push Button Panels”.

Using Walkabout in DashBoard
Walkabout is a Ross router utility operating within DashBoard that enables you to configure the 
network settings for Ross routers, remote control panels, and other devices. Once a valid 
connection is established with Walkabout, the router is listed in the Tree View of DashBoard and 
available for monitoring and configuration using the options in DashBoard. 

Ultrix supports a basic configuration mode via the Walkabout system for initial configuration of IP 
settings. Use Walkabout to:

• specify device IP settings and names
• specify a name for your routing system
• specify the system role (e.g. primary, backup, device)
• select a system to join from a list of valid system names assigned to controllers
• set communications server from a list of valid communication server devices (or IP)

For More Information on...
• the features of Walkabout, refer to the document Configuring Devices Using Walkabout.
• using Walkabout and the Ultrix router, refer to “Using Walkabout to Assign the Initial IP 

Address to the Ultrix Router”.
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Glossary
The following terms are used throughout this guide:

Breakaway — an act of performing a switch on only some of the signals grouped together under 
one label.

Connection Point — setting to define a communication connection between an Ultrix and a device 
in the routing system.

Crosspoint — a switch within a matrix. For example, the connection of signal IN 1 to OUT 1 requires 
one crosspoint.

Destination — a label applied to a router output (or group of outputs).

Device — a physical, virtual, or software application that may include multiple sources, 
destinations, senders, or receivers.

Flow — the continuous raw media content. It can contain more than one essence (e.g. an audio 
flow can contain multiple channels, and an SDI flow may contain audio and video essences). A flow 
is independent of the transport protocol. For example, 48kHz LPCM audio is a flow; AES67 is one 
type of stream which can carry the flow. Flows cannot generally be passed around natively, and 
need to be encapsulated in a stream. Flows from the same source are considered “editorially 
equivalent”, but may be encoded differently. For example, a video source may be encoded as 4:2:2 
YCbCr uncompressed, 4:4:4 RGB uncompressed, and h.265 encoded. Each of these would be a 
separate flow from a common source.

Hard Panel — a physical hardware panel of buttons that is used to control the routing system.

Head — An OUT port on the Ultrix router that is assigned as an UltriScape (Multiviewer) output.

IP Address — a setting that defines the Internet protocol address of a device within a network.

Label — text that is used by control displays to identify a signal as an input or output.

Level — refers to a section of a routing system. For example, a video router would be one level and 
an audio router would be a second level.

Logical (virtual) Label — a name for a group of routing system inputs or outputs.

Logical (virtual) Routing — the action of switching a group of otherwise unrelated signals via a 
common label (name).

Macro — a recorded sequence of Remote Control Panel operations (local to the panel).

Map — a table that defines the allocation of names (labels) to router input and output sockets.

Matrix — the part of the routing system that performs the actual signal switching tasks.

Partition — matrices may be partitioned to behave as smaller independent matrices.

Picture in Picture (PIP) — a sub-picture in an UltriScape (Multiviewer) output.

Receiver — an element within a device that receives exactly one stream, which contains one flow 
from a network.

Remote Control Panel (RCP) — a physical hardware panel of buttons that is used to control the 
routing system.

Resource — a source or destination of a router configuration; an external device providing some 
conversion functionality for use within the routing control system.

Salvo — a system wide sequence of matrix control operations and crosspoint actions.

Sender — an element within a device which presents exactly one flow, packaged as a stream onto a 
network.
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Stream — one flow, encapsulated within a transport protocol. Examples include SMPTE ST 2022-6, 
SMPTE ST 2110-20 Video, or SMPTE ST 2110-30 Audio (AES67).

Soft Panel — a DashBoard interface that represents a panel of buttons that is used to control the 
routing system.

Source — a label applied to a router input (or group of inputs).

T-Bus — the Ross Video proprietary routing communication method via a defined physical 
interface.

UltriClean — clean switch functionality of the Ultrix routers.

Ultricore — refers to the Ultricore-CC and the Ultricore-BCS unless otherwise stated.

UltriMix — SDI embedded audio manipulation sub-system of the Ultrix routers.

UltriScape — licensed Multiviewer option for Ultrix routers.

UltriSpeed — licensed 12Gbps SDI video option.

UltriSync — a per input licensed frame synchronizer.

ULTRIX-FR1 — refers to all versions of the ULTRIX-FR1 router unless otherwise noted.

ULTRIX-FR2 — refers to all versions of the ULTRIX-FR2 router unless otherwise noted.

ULTRIX-NS-FR1 — refers to the next generation of the ULTRIX-FR1 router. This router displays the 
Ultrix logo on the front door with a blue dot in the “i”.

ULTRIX-FR2-NS — refers to the next generation of the ULTRIX-FR2 router. This router displays the 
Ultrix logo on the front door with a blue dot in the “i”. 
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